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1.1 Astera Centerprise 8.1 – Release Notes
We have rolled out the Feb 2020 release of Astera Centerprise. The new Centerprise 8.1 builds up on the current
major rollout in Astera’s Centerprise series, that is Centerprise 8. With Centerprise 8.1, we have released a couple of
new features that have been in demand for quite a while. Moreover, we have also modified and enhanced some of the
existing features for a more secure and seamless integration experience.
Here’s a rundown of what’s new and improved in Centerprise 8.1
• Improvements in Repository Upgrade Paths
Significant improvements have been made in repository upgrade paths in Centerprise 8.1. With this improvement, the
migration from an earlier version to Centerprise 8 becomes more seamless and can be performed on your existing
repository created on a pre-Centerprise 8 version.
With v8.1, you don’t need to create a new repository to communicate with the server while migrating from an earlier
version. All the jobs and schedules on your existing repository can be exported to Centerprise 8.1 by performing a
direct upgrade of cluster database to v8.1. This can be done by going to the Server menu > Manage > Upgrade Cluster
Database.

Provide connection details and set the database to your current repository.

This will upgrade your existing repository to communicate with v8.1 integration server, without affecting any jobs or
schedules. The next step is to configure the server to communicate with the repository. Once you have configured the
server, log in using your admin credentials.
The default admin credentials for Centerprise 8.1 are:
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Username: admin
Password: Admin123
• Improvements in User Roles and Security Control Features
We have made some changes to improve the overall user and security management in Centerprise v8.1. This includes
user activation from within the user management window. Moreover, you can also build up custom user roles on
existing roles by cloning a user role and then making changes to the assigned role resources.
• Support for SAP HANA and Maria DB
Delivering on the popular demand of our users, we have introduced support for SAP HANA and MariaDB databases to
our library of connectors in Centerprise v8.1. This will provide users with seamless and out-of-the-box connectivity to
SAP HANA and MariaDB databases at both source and target points. Moreover, as with all other databases connected
with Centerprise, you will be able to use SAP HANA and MariaDB with SQL Query Lookup, Database Lookup, and
SQL scripts in integration flows and also transform the source data using the built-in transformations in Centerprise.
Read more on how you can use the SAP HANA connector in Centerprise 8.1 in this blog.

1.2 Astera Centerprise 8.0 – What’s New, What’s Fixed, and What’s
Improved
Centerprise 8.0 is a major release in Astera’s line of ETL solutions and is shipped with new features, existing feature
updates, as well as a brand-new UI. Here’s a short summary of what’s new, what’s fixed, and what’s improved:

1.2.1 Centerprise 8.0 – What’s New
REST Server Design
We are now shipping a REST-based Centerprise server with the release of version 8.0. We have transitioned from
.NET remoting to RESTful web services.
Introducing Lean Centerprise client – A Modern, Scalable Architecture
You asked for an easier way to deploy Centerprise across a company network, and we delivered! This is good news
for your IT administrators. We have introduced a lightweight version of the Centerprise client with the 8.0 upgrade.
Assemblies and DLLs (Dynamic Link Libraries) for most database drivers now reside on the Centerprise server instead
of the client machines. Now you can scale horizontally and add more clients to an existing cluster of servers with
minimum IT overhead.
SmartMatch Functionality
We have introduced the SmartMatch functionality in Centerprise 8.0 to simplify complex mapping jobs in ETL flows.
It uses a Synonym Dictionary File created by the user to resolve mapping issues that arise due to naming inconsistencies in the incoming source data. The Synonym Dictionary file is a simple txt file in which users can specify variations
of the header name in a pipe delimited format and Astera integration server will automatically read and match field
names at run-time based on the predefined information in the dictionary.
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Data Cleanse Transformation
Data Cleanse is a new addition to Centerprise’s library of built-in transformations. Data cleansing is an essential step
in the data preparation process and the Data Cleanse transformation makes it all the more convenient for users to
cleanse raw data and present it in a more refined, standardized and enterprise-ready format. Using the Data Cleanse
transformation, users can:
• Replace null strings and numeric values with blanks and zeros respectively
• Remove extra spaces, unnecessary text and numeric characters, punctuations, line breaks, etc.
• Change letter cases to upper, lower, or title case
• Apply regular expressions and find-and-replace actions on datasets
• Prepare raw data for transformation, validation, profiling, and record matching functions
Dynamic Layout
Dynamic Layout feature has been added to some source objects in Centerprise 8.0. It makes it all more convenient for
users to ensure layout consistency in integration flows. The Dynamic Layout feature eliminates the need and hassle of
manually updating the mappings between different objects in a dataflow and ensures they’re all in sync with the source
schema.

1.2. Astera Centerprise 8.0 – What’s New, What’s Fixed, and What’s Improved

3

Centerprise, Release 8

Job Optimizer
Delivering on our promise of optimizing data integration processes for maximum agility and seamless performance,
we have added the Job Optimizer functionality to the latest release of Centerprise 8.0. The Job Optimizer enables
users to optimize ETL performance and minimize job execution time.
The Job Optimizer issues recommendations to optimize integration flows, at runtime in job trace. These recommendations can be removing repetitive sort operations on presorted data, apply an ORDER BY clause on database sources
to run sort operations in the database, or any other suggestion to optimize your flow. As a result, it helps bring a significant increase in performance by efficiently managing the RAM, CPU, network and disk utilization while executing
jobs.
The New Search Feature
A Search feature has been added to the Toolbox, Expression Builder, Server Log and Job Monitor. This new Search
bar enables better navigation through different features and components, resulting in better experience and improved
user-friendliness.
- In the Toolbox, the Search feature enables easy navigation across different sources, destinations, transformations,
text processors, resources, and other components of the toolbox.

- In the Expression Builder, the Search features makes it convenient for users to find a relevant expression function
without having to browse through the extensive library of Centerprise’s built-in expressions.

- In the Server Log, this feature allows users to look for particular jobs deployed, running, or executed on the Server
with respect to JobID, Server Name, Component, Severity and Error Info.

- In the Job Monitor, the search feature allows users to look for jobs based on different criteria such as Date, Job Type,
Job File, Server, etc.

Astera REST Web Service APIs
We have published an extensive library of Astera REST web service APIs. Now, you can perform a wide range of
data integration functions by using APIs to directly communicate with the Centerprise server and get the required data.
Here are the resources that are available for the users in the first round of the beta release:
• Account APIs: Resources related to account login and user authentication.
• Server APIs: Resources related to job monitoring, schedules, and server information.
User Roles and Access Control
Centerprise 8.0 comes with enhanced role-based security features, enabling users to manage data pipelines in heterogenous and multi-user environments. Administrators can grant or restrict access to various users within the organization,
based on their role in the entire data management cycle. The three-fold security mechanism incorporated in Astera
Centerprise 8.0 includes:
• *Secure Domain Configuration –* encrypts information exchange between Centerprise client and server
through an SSL protocol
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• *User Authentication –* prevents unauthorized access to data
• *Role Management –* enables administrators to centrally manage user access by creating custom roles and
access controls

1.2.2 Centerprise 8.0 – What’s Improved
Server Monitoring and Job Management
Centerprise 8.0 includes advanced server monitoring and job management features to enable administrators to proactively manage job monitoring, prevent downtimes, and identify the causes of server failure. Moreover, in case of server
failure or outage, users can generate a diagnostic file to get details about the state of the server and the machine where
it’s deployed.
This diagnostic file contains information such as server status, server health, active connections, process memory size,
thread count, installed drivers, etc. which you can use for troubleshooting and improvements. Furthermore, you can
track, monitor and manage the jobs scheduled, running or executed on the server in the Job Monitor window.
Job Trace Improvements
The Job Trace window has been updated with an improved UI response time and better trace navigation. The trace
refresh on the client is decoupled from the server writing to the trace. As a result, the client may not display all entries
while loading a very fast and long live trace, which will ultimately improve the load time for long trace outputs. The
server performance has also been optimized since the server uses bulk insert to write the trace output.

Here’s a rundown of the improvements in the job trace:
- Refresh and Clear Trace buttons have been added to the monitoring toolbar.
- Suggestions for job optimization are always displayed in the job trace.
- Verification errors or warnings or suggestions can be traced in the job trace.
- The status of the job is also displayed by an icon depending on whether it is completed, queued, terminated, etc.
Workflow Performance Optimization
Another significant highlight of Centerprise 8.0 is the improvement in Astera server code to optimize the performance,
reliability, and scalability of workflows. The workflow execution logic has been optimized to eliminate any chance of
a workflow hanging amidst session in any state (queued, running, or terminating), even if there are transient communication errors between the main server or cluster servers and the repository.

1.2. Astera Centerprise 8.0 – What’s New, What’s Fixed, and What’s Improved
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Significant improvements have been made to Resume and Terminate functionalities for workflows in Centerprise 8.0.
The limitations in resuming complex, nested workflows found in previous releases have been resolved in Centerprise’s
latest release.
In Centerprise 8.0, while working with nested workflows (workflows that call other workflows within a master workflow), if a child component returns an error and is not executed successfully, the parent flow will terminate automatically. Likewise, when you resume a child flow that returned error(s) and led to the termination of the parent flow, the
parent flow will also get resumed automatically.
Parametrization
The parametrization functionality in Centerprise 8.0 has been improved to support expression compilation in variables.
The syntax has been changed from ‘$ ()’ notation to ‘{}’. However, this update won’t affect the parameters incorporated in existing flows. The current flows will continue to run seamlessly as before, without having to manually update
the syntax. And once you save any flow that was using previous notation ‘$ ()’ in version 8, it will automatically get
converted to ‘{}’.

1.2.3 Other Highlights
Improvements in List Lookup and DB Lookup transformations: New options added to the layout builder screen
of List lookup and DB lookup transformations. Now you can keep the source value for the values that do not match
the replacing criteria in a list or a database table.
Path Mappings tab added: A new tab for specifying client and server path mappings has been added on the Cluster
Settings This is particularly useful when the client and server reside on different networks or network file systems and
their paths have to be mapped to correctly transfer files at run-time.
Option added to repair file paths: For better project management, we have added a new option to repair the file
paths for files in any particular folder. This option is useful if you are working in a case-sensitive environment.
Shortcut for replacing parameters information for consolidated parameters added: Now you can replace the
common parameter information for all objects in a flow with this command right from the dataflow screen.
Pushdown mode is expanded and improved: More transformations and expressions are now supported in the Pushdown mode. We have also improved the explanations for the verification errors for easier troubleshooting.
Salesforce UPSERT is fully supported: Salesforce UPSERT is now fully supported. UPSERT uses an external ID
field in the Salesforce table to match incoming data with existing records.
Keyboard shortcuts added and displayed: Keyboard shortcuts are enabled for various task windows. You can view
the shortcut keys next to their respective commands.
Performance improvements when mapping complex trees: Runtime performance of the dataflows containing complex tree structures is improved.
New additions to the data providers list: We have added Tableau to the list of supported data providers.
SCD write strategy improved: SCD type 3 and type 6 are now supported.
REST call retries: For the REST calls running in timeout error, Centerprise will automatically make up to three retry
attempts to process the call.

1.2.4 Migrating from Centerprise 7.x to Centerprise 8.0
If you’re using an older version of Centerprise and planning to upgrade to Centerprise 8.0, follow through the steps
mentioned in this document for a smooth migration.
Have any queries, issues or suggestions? Reach out to us at support@astera.com.
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1.3 Known Issues in Centerprise 8 (Beta)
Centerprise 8 (Beta) comes with significant changes in the product design architecture. To get more information about
the features included in Centerprise 8, refer to the release notes.
However, we are aware of certain issues and limitations in Centerprise 8. These issues are either due to pending fixes
or due to third-party software limitations.
Here is the list of known issues:
1. Name and Address parser features are not available in Centerprise 8 Beta. Functions not supported in beta
release are:
• ParseAddress
• ParseAddressUS
• ParseAndCorrectAddress
• ParseName
• ParseNameEx
2. Oracle bulk load is not supported until Oracle releases .Net Core update for the driver. You can use array insert
as an alternative, which provides a similar performance benefit as the bulk load. If you need record level logging,
you can use Single insert.
3. Spaces in field names will cause verification and run-time error. You will need to replace space with a different
character, for example ‘_’, as a workaround for this issue.
4. Legacy DDTek providers support is deprecated. Oracle - Legacy, DB2 - Legacy and Sybase -Legacy providers
are not supported in version 8. You are advised to use Oracle ODP and IBM DB2 drivers instead.
5. Lean client can only connect to one server at a time. This is done using the Server Connection screen at the
client startup. If the user needs to connect to a different server, they will need to close and restart the client, and
then connect to the new server using the Server Connection screen. To see the server currently connected to, go
to View > Server Explorer. The server will show under DEFAULT cluster.
6. Load-balancing can be achieved using clusters of servers with a single repository database. There is no change
in this functionality compared to version 7.5. However, only the currently connected server will be listed in
Server Explorer, instead of all the servers in the cluster.
7. SOAP requests are not supported in Web Server Transformation object.

1.4 Migrating from Centerprise 7.x to Centerprise 8
Astera Centerprise 8 is a major release and not a direct upgrade of Centerprise 7.6. This means that migrating from
Centerprise 7.x to Centerprise 8 won’t require you to uninstall Centerprise 7 since Centerprise 8 can be installed side
by side with Centerprise 7 on a system. Centerprise 8 is backward compatible, and therefore, most of the flows created
on Centerprise 7 can run on Centerprise 8 without modifications. However, as with most major release of any complex
software, we recommend that you upgrade your lower level environment first, so you have an opportunity to test and
verify any existing flows. This will make it possible to identify any migration issues you may encounter early on in the
upgrade cycle. In this document, we will cover how you can migrate from Centerprise 7.x to the all-new Centerprise
8.

1.4.1 Installing
The installation package for Centerprise 8 (64-bit) contains two setup (.exe) files:
1.3. Known Issues in Centerprise 8 (Beta)
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• CenterpriseDataIntegrator.exe – for Centerprise client, and
• IntegrationServer.exe – for Astera Integration Server
The setup files for Centerprise 8 can be downloaded from the following location:
https://discover.astera.com/test-drive-the-new-centerprise-8-0/
Click here to learn how to install Centerprise 8 client and server.

1.4.2 Licensing
Unlike the previous releases of Astera Centerprise, Centerprise 8 comes with a single licensing key (for server) rather
than two separate keys for Centerprise server and client. The licensing key for Centerprise 8 has changed which means
you cannot use your Centerprise 7 key to register Centerprise 8. The single licensing key for Centerprise 8 is used
to register Centerprise server and it controls how many clients can connect to the server as well as the functionality
available to the connected clients.
If you’re planning to migrate to Centerprise 8, please contact sales@astera.com to get your new your Centerprise 8
license key. The server threshold to accept licenses will depend on the number of licenses you purchase. So, for
instance, if you have purchased 50 licenses, the server will accept up to 50 licenses at most.

1.4.3 Cluster and Server Management in Server Explorer
Centerprise 8 client can be configured with multiple different servers, however, it can only connect with one server at
a time. The jobs scheduled, queued or running on the other registered server will continue to run without interruption
even if the client is not currently connected to the server.
All servers pointing to a single repository database will form a cluster of servers sharing the common workload of
queued jobs. A cluster of v8 servers you configure will be up and running and processing jobs in a similar way to 7.6,
despite the fact that the v8 client can only connect to and manage one v8 server at a time. You can see which server in
the cluster has actually processed a job by right-clicking the Cluster and opening Server Jobs window.
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1.4.4 Repository
You need to set up a new repository to communicate with Centerprise 8 server. While upgrading the previous releases
of Centerprise 7, you would simply go to Server > Upgrade Cluster Database. However, while migrating to Centerprise 8, you need to set up a repository in a new database from the scratch to communicate with the server(s) and store
the record of server activity. To set up a repository in Centerprise 8, go to Server menu > Configure > Build Repository
Database and Configure Server.

Follow through the steps explained in this article to build a cluster database and set up a repository in Centerprise 8.

1.4.5 Manually Migrating Existing Jobs from Centerprise 7 to Centerprise 8
Once you have built a cluster repository in Centerprise 8, the next step is to migrate the scheduled jobs you created in
Centerprise 7.
1. For this, open Scheduler in Centerprise 7 from Server > Job Schedules.

1.4. Migrating from Centerprise 7.x to Centerprise 8
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2. You will see all the scheduled jobs listed in the Scheduler. Select the jobs you want to migrate.

3. Click ‘Export Schedule’ button in the Scheduler toolbar.
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4. Point to the directory and folder where you want to save the scheduled jobs and click OK.

Now Centerprise will create a separate XML file with ‘.Sched’ extension for each scheduled job and save it in the
designated folder.

1.4. Migrating from Centerprise 7.x to Centerprise 8
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5. A message window will pop up to notify that your scheduled jobs have been successfully. Click OK.

6. Now you have to import the job files in Centerprise 8 to complete the migration process. For this, open Centerprise
8 client and go to Server > Job Schedules.

7. This will open the Scheduler tab in Centerprise client. To import the existing jobs, click the ‘Import Schedule’
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button in the Scheduler toolbar.

8. Point the path to the directory where you have saved the schedule files. Select all the scheduled jobs you want to
import and click ‘Open.’

9. You can see that the existing jobs scheduled in Centerprise 7 have been successfully migrated to Centerprise 8 and
a new Job ID has been assigned to each job.
![](migrating-v7-to-v8.assets/2 (1).png)

1.4. Migrating from Centerprise 7.x to Centerprise 8

13

Centerprise, Release 8

1.4.6 Migrating Existing Jobs from Centerprise 7 to Centerprise 8 Using PreDesigned Flows
Prior to any upgrade, we strongly recommend that you take a full backup of your repository database. Also, upgrading a lower level environment first (such as QA, UAT, etc.) is recommended prior to upgrading the Production
environment. This will make it possible to sort out/resolve any issues before upgrading Production.
Steps to Upgrade:
Using Centerprise 7 client, run the following dataflow to export existing schedules into a comma delimited file.
Note: Prior to running the dataflow, you will need to update the Database Source Object to point to the database where
Centerprise repository resides.
Download attached dataflow: Dataflow_ScheduleExport7.df
Take note of any existing Cluster Settings. You can check it by right-clicking the cluster in Server Explorer and
selecting ‘Cluster Settings’ in the context menu. These settings will need to be re-configured manually after the
upgrade.
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It may be helpful to take screenshots of those settings for later reference. The settings include: Staging Directory,
Purge Job Frequency Options, Email Notification Setup, and optionally, Server Profiles if a non-default profile was
used prior to the upgrade.

1.4. Migrating from Centerprise 7.x to Centerprise 8
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Install Centerprise 8 client and server on your machine. You can read more on installing Centerprise 7 client and server
in this document.
Open Centerprise 8 client. Go to Server menu > Manage > Build Cluster Database. Point it to the database hosting
Centerprise repository.
Important Note: This will reset the repository.
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Use the dataflow below to import the schedules you have exported in Step 1.
Note: Prior to running the dataflow, you will need to change the Database Table Destination object to point to the
database where Centerprise 8 repository resides.
Download attached example dataflow: Dataflow_ScheduleImport8.df
Open Server Explorer, right-click your cluster and select ‘Cluster Settings’. Manually re-configure the relevant settings
from Step 2. Optionally, you can manually reconfigure the Server Profiles setting if a non-default profile was used
prior to the upgrade.

1.4. Migrating from Centerprise 7.x to Centerprise 8
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Restart Centerprise server.
This completes the upgrade.
You can download the flows by clicking on the link below:
• Dataflow_ScheduleExport7.df (70 KB)
• Dataflow_ScheduleImport8.df (60 KB)

1.4.7 Migration Best Practices:
• When you are starting the migration process, it is recommended to keep Centerprise 7 and Centerprise 8 servers
running in parallel. This is to avoid any interruption in jobs that are currently running.
• We also recommend you initiate the migration process with a lower-level, testing environment and then promote
your deployment to a higher-level environment as needed. This will help ensure smooth migration process with
any flow compatibility issues spotted early in the transition cycle.
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1.5 Centerprise 8 - Important Considerations
There are some important considerations that you need to take into account when working with Centerprise 8. In this
article, we are covering all the instances where Centerprise 8 differs from Centerprise 7 line up.

1.5.1 Running Centerprise 7 and Centerprise 8 Server Side-By-Side
You can run Centerprise 7 and Centerprise 8 servers in parallel since they are configured to use different port numbers
by default. Note that these port numbers may be different in your environment, so you are advised to check with your
network administrator.
• Port 9259 – for Centerprise 7, and
• Port 9260 – for Centerprise 8

1.5.2 Server URI
Centerprise 8 uses HTTPS (HTTP over SSL) protocol to connect Centerprise clients to the server. Click here to read
more about how to connect a Centerprise server using the Server URI.

1.5. Centerprise 8 - Important Considerations
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1.5.3 Additional Considerations
• Firewalls: In Centerprise 8, HTTPS protocol is used to establish a more secure connection, compared to the
.Net remoting protocol used in Centerprise 7.x. This allows remote Centerprise clients to connect to the server
across AD/Windows domains and even across Cloud/WAN. This also requires that the appropriate ports are
open in your network configuration for SSL connectivity to work.
• Self-Signed Certificates: Centerprise server installer creates a self-signed certificate during server installation.
The certificate file must be present in the server’s application directory for server to start. Click here to learn
more about how to set up a self-signed server certificate in Centerprise 8.
• Port Number: Centerprise 8 server runs on Port 9260.
• Client-Server Connectivity: Centerprise 8 client cannot be connected to Centerprise 7.x server, and likewise,
Centerprise 7.x client cannot be connected to Centerprise 8 server.

1.5.4 User and Security Management
Windows/AD-based domain and local user accounts are not supported in Centerprise 8. Centerprise 8 brings its own
security framework. This means that you will need to define users, roles, and permissions to resources manually as
part of the 7.6 to 8 migration.
You can create and manage user roles, add new users, define and/or delete roles, and edit role resources, all in a
dedicated window in Centerprise client. To manage different users in Centerprise client, go to Server Explorer, rightclick on ‘DEFAULT’ and select ‘User List’ from the context menu.
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This will open a new window where you can register a new user, activate or delete users, and edit their roles.

To manage user roles in Centerprise 8, go to Server Explorer, right-click on ‘DEFAULT’ and select ‘Role List’ from
the context menu.

1.5. Centerprise 8 - Important Considerations
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This will open a new window where you can create and [manage different user
roles](https://www.astera.com/type/blog/security-and-access-control-in-centerprise-8-0/#targetText=Centerprise
8.0 features an intuitive,permission and access related functions.).

Learn more about managing user roles here.
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1.5.5 Legacy Providers
DB2 and Oracle legacy database providers are not supported in Centerprise 8. However, you can natively connect to
Oracle and DB2 databases using the Database Table source in Centerprise 8 client. For these connections to work, you
need to make sure the appropriate database driver is installed on the machine that runs Centerprise server. The client
machines no longer require those drivers, which simplifies product rollout and management. For more information no
installing and configuring Oracle and DB2 drivers, please refer to these articles.
• Setting Up Oracle ODP.Net Connectivity in Centerprise
• Setting Up IBM DB2/iSeries Connectivity in Centerprise

1.5.6 Data Preview
The instant Data Preview feature that was offered as part of Centerprise client in previous releases has now been shifted
over to the server in Centerprise 8. Now when a user wants to preview the data, the data request is processed on the
server and the data is then displayed by Centerprise client in the data preview window. This is particularly beneficial
in cases of some complex network environments or where multiple clients are connected to a single server. Users no
longer need to install the data providers on their workstation, instead, the data providers can be installed directly on
the server.
1.5. Centerprise 8 - Important Considerations
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1.5.7 Repository Database Provider Support
Centerprise 8 supports MS SQL Server and PostgreSQL database providers for repository.

1.5.8 Linux Support
Linux support has been included in Centerprise 8. With this update, Centerprise Integration Server can now be deployed on different versions of Linux (Ubuntu and Centos).
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1.5.9 .NetCore vs .Net4.7
Centerprise 8 is built on .NETCore architecture compared to Centerprise 7.x line which was built on .Net 4.7. This
has brought about a significant performance increase in Centerprise 8, up to 25% faster than the previous releases.

1.5.10 Server Restart (via Services)
In Centerprise 8, there’s no functionality to start or stop a server from the Server Explorer in Centerprise client. To
restart a server in Centerprise 8, go to Services > Server > Restart.

1.5.11 New Service Name
The service name for Centerprise 8 has been changed. ‘Astera.TransferService.exe’ will continue to be
the service name for Centerprise 7, whereas the service name for Centerprise 8 will be identified as
‘Astera.TransferServiceWebApi.exe.’

1.5. Centerprise 8 - Important Considerations
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1.5.12 Schedule Objects vs. Imported Schedules
There are two different types of schedules in Centerprise 8:
• Imported Schedules – create schedules by importing existing jobs using a ‘.Sched’ file.
• Schedule Objects – go to Virtualization menu > Caching Schedules. This schedule is created by adding a new
schedule in the Scheduler window and is saved in an XML file with ‘.Schd’ extension.

1.5.13 SOAP
SOAP transformation is not currently supported in Centerprise 8.

1.5.14 Name and Address Parser
The Name and Address Parser functionality has not been included in this release of Centerprise 8. This was offered
as a third-party feature in Centerprise 7 and previous releases. We’re currently working on making improvements to
this functionality and it will be reintroduced in the coming releases of Centerprise 8 with more enhanced features and
improved performance.

1.6 Centerprise 8 – System Requirements
Note: The overall speed and performance of the application depend on the configuration of your machine. More
memory and higher processing speed on the system will result in faster performance, especially when transferring
large amounts of data as the application takes advantage of the multicore hardware to parallelize operations.
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1.7 Installing Client and Server Applications
In this section we will discuss how to install and configure Centerprise Server and Lean Client applications.

1.7.1 How to install Centerprise Server
1. Run ‘IntegrationServer.exe’ from the installation package to start the server installation setup.
2. You’ll be directed to the welcome screen. Click Next to continue.

3. On the next screen you will see the license agreement. You can only continue if you choose to accept the terms of
the license agreement. Click Next to continue.

1.7. Installing Client and Server Applications
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4. On the next screen, enter the user details and click Next to continue.
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5. You can specify/change the folder for installing Centerprise server on the next screen. By default, it is installed in
Program Files > Astera Software > Astera Integration Server 8. Click Next to continue.

1.7. Installing Client and Server Applications
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6. Select the type of installation (Complete or Custom) you want to proceed with and click Next.
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7. Select Install to complete the installation.

1.7. Installing Client and Server Applications
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8. Select Finish to finish the installation process.
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1.7.2 How to install Centerprise Lean Client
1. Run the ‘CenterpriseDataIntegrator’ application from the installation package to start the client installation setup.
2. You’ll be directed to the welcome screen. Click Next to continue.

1.7. Installing Client and Server Applications
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3. On the next screen you will see the license agreement. You can only continue if you choose to accept the terms of
the license agreement. Click Next to continue.
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4. On the next screen, enter the user details and click Next to continue.

1.7. Installing Client and Server Applications
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5. You can specify/change the folder for installing Centerprise server on the next screen. By default, it is installed in
Program Files > Astera Software > Centerprise Data Integrator 8. Click Next to continue.

36

Chapter 1. Other Versions

Centerprise, Release 8

6. Select the type of installation (Complete or Custom) you want to proceed with and click Next.

1.7. Installing Client and Server Applications
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If you select custom installation, you can choose specific component(s) that you want to download.
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I want to install the complete package therefore, I’ll select Complete on the Setup Type screen and click Next.
7. Select Install to complete the installation.

1.7. Installing Client and Server Applications
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8. Select Finish to finish the installation process.
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This is how you install Centerprise client and server applications. The next step is to establish a connection between
Centerprise client and server. See how to connect to a Centerprise server using lean client.

1.8 How to Install Centerprise Lean Client
1. Run the ‘CenterpriseDataIntegrator’ application from the installation package to start the client installation setup.
2. You’ll be directed to the welcome screen. Click Next to continue.

1.8. How to Install Centerprise Lean Client
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3. On the next screen you will see the license agreement. You can only continue if you choose to accept the terms of
the license agreement. Click Next to continue.
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4. On the next screen, enter the user details and click Next to continue.

1.8. How to Install Centerprise Lean Client
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5. You can specify/change the folder for installing Centerprise server on the next screen. By default, it is installed in
Program Files > Astera Software > Centerprise Data Integrator 8. Click Next to continue.
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6. Select the type of installation (Complete or Custom) you want to proceed with and click Next.

1.8. How to Install Centerprise Lean Client
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If you select custom installation, you can choose the specific component that you want to download.
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I want to install the complete package therefore, I’ll select Complete on the Setup Type screen and click Next.
7. Select Install to complete the installation.

1.8. How to Install Centerprise Lean Client
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8. Select Finish to finish the installation process.
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This is how you install Centerprise client application. The next step is to establish a connection between Centerprise
client and server. See how to connect to a Centerprise server using lean client.

1.9 How to Set up a Server Certificate (.pfx) File in a New Environment
1. To install an SSL certificate, go to Program Files > Astera Software > Astera Integration Server 8 and replace
the certificate (.pfx) file placed in the installation directory with the (.pfx) file provided to you by your SSL certificate
provider.
2. After you have replaced the file, open the certificatesettings.json file placed in the installation directory and update
the new filename and password. The password will be provided to you by the SSL certificate provider.

1.9. How to Set up a Server Certificate (.pfx) File in a New Environment
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3. Save the changes and reboot the services for Astera Integration Server 8 and the Server certificate will be implemented.

1.10 Connecting to a Centerprise Server using Lean Client
1.10.1 How to connect to a Centerprise Server from the Client Startup Screen
After you have successfully installed Centerprise client and server applications, open the client application and you
will see the Server Connection screen as pictured below.
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Enter the Server URI and Port Number to establish the connection.
The server URI will be the IP address of the machine where Astera Integration server is installed.
Server URI: (HTTPS://IP_address)
Note: You can get help of your network administrator to get the IP address of the machine where Astera Integration
server is installed. Or you can launch the command prompt and type the command ipconfig to get the IP configuration
details for the machine and use that information to provide Server URI.

1.10. Connecting to a Centerprise Server using Lean Client
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The default port for the secure connection between the Lean client and Astera Integration server is 9260.
If you have connected to any server recently, you can automatically connect to that server by selecting that server from
the Recently Used drop-down list.
Click Connect after you have filled out the information required.
The client will now connect to the selected server. You should be able to see the server listed in the Server Explorer
tree when the client application opens.
To open Server Explorer go to Server > Server Explorer or use the keyboard shortcut (Ctrl + Alt + E).
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The yellow icon with exclamation mark means that the server is not configured. Before you can start working with
Centerprise Lean client, you will have to create a repository and configure the server.
Read: How to Login using Centerprise Lean Client
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1.11 How to Connect to a Different Centerprise Server from the Lean
Client
You can connect to different servers right from the Server Explorer window in Lean Client. Go to the Server Explorer
window and click on the Connect to Server icon.

A prompt will appear that will confirm if you want to disconnect from the current Server and establish connection to
a different server. Click Yes to proceed.
Note: A client cannot be connected to multiple servers at once.

You will be directed to the Server Connection screen. Enter the required server information (Server URI and Port
Number) to connect to the server and click Connect.
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If the connection is successfully established, you should be able to see the connected server in the Server Explorer
window.

1.12 How to Build a Cluster Database and Create Repository
Before you start using the Centerprise server, a repository must be set up. Centerprise supports SQL Server and
PostgreSQL for building cluster databases, which can then be used for maintaining the repository. The repository is
where job logs, job queues, and schedules are kept.
To see these options, go to Server > Configure > Step 1: Build repository database and configure server.

1.12. How to Build a Cluster Database and Create Repository
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The first step is to point to the SQL Server or PostgreSQL instance where you want to build the repository and provide
the credentials to establish the connection.
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Note: Centerprise will not create the database itself, just the tables. A database will have to be created beforehand or
an existing database can be used. We recommend Centerprise to have its own database for this purpose.

1.12.1 Building a Repository on SQL Server
1. Go to Server > Configure > Step 1: Build repository database and configure server.
2. Select SQL Server from the Data Provider drop-down list and provide the credentials for establishing the connection.

1.12. How to Build a Cluster Database and Create Repository
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3. From the drop-down list next to the Database option, select the database on the SQL instance where you want
to host the repository.

4. Click Test Connection to test whether the connection is successfully established or not. You should be able to see
the following message if the connection is successfully established.
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5. Click OK and the following message will appear. Select Yes to proceed.

6. Following message will appear, which will indicate that the repository is successfully built.

1.12. How to Build a Cluster Database and Create Repository
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The next step is to log in using your credentials.

1.12.2 Building a Repository on PostgreSQL
1. Go to Server > Configure > Step 1: Build repository database and configure server.
2. Select PostgreSQL from the Data Provider drop-down list and provide the credentials for establishing the connection.
3. From the drop-down list next to the Database option, select the database on the PostgreSQL instance where you
want to host the repository.
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4. Click Test Connection to test whether the connection is successfully established or not. You should be able to see
the following message if the connection is successfully established.

1.12. How to Build a Cluster Database and Create Repository
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5. Click OK and the following message will appear. Select Yes to proceed.

6. Following message will appear, which will indicate that the repository is successfully built.

The next step is to log in using your credentials.
Read: License Model in Centerprise 8

62

Chapter 1. Other Versions

Centerprise, Release 8

1.13 How to Configure the Server
Once the cluster database has been set up, the next step is to link the server to this cluster database. To do this, in the
Server Explorer tree and select Configure > Build Repository database and configure server.

Fill in the details for the cluster database you previously created. Test the connection, click OK, and then save it.

1.13. How to Configure the Server
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The server will now be configured. The server icon will have a green arrow.
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To view the server properties, right click on the connected server and select Server Properties.

The next step after configuring the server is to Log in from the lean client.
Read next: How to Login from a Lean Client

1.13. How to Configure the Server
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1.14 How to Login from Lean Client
Once you have created the repository and configured the server, the next step is to login using your Astera Centerprise
account credentials.
You will not be able to design any dataflows or workflows on the Lean client if you haven’t logged in to your Astera
Centerprise account. The options will be disabled.

1.14.1 Log in to your user account
1. Go to Server > Configure > Step 2: Login as admin.

2. This will direct you to a login screen where you can provide your user credentials.
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If you are using Centerprise 8 for the first time, you can login using the default credentials as follows: Username:
admin Password: Admin123
After you log in, you will see that the options in the Centerprise Lean Client are enabled.

You will not see options to create a new dataflow, workflow, or any project. For those options to appear, you’ll have to
enter your license.
[Read: How to enter a license key in Centerprise 8.]

1.14. How to Login from Lean Client
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1.14.2 How to automatically reconnect on client startup
If you don’t want Centerprise to show you the server connection screen every time you run the client application, you
can skip that by modifying the settings.
To do that go to Tools > Options > Client Startup and select the Auto Connect to Server option. On enabling the
option, Centerprise will store the server details you entered previously and will use those details to automatically
reconnect to the server every time you run the application.

The next step after logging in is to unlock Centerprise using the License key.
Read next: How to build cluster database and create repository in Centerprise
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1.15 Licensing Model in Centerprise 8
1.15.1 Single license key model
We have introduced a new single license key model for Centerprise 8. Unlike the previous versions of Astera Centerprise, you will now only need a single licensing key (for server) to register and unlock both Centerprise client and
server applications.
The license key provided to you contains information about how many clients can connect to a single server as well
functionality available to the connected clients.
Note: You cannot use your existing set of keys (from version 6 or 7). If you are planning to migrate from version 7 (or
earlier) to version 8, please contact sales@astera.com, as you will need a new license key.

1.15.2 Unlocking Centerprise 8 using your license key
After you have configured the server, and logged in with the admin credentials, the last step is to insert your license
key.
1. Go to Tools > Manage License. Or you can access the License Management window from the Server Explorer.

1.15. Licensing Model in Centerprise 8
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2. On the License Management window, click on Unlock using a key.
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3. Enter the details to unlock Centerprise – Name, Organization, and Product Key and select Unlock.

1.15. Licensing Model in Centerprise 8
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4. You’ll be shown the message that your license has been successfully activated.
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Note: The connected client applications will shutdown for the server license to take effect.

1.15. Licensing Model in Centerprise 8
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If you go to File menu now, you’ll see all the options (Dataflow, Workflow, Subflow etc.) enabled.
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This concludes unclocking Centerprise client and server applications using a single licensing key.

1.16 User Roles and Access Control
In version 8 of the product, we have introduced a role-based access control mechanism. Which means that now
administrators can grant or restrict access to various users within the organization, based on their role in the entire data
management cycle.
In this article, we will look at the user lists and role management features in detail.

1.16.1 How to Create a New User
Note: When you run the application for the first time, sign in using the default credentials provided on our help site.
Username: admin Password: Admin123
Once you have logged in, you now have the option to create new users and we recommend you to do this as a first
step.
1. To create/register a new user, right-click on the DEFAULT server node in the Server Explorer window and select
User List from the context menu.

1.16. User Roles and Access Control
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2. A new window called User Management will open. On this screen you will see a list of all registered users.

3. Click on the Register User icon on the top left corner of the screen. A new window will open and you will be
asked for the registration details. Fill in the required details and click Register.

1.16. User Roles and Access Control
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4. You will see that the new user is now added to the list.

1.16.2 How to Assign User Roles
Now that a new user is registered, the next step is assign roles to the user.
1. Select the user you want to assign the role(s) to and right-click on it. From the context menu select Edit User
Roles. Alternatively, you can select the user and click on the Edit User Roles icon in the icon bar on the top left.
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2. A new window will open where you can see all roles that are there by default in Centerprise or are custom
created. We haven’t created any custom role, so we’ll see the three default roles that are - Developer, Operator,
and Root.

1.16. User Roles and Access Control
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3. Select the role that you want to assign to the user and click on the arrows in the middle section of the screen.
You’ll see that the selected role will get transferred from the All Roles section to the User Roles section. You
can assign multiple roles to a single user.
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4. After you have assigned the roles. click OK.

1.17 UI Walkthrough - Astera Centerprise 8.0
1.17.1 What is Astera Centerprise?
Astera Centerprise is designed to support integration of complex and high-volume data. It is a powerful ETL (Extract,
Transform, Load) tool that provides connectivity to all leading databases, flat and hierarchical file sources, and even
supports legacy systems such as COBOL. Moreover, PDF Form Source, Email Source and Report Source enables
users to extract data from a PDF file, Email and Report Models in Centerprise.
It combines data profiling, data transformation and data reporting in a single seamless user-interface.
This document consists of a video that will walk you through the new and improved user-interface of Centerprise and
introduce you with its different features, components and window panes.
The video covers:
• Items, options and shortcuts available on the menu bar
• How to access important window panes and panels in Centerprise – Server Explorer, Project Explorer, Toolbox,
etc.

1.17. UI Walkthrough - Astera Centerprise 8.0
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• How to work with different flow documents (dataflows, workflows, and subflows) with their embedded features
• Tools and tasks specific to each of the flow documents (transformations, workflow tasks, subflow input/output,
etc.)
• Options related to data profiling and data quality checks
• How to schedule a job and monitor it’s progress
• Report Model and it’s functionality in Centerprise

1.18 Data Providers and File Formats Supported in Centerprise
Astera Centerprise can read data from a wide range of file sources and database providers. In this article, we have
compiled a list of file formats, data providers, and web-applications that are supported for use in Astera Centerprise.

1.18.1 Databases and Data Warehouses
• Amazon Aurora
• MySQL
• Amazon Aurora Postgres
• Amazon RDS
• Amazon Redshift
• DB2
• Google Cloud SQL
• MariaDB
• Microsoft Azure
• Microsoft Dynamics CRM
• MS Access
• MySQL
• Netezza
• Oracle
• PostgreSQL
• PowerBI
• Salesforce (Legacy)
• Salesforce Rest
• SAP Hana
• Snowflake
• SQL Server
• Sybase
• Tableau
• Teradata
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• Vertica
In addition, Centerprise features an ODBC connector that uses the Open Database Connectivity (ODBC) interface by
Microsoft to access data in database management systems using SQL as a standard.
To learn more about how to use the object to read data from the above-mentioned data providers, click here.

1.18.2 File Formats
• COBOL
• Delimited files
• Fixed length files
• XML/JSON
• Excel workbooks
• PDFs
• Report sources
• Text files
• EDI formats (including X12, EDIFACT, HL7)

1.18.3 Cloud-Based Data Providers
• Microsoft Dynamics CRM
• PowerBI
• Salesforce
• SAP
• Tableau
• Amazon S3 Bucket Storage
• Microsoft Azure Blob Storage
Note: Amazon S3 Bucket Storage and Microsoft Azure Blob Storage is planned for Astera Centerprise 9.1 release.

1.18.4 File Systems and Transfer Protocols
• AS2
• FTP (File Transfer Protocol)
• Email
• HDFS (Hadoop Distributed File System) n/a
• SCP (Secure Copy Protocol)
• SFTP (Secure File Transfer Protocol)

1.18. Data Providers and File Formats Supported in Centerprise
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1.18.5 Web Services
• SOAP (Simple Object Access Protocol)
• REST (REpresentational State Transfer)
Using the SOAP and REST web services connector, you can easily connect to any data source that uses SOAP protocol
or can be exposed via REST API.
Here are some applications that you can connect to using the REST Client object in Centerprise:
• FinancialForce
• Force.com Applications
• Google Analytics
• Google Cloud
• Google Drive
• Hubspot
• IBM DB2 Warehouse
• Microsoft Azure
• OneDrive
• Oracle Cloud
• Oracle Eloqua
• Oracle Sales Cloud
• Oracle Service Cloud
• Salesforce Lightning
• ServiceMAX
• SugarCRM
• Veeva CRM
The list is non-exhaustive.
Read: How to connect to Eloqua using REST client object

1.18.6 Support for Custom Connectors
You can also build a custom transformation or connector from the ground up quickly and easily using the Microsoft
.NET APIs, and retrieve data from various other sources.

1.19 Setting Up Sources
Each source on the dataflow is represented as a source object. You can have any number of sources of the dataflow,
and they can feed into zero or more destinations.
The following source types are supported by the dataflow engine:
Flat File Sources:
• Delimited File
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• Excel File
• Fixed Length File
Tree File Sources:
• COBOL
• XML File
Database Sources:
• Data Model
• Database Table
• SQL Query
All sources can be added to the dataflow by picking a source type on the Flow toolbox and dropping it on the dataflow.
File sources can also be added by dragging-and-dropping a file from an Explorer window. Database sources can be
drag-and-dropped from the Data Source Browser. For more details on adding sources to the dataflow, see Introducing
Dataflows.

1.19.1 Flat File Sources
Delimited File
Adding a delimited file source object allows you to transfer data from a delimited file. An example of what a delimited
file source object looks like is shown below.

To configure the properties of a Delimited File Source object after it was added to the dataflow, right-click on it and
select Properties from the context menu.
Fixed-Length File
Adding a fixed-length file source object allows you to transfer data from a fixed-length file. An example of what a
fixed-length file source object looks like is shown below.

To configure the properties of a Fixed-Length Source object after it was added to the dataflow, right-click on it and
select Properties from the context menu.
Excel File
Adding an Excel file source object allows you to transfer data from an Excel file. An example of what an Excel file
source object looks like is shown below.

1.19. Setting Up Sources
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To configure the properties of an Excel Source object after it was added to the dataflow, right-click on it and select
Properties from the context menu.

1.19.2 Tree File Sources
COBOL File
Adding a COBOL file source object allows you to transfer data from a COBOL file. An example of what a COBOL
file source object looks like is shown below.

To configure the properties of a COBOL Source object after it was added to the dataflow, right-click on it and select
Properties from the context menu.
XML File
Adding an XML file source object allows you to transfer data from an XML file. An example of what an XML file
source object looks like is shown below.

To configure the properties of an XML Source object after it was added to the dataflow, right-click on it and select
Properties from the context menu. The following properties are available:
General Properties screen:
File Path – specifies the location of the source XML file. Using UNC paths is recommended if running the dataflow
on a server.
Note: To open the source file for editing in a new tab, click icon next to the File Path input, and select Edit File.
Schema File Path – specifies the location of the XSD file controlling the layout of the XML source file.
Note: Centerprise can generate a schema based on the content of the source XML file. The data types will be assigned
based on the source file’s content.
To generate the schema, click icon next to the Schema File Path input, and select Generate.
To edit an existing schema, click icon next to the Schema File Path input, and select Edit File. The schema will open
for editing in a new tab.
Optional Record Filter Expression – allows you to enter an expression to selectively filter incoming records according
to your criteria. You can use Expression Builder to help you create your filter expression. For more information on
using Expression Builder, see Expression Builder.
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Note: To ensure that your dataflow is runnable on a remote server, please avoid using local paths for the source. Using
UNC paths is recommended.

1.19.3 Database Sources
Database Table
Adding a database table source object allows you to transfer data from a database table. An example of what a database
table source object looks like is shown below.

To configure the properties of a Database Table Source object after it was added to the dataflow, right-click on it and
select Properties from the context menu. The following properties are available:
Source Connection screen – allows you to enter the connection information for your source, such as server name,
database and schema, as well as credentials for connecting to the selected source.
Pick Source Table screen:
Select a source table using the Pick Table dropdown.
• Select Full Load if you want to read the entire table.
• Select Incremental Load Based on Audit Fields to perform an incremental read starting at a record where the
previous read left off.
Incremental load is based around the concept of Change Data Capture (CDC), which is a set of reading and writing
patterns designed to optimize large-scale data transfers by minimizing database writing in order to improve performance. CDC is implemented in Centerprise using Audit Fields pattern. The Audit Fields pattern uses create time or
last update time to determine the records that have been inserted or updated since the last transfer and transfers only
those records.
Advantages
• Most efficient of CDC patterns. Only records that were modified since the last transfer are retrieved by the query
thereby putting little stress on the source database and network bandwidth
Disadvantages
• Requires update date time and/or create date time fields to be present and correctly populated
• Does not capture deletes
• Requires index on the audit field(s) for efficient performance
To use the Audit Fields strategy, select the Audit Field and an optional Alternate Audit Field from the appropriate
dropdown menus. Also, specify the path to the file that will store incremental transfer information.
WHERE Clause screen:
You can enter an optional SQL expression serving as a filter for the incoming records. The expression should start
with the WHERE word followed by the filter you wish to apply.
For example, WHERE CreatedDtTm >= ‘2001/01/05’
General Options screen:
The Comments input allows you to enter comments associated with this object.
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SQL Query
Adding a SQL Query source object allows you to transfer data returned by the SQL query. An example of what an
SQL Query source object looks like is shown below.

To configure the properties of a SQL Query Source object after it was added to the dataflow, right-click on it and select
Properties from the context menu. The following properties are available:
Source Connection screen – allows you to enter the connection information for your SQL Query, such as server
name, database and schema, as well as credentials for connecting to the selected database.
SQL Query Source screen:
Enter the SQL expression controlling which records should be returned by this source. The expression should follow
SQL syntax conventions for the chosen database provider.
For example, select OrderId, OrderName, CreatedDtTm from Orders

1.19.4 Source/Destination File Options
Source or Destination is a Delimited File
If your source or destination is a Delimited File, you can set the following properties
• First Row Contains Header box - Select this box if you want the first row of your file to display the column
headers. In the case of Source file, this indicates if the source contains headers.
• Field Delimiter box - Allows you to select the delimiter for the fields. The available choices are <Comma>,
<Tab> and <Semicolon>. You can also type the delimiter of your choice instead of choosing the available
options.
• Record Delimiter box - Allows you to select the delimiter for the records in the fields. The choices available
are carriage-return line-feed combination <CR><LF>, carriage-return <CR> and line-feed <LF>. You can also
type the record delimiter of your choice instead of choosing the available options. For more information on
Record Delimiters, please refer to the Glossary.
• Encoding box - Allows you to choose the encoding scheme for the delimited file from a list of choices. The
default value is Unicode (UTF-8)
• Quote Char box - Allows you to select the type of quote character to be used in the delimited file. This quote
character tells the system to overlook any special characters inside the specified quotation marks. The options
available are ” and ’.
You can also use the Build fields from an existing file feature to help you build a destination fields based on an
existing file instead of manually typing the layout.
Source or Destination is a Microsoft Excel Worksheet
If the Source and/or the Destination chosen is a Microsoft Excel Worksheet, you can set the following properties:
• First Row Contains Header box - Select this box if you want the first row of your file to display the column
headers. In the case of Source file, this indicates if the source contains headers.
• Worksheet box - Allows you to select a specific worksheet from the selected Microsoft Excel file.
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You can also use the Build fields from an existing file feature to help you build a destination fields based on an
existing file instead of manually typing the layout.
Source or Destination is a Fixed Length File
If the Source and/or the Destination chosen is a Fixed Length File, you can set the following properties:
• First Row Contains Header box - Select this box if you want the first row of your file to display the column
headers. In the case of Source file, this indicates if the source contains headers.
• Record Delimiter box - Allows you to select the delimiter for the records in the fields. The choices available
are carriage-return line-feed combination <CR><LF>, carriage-return <CR> and line-feed<LF>. You can also
type the record delimiter of your choice instead of choosing the available options. For more information on
Record Delimiters, please refer to the Glossary.
• Encoding box - Allows you to choose the encoding scheme for the delimited file from a list of choices. The
default value is Unicode (UTF-8)
You can also use the Build fields from an existing file feature to help you build a destination fields based on an
existing file instead of manually typing the layout.
Using the Length Markers screen, you can create the layout of your fixed-length file, The Length Markers screen
has a ruled marker placed on the top of the window. To insert a field length marker, you can click in the window at a
particular point. For example, if you want to set the length of a field to contain five characters and the field starts at
five, then you need to click at the marker position nine.
In case the records don’t have a delimiter and you rely on knowing the size of a record, the number in the
RecordLength box is used to specify the character length for a single record.
You can delete a field length marker by clicking the marker.
Source or Destination is an XML file
If the source is an XML file, you can set the following options:
• Source File Path specifies the file path of the source XML file.
• Schema File Path specifies the file path of the XML schema (XSD file) that applies to the selected source XML
file.
NOTE: Centerprise makes it possible to generate an XSD file from the layout of the selected source XML file. This
feature is useful when you don’t have the XSD file available. Note that all fields are assigned the data type of String
in the generated schema. To use this feature, expand thecontrol and select Generate.
• Record Filter Expression allows you to optionally specify an expression used as a filter for incoming source
records from the selected source XML file. The filter can refer to a field or fields inside any node inside the
XML hierarchy.
The following options are available for destination XML files.
• Destination File Path specifies the file path of the destination XML file.
• Encoding - Allows you to choose the encoding scheme for the XML file from a list of choices. The default
value is Unicode (UTF-8).
• Format XML Output instructs Centerprise to add line breaks to the destination XML file for improved readability.
• Read From Schema File specifies the file path of the XML schema (XSD file) that will be used to generate the
destination XML file.
• Root Element specifies the root element from the list of the available elements in the selected schema file.
• Generate Destination XML Schema Based on Source Layout creates the destination XML layout to mirror the
layout of the source.
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• Root Element specifies the name of the root element for the destination XML file.
• Generate Fields as XML Attributes specifies that fields will be written as XML attributes (as opposed to XML
elements) in the destination XML file.
• Record Node specifies the name of the node that will contain each record transferred.
Note: To ensure that your dataflow is runnable on a remote server, please avoid using local paths for the source. Using
UNC paths is recommended.

1.19.5 Advanced Flat-File Reading Options
When importing from a fixed-width, delimited, or Excel file, you can specify the following advanced reading options:
Header Spans x Rows - if your source file has a header that spans more than 1 row, select the number of rows for the
header using this control.
Skip Initial Records - sets the number of records which you want skipped at the beginning of the file. This option can
be set whether or not your source file has a header. If your source file has a header, the first record after the specified
number of rows to skip will be used as the header row.
Raw Text Filter - Only records starting with the filter string will be imported. The rest of the records will be filtered.
You can optionally use regular expressions to specify your filter. For example, the regular expression ^[12][4] will
only include records starting with 1 or 2, and whose second character is 4.
Note: Centerprise supports Regular Expressions implemented with the Microsoft .NET Framework and uses the Microsoft version of named captures for regular expressions.
Raw Text Filter setting is not available for Excel source files.

1.19.6 Managing Differences between Source Layout and Source File
If your source is a fixed-length file, delimited file, or Excel spreadsheet, it may contain an optional header row. A
header row is the first record in the file that specifies field names and, in the case of a fixed-length file, the positioning
of fields in the record.
If your source file has a header row, you can specify how you want the system to handle the differences between your
actual source file, and the source layout specified in the setting. Differences may arise due to the fact that the source
file has a different field order from what is specified in the source layout, or it may have extra fields compared to the
source layout. Conversely, the source file may have fewer fields than what is defined in the source layout, and the field
names may also differ, or may have changed since the time the layout was created.
By selecting from the available options, you can have Centerprise handle those differences exactly as required by your
situation. These options are described in more detail below:
Enforce exact header match – causes Centerprise to proceed with the transfer only if the source file’s layout exactly
matches the source layout defined in the setting. This includes checking for the same number and order of fields and
field names.
Columns order in file may be different from the layout – causes Centerprise to ignore the sequence of fields in the
source file, and match them to the source layout using the field names.
Column headers in file may be different from the layout – This mode is used by default whenever the source file does
not have a header row. You can also enable it manually if you want to match the first field in the layout with the first
field in the source file, the second field in the layout with the second field in the source file, and so on. This option
will match the fields using their order as described above even if the field names are not matched successfully. We
recommend that you use this mode only if you are sure that the source file has the same field sequence as what is
defined in the source layout.
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1.19.7 Creating Field Layout
The Field Layout screen is available in the properties of most objects on the dataflow to help you specify the fields
making up the object. The table below explains the attributes you can set in the Field Layout screen.
The table below provides a list of all the attributes available for a particular layout type.

1.19.8 Using Data Formats
Centerprise supports a variety of formats for each data type. For example, for Dates, you can specify the date as “April
12” or “12-Apr-08”. Data Formats can be configured independently for source and for destination, giving you the
flexibility to correctly read source data and change its format as it is transferred to destination.
If you are transferring from a flat file (for example, Delimited or Fixed-Width), you can specify the format of a field
so that the system can correctly read the data from that field.
If you do not specify a data format, the system will try to guess the correct format for the field. For example, Centerprise is able to correctly interpret any of the following as a Date:
April 12
12-Apr-08
04-12-2008
Saturday, 12 April 2008
and so on
Centerprise comes with a variety of pre-configured formats for each supported data type. These formats are listed in
the Sample Formats section below. You can also create and save your own data formats.

To open the Data Formats screen, click

icon on the Toolbar.

To select a data format for a source field, go to Source Fields and expand the Format dropdown menu next to the
appropriate field.
To select a data format for a destination field, go to Destination Fields and expand the Format dropdown menu next to
the appropriate field.
Sample Formats
Dates:
Booleans:
Integers:
Real Numbers:
Numeric Format Specifiers:

1.20 Excel Workbook Source
1. Various ways to get Excel Workbook Source object on the dataflow designer.
2. Configuring the Excel Workbook Source object according to our required layout and settings.
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1.20.1 Getting Excel Workbook Source object
In this section, we’ll cover the various ways to get Excel Workbook Source object on the dataflow designer.
From the Toolbox
1. To get an Excel File Source from the Toolbox, go to Toolbox > Sources > Excel Workbook Source. If you’re
unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag-and-drop the Excel Workbook Source object onto the designer.

1.20. Excel Workbook Source
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You can see that the dragged source object is empty right now. This is because we haven’t configured the object yet.
We will discuss the configuration properties for the excel workbook source in the next section.
From the Project Explorer
If you already have a project defined and excel source files are a part of that project, you can directly drag-and-drop
the excel file sources from the project tree on to the dataflow designer. The excel file source objects in this case will
already be configured. Centerprise detects the connectivity and layout information from the source file itself.
Note: In this case we are using an excel file with Customers data. The file is a part of an existing project folder.
1. To get an Excel File Source from the Project Explorer, go to the Project Explorer window and expand the project
tree.

2. Select the excel file you want to bring in as the source and drag-and-drop it on the designer. In this case, we are
working with Customers -Excel Source.xls file so we will drag-and-drop it onto the designer.
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If you expand the dropped object, you will see that the layout for the source file is already built. You can even preview
the output at this stage.

1.20. Excel Workbook Source
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From the file location
1. To get an Excel File Source directly from the file location, open the folder containing the excel file.

2. Drag-and-drop the excel file from the folder onto the designer in Centerprise.
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If you expand the dropped object, you will see that the layout for the source file is already built. You can even preview
the output at this stage.

1.20. Excel Workbook Source
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1.20.2 Configuring the Excel File Source object
1. To configure the Excel Workbook Source object, right-click on its header and select Properties from the context
menu.

As soon as you’ve selected the Properties option from the context menu, a dialog box will open.
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This is where you can configure your properties for the Excel Workbook Source object.
2. The first step is to provide the File Path for the excel source. By providing the file path you are building the
connectivity to the source dataset.

1.20. Excel Workbook Source

99

Centerprise, Release 8

Note: In this case we are going to be using an excel file with sample Customers data.
3. The dialog box has some other configuration options:
• Options
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– If your source File Contains Header*,* and you want you Centerprise source layout to read headers from
the source file, check the box.
– If you have blank rows in your file, you can indicate after how many blank rows you want to indicate the
end of the file, using Consecutive Blank Rows to Indicate End of File option.
– Use the Worksheet option to specify if you want to read data from a specific worksheet in your excel file.
– In the Start Address option, you can indicate the cell value from where you want Centerprise to start
reading the data from.
• Advanced File Options

1.20. Excel Workbook Source
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– In the Header spans over option, give the number of rows that your header takes. Refer to this option
when your header spans over multiple rows.
– Check on Enforce exact header match if you want the header to be read as it is.
– Check on Column order in file may be different from the layout, if the field order in your source layout
is different from the field order in Centerprise layout.
– Check on Column headers in file may be different from the layout if you want to use alternate header
values for your fields. The Layout Builder lets you specify alternate header values for the fields in the
layout.
– Check the Use SmartMatch with Synonym Dictionary option when the header values vary in the source
layout and Centerprise layout. You can create a Synonym Dictionary file to store the values for alternate
headers. You can also use Synonym Dictionary file to facilitate automapping between objects on the flow
diagram that use alternate names in field layouts.
• String Processing
String processing options come in use when you are reading data from a file system and writing it to a database
destination.
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– Check on Treat empty string as null value when you have empty cells in the source file and want those
to be treated as null objects in the database destination that you are writing to, otherwise Centerprise will
omit those accordingly in the output.
– Check on Trim strings when you want to omit any extra spaces in the field value.
4. Once you’ve specified the data reading options on this screen, click Next.

1.20. Excel Workbook Source
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The next screen will show you a Layout Builder. On this screen, you can modify the layout of your excel source file.
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• If you want to add a new field to your layout, go to the last row of your layout (Name column), which will be
blank and double-click on it, and a blinking text cursor will appear. Type in the name of the field you want to
add and select subsequent properties for it. A new field will be added to the source layout.

1.20. Excel Workbook Source
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• If you want to delete a field from your dataset, click on the serial column of the row that you want to delete. The
selected row will be highlighted in blue.
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Right-click on the highlighted line, you get a context menu in which you will have the option to Delete.

1.20. Excel Workbook Source
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Selecting delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
Note: Modifying the layout (adding or deleting fields) from the layout builder screen in Centerprise will not
make any changes to the actual source file. The layout is specific to Centerprise only.
• If you want to change the position of any field and want to move it below or above another field in the layout,
you can do that by selecting the row and using move up/move down keys.
Note: You will find the Move up/Move down icons, on the top left of the builder.
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For example: To move the Country field right below the Region field. Therefore, we’ll select the row and use
the Move up key to from the 9th row to the 8th.
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• Other options that the Layout Builder provides with:

5. After you’re done customizing the Object Builder, click Next. You will be taken to a new screen - Config Parameters. Here, you can further configure and define parameters for the Excel Source.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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6. Once you’ve been through all the options to configure, click OK.
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The ExcelSource object is now configured according to the changes made.

1.20. Excel Workbook Source
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You have successfully configured your Excel File Source object. The fields from the source object can now be mapped
to other objects in the dataflow.

1.21 COBOL File Source
Centerprise COBOL File Source provides the functionality to read a COBOL file. Centerprise features a high-speed
COBOL file reader capable of efficiently processing large COBOL file. COBOL File Source features include:

1.21.1 Copybook Parsing
Centerprise features a built-in parser that reads COBOL copybook specifications and automatically builds layout.
Where copybook is not available, you can treat the file as a standard fixed length file and visually define field markers
and specify data types and numeric formats.

1.21.2 REDEFINES, OCCURS, and OCCURS DEPENDING
COBOL File Source provides full support for REDEFINES, OCCURS, and OCCURS DEPENDING. For REDEFINES, you can specify values that will be used to identify individual record types. These values can be defined as
strings or regular expressions.

1.21.3 Numeric Formats and Encodings
COBOL File Source supports conversion for numeric types including COMP, COMP-1, COMP-2, COMP-3, COMP4, Zoned Decimal as well a wide range of encodings and character sets.

1.21.4 Steps
Adding a COBOL file source object allows you to transfer data from a COBOL file. An example of what a COBOL
file source object looks like is shown below.

To configure the properties of a COBOL Source object after it was added to the dataflow, right-click on it and select
Properties from the context menu.

1.22 Database Table Source
Centerprise Database Source object provides the functionality to retrieve data from a database table. It also provides
change data capture functionality to perform incremental reads and supports multi-way partitioning, which partitions
a database table into multiple chunks and reads these chunks in parallel. This features brings about major performance
benefits for database reads. Database source also enables you to specify a where clause and sort order to control the
result set.
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1.22.1 Video
1. Get Database Table Source object on the dataflow designer.
2. Configure the Database Table Source object according to the required layout and settings.
We’ll also be discussing some best practices for using a Database Table Source object.

1.22.2 Getting Database Table Source
In this section, we’ll cover how to get Database Table Source object on the dataflow designer from the toolbox.
1. To get a Database Table Source from the Toolbox, go to Toolbox > Sources > Database Table Source. If you’re
unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.

1.22. Database Table Source
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2. Drag-and-drop the Database Table Source object onto the designer.

116

Chapter 1. Other Versions

Centerprise, Release 8

You can see that the dragged source object is empty right now. This is because we haven’t configured the object yet.

1.22.3 Configuring the Database Table Source
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

1.22. Database Table Source
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As soon as you’ve selected the Properties option from the context menu, a dialog box will open.
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This is where you can configure the properties for the Database Table Source object.
2. The first step is to specify the Database Connection for the source object.

1.22. Database Table Source
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• Put in the required credentials. You can also use the Recently Used drop-down menu to connect to a recently
connected database.
• You will find a drop-down list next to the Data Provider.
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That is where you select the specific database provider to connect to and the following connection credentials will vary
according to the provider selected.
• Test Connection to make sure that your database connection is successful and click Next.
3. Next, you will see a Pick Source Table and Reading Options screen. On this screen, you will select the table from
the database that you previously connected to, and configure the table from the given options.

1.22. Database Table Source
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• From the Pick Table box, choose the table that you want to read the data from.
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Note: We will be using the Customers table in this case.

1.22. Database Table Source
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– Once you pick a table, an icon will show up beside the Pick Table box.
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* View Data: You can view data in a separate window in Centerprise.

1.22. Database Table Source
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* View Schema: You can view the schema of your database table from here.

* View in Database Browser: You can see the selected table in the Database Source Browser in Centerprise.
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• Table Partition Options
This feature substantially improves the performance of large data movement jobs. Partitioning is done by selecting a field and defining value ranges for each partition. At runtime, Centerprise generates and runs multiple
queries against the source table and processes the result set in parallel.

1.22. Database Table Source
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– Check on the Partition Table for Reading if you want your table to be read in partitions.
– You can specify the Number of Partitions.
– Pick Key for the Partition box will let you choose the key field for partitioning the table.
– If you have specific key values based on which you want to partition the table, you can use the option
***Specify Key Values (Separated by comma)***.
• Favor Centerprise Layout is useful in the cases where your source database table layout has changed over time,
but the layout built in Centerprise is static. And you want to continue to use your dataflows even with the
updated source database table layout. You check this box and Centerprise will favor its own layout over the db
layout.

– Incremental Reads Options
Database Table Source provides incremental read functionality based on the concept of audit fields. Incremental read is one of the three change data capture approaches supported by Centerprise. Audit fields are
fields that are updated when a record is created or modified. Examples of audit fields include created date
time, modified date time, and version number.
Incremental read works by keeping a track of the highest value for the specified audit field. On the next run,
only the records with value higher than the saved value are retrieved. This feature is useful in situations
where two applications need to be kept in sync and the source table maintains audit field values for rows.

* Select Full Load if you want to read the entire table.
* Select Incremental Load Based on Audit Fields to perform an incremental read. Centerprise will
start reading the records from the last read.
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· Checking on Perform full load on next run, will override the incremental load function from the
next run onwards and will perform a full load on it.
· Use Audit Field to compare when the last read was performed on the dataset.
· Specify the path to the file in the File Path, that will store incremental transfer information.
4. The next screen will show you a Layout Builder. On this screen, you can modify the layout of your database table.
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Note: By default, Centerprise reads the source layout.
• If you want to delete a field from your dataset, click on the serial column of the row that you want to delete. The
selected row will be highlighted in blue.

Right-click on the highlighted line, a context menu will appear in which you will have the option to Delete.
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Selecting Delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
Note: Modifying the layout (adding or deleting fields) from the layout builder screen in Centerprise will not
make any changes to the actual database table. The layout is only specific to Centerprise.
• If you want to change the position of any field and want to move it below or above another field in the layout,
you can do that by selecting the row and using Move up/Move down keys.
Note: You will find the Move up/Move down icons, on the top left of the builder.
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For example: We want to move the Country field right below the Region field. We’ll select the row and use the
Move up key to move the field from the 9th row to the 8th.

5. After you’re done customizing the Layout Builder, click Next. You will be taken to a new screen - Where Clause.
Here, you can provide a WHERE clause, which will filter the records from your database table.
Note: If the wizard is left blank Centerprise will use the default values of the database table.

1.22. Database Table Source
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• For instance, if you add a WHERE clause that selects all the customers from the country “Mexico” in the
“Customers” table.

Your output will be filtered out and only the records that satisfy the where condition will be read by Centerprise.
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6. Once you’ve configured the database table source object, click Next.

1.22. Database Table Source
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7. A new screen - Config Parameters will open. Here, you can define parameters for the Database Table Source
object.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
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Note: Parameters can be changed in the Config Parameters wizard page. Parameters left blank will use their default
values assigned on the properties page.
8. Click OK.

1.22. Database Table Source
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You have successfully configured your Database Table Source object. The fields from the source object can now be
mapped to other objects in a dataflow.

1.22.4 Best Practices for using Database Table Source
Get the database table from the Data Source Browser
1. To get Database Table Source from the Data Source Browser, go to View > Data Source Browser or press Ctrl +
Alt + D.

1. A new window will open. You can see that the pane is empty right now. This is because we are not connected
to any database source yet.

1.22. Database Table Source
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3. To connect the browser to a database source, click on the first icon on the top left of the pane.

• A Database Connection box will open.
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This is where you can connect your database from the browser.
• You can either connect to a recently connected database or create a new connection.
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Note: In this case we will use one of our recent connections.
• To create a new connection, first you select your Data Provider from the drop-down list.
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Note: We’ll be using the SQL Server in this case.
• The next step is to fill in the required credentials. Also, to ensure that the connection is successfully made, Test
Connection.

1.22. Database Table Source
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Once you test your connection, a dialog box will open, which will indicate whether the test was successful or
not.
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Click OK.

1.22. Database Table Source
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Once you’re connected the browser, your Data Source Browser will now have the databases that you have on your
server.
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4. Select the database that you want to work with and then choose the table you want to use.
Note: In this case we’ll be using the Northwind database and Customers table.
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5. Drag-and-drop Customers onto the designer in Centerprise.

148

Chapter 1. Other Versions

Centerprise, Release 8

If you expand the dropped object, you will see that the layout for the source file is already built. You can even preview
the output at this stage.

1.22. Database Table Source
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Database Table Options

Right-clicking on the Database Table Source will also display options for the Database Table.
• Show in DB Browser - Will show where the table resides in the database in the Database Browser
• View Table Data - Builds a Query and displays all the data from the table
• View Table Schema - Displays the schema of the database table
• Create Table - Creates a table on a database based on the schema
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1.23 Delimited File Source
Delimited files are one of the most commonly used data sources and are used in a variety of situations. Delimited File
Source object in Astera Centerprise provides the functionality to read data from a delimited file. In this article, we will
cover how to use a delimited file source object.

1.23.1 Getting Delimited File Source Object
In this section, we’ll cover how to get Delimited File Source object on the dataflow designer from the toolbox.
1. To get a Delimited File Source from the Toolbox, go to Toolbox > Sources > Delimited File Source. If you’re
unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.

1.23. Delimited File Source
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2. Drag-and-drop the Delimited File Source object onto the designer.
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You can see that the dragged source object is empty right now. This is because we haven’t configured the object yet.

1.23.2 Configuring the Delimited File Source Object
1. To configure the Delimited File Source object, right-click on the header and select Properties from the context
menu.

1.23. Delimited File Source

153

Centerprise, Release 8

As soon as you’ve selected the Properties option from the context menu, a dialog box will open.
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This is where you configure the properties for the Delimited File Source object.
2. The first step is to provide the File Path for the Delimited Source. By providing the file path you are building the
connectivity to the source dataset.

1.23. Delimited File Source
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Note: In this case we are going to be using a delimited file with sample Orders data. This file works with the following
options:
• File Contains Headers
• Record Delimiter is specified as CR/LF:
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3. The dialog box has some other configuration options:
• Options
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– If the source File Contains Header, and you want Centerprise to read headers from the source file, check
the box.
– If you want your file to be read in portions, for instance your file has data over 1000 rows, on selecting
Partition File for Reading Centerprise will read your file according to the Partition Count that you specify.
For instance, for a file with 1000 rows, you give the partition count to be 2, it will read your file in two
partitions. This is a back-end process that makes data reading more efficient and helps in processing the
data faster. This will not have any effect on your output.
– Record Delimiter box allows you to select the delimiter for the records in the fields. The choices available
are carriage-return line-feed combination <CR/LF>, carriage-return - CR and line-feed - LF. You can also
type the record delimiter of your choice instead of choosing from the available options.
– In case the records don’t have a delimiter and you rely on knowing the size of a record, the number in the
Record Length box is used to specify the character length for a single record.
– Encoding box allows you to choose the encoding scheme for the delimited file from a list of choices. The
default value is Unicode (UTF-8)
– A Text Qualifier is a symbol that identifies where text begins and ends. It is used specifically when
importing data.
Say you need to import a text file that is comma delimited (commas separate the different fields that will
be placed in adjacent cells).
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– To define hierarchical file layout and process the data file as a hierarchical file check the This is a Hierarchical File box. Centerprise IDE provides extensive user interface capabilities for processing hierarchical
structures.
– Use Null Text to specify a certain value that you don’t want in your data and want it to be replaced by a
null value.
– Check on Allow Record Delimiter Inside a Field Text when you have the record delimiter as text inside
your data and want that to be read as it is.
• Advanced File Options

– In the Header spans over option, give the number of rows that your header takes. Refer to this option
when your header spans over multiple rows.
– Check on Enforce exact header match if you want the header to be read as it is.
– Check on Column order in file may be different from the layout, if the field order in your source layout
is different from the field order in Centerprise layout.
– Check on Column headers in file may be different from the layout if you want to use alternate header
values for your fields. The Layout Builder lets you specify alternate header values for the fields in the
layout.
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– Check the Use SmartMatch with Synonym Dictionary option when the header values vary in the source
layout and Centerprise layout. You can create a Synonym Dictionary file to store the values for alternate
headers. You can also use Synonym Dictionary file to facilitate automapping between objects on the flow
diagram that use alternate names in field layouts.
• To skip any unwanted rows at the beginning of your file, you can specify the number of records that you want
to omit through the Skip initial records option.

• Raw text filter
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– If you don’t want to apply any filter and process all records, check No filter. Process all records.
– If there is a specific value which you want to filter out, you can check on Process if begins with and give
the value that you want Centerprise to read from the data, in the box.
– If there is a specific expression which you want to filter out, you can check on Process if matches this
regular expression and give the expression that you want Centerprise to read from the data, in the box.
• String Processing
String processing options come in use when you are reading data from a file system and writing it to a database
destination.

1.23. Delimited File Source
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– Check on Treat empty string as null value when you have empty cells in the source file and want those
to be treated as null objects in the database destination that you are writing to, otherwise Centerprise will
omit those accordingly in the output.
– Check on Trim strings when you want to omit any extra spaces in the field value.
4. Once you’ve specified the data reading options on this screen, click Next.
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The next screen will show you a Layout Builder. On this screen, you can modify the layout of the delimited source
file.
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• If you want to add a new field to your layout, go to the last row of your layout (Name column), which will be
blank and double-click on it, and a blinking text cursor will appear. Type in the name of the field you want to
add and select subsequent properties for it. A new field will be added to the source layout.
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• If you want to delete a field from your dataset, click on the serial column of the row that you want to delete. The
selected row will be highlighted in blue.
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Right-click on the highlighted line, a context menu will appear where you will have the option to Delete.
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Selecting delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
Note: Modifying the layout (adding or deleting fields) from the layout builder screen in Centerprise will not
make any changes to the actual source file. The layout is specific to Centerprise only.
5. After you’re done customizing the layout, click Next. You will be directed to a new screen - Config Parameters.
Here, you can define parameters for the Delimited File Source object.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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6. Once you’ve configured the source object, click OK.
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The DelimitedSource object is now configured according to the changes you made.
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The Delimited Source object has now been modified from its previous configuration. The new object has all the
modifications that were made in the builder.
In this case, the modifications that were made are:
• Added the CustomerName column.
• Deleted the ShipCountry column.
You have successfully configured your Delimited File Source object. The fields from the source object can now be
mapped to other objects in the dataflow.

1.24 File System Items Source
The File System Items Source in Astera Centerprise is used to provide metadata information to a task in a dataflow
or workflow. In a dataflow, it can be used in conjunction with a source object, especially in cases where you want to
process multiple files through the transformation and loading process. In a workflow, the File System Items Source can
be used to provide input paths to a subsequent object such as a RunDataflow task.
Let’s see how it works in a dataflow.

1.24.1 Using File Systems Items Source in a Dataflow
Scenario
Here we have a dataflow that we want to run on multiple source files that contain customer data from a fictitious
organization. We’re going to use the source object as a transformation and provide the location of the source files
using a File System Items Source object. The File System Items Source will provide the path to the location where our
source files reside and the source will object pick the source files from that location, one by one, and pass it on for
further processing in the dataflow.
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Steps to Use the File System Item Source in a Dataflow
Here, we want to sort the data, filter out records of customers from Germany and write the filtered records into a
database table. The source data is stored in delimited (.csv) files.

First, change the source object into a transformation. This is because the data is stored in multiple delimited files
and we want to process all of them in the dataflow. For this, right-click on the source object’s header and click on
‘Transformation’ in the context menu.
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You can see that the color of the source object has changed from green to purple which indicates that the source object
has changed into a transformation.

You can also notice that the source object now has two nodes: Input and Output. The Input node has an input mapping
port which means that it can take the path to the source file from another object.
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Now we will use a File System Items Source to provide path to Customer_Data Transformation object. Go to the
Sources section in the Toolbox and drag and drop the File System Items Source onto the designer.

If you look at the File System Items Source, you can see that the layout is pre-populated with fields such as FileName,
FileNameWithoutExtension, Extension, FullPAth, Directory, ReadOnly, Size, and other attributes of the files.

To configure the properties of the File System Items Source, right-click on the File System Items Source object’s header
and go to Properties.
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This will open the File System Properties window.
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The first thing you need to do is point the path to the directory or folder where your source files reside.
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You can see a couple of other options on this screen:
Filter: If your specified source location contains multiple files in different formats, you can use this option to filter
and read files in the specified format. For instance, our source folder contains multiple PDF, .txt. doc, .xls, and .csv
files, so we will write “*.csv” in the filter box to filter and read delimited files only.
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Include items in subdirectories: Check this option if you want to process files present in the sub-directories
Include Entries for Directories: Check this option if you want to include all items in the specified directory
Once you’ve specified the path and other options, click OK.
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Now right-click on the File System Items Source object and select Preview Output.
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You can see that the File System Items Source object has filtered out delimited files from the specified location and
has returned the metadata in the output. You can see the FileName, FileNameWithoutExtension, Extension, FullPath,
Directory, and other attributes such as whether the file is ReadOnly, FileSize, LastAccessed, and other details in the
output.

Now let’s do the mapping. Map the FullPath field from the File System Items Source to the FullPath field under the
Input node in the Customer_Data Transformation object.
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Once mapped, when we run the dataflow, the File System Items Source will pass the path to the source files, one by
one, to the Customer_Data Transformation object. The Customer_Data Transformation object will read the data from
the source file and pass it to the subsequent transformation object to be processed further in the dataflow.

1.24.2 Using File System Items Source in a Workflow
In a workflow, the File System Items Source can be used to provide input paths to a subsequent task such as a RunDataflow task. Let’s see how it works.
Steps to Use the File System Items Source in a Workflow
We want to design a workflow to orchestrate the process of extracting customer data stored in delimited files, sorting
that data, filtering out records of customers from Germany and loading the filtered records in a database table.
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We have already designed a dataflow for the process and have called this dataflow in our workflow using the RunDataflow task object.

We have multiple source files that we want to process in this dataflow. So, we will use a File System Items Source
object to provide the path to our source files to the RunDataFlow task. For this, go to the Sources section in the toolbox
and drag and drop the File System Items Source onto the designer.

If you look at the File System Items Source, you can see that the layout is pre-populated with fields such as FileName,
FileNameWithoutExtension, Extension, FullPAth, Directory, ReadOnly, Size, and other attributes of the files. Also,
there’s this small blue icon with the letter ‘s’ which indicates that the object is set to run in Singleton mode.
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By default, all objects in a workflow are set to execute in Singleton mode. However, since we have multiple files to
process in the dataflow, we will set the File System Items Source object to run in loop. For this, right-click on the File
System Items Source and click ‘Loop’ in the context menu.
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You can see that the color of the object has changed to purple, and it now has this purple icon over the header which
denotes the loop function.
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It also has these two mapping ports on the header to map the File System Items Source object to the subsequent action
in the workflow. Let’s map it to the RunDataflowTask.

To configure the properties of the File System Items Source, right-click on the File System Item Source object’s header
and go to Properties.
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This will open the File System Items Source Properties window.
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The first thing you need to do is point the path to the directory or folder where your source files reside.
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You can see a couple of other options on this screen:
Filter: If your specified source location contains multiple files in different formats, you can use this option to filter
and read files in the specified format. For instance, our source folder contains multiple PDF, .txt. doc, .xls, and .csv
files, so we will write “*.csv” in the filter box to filter and read delimited files only.
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Include items in subdirectories: Check this option if you want to process files present in the sub-directories
Include Entries for Directories: Check this option if you want to include all items in the specified directory
Once you’ve specified the path and other options, click OK.
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Now right-click on the File System Items Source object and click Preview Output.
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You can see that the File System Items Source object has filtered out delimited files from the specified location and
has returned the metadata in the output. You can see the FileName, FileNameWithoutExtension, Extension, FullPath,
Directory, and other attributes such as whether the file is ReadOnly, FileSize, LastAccessed, and other details in the
output.

Now let’s do the mapping. Map the FullPath field from the File System Items Source object to the FilePath variable in
the RunDataflow task.
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Once mapped, upon running the dataflow, the File System Items Source will pass the path to the source files, one by
one, to the RunDataflow task. In other words, the File System Items Source acts as a driver to provide source files to
the RunDataflow tasks, which will then process them in the dataflow.
When the File System Items Source is set to run in a loop, the dataflow will run for ‘n’ number of times; where ‘n’ =
the number of files passed by the File System Items Source to the RunDataflow task. For instance, you can see that we
have six source files in the specified folder. The RunDataflow task object will pass these six files one by one to the
RunDataflow task to be processed in the dataflow.

This concludes using the File System Items Source in Astera Centerprise.

1.25 Fixed Length File Source
1.25.1 Getting Fixed Length Source Object
In this section, we’ll cover how to get Fixed Length File Source object on the dataflow designer from the toolbox.
1. To get a Fixed Length File Source from the Toolbox, go to Toolbox > Sources > Fixed Length File Source. If
you’re unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag-and-drop the Fixed Length File Source object onto the designer.
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You can see that the dragged source object is empty right now. This is because we haven’t configured the object yet.

1.25.2 Configuring the Fixed Length File Source Object
1. To configure the Fixed Length File Source object, right-click on its header and select Properties from the context
menu.
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When you select the Properties option from the context menu, a dialog box will open.
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This is where you configure the properties for Fixed Length File Source object.
2. The first step is to provide the File Path for the fixed length source. By providing the file path you are building the
connectivity to the source dataset.
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Note: In this case we are going to be using a fixed length file that contains Orders sample data. This file works with
the following options:
• File Contains Headers
• Record Delimiter is specified as
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3. The dialog box has some other configuration options:
• Options
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– If the source File Contains Header and you want Centerprise source layout to read headers from the source
file, check the box.
– If you want the file to be read in portions, for instance, your file has data over 1000 rows, on selecting
Partition File for Reading, Centerprise will read your file according to the Partition Count that you
specify. For example, for a file with 1000 rows, you give the partition count to be 2, it will read your file in
two partitions. This is a back-end process that makes data reading more efficient and helps in processing
the data faster. This will not have any effect on your output.
– Record Delimiter box allows you to select the delimiter for the records in the source file. The choices
available are carriage-return line-feed combination , carriage-return and line-feed**. You can also type
the record delimiter of your choice instead of choosing from the available options.
– In case the records don’t have a delimiter and you rely on knowing the size of a record, the number in the
Record Length box is used to specify the character length for a single record.
– Encoding box allows you to choose the encoding scheme for the delimited file from a list of choices. The
default value is Unicode (UTF-8)
– Check the This is a COBOL data file box if you are working with COBOL files and do not have COBOL
copybooks, you can still import this data by visually marking fields in the layout builder and specifying
field data types. For more advanced parsing of COBOL files, you can use Centerprise COBOL File Source.

1.25. Fixed Length File Source

199

Centerprise, Release 8

– To define hierarchical file layout and process the data file as a hierarchical file check the This is a Hierarchical File box. Centerprise IDE provides extensive user interface capabilities for processing hierarchical
structures.
• Advanced File Options

– In the Header spans over option, give the number of rows that your header takes. Refer to this option
when your header spans over multiple rows.
– Check on Enforce exact header match if you want the header to be read as it is.
– Check on Column order in file may be different from the layout, if the field order in your source layout
is different from the field order in Centerprise layout.
– Check on Column headers in file may be different from the layout if you want to use alternate header
values for your fields. The Layout Builder lets you specify alternate header values for the fields in the
layout.
– Check the Use SmartMatch with Synonym Dictionary option when the header values vary in the source
layout and Centerprise layout. You can create a Synonym Dictionary file to store the values for alternate
headers. You can also use Synonym Dictionary file to facilitate automapping between objects on the flow
diagram that use alternate names in field layouts.
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• To skip any unwanted rows at the beginning of your file, you can specify the number of records that you want
to omit through the Skip initial records option.

• Raw text filter
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– If you don’t want to apply any filter and process all records, check on No filter. Process all records.
– If there is a specific value which you want to filter out, you can check on Process if begins with and give
the value that you want Centerprise to read from the data, in the box.
– If there is a specific expression which you want to filter out, you can check on Process if matches this
regular expression and give the expression that you want Centerprise to read from the data, in the box.
• String Processing
String processing options come in use when you are reading data from a file system and writing it to a database
destination.
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– Check on Treat empty string as null value when you have empty cells in the source file and want those
to be treated as null objects in the database destination that you are writing to, otherwise Centerprise will
omit those accordingly in the output.
– Check on Trim strings when you want to omit any extra spaces in the field value.
4. Once you’ve specified the data reading options on this screen, click Next.
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The next screen is your Length Markers screen. You can put marks and specify the columns in your data.
Using the Length Markers screen, you can create the layout of your fixed-length file. To insert a field length marker,
you can click in the window at any point. For example, if you want to set the length of a field to contain five characters
and the field starts at five, then you need to click at the marker position nine.
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Note: In this case we are using a fixed length file with Orders sample data.
• If you point your cursor to where the data is starting from, (in this case next to OrderID) and double-click on it,
Centerprise will automatically detect columns and put markers in your data. Blue lines will appear as markers
on the columns that will get detected.
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You can modify the markers manually. To delete a marker, double-click on the column which has been marked.
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In this case we removed the second marker and instead added a marker after CustomerID and EmployeeID.
In this way you can add as many markers as the number of columns/fields there are in the data set.
– You can also use the Build from Specs feature to help you build destination fields based on an existing file
instead of manually specifying the layout.
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5. After you have built the layout by inserting the field markers, click Next.
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The next screen will show you a Layout Builder. On this screen, you can modify the layout of your fixed length source
file.
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• If you want to add a new field to your layout, go to the last row of your layout (Name column), which will be
blank and double-click on it, and a blinking text cursor will appear. Type in the name of the field you want to
add and select subsequent properties for it. A new field will be added to the source layout.
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Note: Make sure to specify the length of the field that you’ve added in the properties of the field.
• If you want to delete a field from your dataset, click on the serial column of the row that you want to delete. The
selected row will be highlighted in blue.
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Right-click on the highlighted line, a context menu will open where you will have the option to Delete.
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Selecting delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
Note: Modifying the layout (adding or deleting fields) from the layout builder screen in Centerprise will not
make any changes to the actual source file. The layout is specific to Centerprise only.
• Other options that the Layout Builder provides are:
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6. After you’re done customizing the layout on the Object Builder screen, click Next. You will be taken to a new
screen - Config Parameters. Here, you can define parameters for the fixed length file source.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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7. Once you’ve been through all the options to configure, click OK.

216

Chapter 1. Other Versions

Centerprise, Release 8

The FixedLengthFileSource object is now configured.
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The Fixed Length Source object has now been modified from its previous configuration. The new object has all the
modifications that we specified in the layout builder.
In this case, the modifications that we made were:
• Separated the EmployeeID column from the OrderDate column.
• Added the CustomerName column.
You have successfully configured your Fixed Length File Source object. The fields from the source object can now
be mapped to other objects in a dataflow.

1.26 Email Source
Email Source in Astera Centerprise enables users to retrieve data from emails and process the incoming email attachments.

1.26.1 Getting Email Source Object
In this section, we will cover how to get Email Source object onto the dataflow designer from the toolbox.
1. To get an Email Source from the Toolbox, go to Toolbox > Sources > Email Source. If you’re unable to see the
toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag-and-drop the Email Source object onto the designer.

You can see some built-in fields and an Attachments node.

1.26.2 Configuring the Email Source Object
1. Double-click on the header of the Email source object to go to the Properties window
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A configuration window for Email Source will open up. The Email Connection screen is where you will specify the
connection details.
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2. If you have configured email settings before, you can access the configured settings from the drop-down list next to
the Recent option*.* Otherwise, provide server settings for the mailing platform that you want to use. In this case, we
are using Outlook server.
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Test your connection by clicking on Test Connection, this will give you the option to send a test mail to the login email.
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4. Click Next. This is the Email Source Properties screen. There are two important parts to this screen:
• Download attachment options
• Email reading options
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5. Check the Download Attachments box if you want to download the contents of your email. Specify the directory
where you want to save the email attachments, in the space next to Directory.
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6. The second part of the Email Source Properties screen has the email reading options that you can work with to
configure various settings.
• Read Unread Only – Check the option if you only want to process the unread emails.
• Mark Email as Read – Check the option if you want to mark the processed emails as read.
• Folder – From the drop-down list next to Folder, you can select the specific folder to watch for example, Inbox,
Outbox, Sent Items etc.
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• Filters - You can apply various filters to only process specific emails in the folder.
o From Filter: Filters out emails based on the sender’s email address
o Subject Filter: Filters out emails based on the text of the subject line
o Body Filter: Filters out emails based on the body text
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Click OK.
7. Right-click on Email Source object’s header and select Preview Output from the context menu.
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A Data Preview window will open up and will show you the preview of the extracted data.

Notice that output only contains emails from the email address specified in the Filter section.
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1.27 Report Source
Report Model extracts data from an unstructured file into a structured file format using an extraction logic. It can
be used through Report Source inside dataflows in order to leverage the advanced transformation features in Astera
Centerprise and Astera ReportMiner.

1.27.1 Getting Report Source Object
In this section, we will cover how to get Report Source object onto the dataflow designer from the toolbox.
1. To get a Report Source from the Toolbox, go to Toolbox > Sources > Report Source. If you’re unable to see the
toolbox, go to View > Toolbox or press Ctrl + Alt + X.

2. Drag-and-drop the Report Source object onto the designer.

You can see that the dragged source object is empty right now. This is because we haven’t configured the object yet.
1.27. Report Source
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1.27.2 Configuring the Report Source Object
1. To configure the Report Source object, right-click on its header and select Properties from the context menu.

A configuration window for Report Source will open up.
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2. First, provide the File Path of the unstructured file (your report) for which you have created a Report Model.
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3. Then specify the path for the associated Report Model.

232

Chapter 1. Other Versions

Centerprise, Release 8

4. Click OK and the fields added in the extraction model will appear inside the Report Source object with a sub-node,
Items_Info in this example.

5. Right-click on Report Source’s header and select Preview Output from the context menu.
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A Data Preview window will open and shows you the data extracted through the Report Model.

1.28 SQL Query Source
The SQL Query Source enables you to retrieve data from a database using an SQL query or a stored procedure. You
can specify any valid SELECT statement or a stored procedure call as a query. In addition, you can parameterize your
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queries dynamically, thereby allowing you to change their values at runtime.
In this article, we’ll be looking at how you can configure the SQL Query Source object and use it to retrieve data in
Astera Centerprise.

1.28.1 Configuring the SQL Query Source
1. Before moving on to the actual configuration, we’ll have to get an SQL Query Source object from the Toolbox onto
the dataflow designer. To do so, go to Toolbox > Sources > SQL Query Source. In case you’re unable to view the
toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag and drop the SQL Query Source object onto the designer.

The source object is currently empty because we are yet to configure it.
3. To configure the SQL Query Source object, right-click on its header and select Properties from the context menu.
Alternatively, you can double-click the header of the source object.
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A new window will pop up when you click on Properties from the context menu.

This window is where you configure the properties for the SQL Query Source object.
4. On the Database Connection screen, enter the information for the database you wish to connect to.
• Use the Data Provider drop-down list to specify which database provider you want to connect to. The required
credentials will vary according to your chosen provider.
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• Provide the required credentials. Alternatively, use the Recently Used drop-down list to connect to a recently
connected database.
• Test Connection to ensure that you have successfully connected to the database. A separate window will appear,
showing whether your test is successful. Close it by clicking OK, and then click Next.
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1.28. SQL Query Source
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5. The next screen will present a blank page for you to enter your required SQL query. Here, you can enter any valid
SELECT statement or stored procedure to read data from the database you connected to in the previous step.
The curly brackets on the right side of the screen indicate that the use of parameters is supported, which implies that
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you can replace a regular value with one that is parameterized and can be changed during runtime.

In this example, we will be reading the Orders table from the Northwind database.
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Once you’ve entered the SQL query, click Next.
6. The following screen will allow you to check or uncheck certain options that may be utilized while processing the
dataset, if needed.
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• The Trim Trailing Spaces option, if checked, will refine the dataset by removing the extra whitespaces present
after the last character in a line, up until the end of that line. This option is checked by default.
• The Dynamic Layout option is unchecked by default. If checked, it will automatically enable two other suboptions.
o Delete Field In Subsequent Objects: When checked, this option will delete all fields that are present in subsequent objects.
o Add Fields In Subsequent Objects: When checked, this option will add fields that are present in the source
object to subsequent objects.
Choose your desired options and click Next.
7. The next screen will present the Layout Builder. Here, you can modify the layout of the table that is being read
from the database. However, these modifications will only persist within Centerprise and will not apply to the actual
database table.
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• To delete a certain field, right-click on its serial column and select Delete from the context menu. In this example,
we have deleted the OrderDate field.
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• To change the position of a field, click its serial column and use the Move up/Move down icons on the top-left of
the screen. In this example, we’ve moved EmployeeID to second place by using the Move up icon, thus shifting
CustomerID to third place. You can move other fields up or down in a similar manner, consequently allowing
you to modify the entire order of the fields present in the table.
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Once you’re done customizing your layout, click Next.
8. On the new Config Parameters screen, you can define certain parameters for the SQL Source object.
These parameters facilitate an easier deployment of flows by excluding hardcoded values and providing a more convenient method of configuration. If left blank, they will assume the default values that were initially assigned to
them.
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Enter your desired values for these parameters, if any, and click Next.
9. At the end, a General Options screen will appear. Here, you are provided with:
• A text box to add Comments.
• A set of general options that have been disabled.

1.28. SQL Query Source
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To conclude the configuration, click OK.
You have successfully configured the SQL Query Source object. The fields are now visible and can be mapped to other
objects in the dataflow.

1.29 XML/JSON File Source
Adding an XML/JSON file source object to a dataflow allows you to read and transfer data from an XML or a JSON
file.

1.29.1 Getting XML/JSON Source Object
In this section, we’ll cover how to get XML/JSON File Source object on the dataflow designer from the toolbox.
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1. To get an XML/JSON File Source from the Toolbox, go to Toolbox > Sources > XML/JSON File Source. If you’re
unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.

1.29. XML/JSON File Source
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2. Drag-and-drop the XML/JSON File Source object onto the designer.

You can see that the dragged source object is empty right now. This is because we haven’t configured the object yet.

1.29.2 Configuring the XML/JSON File Source Object
1. To configure the XML/JSON File Source object, right-click on the header and select Properties from the context
menu.
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When you select the Properties option from the context menu, a dialog box will open.

1.29. XML/JSON File Source

253

Centerprise, Release 8

This is where you configure the properties for the XML/JSON File Source object.
2. The first step is to provide the File Path & Schema Location for the XML/JSON Source. By providing the file path
and schema, you are building the connectivity to the source dataset.
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• Check on JSON Format if your source file is a JSON.
• Check on Provide Inner XML to get the XML markup representing only the child nodes of the parent node.
Note: In this case we are going to be using an XML/JSON file with Orders sample data in the parent node and
Order Details sample data in the child node.

1.29. XML/JSON File Source
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3. Once you’ve specified the data reading options on this screen, click Next.
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On this screen, you can view the layout of your XML/JSON source file in the left column of the screen.

1.29. XML/JSON File Source
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4. After you’re done viewing the layout, click Next. You will be taken to a new screen - Config Parameters. Here,
you can define the parameters for the XML/JSON File Source.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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5. After you’ve configured the source object, click OK.

1.29. XML/JSON File Source
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You have successfully configured your XML/JSON File Source object. The fields from the source object can now be
mapped to other objects in a dataflow.
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1.30 PDF Form Source
A PDF Form Source object provides us with the functionality of extracting data from a fillable PDF document . A
fillable PDF document comprises of certain data points or digital fields which are editable by a user using any modern
PDF viewers. They are often used instead of official documents on the web. The PDF Form Source object detects
those points, extracts out the written data, and creates relative fields for them.
In this article, we will explore how to make use of the PDF Form Source object in Astera Centerprise to retrieve data.

1.30. PDF Form Source

261

Centerprise, Release 8

262

Chapter 1. Other Versions

Centerprise, Release 8

1.30.1 Sample Use-Case

1.30. PDF Form Source
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Note: This is a Scholarship Application Form with fillable data fields for Personal Information, Contact Details, and
Education Qualifications.

1.30.2 Utilizing the PDF Form Source Object
1. Select the PDF Form Source object from the toolbox window and drag-and-drop onto the dataflow designer.

2. Right-click on the header of the PDF Form Source object and select the Properties option from the context menu.
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A configuration window will open, as shown below.

1.30. PDF Form Source
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3. Provide the file path for the fillable PDF document.
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• Owner Password: If the file is protected, then enter the password that is configured by the owner of the fillable
pdf document. If the file is not protected, this option can be left blank.
• Use UTF-8 Encoding: Check this option if the file is UTF-8 i.e., Unicode Transformation Format – 8-bit,
encoded.
Click on Next.

1.30. PDF Form Source
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This is the Layout Builder window, where you can see the data fields extracted from the fillable PDF document. Click
on Next.
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This is the Config Parameters window. Click on Next.

1.30. PDF Form Source
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This is the General Setting window. Click on OK.
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4. Right-click the PDF Form Source object’s header and select Preview Output from the context menu.

1.30. PDF Form Source
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View the data through the Data Preview window.

The data is now available for mapping. For simplicity, we will delete the non-required data fields and store the output
in a separate file. To store the data, we must write it to a destination file.
5. We are using a Delimited Destination object. Drag-and-drop the Delimited Destination object onto the dataflow
designer and map the fields from PDF Form Source object to the destination object.

Right-click on the fields that you do not want to store and select the Remove Element option.
Note:
• Do not delete the data fields from the PDF Form Source object, as it will disturb the layout that has been
generated for the detected data fields.
• You can also delete the data fields in the destination file by using the Layout Builder. Or map only the relevant
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fields onto the nodes of the destination object. You can refer to this article to learn more about Delimited
Destination object.
6. Simply double-click or right-click on the Delimited Destination object’s header and select the Properties option
from the context menu. Select the file path where you want to store the file. Click on OK.

7. To preview the data, right-click on the destination object’s header and select Preview Output from the context menu.

1.30. PDF Form Source
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Here, you can see the data of the selected fields.

This is how a PDF Form Source object is used in Astera Centerprise to mine out data point/digital fields from fillable
PDF documents.

1.31 Introducing Transformations
Transformations are used to perform a variety of operations on data as it moves through the dataflow pipeline. Centerprise provides a full complement of built-in transformation enabling you to build sophisticated data maps.
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Centerprise transformations are divided into two types—record level and set level. Record level transformations are
used to create derived values by applying a lookup, function, or expression to fields from a single record. Set level
transformations, on the other hand, operate on a group of records and may result in joining, reordering, elimination, or
aggregation of records. Example of record level transformations include lookups, expression, and function transformations while set transformations include join, sort, route, distinct, etc. Data sources and destinations are also considered
set transformations. In Centerprise, data records flow between set transformations. Record level transformations are
used to transform or augment individual fields during these movements.
A record level transformation can be connected to only one set transformation. For instance, a lookup or expression
cannot receive input from two different set transformations.
Other than transformations that enable combining multiple data sources—such as join, merge, and
union—transformations can receive input from only one set transformation. Transformations, however, can receive
input from any number of record level transformations as long as all these record level transformations receive input
from the same transformation.

1.32 Aggregate Transformation
1.32.1 Overview
The Aggregate transformation object provides the functionality to create aggregations of your dataset, using aggregate
functions such as Sum, Count, First, Last, Min, Max, Average, Var or Standard Deviation. The dataset can be split
into groups so that the aggregate value(s) can be generated for the group instead of the whole dataset. For example,
calculate product count by month of year, or get average sales price by region and year.
Aggregate Transformation can be applied to unsorted data or data sorted on group by values. When applied to an input
stream that is sorted on group by fields, Aggregate Transformation performs substantially better and consumes very
little memory. Alternatively, when applied to unsorted datasets, Aggregate Transformation may consume substantial
memory resources for large data sets and may slow down the performance of the server.

1.32.2 Use Case
In this scenario, we have products data stored in a csv file. The source file contains information such as products and
supplier IDs, unit price of the various products, quantity of products available etc. Now you want to derive following
information from your source data:
1. Number of products per category
2. Total price of all the products per category
3. Minimum price per category
4. Maximum price per category
We will use Aggregate Transformation to calculate the information we want. Let’s see how to go about it.

1.32.3 How to Work with Aggregate Transformation
1. Select the Source object from the sources section in the toolbox and drag-and-drop it on the designer. In this case,
a Delimited File Source object is used.
2. To work with Aggregate Transformation, drag-and-drop the Aggregate Transformation object from Toolbox >
Transformations > Aggregate.

1.32. Aggregate Transformation
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3. Right-click on the transformation object and select Properties. Layout builder screen will open.

4. Write names of the fields you want to map to the transformation object in the Name column and specify the relevant
aggregate functions for them.
For this case:
• CategoryID: We will select aggregate function Group-By for the field because we want to group the records
based on the product categories available.
(Note: At least one field should be marked as Group-By for the Aggregate transformation to work.)
• ProductID: We will select aggregate function Count for the field in order to calculate the number of products
per category.
• UnitPrice: The field is mapped three times.
– To calculate TotalPricePerCategory, select aggregate function Sum .
– To calculate MaxPricePerCategory, select aggregate function Max.
– To calculate MinPricePerCategory, select aggregate function as Min.
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5. Click on Next, Aggregate Transformation Properties window will open.

1.32. Aggregate Transformation
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There are three sorting options in Aggregatetransformation:
• Incoming datais presortedongroup by fields:Inthisoption,aggregaterequires data to be sorted bythe
specifiedgroup-byfield.
• SortIncoming data beforebuilding aggregate:This option willfirst sort the incomingdata, then build its aggregate.
• Build aggregate using unsorted data:This option will buildaggregate usingthe incoming data whether it is
sorted or not.
6. Click on Next, Config Parameters window will open where you can further configure and define parameters for the
Aggregate transformation.
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7. Click Next, to go on the General Options screen. Click on Ok.

1.32. Aggregate Transformation
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General Options screen:
This screen shares the options common to most objects on the dataflow.
Clear Incoming Record Messages
When this option is checked, any messages coming in from objects preceding the current object will be cleared. This
is useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
Do Not Process Records with Errors
When this option is checked, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
The Comments input allows you to enter comments associated with this object.
8. After you have configured the properties, click OK.
9. You will see the fields in the object that were added on the layout builder screen.
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10. Map the data fields from the source object to the transformation object. You can auto-map the entire dataset from
source to transformation object or only map the selected fields that you want to work with. In this case, we will map
CategoryID, ProductID and UnitPrice because those are the fields we want to find aggregations for*.*
(Note: UnitPrice field has been mapped three times because TotalPricePerCategory, MaximumPricePerCategory and
MinimumPriceperCategory will be determined by the it.)

11. Right-click on Aggregate transformation object and click Preview Output.

1.32. Aggregate Transformation
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12. You will see that the specified aggregate functions have been applied.

1.33 Constant Value Transformation
1.33.1 Overview
Constant Value Transformation returns a single, predefined value for all records in a dataset.

1.33.2 Use Case
In this example, we have an excel worksheet containing employees’ data. The data is being written to a database table.
The database table contains an additional field that stores the department information. We want to pass a constant value
to the Department field and to do that, we will use Constant Value transformation object in Centerprise. Constant Value
transformation will be mapped to that field to append the name of the department with the final output.

1.33.3 How to Work with Constant Value Transformation
1. Select a source object from Sources section in the toolbox. In this case, an Excel source will be used.
Read: How to work with an Excel source
2. Select a destination object from Destinations section in the toolbox, where the data would be written. In this case,
a Database destination would be used.
Read: How to work with a Database destination
3. Map the Employees source object with the Employees_Database destination object.

Note: There is an additional field (Department) in the destination object but there is no such field in the incoming
dataset. To append the Department field with final output, we will use Constant Value transformation.
4. Now, drag-and-drop the Constant Value transformation object from Toolbox > Transformations > Constant Value.

5. Right-click on the ConstantValue transformation object and click on Properties.
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6. Constant Value Map Properties window will open. Here you will see a Constant Value section where you can
write any value which you want to append to your output data.
In this case, the value will be Marketing, to specify the department of the employees in the source dataset.

7. Click Next, a General Options window will open then click OK.

1.33. Constant Value Transformation
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General Options screen:
This screen shares the options common to most objects on the dataflow.
Clear Incoming Record Messages
When this option is on, any messages coming in from objects preceding the current object will be cleared. This is
useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
Do Not Process Records with Errors
When this option is on, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
Your transformation object will look like:
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8. Now map the Value field in the ConstantValue object with the Department field in the Employees_Database object.

1.33. Constant Value Transformation
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9. Right click on the Employees_Database object and click on Preview Output.

Your final output will look like:

So, the department of source dataset has been successfully appended with the final output using Constant Value
transformation.
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1.34 Denormalize Transformation
You can create many-to-one mappings with the help of Denormalize transformation in Centerprise. Denormalizing,
also known as pivoting, allows you to combine a number of records into a single record (simply stating, it brings data
from rows to columns). It is useful for reducing the number of tables in the schema, which simplifies querying and
possibly improves reading performance.

1.34.1 Sample Use Case
The source data contains information about taxes (City Tax, County Tax, State Tax, and Federal Tax) and SSN (Social
Security Number) of taxpayers.

1.34. Denormalize Transformation

287

Centerprise, Release 8

Now, we want to reduce the number of rows and create separate fields for City tax, County tax, State tax, and Federal
tax.
Let’s see how can we use Denormalize transformation to achieve the task.

1.34.2 How to Use Denormalize Transformation
1. Sort the source data based on the key field, which is the SSN field in this case.
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2. Drag-and-drop the Denormalize transformation from the Transformations section in the Toolbox.

3. Right-click on the Denormalize transformation object and select Properties from the context menu.
Following properties are available for the Denormalize transformation:
Layout Builder Screen:
Layout Builder screen is used to add or remove fields in the field layout, as well as select their data type. The
fields added in the Layout Builder will show in the Output node inside the object box, as well as in all Input nodes
corresponding to the number of mapping groups created (see below), with the exception of the key field(s).

1.34. Denormalize Transformation
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Denormalize (Many-to-One) Transformation Properties Screen:
Select Keys: Using Select Keys dropdown, select the field or fields that uniquely identify the record. These keys will
be used to match the records between the normalized source and the denormalized destination.
Sort Input: Turn this option on only if the values in the matching field (or fields) are not already sorted.
Driver Field Value: Enter the pivot values for your Denormalize transformation. Using the example below, the pivot
values would be City, State, Federal, and Country.
Note: Entering driver key values is required prior to mapping the Denormalize object. For each entry in the Driver
Field Value grid, a new Input mapping group is created in the object box.
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General Options Screen:
This screen shares the options common to most objects on the dataflow:
Clear Incoming Record Messages
When this option is on, any messages coming in from objects preceding the current object will be cleared. This is
useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
Do Not Process Records with Errors
When this option is on, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
The Comments input allows you to enter comments associated with this object.
After you have configured the properties, click OK.
4. An input mapping node will be created for each value specified in the Driver Field Value grid.
1.34. Denormalize Transformation
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5. Map the fields and preview the output to view the denormalized data.
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1.34. Denormalize Transformation
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1.35 Distinct Transformation
1.35.1 Overview
Distinct transformation in Astera Centerprise removes duplicate records from the incoming dataset. You can use all
fields in the layout to identify duplicate records, or specify a subset of fields, also called key fields, whose combination
of values will be used to filter out duplicates.
Consider the scenario where we have data coming in from an Excel source and the dataset contains duplicate records.
We want to filter our all the duplicate records from our source data and create a new dataset with distinct records from
our source data. We can do this by using the Distinct transformation in Astera Centerprise. To achieve that, we will
specify data fields with duplicate records as Key Values.
In order to add a separate node for duplicate records inside the Distinct transformation object, we will check the option
Add Duplicate Records. Then write both distinct and duplicate output into a Delimited File Destination.
Let’s see how to do that.

1.35.2 How to work with Distinct Transformation
1. Select the relevant source object from the Sources section in the toolbox. In this example, we have our source data
stored in an Excel source. Therefore, an Excel source would be used.
(Read: How to work with an Excel source)
2. To apply Distinct transformation to your source data, drag and drop the Distinct transformation object from the
Transformations section in the toolbox. Map the fields from source object by dragging the top node of ExcelSource and
dropping it over the top node of Distinct transformation object. To do that, go to Toolbox>Transformations>Distinct.
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3. Now, right-click on the Distinct transformation object and select Properties. This will open the Layout Builder
screen where you can modify fields (add or remove fields) and the object layout.
Layout Builder screen will look like:

4. Click on Next. Distinct Transformation Properties screen will open.

1.35. Distinct Transformation
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Data Ordering
• Data is Presorted on Key Fields: Select this option if the incoming data is already sorted based on defined key
fields.
• Sort Incoming Data: Select this option if your source data is unsorted and you want to sort it.
• Work with Unsorted Data: When this option is selected, the Distinct transformation object will work with
unsorted data.
5. On this screen, the distinct function can be applied on the fields containing duplicate records by specifying them as
Key Field.
(Note: In this case, we will specify Name and Type fields as Key Field)
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You can now write the Distinct output to a destination object. In this case, we will write our output into a Delimited
destination object.

6. Right-click on Delimited Destination object and click Preview Output.
Your output will look like:

1.35. Distinct Transformation
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To add duplicate records
1. To add duplicate records in your dataset check the Add Duplicates Output option in the distinct . transformation
properties.

2. When you check this option, three output nodes would be added in the Distinct transformation object.
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1. Input
2. Output_Distinct
3. Output_Duplicate
(Note: When you check Add Duplicate Records option, mapping from source object to the Distinct transformation
object will be removed.)

3. Now, map the objects by dragging the top node of ExcelSource and dropping it over on the Input node of **Distinct
** transformation object.

1.35. Distinct Transformation
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4. You can now write the Output_Distinct and Output_Duplicate nodes into two different destination objects to get
the outputs accordingly. In this case, we will write our output into a Delimited destination object.
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Distinct output:

Duplicate output:

So, duplicate records have been successfully separated from your source data.

1.36 Expression Transformation
The Expression transformation in Astera Centerprise defines an expression or logic to process an incoming value
(or values). As a result, it may return a new set of values which do not depend on any user-provided input data.
Expressions can also be modified and used as variables for various other calculations.
Expression Transformation uses an expression as a logic to transform data. You can write an expression of your
own or use different functions or operations from Centerprise’s extensive library of built-in functions, such as string
manipulations, data conversion, date and time manipulation, etc. to manipulate the data. You can also perform various
operations such as mathematical calculations, comparison, etc. using the Expression transformation.

1.36.1 Use case
In this example, we have some sample data of customers stored in an Excel file in which the address information is
split into multiple fields such as address, region, country and postal code. We want to concatenate the information in
these fields and return it as full address in a new data field. For this, we will use Expression transformation.

1.36.2 How to work with Expression transformation
1. Retrieve your data in the dataflow by using one of the source objects from the Sources section in the toolbox. In
this example, we will work with an Excel Workbook Source.

1.36. Expression Transformation
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2. Drag-and-drop the Expression transformation object from toolbox>transformations>expression onto the designer
window.

3. Map the fields on which you want to apply the expression, from source to the Expression transformation object. In
this example, we have mapped Address, Region, City, Country and PostalCode fields.

4. Now right-click on the Expression transformation object and select Properties from the context menu.

5. This will open the Layout Builder screen where you can add or remove fields and modify your layout.
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You can see the following options on the Layout Builder screen:
Name: Here, name of the field is specified. You can change the name of existing fields if required.
Data Type: It shows the data type of the mapped fields.
Input: The field can be mapped as an input, with an input mapping port, to take data input from a source.
Output: The field can be mapped as an output. If an expression is present, the expression will be applied to this
output.
Variable: Turns the field into a variable which can then be applied on other fields. These expressions are calculated
first and then assigned to other expressions using it. Once a field turns into a variable, it cannot be assigned for input
or output mapping.
Expression: Here you specify the expression used for modifying the field or group of fields.
6. Since we want to write the address details from multiple fields into a single field, let’s create a new field named
Full_Address, specify Data Type as String and check the Output option.

1.36. Expression Transformation
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You can either write an expression directly in the Expression box on the Layout Builder screen, or you can build an
expression in the Expression Builder. To access the expression builder, click on
screen will open up.
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You will find the following options on the Expression Builder screen:
• Functions: It is an extensive library of built-in functions from where you can select any function according to
your requirement.

1.36. Expression Transformation
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• Expressions: Here, you can write an expression rule or choose one from the built-in functions in Centerprise.
• Objects: In this panel, you can find all the fields in your layout listed under the Expression node. You can
double click on any field name to map it to your expression.
7. In this example, we can either use a concatenate function from the built-in functions or write an expression of our
own to return the complete address information in a single field.
Address + ‘ ‘ + Region + ‘ ‘ + City + ‘ ‘ + Country + ‘ ‘ + PostalCode

306

Chapter 1. Other Versions

Centerprise, Release 8

(Note: Once you’ve built the expression, click on the Compile button to check whether or not the expression was
compiled successfully. If the Compile Status is Successful, then click OK.)
9. You can now see your expression appear in the Expression field. Click Next.

1.36. Expression Transformation
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10. A General Options screen will open where you can add comments and specify other general options. Once you’re
through with these general settings, click OK.
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General Options screen:
This screen shares the options common to most objects in a dataflow.
Clear Incoming Record Messages
When this option is checked, any messages coming in from objects preceding the current object will be cleared. This
is useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
Do Not Process Records with Errors
When this option is checked, records with errors will not be processed and won’t appear in the output. When this
option is not checked, records with errors will be processed with an error message along the record. This record
message can then feed into downstream objects on the dataflow, for example a destination file that will capture record
messages, or a log that will capture the messages and as well as collect their statistics.
In the Comments input section, you can write comments related to the object.
11. To preview the output, right-click on the Expression transformation object and select Preview Output from the
context menu.

Here’s a preview of the concatenated output:

1.36. Expression Transformation
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12. You can now map your output to a destination or some other transformation in the dataflow . In this example, we
will be writing our output to a Delimited File destination.
You may rename your destination object from the context menu options for this object. Here, we will rename it as
Full_Address.

This concludes using the Expression transformation in Astera Centerprise.
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1.37 Filter Transformation
1.37.1 Overview
Filter transformation in Astera Centerprise is used to filter out records based on some pre-defined rule. The records
that match the specified rule are filtered out and can be mapped further in the dataflow whereas the records that do not
satisfy the specified condition are omitted. The rule or logic to filter out records from data can either be chosen from
an extensive library of built-in functions or you can write one of your own.
Filter transformation is quite similar to Data Quality Rules in its function. However, unlike data quality rules, which
return an error or warning when the rule condition fails while still passing the record downstream, the Filter transformation will completely filter out any such records. The filtered records, as well as their status will not be accessible to
any downstream object on the dataflow, including any type of log.

1.37.2 Use Case
In this case, we have Customers data for a fictitious organization stored in a Delimited file source. We want to filter
out the records in which the customer has:
• Country = Germany
• Contact title = Owner
To filter out these records from our source data, we will use Filter transformation and write the relevant expression in
the expression builder to achieve our desired output. We will then write our filtered output to a Fixed length destination.

1.37.3 How to Work with Filter transformation
1. Retrieve your source data by using the relevant source object from the Sources section in the toolbox. In this
case, our sample Customers data is stored in a delimited file so we will be using a Delimited file source object
to retrieve this data in the dataflow.
2. Next, drag and drop the Filter transformation object from the Transformations section of the toolbox onto the
designer and map fields from the source object to the Filter transformation object.

3. Right-click on the Filter transformation object and select Properties.

1.37. Filter Transformation
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A Layout builder screen will open where you can modify fields and the object layout.
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4. Click Next. This will take you to the Filter Transformation Properties screen. Here, you can see the following three
sections:

1.37. Filter Transformation
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• Functions: It is an extensive library of built-in functions organized in various categories. From here, you can
select functions according to your requirement.
• Expressions: Your filter expression will appear in this Expression box. You can either write your own expression or choose from the built-in functions library.
• Objects: It contains your object layout. You can double click on any element in the layout to write it in your
expression builder.
5. In this example, we want to filter out records of customers with the contact title ‘Owner’ in Germany. For
this, we will write the following expression in the Expression box:
Country = “Germany” and ContactTitle = “Owner”
After writing the expression, click on the Compile button to check if the expression is correct. If the compile status is
Successful, the expression is correct. If it’s not, then you need to check and rectify your expression before proceeding
to the next screen.
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6. Click Next. This will take you to the Config Parameters screen where you can further configure and define parameters for Filter transformation.

1.37. Filter Transformation
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7. Click Next to proceed to the General Options screen. This screen shared the options common to most objects in a
dataflow, such as:
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• Comments:
The Comments input option allows you to enter comments associated with this object.
• Clear Incoming Record Messages
When this option is checked, any messages coming in from objects preceding the current object will be cleared. This
is useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
• Do Not Process Records with Errors
When this option is checked, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
Filter transformation object has been configured, click OK.
8. To preview filtered records, right-click on the Filter transformation object and select Preview Output.

The output would look like:

1.37. Filter Transformation
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9. You can now write your output to a destination or further transform it by applying some transformation.
In this case, we will write our output to a FixedLength file destination.
Rename your destination object by right-clicking on top of it. Here, we will rename it as German_Customers.

This concludes using the Filter transformation in Astera Centerprise.

1.38 Join Transformation
Join transformation joins records from two record sets. The join functionality is similar to standard SQL joins, but the
distinguishing advantage of Centerprise’s implementation is that you can join records from any two sources and not
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just two database tables.
This article covers how you can use Join transformation in Centerprise.

1.38.1 Sample Use Case
Suppose we have two database tables - Customers and Orders, as shown in the screenshot below, and we want to join
these two tables.

Let’s see how we can join the two tables using the Join transformation in Centerprise:
1. Drag-and-drop the Join transformation object from the Transformations section in the toolbox. To open the toolbox,
go to View > Toolbox.

1.38. Join Transformation
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2. Map the fields from the source objects to the Join transformation object.
(Note: To quickly add fields to the layout, drag and drop the node Output port of the object whose layout you wish to
replicate into the node Input port of the Join object.)
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3. To set the properties for the Join transformation, double-click on the object or right-click and go to the Properties.

1.38. Join Transformation
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4. The first screen is a Layout Builder screen. You can manage the layout for your transformation (add or remove
fields) from this screen. Click Next to go to the next screen.
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5. The next screen is the Relation Join Transformation Properties screen. Select the Join Type from the drop-down
menu. Centerprise supports four types of joins:
• Inner Join – joins records from two record sets based on matching values in key fields. Any unmatched records
are discarded.
• Left Outer Join – same as Inner Join, but unmatched records from the left record set (also called ‘first record
set’) are preserved, and null values are written for the unmatched record in the right record set (also called
‘second record set’).
• Right Outer Join – same as Inner Join, but unmatched records from the right record set (also called ‘second
record set’) are preserved, and null values are written for the unmatched record in the left record set (also called
‘first record set’).
• Full Outer Join - same as Inner Join, but unmatched records from either record set are preserved, and null
values are written for the unmatched record in the other record set.

1.38. Join Transformation
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6. Other options on the screen:
• Join in Database: Check the option if you want to join the tables in the database.
• Case Sensitivity: Check the option if you want a case sensitive match of the values in the key fields.
• Sort (Left/Right) Input: Specify whether the left input, the right input, or both, need to be sorted.
7. Select the key fields from the Left Field and Right Field drop-down lists. Click Next and Ok.
Note: You can add multiple fields to create a composite key field.
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8. You can now preview the output and see the consolidated data.

1.38. Join Transformation
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General Options screen in Join Transformation:
This screen shares the options common to most objects on the dataflow.
Clear Incoming Record Messages
When this option is on, any messages coming in from objects preceding the current object will be cleared. This is
useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
Do Not Process Records with Errors
When this option is on, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
The Comments input allows you to enter comments associated with this object.

1.39 List Lookup Transformation
List Lookup is a type of lookup that stores information in the metadata. Which means that your lookup data is stored
in the dataflow itself. List Lookup uses a list of values for both the input and output fields. You can use it to look up
for certain values in your source data and replace them with the desired information. Or you can define a list of values
in the lookup grid in properties, and the value is then looked up in the grid when you run your dataflow.
Let’s see how it works in Centerprise.

1.39.1 Use Case
In this example, we are working with a Fixed-Length File Source that contains customer information for a fictitious
organization. The customers data contains information about customers belonging to different countries. We want to
convert the country names in this data into CountryCodes by using List Lookup transformation.

1.39.2 How to Work with List Lookup in Centerprise
1. Select source from the Sources section in the toolbox and drag-and-drop it onto the designer window. In this case,
a Fixed-Length File Source is used.
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To preview the incoming data, right-click on the source object’s header and select Preview Output.

2. To start working, drag-and-drop the List Lookup object from Toolbox>Transformations>List Lookup.

1.39. List Lookup Transformation
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This is what a List Lookup object looks like:

3. Map the field from the source dataset you want to look up values for to the ‘Value’ field in the List Lookup object.

4. Now, right-click on the List Lookup object and select Properties from the context menu. List Lookup Map Properties
screen will open.
Here, the first option we have is the Case Sensitive Lookup checkbox which is always checked by default. When this
option is checked, the List Lookup will look up for values on a case sensitive basis. If you don’t want to perform look
up on case sensitive basis, you can uncheck this option.

1.39. List Lookup Transformation
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Next, you can see that there is a table where we can specify the source value and the destination value. Source values
are the values from your source data, and destination values are the values which you want to replace with the source
values.
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For example, if we write destination value ‘DE’ against source value ‘Germany’, Centerprise will write ‘DE’ in place
of ‘Germany’ in the output.

1.39. List Lookup Transformation
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This is one way of specifying the lookup values. However, there can be a lot of source values and typing them manually
can be a tedious task. There’s a more efficient way of doing this in Centerprise.
If you right-click on the List Lookup object, you can see that there is an option called Fill Lookup List with Unique
Input Values.
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Selecting this option prepopulates the source values in the Source Value column with unique source values.

1.39. List Lookup Transformation
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Now, all you have to do is type in the Destination Values, that is, the codes corresponding to each country name.
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5. Once you have populated the lookup list, click Next to proceed to the Lookup Options screen.

1.39. List Lookup Transformation
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6. In case, the lookup field does not return any value for a given source value, then you have to select from the
following option:
• No Message – won’t mark the unmatched source value as an error or warning
• Add Error – the List Lookup table will trigger an error for the records that found no match in the lookup field
• Add Warning – the List Lookup will generate a warning and return a null value for records from the source that
do not have any match in the lookup table
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7. In addition to that, when the value is not found in the lookup list, you can choose from the following options to
assign it a value:
• Assign Source Value – will return the original value from the source
• Assign Null – will return a null value for each unmatched source record
• This Value – you can type in a specific value in the given field, and the List Lookup will return the same value
for each unmatched source value.

1.39. List Lookup Transformation
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In this example, I want to add an error and return the source value if the lookup value isn’t found, so let’s select the
‘Add Error’ and ‘Assign Source Value’ options. You can choose your preferred option and click Okay.
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value.
9. These CountryCodes will flow through this output port if you want to write your data to a destination.
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10. This is how we can map the lookup values to a target or a transformation in the dataflow using the output port.

This concludes using the List Lookup transformation in Astera Centerprise.

1.39. List Lookup Transformation
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1.40 Merge Transformation
Merge transformation in Centerprise is designed to merge data fragments from disparate sources, based on some
predefined logic, and present it in a consolidated form to draw actionable insights.

1.40.1 Sample Use Case
Let’s assume that there is an organization that maintains customers’ data in two different departments – Marketing and
Sales. Marketing department stores information in a database table and Sales department maintains an Excel sheet for
storing customers information. We want to merge the information from both the sources, so that we have consolidated
data.

1.40.2 Steps to Use Merge Transformation in Centerprise Data Integrator
1. Drag-and-drop the relevant source objects from the toolbox to the designer. (Click here to find how to set up
sources.)
(Note: In this case, the marketing department has the customer information stored in a database, whereas the sales
department records customer information in an Excel file. Therefore, we will use the ‘Database Table Source’ and
‘Excel Workbook Source’ as source objects.)
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2. Merge transformation merges data from a single source only, we will first combine both the records using the
‘Union’ Map the fields from the data sources to the Union transformation object and add a new field ‘DataSource’ to
keep track of which information is coming from which source.

1.40. Merge Transformation
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3. Drag the Merge transformation object from the transformations section in the Toolbox and drop it on to the data
flow designer.
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1.40. Merge Transformation
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This is what a Merge transformation object looks like:

4. Map the Union transformation output to Merge transformation.

5. Right click on the Merge transformation object to set up transformation properties on the ‘Layout Builder’ This is
what a Layout Builder window looks like:
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6. On the ‘Layout builder Screen,’ specify the primary key. The ‘Primary Key’ is a common identifier that identifies
similar records from various sources and merges the information against these records.
(Since we are consolidating different customer records, we will set up ‘Customer ID’ as the primary key in this case.)

1.40. Merge Transformation
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7. Next, you have to specify the field to be used as Version. If your data is coming from multiple sources, the Version
field shows which source the data is coming from in the final merged output. In this case, we will use the ‘Data Source’
field we added in the Union transformation as the version field.

348

Chapter 1. Other Versions

Centerprise, Release 8

8. Next, specify the Survivor type for each field. Survivor type allows you to choose the survivor values – the values
you want to retain from your data sources – for each field. Survivor Types are set as ‘First’ by default. However,
depending on your case, you can choose the Survivor Type from the following options:

1.40. Merge Transformation
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Since CustomerID, CompanyName, and ContactName records are common in both the source files (Customers_Marketing and Customers_Sales), we will set the Survivor Type as ‘First’ for these fields. For the other
fields with missing records, the survivor type will be set as follows:
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9. Once you have set the Survivor Type, specify ‘Precedence’ for each field. Precedence is the order in which you
want the source data to be assessed. For instance, we have common data fields in both the sources, but different and
missing records. We can set appropriate precedence value to bring data from the desired data source.

1.40. Merge Transformation
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10. Next, you can set a specific condition, and the Merge transformation will process records based on the criteria
specified for a particular field.
(In this case, we have specified ‘IsNotNull’ for Address and Region fields since we want none of these fields to be
empty or have missing records.)
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11. Depending on the requirements of the business case, you can add a logical expression in the ‘Expression’ field to
process the incoming data value and transform it into the output according to the logic defined. Expression field can be
used for mathematical and financial calculations, date and time manipulations, comparisons and conversion functions.

1.40. Merge Transformation
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12. Click ‘Next’ to proceed to the ‘Merge Transformation Properties’ Here, you will see the following three checkboxes:
• Case Sensitive – check, if data is to be assessed on a case-sensitive basis
• Sort Input – check, if the incoming data is not already sorted
• Version Order Descending – check, if you want the data to be sorted in a descending version order
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13. Click ‘Next’ to proceed to the General Properties window. Here, you can add comments, instructions, or any
relevant information about the transformation. This won’t change or alter your transformation action in any way.

1.40. Merge Transformation
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You may also skip this step by clicking ‘OK’ in the previous step (on the Merge Transformation Window) to close the
transformation properties window.
14. To get the output, right-click on the Merge transformation object, and click on ‘Preview Output.’ You will get the
merged records based on your specified transformation properties.
Data Preview before applying Merge transformation:

Data Preview after applying Merge transformation:

1.40.3 Usage and Benefits
Merge transformation can be applied in cases where data is sorted into different records. Centerprise makes it extremely convenient for users to get consolidated data that is stored in different sources, while also allowing them the
flexibility to choose how the output should look like, through the various transformation properties.
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1.41 Normalize Transformation
The Normalize transformation object in Astera Centerprise is used to create one-to-many mappings. It allows users to
create multiple records from a single record by transposing the columns in a dataset into rows. In other words, you
can take a dataset that has many columns and turn it into one that has many rows.

1.41.1 Use Case
In this use case, we have a sample Excel dataset that contains information on the types and amounts of taxes paid by
taxpayers. This includes taxpayers’ Social Security Number (SSN) and the different types of taxes that they have paid.
These types are divided into different fields, such as City, County, State, and Federal, with each column containing
the amount paid by each customer for a particular tax type. Our goal is to reduce the number of fields and increase the
number of records by specifying the tax type in one consolidated field. To do that, we will use the Normalize object in
Astera Centerprise.

1.41.2 How to Work with the Normalize Transformation in Centerprise
1. Drag the relevant source object from the toolbox and drop it onto the designer. In this case, we will select the Excel
Workbook Source object from Toolbox > Sources > Excel Workbook Source and configure it so that it reads data from
the taxpayers’ dataset.

To preview the data, right-click on the object header and select Preview Output from the context menu. Here is a look
at the dataset:

1.41. Normalize Transformation
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To learn how you can configure an Excel Workbook Source object, click here.
2. Drag the Normalize object from Toolbox > Transformations > Normalize and drop it onto the designer.

You’ll notice that the object header contains one output node and two input nodes by default.

Any field mapped as a new member to one input node will appear in all of the input nodes as well as the output node.
In this case, we’ll map the SSN field from the source object to an input node.

3. Right-click on the header of the Normalize object and select Properties from the context menu.
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A dialogue box will appear.

1.41. Normalize Transformation
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This dialogue box is used to configure the Normalize object.
4. On the Layout Builder screen, create the layout of your normalized dataset by providing field names. In this case,
we’ve already mapped SSN from the source and will create two new fields, one for the tax amount and the other for
the tax type.
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Once you’ve created the layout, click Next.
5. On the Normalize (One to Many) Transformation Properties screen, make appropriate selections for the following
options:
• Number of Mapping Groups: Here, you can specify the number of mapping groups that are required. Increasing
this number from 2 will also increase the number of input nodes in the object. In this case, there are four tax
types. Hence, we will increase the number to 4.

1.41. Normalize Transformation
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• Omit Record If this Element is Null: From this drop-down menu, you can select a field from your layout. If an
element in this field is null, the entire record containing that null element will be omitted from the dataset. In
this case, we will select , the default option, which denotes that this option will not apply to any field.

362

Chapter 1. Other Versions

Centerprise, Release 8

Once you’ve made the required selections, click Next.
6. On the last screen, which is the General Options screen, you will be provided with an empty text box for comments.
Moreover, you can also select a few options that are common to most objects in Centerprise.
• Clear Incoming Record Messages: When this option is checked, any messages coming in from the preceding
object will be cleared.
• Do Not Overwrite Default Values with Nulls: When this option is checked, it makes sure that actual values are
not overwritten with null values in the output.

1.41. Normalize Transformation
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In this case, we will leave the options unchecked. Once you’re done, click OK.
Now that you’ve configured the Normalize object, you’ll notice that some new input nodes have been added to the
object based on our selection for the Number of Mapping Groups option. Each node contains the layout we specified
on the Layout Builder screen.
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7. The next step is to make the required mappings from the source object to the Normalize object. These are the
mappings needed for this particular use case:
• Map SSN from the Excel Workbook Source object to SSN in all four input nodes of the Normalize object.

1.41. Normalize Transformation
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• Map City to TaxAmount in the first input node, County to TaxAmount in the second input node, State to TaxAmount in the third input node, and Federal to TaxAmount in the fourth input node.
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• Map the City field name to TaxType in the first input node, the County field name to TaxType in the second
input node, the State field name to TaxType in the third input node, and the Federal field name to TaxType in
the fourth input node. To map field names, right-click on the mapping link, hover over Change Map Type, and
select Field Name.

1.41. Normalize Transformation
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Here is what the final dataflow should look like:
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8. Preview the output to have a look at the normalized dataset.

1.41. Normalize Transformation
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You can map these fields further to other objects in the dataflow using the output node of the Normalize object.
This concludes using the Normalize object in Astera Centerprise.

1.42 Passthru Transformation
Passthru Transformation creates a new dataset based on the elements that were passed to the transformation. This is
useful for organizing datasets for better readability and grouping of values that are otherwise calculated over and over
again (e.g. a Sequence Generator Transformation).
In this document, we will learn how to use Passthru Transformation in Astera Centerprise.

1.42.1 Sample Use-Case
In this case, we are using an XML/JSON File Source
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The source file contains customers’ information in the parent node and their order and shipping details in the collection/child node.
Preview data by right-clicking on source object’s header > Preview Output.

1.42. Passthru Transformation
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A Data Preview window will open up showing you the preview of the hierarchical data.

Now, we want to create a field in the parent node that contains the count of orders that arrived late for each customer,
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and write these records to a destination file. This new field in the parent node will depend on two fields, RequiredDate
and ShippedDate, that are already present in the collection/child node.
For this purpose, we will use Passthru Transformation.
Using Passthru Transformation
1. To get a Passthru Transformation from the Toolbox, go to Toolbox > Transformations > Passthru and drag-anddrop the Passthru object onto the designer.

You can see that the dragged transformation object is empty right now. This is because we haven’t mapped any fields
on it yet.
3. Auto-map source onto the transformation by dragging-and-dropping top node of the source object, SampleData
onto the top node of transformation object – PassthruTransformation.

Now the mapping is done, let’s configure the Passthru Transformation object.
Configuring the Passthru Transformation Object
1. Right-click on its header and select Properties from the context menu. A configuration window for Passthru
Transformation will open. First screen is the Layout Builder screen. This is where we can create or delete fields,
change their name or data types, mark any field as a variable or attach expression to any field.

2. Create a new field under the parent node. Let’s call it LateOrders and mark it as an output field.

1.42. Passthru Transformation
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3. Click Next and you will be directed to a Layout Modifications window.
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4. Select the LateOrders field. Here you can modify any field by applying expressions on it.

1.42. Passthru Transformation
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5. Write the expression that counts the number of late arriving orders. Click “. . . ” next to the expression box to open
the expression builder window where you can make use of the extensive library of built-in functions and expressions.
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6. Click on Orders node and a panel (Options for Collection) will appear. These options are only available for
collection nodes. This is where we will specify the rule for routing late arriving orders. Select Route Based on Rules
and a new section for adding rules will appear on the screen.

1.42. Passthru Transformation
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7. Add a new rule by clicking on Add switch condition icon
Now, write an expression to route late arriving orders and name this rule “LateArrivals”.

378

Chapter 1. Other Versions

Centerprise, Release 8

8. Click OK. Now observe that a new collection node Orders_LateArrivals is added to the Passthru Transformation
object.

1.42. Passthru Transformation
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To preview data, right-click on the header of the transformation object and select Preview Output from the context
menu.
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A Data Preview window will open. On expanding records, you will get corresponding order details and appended
details of late arriving orders.

1.42. Passthru Transformation
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To store the output for late arriving orders, write it to a destination file.
9. Right-click on the collection node, Orders_LateArrivals, and go to Write to > Excel Workbook Destination. An
Excel Workbook Destination object will be added to the dataflow designer with auto-mapped fields from the collection
field.

10. Configure settings for Excel Workbook Destination object.
Learn how to configure the settings for Excel Workbook Destination from here.
11. Click on the Start Dataflow button placed in the toolbar at the top to create the destination file.

An excel file will successfully be created. You can find its link in the Job progress window.

1.43 Reconcile Transformation
Reconcile transformation in Astera Centerprise enables the user to identify and reconcile new, updated, or deleted
information entries within the existing data source. It can be applied in a wide variety of business scenarios that require
a user to identify changes in multiple data records and capture them efficiently to drive critical business decisions.

1.43.1 Sample Use Case
Consider an example where we have a sample data of complaints filed by customers regarding the products and
services provided by a company. Assume that the source file 1 contains the details and status of complaints on January
1st, 2018, and the source file 2 contains the details and status of complaints on February 1st, 2018. We want to track
the progress of the resolved complaints during that one month. To do so, we will reconcile the information contained
in the source data files and capture changes using the Reconcile transformation.
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1.43.2 How to Use Reconcile Transformation
1. Drag and drop the appropriate source objects and point them towards the files that you want to reconcile. In this
example, we will be working with Excel Workbook Source.

2. Drag and drop the Reconcile transformation object from Toolbox> Transformations> Reconcile on the data flow
designer.
This is what a Reconcile transformation object looks like:

1.43. Reconcile Transformation
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You can see the transformation object contains three child nodes (Output, Input_1, and Input_2) under the parent node
Reconcile.
3. Expand the Input nodes to map fields from the source files.

4. Map the data fields from the source objects that you want to reconcile to the respective input node in the Reconcile
transformation object.
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5. Right click on the Reconcile transformation object’s header and go to Properties.

6. This will open the Reconcile Transformation Properties screen where you will see the following options:
• Case Sensitive-check this option, if you want to derive a case sensitive output
• Sort Input 1 – check this option, if the incoming data from source 1 is not sorted
• Sort Input 2– check this option, if the incoming data from source 2 is not sorted

1.43. Reconcile Transformation
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You can choose the Reconcile Output Type from the following options:
• Side By Side Element With Change Flag – if you want to get values from both sources presented side by side,
with a separate column presenting the reconciled output by putting a flag – true, in case of an update, and false
if it remains unchanged.
• Original Layout – if you want to get the reconciled output for each record and corresponding information in the
reconciled field.
• Original Layout With Changed Element Collection – applies when working with hierarchical data, to reconcile
the information contained in child nodes.
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Once you have selected the preferred Output Type, you can specify the records to be shown in the output by applying
the Record filter and Inner Node Filter. You may choose one, multiple, or all of the following options by check
marking the box.
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7. Click Next to proceed to the Layout Builder screen. Here you will have to specify a Key. It is a common identifier
in both the source files that will identify and reconcile records. In this case, we want to reconcile the progress on
complaints made against each complaint ID; therefore, we will select Complaint_ID as our Key.
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8. Now go to the Survivor Value drop-down list to set the survivor value for each data field. Survivor values are the
values from your source datasets which you want to retain in the output.
You may select from the following Survivor Value options:
• Second – if you want to derive output value from the second source
• First – if you want to derive the output value from the first source
• First If Not Null, Otherwise Second – if you want to bring output value from the first source if the record is not
null, otherwise from the second source.
• Second If not Null, Otherwise First – if you want to bring output value from the second source if it is not null,
otherwise from the first source.
• Higher – if the input values are integers, and you want to choose the higher value
• Lower – if the input values are integers, and you want to select the lower value
• Expression – if you want to derive the output value based on a formula expression
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Note: You will only need to specify the Survivor Value if you want to get the Original Layout or Original Layout
With Changed Element Collection as output. The Survivor Value option does not apply if you want to get Side by Side
Element with Change Flag as your output since both of the source values are retained when this option is selected.
9. Click Next to proceed to the General Options window, then click OK.
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• General Options screen - this screen shares the options common to most objects on the dataflow.
• Clear Incoming Record Messages - when this option is on, any messages coming in from objects preceding the
current object will be cleared. This is useful when you need to capture record messages in the log generated by
the current object and filter out any record messages generated earlier in the dataflow.
• Do Not Process Records with Errors - when this option is on, records with errors will not be output by the
object. When this option is off, records with errors will be output by the object, and a record message will be
attached to the record. This record message can then feed into downstream objects on the dataflow, for example
a destination file that will capture record messages, or a log that will capture the messages and as well as collect
their statistics.
10. Now, right click on the Reconcile transformation object’s header and select Preview Output to get the reconciled
output.
You will get one of the following outputs according to the output type selected in Reconcile Transformation Properties.
Side by Side Element with Change Flag
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Original Layout
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Original Layout With Changed Element Collection
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1.43.3 Usage and Benefits
Reconcile transformation can be applied in a variety of business cases, particularly those where monitoring the changes
in assorted data records is crucial to driving critical business decisions. Here are some of the benefits and uses of the
reconcile transformation:
• Reconciles data by deriving old and new values for specific fields in the source data
• Allows users to choose from various layout options to reconcile changes in the most appropriate way
• Works effectively with structured and unstructured (hierarchical) data formats
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• Offers the flexibility to select the information to be retained through different survivor value options

1.44 Route Transformation
A Route transformation invokes one or more paths in the dataflow, in accordance with some decision logic expressed
as a set of Rules. Using Route transformation, you can create some custom logic involving multiple paths and adapt it
to suit your data processing scenario.
For example, a record passing some rule will be written into Destination1. A record passing another rule will be
written to Destination2. A record passing still other rule will not go anywhere, and any remaining records will be fed
to a downstream transformation object.

1.44.1 Steps to Use the Route Transformation in Centerprise
To add a Route transformation, drag the Route object from the Transformations group in the Flow toolbox and drop it
on the dataflow.
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An example of what a Route object might look like is shown below:

To configure the properties of a Route object after it was added to the dataflow, right-click on it and select Properties
from the context menu. The following properties are available:
Layout Builder screen:
The Layout Builder screen allows you to add or remove fields in the field layout, as well as select their data type.
The fields added in Layout Builder will show in the Input node inside the object box, as well as in all Rule nodes
corresponding to the number of rules created (see below).

Route Transformation Properties screen:
Router Transformation Properties screen provides the interface to manage the Router rules.
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Click theicon to create a new Router rule.
Type a descriptive name for the rule in the Description field.
In the Expression input, enter the expression making the rule. For example, LTV > 60 and LTV <= 80, or any rule

or condition you want to apply to your data. Alternatively, you can click on the
button to open Expression
Builder – a tool that allows you to visually build your rule using Record tree and IntelliSense.
Click Compile to check for any syntax errors in your rule. The Status should read “Successful” for a successful
compilation.
To activate the rule, check the Active switch.
Add other Router rules if necessary. To delete an existing Router rule, select it and click the icon.
Note: Each Router rule you add here will have its own Rule node in the Router object box once you close the Properties
dialog. You can then map it to downstream objects on the dataflow as needed.
Note: Any Route transformation object has the Default node. This node handles records not passing any rules defined
in your Route transformation object.
General Options screen:
This screen shares the options common to most objects on the dataflow.
Clear Incoming Record Messages
When this option is on, any messages coming in from objects preceding the current object will be cleared. This is
useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.

398

Chapter 1. Other Versions

Centerprise, Release 8

Do Not Process Records with Errors
When this option is on, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
The Comments input allows you to enter comments associated with this object.

1.44.2 Usage
An example of using the Route transformation object is shown below.

1.45 Sequence Generator
The Sequence Generator in Astera Centerprise is used to add sequences of integer values to a dataflow. The sequences
can start with any number and have any step, for example, 50, 55, 60, 65 etc.
Centerprise can either create a sequence at dataflow’s run-time (this is called in-memory sequence), or it can read
sequence control data from a database table as your dataflow is executed.
In the case of in-memory sequences, a sequence always starts at the Start Value provided in the sequence properties.
In the case of database sequences, the last value used is recorded into the control database, and a new start value is
used every time the sequence is invoked. This makes it possible to generate ever increasing values for the sequence
each time the dataflow runs. In effect, such a sequence is a chain of sequences with non-overlapping values.
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1.45.1 Use Case
Here, we have retrieved data from the Orders table using a Database Table Source object. We will use the Sequence
Generator transformation to generate a sequence for OrderNo for the source data. Let’s see how it works.

1.45.2 How to Use the Sequence Generator
1. Drag the Sequence Generator transformation object from the Transformations drop-down in the Toolbox and drop
it on to the dataflow designer.

2. Map the required fields from the source object to a destination object.
Note: We have the Orders table as our source from a ***Database Table Source***. We will map the fields OrderDate,
RequiredDate, ShippedDate, ShipVia and Freight to an Excel Workbook Destination object.
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3. To configure the properties of the Sequence Generator Transformation object, right-click on its header and select
Properties from the context menu.
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This will open the Context Information Properties screen.
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4. On this screen, you can choose between three different types of sequence generation and specify the Sequence
Details.
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A description of these three methods is given below:
• In Memory: The sequence will be created in memory at the dataflow run-time. The sequence always starts at
the specified start value in the sequence properties.
Sequence Details:
– Start Value – the initial value for the sequence
– Step – the increment value
• Database Table: The sequence control information for the database table can be managed within Centerprise
through the Manage Sequences option.
– Connection: Specify the connection to the database where the sequences will be stored
– Sequence: Select the sequence from the list of available sequences in database.
Note: To manage database sequences, go to Menu > Tools > Sequences.
– Batch Size: Specifies the minimum number of values to be allocated to the sequence.
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– Use Memory Sequence during preview: Prevents the user from breaking the sequence cycle during a data
preview by substituting with an in-memory sequence, which does not affect (i.e. increase) the database
sequence’s current value.

• Sequence Object - The sequence control information is read from a special database table coming from SQL
Server or Oracle database.
– Connection: Specify the connection to the database that stores your sequences.
– Sequence: Select the sequence from the list of available sequences.
– Use Memory Sequence during previews: Prevents the user from breaking the sequence cycle during a data
preview by substituting with an in-memory sequence.
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Note: In this case we will use the In-Memory sequence generator option. Let’s specify the Sequence Details as
follows:
Start Value: 0
Step: 1
5. In the destination object, a new field will be created where the sequence generator value will be mapped.
Note: In this case, the OrderNo field has been created in the ExcelDest object.

406

Chapter 1. Other Versions

Centerprise, Release 8

6. The NextVal field will be mapped to the OrderNo field in the ExcelDest object.

7. You can see the output of the excel destination object in the Data Preview window.

The sequence has been generated in the new field OrderNo.
This is how the Sequence Generator transformation is used in Astera Centerprise.
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1.46 Sort Transformation
The Sort Transformation in Astera Centerprise is used to sort an incoming data stream. It also provides the option to
remove duplicate values from the input.
It is a blocking transformation which means that the input records are accumulated until the end of input. Blocking
transformations affect the performance of overall dataflow because subsequent steps cannot be executed until all the
records have been received and processed by the blocking transformation.
The Sort Transformation uses storage on the server for temporary data during sorting. The server must have enough
capacity to store the entire data set and index.

1.46.1 Use Case
We have retrieved the OrderDetails data from a database table . The dataset containts fields such as OrderID, ProductID, UnitPrice, Quantity, and Discount. This data is unsorted and we want to sort it in the ascending order of
UnitPrice.

1.46.2 How to Use the Sort Transformation
1. Drag the Sort Transformation object from the Transformations drop down in the Toolbox and drop it on the
dataflow designer.

2. Map fields from the source object to the Sort Transformation object.

3. To configure the properties of the Sort Transformation object, right-click on its header and select Properties from
the context menu.
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4. A Layout Builder screen will appear.
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On this screen you can either:
• Add Member Objects or Collection Objects to the layout.

• Edit the elements of the Sort object. The Layout builder allows you to add or remove fields in the layout, as
well as select their data type. The fields added in the Layout Builder will be shown in the Input node inside the
object box. Once you’re done making changes to the layout, click Next.
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5. The next screen is the Sort Transformation Properties screen.
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Here, you can specify the sorting criteria. You will see the following options on this screen:
• Return Distinct Values Only: Check this option if you want to remove duplicate values from the output.
• Treat Null as the Lowest Value: Check this option if you want a null value to be returned first in the ascending
sort order, and conversely, have the null value returned last in the descending sort order.
• Case Sensitive: Check this option if you require case sensitive comparison for strings.
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6. On the same screen, you need to select the sorting Field from the drop-down list and set the Sort Order as Ascending
or Descending.
Note: In this case, the sorting Field is UnitPrice and the Sort Order is Ascending.
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7. The last screen is the General Options screen. Here you can add comments or specify some General Options.
Once done, click OK and the window will close.
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8. You can now map the Sort Transformation object to a destination and preview the output.
Note: In this case we will write this to an Excel Workbook Destination.

9. The output now shows the entire source data sorted in the ascending order of UnitPrice.
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This is how the Sort Transformation can be used in Astera Centerprise.

1.47 Sources as Transformations
Centerprise provides an array of source options to read and extract data from. Different source objects can be found
in Toolbox > Sources.
Look for the supported sources and data providers here.
For a detailed overview of different source objects in Centerprise, see Setting Up Sources.
Transformations in Centerprise are used to perform a variety of operations on data as it moves through the dataflow
pipeline. Centerprise provides an extensive library of built-in transformations enabling you to cleanse, convert, and
transform data as per your business needs. Transformations can be found through Toolbox > Transformations. For a
detailed review on transformations, see Introducing Transformations.
In this article, we will discuss:
1. How various sources in Centerprise can be used as a transformation
2. Some common scenarios where you want to use a source as a transformation
While the basic function of source objects in Centerprise is to extract data and bring it to the designer for further
integration, a source object can also be used as a transformation function.

1.47.1 Changing a Source object to a Transformation object
To use a source object as a transformation, you will need to:
1. Select the relevant source object from Toolbox > Sources and drag-and-drop it onto the designer.
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2. Right-click on the source header and select Transformation from the context menu.

As soon as the Transformation option is selected from the context menu, header color of the source object will change
from green to purple. This is because, by default, Source objects in Centerprise are indicated by a green header and
Transformation objects are indicated by a purple header. Hence the change in color, when you’re using a source object
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as a transformation.

Listed below are the source objects that can be used as a transformation:
· Delimited File Source
· Excel File Source
· Report Source
· XML/JSON File Source
Note: Some sources in Centerprise cannot be used as transformations. These sources are: ADO.Net Metadata Collections, COBOL source, SQL Query source, Multi-table Query source, and FTP List Directory Contents.
Generally, the source objects are used as a transformation when the source file path is dynamic.
In the next section of the article, we will discuss how to use a Delimited File Source object as a transformation.

1.47.2 Using Delimited File Source as a Transformation
A delimited file source object can be used as a transformation when it is taking a dynamic file path; meaning that it
will have multiple files of the same layout processing in a single dataflow or workflow.
1. Drag-and-drop the Delimited File Source object onto the designer.

2. Go to its properties and provide the path for the delimited source file.
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3. Once you’ve provided the file path and configured the properties of the source object, click OK. Now right-click on
the header and select Transformation from the context menu, to change it into a transformation object.
The header of the DelimitedSource object will change to purple indicating that the source object is now converted into
a transformation object.
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The transformed DelimitedSourceTrans object will now have two nodes:
• Input node: To map the file path of the folder that contains delimited files that are to be processed.
• Output node: On expanding the Output node, you will see the data fields in the delimited source file. Map
these fields to other objects in a dataflow through the output mapping ports.

4. Use the File System Item Source to pass the file path information in the input node of the Delimited sourcetransformation object. Drag-and-drop it from the Toolbox > Sources section.
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5. In the File System Source Properties, point the path to the directory and folder where the delimited files are located.

6. Map the FullPath field from FileSystem to DelimitedSource object’s input node (FilePath).
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Now our Delimited source transformation object is ready. To preview the data, right-click on the DelimitedSourceTrans
object and select Preview Output.
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Once you choose Preview output, you will be able to view the data in the Data Preview pane. The data that you see in
the above image is in condensed preview format. Click on the +icon right next to the root node DelimitedSourceTran
object to expand the node and preview your data.
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You now have an expanded version of your data:
• Root Node: Object Path – DelimitedSourceTran
• Sub Node:
– Input: Displays the path of the file that is being used as the input for this data.
– Output: Displays the fields in the source data.
This is how you use a Delimited File Source as a transformation.
Next, we will see how to use Excel Workbook source object as a transformation.

1.47.3 Using Excel File Source as a Transformation
The Excel File Source can be used as a transformation when you have multiple Excel files with the same layout, and
want to process them together in a dataflow or workflow.
1. Drag-and-drop the Excel Workbook Source object onto the designer.

2. Go to its properties and provide the path for the excel source file.
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3. Once you’ve provided the file path and configured the properties of the excel source object, click OK. Now rightclick on the header and select Transformation from the context menu, to change it into a transformation object.
The header of the ExcelSource object will change to purple indicating that the Excel source object is now converted
to a transformation object.
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The transformed ExcelSource object will now have two nodes:
• Input node:
– FilePath: To map the path of the folder that contains excel files that are to be processed.
– Worksheet: This option can be used when you have more than one worksheet in an excel source file and
want to use any particular worksheet in the dataflow/workflow. This can be done by specifying the worksheet name using a Constant Transformation object which you’ll get through Toolbox > Transformation
> Constant Value.
• Output node: On expanding the output node, you will be able to see the data fields in the excel source file. Map
these fields to other objects in the dataflow through the output mapping ports.
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4. Use the File System Item Source to pass the file path information in the input node of the Excel sourcetransformation object. Drag-and-drop it from the Toolbox > Sources section.

5. In the File System Source Properties, provide the path of the directory and folder where the excel files are located.

6. Map the FullPath field from FileSystem to ExcelSource object’s Input node (FilePath).
• Map the Value field from ConstantValue to ExcelSource object’s Input node -Worksheet.
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Now our Excel Source transformation object is ready. To preview the data, right-click on the ExcelSourceTrans object
and select Preview Output.
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On selecting Preview output, you will be able to view the data in the Data Preview pane. The data that you see in
the above image is in condensed preview format. Click on the +icon right next to the root node ExcelSourceTran to
expand the node and preview your data.
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You will see the following nodes:
• Root Node: Object Path – ExcelSourceTran
• Sub Node:
– Input: Gives the file path of the file that is being used as the input for this data.
– Output: Displays the fields in the source data.
This is how you use an Excel File Source as a transformation.
Now we will discuss how to use an XML/JSON File Source as a transformation in Centerprise.

1.47.4 XML/JSON File Source as a Transformation
The XmlJson File Source object can be used as a transformation when you have multiple XML or JSON files with
the same layout, and want to process them in a dataflow or a workflow.
1. Drag-and-drop the XML/JSON File Source object onto the designer.

2. Go to its properties and provide the path for the XML source file and its schema.
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3. Once you’ve provided both the paths and configured the XML/JSON source object, click OK. Now right-click on
the header and select Transformation from the context menu to change it into a transformation object.
The header of the XmlJsonSource object will change to purple indicating the conversion from a source object to a
transformation object.
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The transformed XmlJsonSource object will now have two nodes:
• Input node: To map the file path of the folder that contains XmlJson files that are to be processed.
• Output node: Expand the Output node, you will be able to see the data fields that are in the XmlJson source file.
You can map these fields to other objects in a dataflow through the output mapping ports.

4. Use the File System Item Source to pass the file path information in the input node of the XmlJson sourcetransformation object. Drag-and-drop it from the Toolbox > Sources section.
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5. In the File System Source Properties, provide the path of the directory and folder where the XML/JSON files are
located.

6. Map the FullPath field from FileSystem to XmlJsonSource object’s Input node (FilePath).
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Now our XmlJson source transformation object is ready. To preview the data, right-click on the XmlJsonSourceTrans
object and select Preview Output.
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On selecting Preview output, you will be able to view the data in the Data Preview pane. The data that you see in the
above image is in its condensed form. To expand the data and preview your output, you need to click on the +icon
right next to the root node – XmlJsonSourceTran.

You now have an expanded version of your data:
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• Root Node: Object Path – XmlJsonSourceTran
• Sub Node:
– Input: Gives the file path of the file that is used as the input for this data.
– Output: Displays the fields in the source data.
This is how you use an XmlJson File Source as a transformation.
In the next section of the article, we will discuss how to use Report Source as a transformation in Centerprise.

1.47.5 Report Source as a Transformation
The Report Source can be used as a transformation when you have multiple report models with the same layout, and
process them in a dataflow or a workflow.
1. Drag-and-drop the Report Source object onto the designer.

2. Go to the properties and provide the path for the report source and its report model.
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3. Once you’ve provided both the paths and configured the properties of the report source object, click OK. Now
right-click on the header and select Transformation from the context menu, to change it to a transformation object.
The header of the ReportSource object will change to purple indicating the conversion from a source object to a
transformation object
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The transformed ReportSource object will now have two nodes:
• Input node: Map the file path of the folder that contains report files that are to be processed.
• Output node: Expand the Output node, you will be able to see the data fields that are in the report source file.
You can map these fields to other objects in the dataflow through the output mapping ports.

4. Use the File System Item Source to pass the file path information in the input node of the Report sourcetransformation object. Drag-and-drop it from the Toolbox > Sources section.
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5. In the File System Source Properties, provide the path of the directory folder where report files are located.

6. Map the FullPath field from FileSystem to ReportModel object’s Input node (FilePath).
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Now our Report source transformation object is ready. To preview the data, right-click on the report source object and
select Preview Output.
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On selecting Preview output, you will be able to view the data in the Data Preview pane. The data that you see in the
above image is in its condensed form. To expand the data and preview your output, you need to click on the +icon
right next to the root node – ReportModelTran. And then to further expand the data, click on the +icon right next to
the sub node – Output.

You now have an expanded version of your data:
• Root Node: Object Path – ReportModelTrans
• Sub Node:
– Input: Gives the file path of the file that is being used as the input for this data.
– Output: On further expansion it will show the fields/data that is there in the report model.
This is how you use Report Source as a transformation.

1.48 Subflow Transformation
The Subflow transformation object is used to call a subflow that will run as part of your dataflow. The subflow acts
like a wrapper for the objects it contains. Subflows can be seen as ‘black boxes’ inside your dataflow, simplifying
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and streamlining the dataflow design, increasing reusability, achieving an easier-to-understand view of your dataflow,
and possibly eliminating the need to know what is going on inside the subflow so that you can focus on the output it
creates. Over time, if the logic inside your subflow changes, you can modify the subflow, and the modified subflow
can now be used by the dataflow calling your subflow.
Subflows can be nested, meaning that a subflow can call other subflows. The output of the subflow can be fed into
downstream objects on your dataflow, just like the output of any dataflow object.
To add a Subflow transformation, drag the Subflow object from the Transformations section in the toolbox and drop it
on to the dataflow designer.

An example of what a Subflow object might look like is shown below.

To configure the properties of a Subflow object after it was added to the dataflow, right-click on it and select Properties
from the context menu. The following properties are available:
Subflow Properties screen:
Enter the file path of your subflow in the path input. Using UNC paths is recommended to allow for remote execution
of your dataflow on a server.
General Options screen:
This screen shares the options common to most objects on the dataflow.
• Clear Incoming Record Messages
When this option is on, any messages coming in from objects preceding the current object will be cleared. This is
useful when you need to capture record messages in the log generated by the current object and filter out any record
messages generated earlier in the dataflow.
• Do Not Process Records with Errors
When this option is on, records with errors will not be output by the object. When this option is off, records with
errors will be output by the object, and a record message will be attached to the record. This record message can then
feed into downstream objects on the dataflow, for example a destination file that will capture record messages, or a log
that will capture the messages and as well as collect their statistics.
The Comments input allows you to enter comments associated with this object.
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1.48.1 Creating a Subflow
Creating a subflow is similar to creating a regular dataflow, because a subflow is essentially a dataflow or a subdataflow. The difference between the two, however, is that a subflow may optionally have an input and output.
The subflow input makes it possible to feed data into the subflow from an upstream object on the dataflow that calls
the subflow. The subflow’s output is used to send data to the downstream dataflow object connected to the subflow.
To create a new subflow, go to File -> New -> Subflow on the main menu.

Or you can expand the

dropdown on the main toolbar and select Subflow as shown below.
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Designing a subflow is similar to designing a dataflow. For more information on working with dataflows, see the
Creating Dataflow chapter.
When a subflow tab is active, the flow Toolbox has an additional group Subflow. This group has two objects that
control input and output properties of your subflow.

1.48.2 Subflow Input
Subflow Input object is a connector controlling the input layout of your subflow. Any data feeding into the subflow
will pass through the Subflow Input when the subflow is called by a dataflow or another subflow.
To add the subflow input, drag the Subflow Input object from the Subflow group in the toolbox and drop it on to the
subflow designer.
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To configure the properties of a Subflow Input object after it is added to the subflow, right-click on it and select
Properties from the context menu. The following properties are available:
• Layout Builder screen:
Meta Object Builder screen allows you to add or remove fields in the field layout, as well as select their data type. The
fields added in Meta Object Builder will show in the SubflowInput1 node inside the object box.
• General Options screen:
This screen shares the options common to most objects on the dataflow.

1.48.3 Subflow Output
Subflow Output object is a connector controlling the output layout of your subflow. Any data leaving the subflow will
pass through the Subflow Output when the subflow is called by a dataflow or another subflow.
To add the subflow output, drag the Subflow Output object from the Subflow group in the Flow toolbox and drop it on
to the subflow.

1.48. Subflow Transformation
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To configure the properties of a Subflow Output object after it was added to the subflow, right-click on it and select
Properties from the context menu. The following properties are available:
• Layout Builder screen:
Meta Object Builder screen allows you to add or remove fields in the field layout, as well as select their data type. The
fields added in Meta Object Builder will show in the SubflowOutput1 node inside the object box.
• General Options screen:
This screen shares the options common to most objects on the dataflow.

1.48.4 Usage
Some examples of using Subflows are shown below:
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1.49 Switch Transformation
Switch transformation matches source data for the criteria specified by the user, and wherever the criteria is met, it
replaces the information in the particular field with the desired output (also specified in the layout). This gives users
more control over their data and helps them manage it in a better way.
There are two modes in Switch transformation:
1. Basic Mode
2. Enhanced Mode
The basic mode in Switch transformation matches for specific values in the source data and replace it with the desired
output. Enhanced mode enables users to set lookup criteria by writing expressions and thus makes the feature more
flexible.

1.49.1 How to work with Switch transformation (basic mode) in Centerprise
1. Select your source by dragging the relevant object from the Sources section in the Toolbox on to the dataflow
designer and configure the connection by putting in relevant details.
(Note: In this example, we are working with an Excel Workbook Source that contains employee information for a
fictitious organization, but you can select the source type from a wide range of options provided in Centerprise).

2. After setting up the connection and configuring the source file, drag the Switchtransformation object from the
toolbox. If the toolbox is hidden, go to View > Toolbox > Transformation > Switch.
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3. Map the required fields from the source to the Switch transformation object.

4. Either double-click on the Switch transformation object to open the Properties window or right-click on the object
and go to Properties from the list.
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5. First screen on the properties window is a layout builder screen. Here you can manage the fields (add and/or remove
the fields) to make your Switch field layout.

1.49. Switch Transformation
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(Note: Switch transformation only allows one output field. If you check the output box next to multiple fields,
Centerprise will show a verification error).

6. After specifying the layout and selecting the relevant output field, click Next. It will take you to the Switch Map
Properties screen. At this stage, you can select the mode of the Switch transformation and assign the rules in the Case
Value and Output Value sections.
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Centerprise will look for the values specified in the Case Value column in the source file and replace it with the
corresponding values in the Output Value column.
(Note: Switch transformation only allows one default value and if you select multiple default values, Centerprise will
give verification error).

Example
In this example, the source table contains information about the departments in numbers. We will use the Switch
transformation in basic mode, to switch the stored numeric information with the descriptive information.
Data Preview (Before Switch)
1.49. Switch Transformation
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Data Preview (After Switch)
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1.49.2 How to work with Switch transformation (enhanced mode) in Centerprise
Steps 1-5 are going to remain the same even when working with the Enhanced Mode in Centerprise.
1. After you have created the layout in the Layout Builder screen in the properties window, click Next and go to
the Switch Map Properties screen and select Enhanced Mode.

1.49. Switch Transformation
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(Note: Switch transformation is not field specific in the enhanced mode therefore, the option for selecting the Switch
Field is disabled).
Example:
An organization stores information about employees’ salaries. They have set criteria about issuing credit cards, which
is dependent on individual’s salary. In this scenario, to see which individual is available for which perk, define the
salary range in the Case Expression section and specify the corresponding output in the Output Expression section.
See the screenshot above. To store the information in a separate field, we created a new field (CreditCard) in the
Layout Builder and selected it as the Output.
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Data Preview (Before Switch)

1.49. Switch Transformation
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Data Preview (After Switch)

460

Chapter 1. Other Versions

Centerprise, Release 8

1.50 Tree Join Transformation
The Tree Join Transformation in Astera Centerprise enables users to create complex, hierarchical data structures such
as EDI or XML documents with ease. Unlike the standard relational join which combines left and right elements to
create a new record, the Tree Join transformation allows users to create collection and member nodes. It also enables
users to join datasets in parent-child hierarchies using a key field. It is a set level transformation that operates on a
group of records.
In this document, we will learn to use the Tree Join Transformation in Astera Centerprise.

1.50. Tree Join Transformation
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1.50.1 Use Case
In this use case we have two different source datasets. The first data contains information about Customers and has
fields such as CustomerName, CustomerID, Address, etc.

The second dataset contains details of Orders placed by customers. It includes fields such as OrderID, CustomerID,
and order details such as RequiredDate, ShippedDate and other shipping details.
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We’ll join these two datasets using the Treejoin Transformation and create a hierarchical dataset in which all orders
placed by a customer along with the order details are represented in a parent-child hierarchy.
Contrary to the regular Join that joins two datasets in a flat layout, the Tree Join Transformation joins data from two
different datasets into a hierarchical data structure.
In this use case, each record from the first dataset that contains Customer details will be a parent node, and under the
parent node, the details of Orders placed by that customer will be returned in a child node.

1.50. Tree Join Transformation
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1.51 Using the Tree Join Transformation
1. To get the Tree Join Transformation from the Toolbox, go to Toolbox > Transformations > Tree Join and drag
and drop the Tree Join Transformation object onto the designer.

2. Now map fields from the Customer source dataset to the TreeJoin object.

3. Right-click on the Tree Join header and go to Properties from the context menu. On the Tree Join Layout Builder
screen, you can see the fields from the Customer dataset listed under the root node.
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4. Next, click on the TreeJoin node, you will see that the small icons or buttons at the top of the screen will become
active. If you click on the icon, you’ll get two options:

• Add Member Object – to add a new member node to your layout
• Add a Collection Object – to add a new collection node under the parent node. It will return all corresponding
records as a collection under the parent node.
In this case we will Add a Member Object to create a separate record for each order placed by a customer, under
a separate customer record node.
5. Add a Member Object to this root node. A dialogue box will open to name your member object.
In this case, let’s name it as ‘Orders’ and click OK. A member object has been added to our parent node.

6. Click OK, to close the properties window. Now map the ‘Orders’ dataset to the member node that we created in the
previous step to complete the layout.

1.51. Using the Tree Join Transformation
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7. Go to the properties of the TreeJoin object again. We’ve already created the layout, so we’ll proceed to the next
screen.

466

Chapter 1. Other Versions

Centerprise, Release 8

8. On the TreeJoin Properties screen, we must specify the Join Key.

1.51. Using the Tree Join Transformation
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Join key is a common field or a common identifier in both the datasets which will identify and join records in a treelike structure. The parent and child fields are the same fields which are common in both the source datasets and serves
as a key identifier to join records.
• Parent Field – Join field from the first dataset
• Child Field – same field as the parent field, selected from the second dataset.
In this case, the CustomerID field is common in both the datasets, so we’ll use it as the Join Key.
9. Click on the Parent field dropdown button. Expand the TreeJoin node and select the CustomerID field.

10. Click on the Child field column and expand the TreeJoin root node. Scroll down to your member node, expand
this node and select the CustomerID field from the second dataset.

Let’s discuss the other options on the properties window:
• Join In Database – lets you join the tables in the database itself rather than in-memory. However, it applies only
when both the tables are sourced from the same database.
• Case Sensitive – to process and join records on a case sensitive basis.
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11. We have our layout and the TreeJoin properties ready, click OK.

1.51. Using the Tree Join Transformation
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12. Right-click on the TreeJoin object and select ‘Preview Output’.
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The TreeJoin has returned the customer records in parent nodes. Upon expanding the node, you can see the order
placed by the customer listed as its member unit under the parent node.

If we choose to Add a Collection Object in the Layout Builder, all the records for orders placed by a customer will be
returned in a collection under a single parent node for each customer.

1.51. Using the Tree Join Transformation
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13. The joined dataset can now be written to a desired destination. In this case we will write it to an XML File
Destination object.
To know more about writing to an XML File Destination object, click here.

This concludes using the Tree Join Transformation in Astera Centerprise.
Download datasets used in the use case from here.

1.52 Tree Transform
The Tree Transform in Astera Centerprise enables users to transform data in a hierarchical structure. Users can create
new fields in the parent node based on the data in the collection/child node. Tree Transform supports rule-based
routing, filtering, merging and sorting of data while maintaining its hierarchy.
In this document, we will learn to use Tree Transform in Astera Centerprise.
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1.52.1 Use Case
In this case, we are using the XML/JSON File Source to extract our source data. You can download this sample data
from here.

The source file contains customers’ information in the parent node and their orders and shipping details in the collection/child node.
You can preview this data by right-clicking on source object’s header > Preview Output.

1.52. Tree Transform
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A Data Preview window will open, displaying a preview of the hierarchical source data.
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Now, we want to create a new field in the parent node that contains the count of orders that arrived late for each
customer, and route these records to a destination file while maintaining the hierarchical format of the dataset.
This new field in the parent node will depend on two fields: RequiredDate and ShippedDate, that are already present
in the collection/child node.
In other words, we are trying to transform a hierarchical data without flattening its structure. For this purpose, we will
use the Tree Transform transformation.
Using Tree Transform
1. To get a Tree Transform from the Toolbox, go to Toolbox > Transformations > Tree Transform and drag-and-drop
the Tree Transform object onto the designer.
![Untitled Project1f2a39c.autosave](tree-transform.assets/Untitled Project1f2a39c.autosave.gif)
The transformation object is empty right now. This is because we haven’t mapped any fields to it yet.
2. Auto-map source fields onto the transformation by dragging and dropping the root node of the source object
CustomerOrders onto the root node of the transformation object – TreeXform.

Now that the mapping is done, let’s configure the TreeXfrom object.
Configuring the Tree Transform Object
1. Right-click on the object’s header and select Properties from the context menu. A configuration window for Tree
Transform will open. The first screen is the Layout Builder screen. This is where we can create or delete fields, change
their name or data types, mark any field as a variable or attach an expression to a field.
![Untitled Project1f2a39c.autosave](tree-transform.assets/Untitled Project1f2a39c.autosave-1593152207933.gif)
2. Create a new field under the parent node. Let’s name it LateOrders.

1.52. Tree Transform
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3. Click Next and you will be directed to a Layout Modifications window.
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4. Select the LateOrders field. Here you can modify any field by applying expressions on it.

1.52. Tree Transform
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5. Write the expression that counts the number of late arriving orders.
Click “. . . ” next to the expression box to open the Expression Builder where you can make use of the extensive library
of built-in functions and expressions.
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This creates the field values for LateOrders based on the field values of RequiredDate and ShippedDate fields.
6. Click on Orders node and a panel (Options for Collection) will appear. These options are only available for
collection nodes.

1.52. Tree Transform
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Options for Collection:
• Show – shows collection node in Tree Transform object.
• Flatten With Item Count – flattens data based on the record count in the collection node against each item in the
parent node.
• Flatten Based on Rules – flattens a part of hierarchical data based on predefined rules.
• Route Based on Rules – routes and creates subsets of data based on predefined rules.
• Merge With Item Count – merges data based on the record count in the collection node against each item in the
parent node.
• Hide – hides collection node from the Tree Transform object.
• Calculation Formula – an expression box used for writing rules to route or flatten hierarchical data.
• Sort Based On Keys – sorts hierarchical data based on the field in the collection node. Only available for Show
and Flatten With Item Count options.
This is where we will specify the rule for routing late arriving orders. Select Route Based on Rules and a new section
for adding rules will appear on the screen.
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7. Add a new rule by clicking on Add switch condition icon

.

Now, write an expression to route late arriving orders and name this rule ‘LateArrivals.’

1.52. Tree Transform
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8. Click OK. Now observe that a new collection node Orders_LateArrivals has been added to the Tree Transform
object.
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To preview data, right-click on the header of the transformation object and select Preview Output from the context
menu.

1.52. Tree Transform
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A Data Preview window will open. On expanding the records, you will get corresponding order details and appended
details of late arriving orders.
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To store the output for late arriving orders, you can write it to a destination file or use that data further in the dataflow.
This concludes using the Tree Transformation in Astera Centerprise.

1.53 Union Transformation
The Union transformation in Astera Centerprise is used to combine incoming data from two or more inputs into a
single output. It functions similar to a union operator in SQL query. It has multiple input nodes and a single output
node. It puts together two sets of data irrespective of the repetition that might occur in the datasets. In order to perform
this transformation on two datasets, their cardinality must be same.
Note: An input node in a union transformation cannot receive data from two different set transformations.

1.53.1 Use-Case
In this example, we have a customers data from two different departments: Sales and Marketing, stored in two separate
Excel files. We want to combine this data into a single dataset using Union transformation. To keep track of records
coming in from each department, we will also add a new field ‘Category’ in the layout of the Union transformation
and pass the value using a Variable object.

1.53.2 How to Work with Union Transformation
1. To work with Union transformation, drag and drop the Union transformation object from Toolbox > Transformations
> Union onto the dataflow designer.

2. Map the Marketing data to Input_1 and Sales data to Input_2 in the Union transformation object.

1.53. Union Transformation
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3. Now, right click on the Union transformation’s header and select Properties.
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4. The first screen is the Layout Builder screen where you can customize your layout or modify your fields. You can
also provide a default value to be used in place of null values.
Add a new field and name it as Category and specify its Data Type as String.
Click Next.

1.53. Union Transformation
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5. Next is the Union Transformation Properties screen where there are two input nodes defined as Input_1 and Input_2
by default. You can also rename them if you want. You can also define any number of input nodes based on the number
of datasets you want to combine using the Union transformation.
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Click OK.
6. Now, map the categories of respective departments from the Variable resource object to the Category field in the
Union transformation object. This is done to identify which department a particular record is coming from.

1.53. Union Transformation
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Now, we have successfully configured the Union transformation object.
7.
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Output.
You can see that the Union transformation has successfully combined the two datasets into a single, unified dataset.

Note: Union transformation will show the combined fields from both the sources as a resultant, regardless
of whether they are present in one or both the datasets. In the final output, the dataset which does not have
one or more fields will be assigned null value in that field.
8. You can now further transform your dataset or write it to a destination.

1.53. Union Transformation
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This concludes working with Union transformation in Astera Centerprise.

1.54 Data Cleanse Transformation
Data cleanse transformation is a new addition to Astera Centerprise’s library of transformations. It makes it all the
more convenient for business users to cleanse raw data and present it in a more refined, standardized, and enterpriseready format. Using the Data Cleanse transformation, users can clean up data from null values and redundant text and
characters, and prepare raw data for transformation, validation, profiling, and record matching functions.

1.54.1 Steps to Use the Data Cleanse Transformation in Astera Centerprise
1. Retrieve the data you want to cleanse using the relevant source object. (Click here to learn more about setting
up sources in Centerprise.)
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2. Now drag the Data Cleanse transformation object from the Transformations section of the toolbox and drop it
onto the designer.

3. This is what a Data Cleanse transformation object looks like.

1.54. Data Cleanse Transformation
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4. Map data from the source object to the Data Cleanse transformation object. You can either auto-map the entire
data set or map a few fields manually.

5. Now you have to specify the criteria for data cleansing. Right-click on the Data Cleanse transformation object
and go to Properties from the context menu.
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6. This will open a new window where you have to set up the properties for data cleansing. The first screen is the
Layout Builder Screen. Here you can customize the layout of your dataset by adding, removing or renaming
fields. Once you have created the layout, click Next to proceed to the next screen.

1.54. Data Cleanse Transformation
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7. This is where you set up the data cleanse criteria for your source data.
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You can find various data cleanse options arranged in different sections. Let’s explore them one by one.
Remove
The options provided within this category allow you to remove values, spaces, tabs, and line breaks from your data.
You can find the following options within this category:

1.54. Data Cleanse Transformation
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• All whitespaces – removes all whitespaces from the data
• Leading and trailing whitespaces – removes the whitespaces preceding and succeeding the values
• Tabs and line breaks – removes tabs and line breaks within the source values
• Duplicate whitespaces – removes double spaces from the data
• Letters – removes all alphabets from the data
• Digits – removes all digits from the data
• Punctuation – removes all punctuation from the data
• Specified Character – removes any specific character from the data
Replace Nulls
As the name suggests, the options within this category allow you to replace null values inside a string or numeric field
with a corresponding value – blank in case of a string, and zero, in case of a numeric field.
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• Null strings with blanks: replaces all null strings with blanks
• Null numerics with zeros: replaces all null numeric values with zeros
Find and Replace
The Find and Replace options enable users to replace a value in the source dataset with another value.

1.54. Data Cleanse Transformation
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It also provides users the option to choose whether the find and replace function is to be performed on a case sensitive
basis. You can select a search mode from three options:
• Normal – will perform a normal find and replace function
As in this example, we want to change the status from ‘Planned’ to ‘Scheduled.’

So, we’ll type in ‘Planned’ in the Find bar and ‘Scheduled’ in the Replace bar.
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Now, if we look at the output, we can see that the Data Cleanse transformation has found and replaced the status values
from ‘Planned’ to ‘Scheduled.’

• Extended – allows you to search for tabs(\t), newline(\r\n), or a character by its value (\o, \x, \b, \d, \t, \n, \r and
\) and replace with the desired value
In the example below, we want to replace whitespaces within our source values with a hyphen (-).

So, we’ll type ‘\s’ in the Find bar and ‘-’ in the Replace bar.

1.54. Data Cleanse Transformation
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Now, if we look at the output, we can see that the Data Cleanse transformation has found and replaced whitespaces
from within the values with a hyphen.
Preview before applying the Extended Find and Replace function

Preview after applying the Extended Find and Replace function

• Regular Expressions – allows you to find and replace a value based on a regular expression
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In the example below, we want to replace the ALFKI value(s) in the CustomerID field with A1234.

For this, we will write a regex in the Find bar and the desired value in the Replace bar.

Now, if we look at the preview, you can see that Centerprise has replaced the values in the source data with the desired
values.

1.54. Data Cleanse Transformation
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Case
Case options allow users to convert the letter case of source data to Upper, Lower, or Title case.

You can choose from the following options:
• None – keeps the letter case as is

• Upper – changes all letters to upper case
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• Lower – change all letters to lower case

• Title – changes all letters to title case

Modify Data
The Modify Data option provides you the flexibility and convenience of applying an expression to all fields in your
data. Check the ‘Run expression on all fields’ option to activate this feature.
The ‘Run Expression on all fields’ feature was previously called ApplyToAll and offered as a standalone transformation
in Centerprise 7.5 and previous releases. It had a limited functionality though, compared to the all-new Data Cleanse
transformation, which is why it has been replaced altogether with the Data Cleanse transformation in Centerprise 7.6
and now in Centerprise 8.0.
The ‘Run Expression on all fields’ feature is enabled by default for any existing flows created prior to Centerprise 7.6.
This means that existing flows created on Centerprise 7.5 or a prior release will continue to work seamlessly on 8.0
upgrade and won’t require any modification at all.

1.54. Data Cleanse Transformation
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Now click on this
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Here, you can choose from the extensive library of built-in expressions and apply it on all the mapped fields by adding
it to a $FieldValue parameter.
As in this example, we have mapped a regular expression to $FieldValue parameter.

1.54. Data Cleanse Transformation
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Now if we look at the preview, you can see that Centerprise has applied the regular expression to all fields and removed
whitespaces from the values.
Preview before running the expression on all fields:

Preview after running the expression on all fields:

This function was previously performed using the ApplyToAll transformation in Centerprise 7.5 and previous releases.
However, in Centerprise 7.6 and Centerprise 8.0, you can perform this and other data cleanse tasks using the Data
Cleanse transformation.
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1.55 File Lookup Transformation
The File Lookup transformation in Astera Centerprise is used to look up values coming from a source. It uses an excel
or delimited file which contains the lookup values as well as the output values to perform the lookup. File lookup can
be performed based on a single lookup field as well as a combination of fields. Similarly, a file lookup transformation
can return a single output field from a lookup table or a combination of fields. In either case, the output field or fields
are returned from the records in which the lookup values match the incoming values.

1.55.1 Use Case
In this scenario, we have a customers data from a fictitious organization stored in a database source. It contains
information of customers from different countries. We want to replace the country names by country codes in our
database, by switching them with the lookup values (country codes) stored in an excel file. To achieve that, we will
use the File Lookup transformation.

1.55.2 How to Work with the File Lookup transformation
1. Select the relevant source object from the Sources section in the toolbox. In this example, we will use Customers
data stored in a database table.

Right-click on the source object’s header and select Preview Output. You can see the country names in the Country
field which we want to convert into country codes.

1.55. File Lookup Transformation
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2. Drag-and-drop the File Lookup transformation object from Tooblbox>Transformations>FileLookup onto the designer window.

Now, let’s configure the transformation object.
3. Right-click on the header of File Lookup transformation object and select Properties.
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4. A File Lookup Map Properties screen will open where you can see an option for Source File Type.
Source File Type: Here, you need to specify the type of your lookup file.

1.55. File Lookup Transformation
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You can perform it using an Excel or delimited lookup file.
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5. Select the source file type from the dropdown menu. In this example, our country codes are stored in an Excel file
so we will specify the source file type as ‘Excel’.

1.55. File Lookup Transformation
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6. Click Next to proceed to the File Lookup Details screen. You will see two options:
File Location: Here, you need to specify the path to the lookup source file.
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Options:
First Row Contains Header: You can check this option if your lookup file contains header in the first row. Else, you
can leave it unchecked.
Worksheet: If your lookup file contains multiple worksheets, you can select the worksheet you want to use to perform
the lookup.

1.55. File Lookup Transformation
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7. Click Next to proceed to the Layout Builder. Here, you can make changes to the object’s layout by modifying the
existing fields or creating new fields.
Once you’re done, click Next.
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8. On the next screen, you will see various Lookup Options.

1.55. File Lookup Transformation
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If Multiple Values Are Found
Multiple Matches Found Option: This option provides the flexibility to choose the output value, if more than one
matches are found for a single value in your lookup file. The option expands into a drop-down list where you can
select one from the following three options:
1. Return First: It will return the first matched value found.
2. Return Last: It will return the last value among all the matched values.
3. Return All: It will return all the values in the lookup file that match a source value.
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If Value Is Not Found In The Lookup List:
In case no lookup value is found against a source value, you can choose one of the following three options to be
appended with your output.
No Message: There will be no message and the output will be the same as the input value.
Add Error: An error message will appear with the output.
Add Warning: A warning will appear with the output.

1.55. File Lookup Transformation
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If Value Is Not Found In The Lookup List, Assign Value:
If no lookup value is found against a source value, you can assign an output value of your choice.
Assign Source Value: It will return the source value in the output.
Assign Null: It will assign null to your output value.
This Value: You can select this option and assign any value of your choice.
9. Click Next. This will take you to the Config Parameters screen where you can further configure and define parameters for File Lookup transformation.
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Once you have configured the File Lookup transformation object, click OK.
10. Map the Country field from source object to the Country field in the File Lookup transformation object. Now map
the Code field from transformation object to the Country field in the database destination object.
This is how your dataflow will look like:
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11. Map the remaining fields from the source object to the destination object.

12. Right-click on the destination object’s header and select Preview Output.
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13. You can see that the country names in the database table have been successfully converted into country codes.

This concludes using the File Lookup transformation in Astera Centerprise.

1.56 SQL Statement Lookup
The SQL Statement Lookup object in Astera Centerprise is used to look up certain values that are mapped onto it from
a source object. It uses an SQL statement to access a table that contains the lookup values and their corresponding
output values. Once the lookup is performed, the SQL Lookup object returns either a single or multiple output fields,
depending on the nature of the lookup table. Similarly, the lookup can be performed based on one lookup field
or multiple lookup fields. When the incoming values match the lookup values, the output field or fields for those
particular records are returned by the SQL Lookup object.
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1.56.1 Use Case
In this use case, we will read data from the Customers table in the Northwind database using a Database Table Source
object. This table contains customer information from a fictitious organization and will serve as the source table. Our
purpose is to use an SQL Statement Lookup object to find some information about the orders placed by customers.
This data is stored in a separate table called Orders, which will serve as the lookup table.

1.56.2 How to Work with SQL Statement Lookup in Centerprise
1. Drag and drop the Database Table Source object from Toolbox > Sources > Database Table Source onto the dataflow
designer. Configure the object so that it reads data from the Customers table.

To learn how you can configure a Database Table Source object, click here.
2. Now drag and drop the SQL Statement Lookup Transformation object from Toolbox > Transformations > SQL
Statement Lookup onto the dataflow designer, next to the source object.
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3. Right-click on the header of the SQL Statement Lookup object and select Properties from the context menu.
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This will open a new window.
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Here, we need to configure the properties of the SQL Statement Lookup object.
4. On the Database Connection screen, enter the details for the database you wish to connect to.
• Use the Data Provider drop-down list to specify which database provider you wish to connect to. The required
credentials will vary according to your chosen provider.
• Alternatively, use the Recently Used drop-down list to connect to a recently connected database.
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• Test Connection to ensure that you have successfully connected to the database. A separate window will appear,
showing whether your test is successful. When the connection has been successfully established, close it by
clicking OK, and then click Next.
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5. The next screen will present a blank space for you to write an SQL statement. Here, you can enter any valid
SELECT statement or stored procedure to read any table from the database that was specified earlier. This table will
serve as the lookup table.
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In this case, we will be reading data from the Orders table.
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Enter the SQL statement and click OK. This will take you back to the dataflow designer.
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As you can see, the SQL Statement Lookup object has been populated with all the fields present in the Orders table.
6. The next step is to choose an incoming field or multiple incoming fields from the source object, based on which the
lookup action will be performed. This field needs to be mapped to the transformation object.
In this case, we can clearly see that CustomerID is a common element between the two tables. Hence, this field will
be used to perform the lookup. It will be mapped from the Database Table Source object to the SQL Statement Lookup
object as a new member.
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7. Right-click on the transformation object’s header and select Properties to open the Properties window. Keep
clicking Next until you reach the Layout Builder screen. Here, you can customize the layout by modifying the existing
fields or creating new fields.
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Once you’re done, click Next.
8. On the next screen, you can define one or more lookup conditions. These conditions will determine what values are
returned when the lookup is complete.

1.56. SQL Statement Lookup

535

Centerprise, Release 8

You will have to make appropriate selections from three drop-down lists:
Database Element Name: This list contains all the elements present in the SQL Lookup object. Select the element that
you wish to use as a lookup field. In this case, it is CustomerID.
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Operator: This list contains a set of operators that are used to define the condition. In this case, we will be using the
‘equals to’ operator because the lookup value is supposed to match the incoming value.
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Input Element: This list contains the elements that have been mapped to the lookup object. In this case, the only input
element available is CustomerID from the Customers table.
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Once you’re done defining the condition, click Next.
9. The next screen will allow you to choose a Lookup Caching Type. The following options are available:
No Caching: No data will be stored in cache. This option is selected by default.
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Static: The lookup values are stored in a cache. Once the cache is created, the lookup object will always query the
cache instead of the lookup table. When you select this option, the following sub-options are enabled:
• Fill Cache With All Lookup Values at Start: Fills the cache with all of the lookup values at the start and continues
to use this cache for every lookup.
• Cache After First Use: Uses the database table for the first lookup and fills the cache right after it is done. This
cache is then used for every subsequent lookup. Checking this option enables another sub-option:
o Cache Commit Count: Defines the number of records collected per cache chunk before they are committed to
the cache.
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Persistent: Saves the lookup values in a cache file that can be reused for future lookups. When you choose this option,
the following sub-options are enabled:
• Rebuild Persistent Cache on Next Run: Checking this option will allow the contents of the cache file to be
modified after every run.
• Cache File Name: Here, you can enter a name for your cache file.
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In this case, we will select the No Caching option. Once you’re done, click Next.
10. On the next screen, you will see multiple lookup options.
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The page provides a set of options for different scenarios that could be faced during a lookup.
If Multiple Values Are Found
Multiple Matches Found Option: This option provides the flexibility to choose the output value if more than one
matches are found for a single value in the lookup table. You can select one out of three options that appear in the
drop-down list:
• Return First: Returns the first matched value.
• Return Last: Returns the last value among all matched values.
• Return All: Returns all the matches values.
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If Value Is Not Found In the Lookup List
If no lookup values are found for a source value, you can choose from the following options to be appended with the
output:
• No Message: The output value will be the same as the input value and no message will appear with it.
• Add Error: An error message will appear with the output.
• Add Warning: A warning message will appear with the output.
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If Value Is Not Found in the Lookup List, Assign Value
If no lookup value is found for a source value, you can assign an output value of your choice.
• Assign Source Value: Returns the source value in the output.
• Assign Null: Returns null in the output.
• This Value: Allows you to enter any value that will be returned in the output.
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In this case, we want to look up the details for all of the orders placed by every customer. Hence, we’ll select Return
All from the drop-down list in the Multiple Matches Found Option. This will automatically disable the rest of the
options available on the screen.
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Once you’re done choosing the option, click Next.
11. On the next screen, you can define certain parameters for the SQL Statement Lookup object.
These parameters facilitate an easier deployment of flows by excluding hardcoded values and providing a more convenient method of configuration. If left blank, they will assume the default values that were initially assigned to
them.
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In this case, we will be leaving them blank. Click Next.
12. On the last screen, you will be provided with a text box to add comments. The general options on this screen have
been disabled.
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You are now done configuring the SQL Statement Lookup object. Click OK.
13. Right-click on the SQL Lookup object’s header and select Preview Output.
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You will able to see the following results:

Scroll down the Data Preview window to see the rest of the results.
The SQL Statement Lookup object has successfully returned the details for the orders placed by every customer in the
Customers table (Source table) by comparing the CustomerID to its counterpart in the Orders table (lookup table).
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This concludes using the SQL Statement Lookup transformation in Astera Centerprise.

1.57 Database Lookup
The Database Lookup object in Astera Centerprise is used to look up values from a source. It uses a database table that
contains the lookup values as well as a set of corresponding output values. When the lookup is performed, the object
returns either a single output field or multiple output fields, depending on the nature of the lookup table. Similarly, the
lookup can be performed based on one lookup field or multiple lookup fields. In each case, the output field or fields
are returned from the records in which the lookup values match the incoming values.

1.57.1 Use Case
In this use case, we have a sample dataset of customers that is stored in a database table. Within this dataset, there is
a field that contains the country of residence for each customer. We have another database table that contains all of
these countries and their corresponding codes. Our goal is to replace the full country names with codes while writing
the customer dataset to an Excel file. To do that, we will use a Database Lookup object.

1.57.2 How to Work with Database Lookup in Centerprise
1. Drag the relevant source object from the toolbox and drop it onto the designer. In this case, we will select the
Database Table Source object from Toolbox > Sources > Database Table Source and configure it so that it reads data
from the customer dataset.

To learn how you can configure a Database Table Source object, click here.
To preview the data, right-click on the object header and select Preview Output from the context menu. Here, you can
see that there is a field that contains each customers’ country of residence.
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2. Drag the Database Lookup object from Toolbox > Transformations > Database Lookup and drop it onto the
designer.

3. Right-click on the header of the Database Lookup object and select Properties from the context menu.
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This will open a new window on your screen.
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Here, you’re required to configure the properties for the Database Lookup object.
4. On the Database Connection screen, enter the details for the database you wish to connect to.
• Use the Data Provider drop-down list to specify which database provider you wish to connect to. The required
credentials will vary according to your chosen provider.
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• Provide the required credentials. Alternatively, use the Recently Used drop-down list to connect to a recently
connected database.
• Test Connection to ensure that you have successfully connected to the database. A new window will open, showing whether your test is successful or has ended up in some error. When the connection has been successfully
established, close it by clicking OK, and then click Next.
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5. The next screen is the Database Lookup Map Properties screen. Here, you can pick a table from the database that
you’ve connected to.

1.57. Database Lookup
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In this case, we will select the table named CountryCodeLookup. This table contains the code for each country and
will serve as the lookup table in our use case.
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In the text box provided under the Pick Table option, you can enter a where clause to modify the lookup query. In this
case, we will leave it empty.
Once you’ve chosen a table, click Next.
6. On the next screen, you can choose a Lookup Cache Type from the following options:
No Caching: No data will be stored in a cache. This option is selected by default.

1.57. Database Lookup

559

Centerprise, Release 8

Static: The lookup values are stored in a cache. Once the cache is created, the transformation object will always query
the cache instead of the lookup table. When you select this option, the following sub-options are enabled:
• Fill Cache With All Lookup Values at Start: Fills the cache with all of the lookup values at the start and continues
to use this cache for every lookup.
• Cache After First Use: Uses the database table for the first lookup and fills the cache right after it is done. This
cache is then used for every subsequent lookup. Checking this option enables another sub-option:
– Cache Commit Count: Defines the number of records collected per cache chunk before they are committed
to the cache.
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Dynamic: The lookup values are stored in a temporary cache file, which is deleted once the dataflow has been executed.
When you select this option, the following sub-options are enabled:
• Fill Cache With All Lookup Values at Start: Fills the cache with all of the lookup values at the start and continues
to use this cache for every lookup.
• Cache After First Use: Uses the database table for the first lookup and fills the cache right after it is done. This
cache is then used for every subsequent lookup. Checking this option enables another sub-options:
– Cache Commit Count: Defines the number of records collected per cache chunk before they are committed
to the cache.
– Cache Key Column: Defines a matching key field to check whether a record already exists in the cache.
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Persistent: Saves the lookup values in a cache file that can be reused for future lookups. When you choose this option,
the following sub-options are enabled:
• Rebuild Persistent Cache on Next Run: Checking this option will allow the contents of the cache file to be
modified after every run.
• Cache File Name: Here, you can enter a name for your cache file.
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In this case, we will select the No Caching option. Once you’re done, click Next.
7. On the Lookup Options screen, you can choose between multiple lookup options.
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This page provides a set of options for different scenarios that could be faced during a lookup.
If Multiple Values Are Found
Multiple Matches Found Option**:** This option provides the flexibility to choose the output value if more than one
matches are found for a single value in the lookup table. You can select one out of the three options that appear in the
drop-down list:
• Return First: Returns the first matched value.
• Return Last: Returns the last value among all matched values.
• Return All: Returns all the matches values.
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If Value Is Not Found In the Lookup List
If no lookup values are found for a source value, you can choose from the following options to be appended with the
output:
• No Message: The output value will be the same as the input value and no message will appear with it.
• Add Error: An error message will appear with the output.
• Add Warning: A warning message will appear with the output.
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If Value Is Not Found in the Lookup List, Assign Value
If no lookup value is found for a source value, you can assign an output value of your choice.
• Assign Source Value: Returns the source value in the output.
• Assign Null: Returns null in the output.
• This Value: Allows you to enter any value that will be returned in the output.
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In this case, there is only one code for each country. Therefore, we will choose Return First from the drop-down list
in the Multiple Matches Found Option. Moreover, we will leave the other options at their default selection i.e. No
Message under If Value Is Not Found in the Lookup List, and Assign Null under If Value Is Not Found, Assign Value.
Once you’re done choosing the option, click Next.
8. On the Config Parameters screen, you can define certain parameters for the Database Lookup object.
These parameters facilitate an easier deployment of flows by excluding hardcoded values and providing a more convenient method of configuration. If left blank, they will assume the default values that were initially assigned to
them.
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In this case, we will leave them blank. Click Next.
9. On the last screen, which is the General Options screen, you will be provided with a text box to add comments. The
general options on this screen have been disabled.
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You are now done configuring the Database Lookup object. Click OK to close the configuration window.
10. Expand the Database Lookup object to view the layout of the lookup table. In this case, it contains two field,
Country and Code. The former contains the full name of each country and the latter contains each country’s code.
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11.Map the Country field from the Database Table Source object to its counterpart in the Database Lookup object.

12. Drag an Excel Workbook Destination object from Toolbox > Destinations > Excel Workbook Destination and drop
it onto the designer. Configure the object by providing a name and the path to the directory and folder where you want
to save your destination file.
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To learn how you can configure an Excel Workbook Destination object, click here.
13. Auto-map the source dataset to the destination object.

14. Delete the mapping link between the Country fields in the source and destination. To do that, right-click on the
mapping link and select Delete from the context menu.

1.57. Database Lookup

571

Centerprise, Release 8

15. Map the Code field from the Database Lookup object to the Country field in the destination object. This is what
the final dataflow should look like:

16. Right-click on the destination object’s header and select Preview Output from the context menu.
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In the Data Preview window, you’ll see that each county name has been replaced by its corresponding code.

This concludes using the Database Lookup object in Astera Centerprise.

1.58 Setting Up Destinations
Each destination on the dataflow is represented as a destination object. You can have any number of destinations of
the dataflow. Each destination can only receive data from a single source. To feed multiple sources into a destination
you need to connect them through a transformation object, for example Merge or Union. For more information on
Transformations, see the Creating Transformations article.
The following destination types are supported by the dataflow engine:
Flat File Destinations:
• Delimited File
• Excel File
• Fixed Length File
1.58. Setting Up Destinations
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Tree File Destinations:
• XML File
Database Destinations:
• Database Table
• SQL Statement
All destinations can be added to the dataflow by grabbing a destination type on the Flow toolbox and dropping it on the
dataflow. File destinations can also be added by dragging-and-dropping a file from an Explorer window while pressing
the ‘Shift’ key. Database destinations can be dragged-and-dropped from the Data Source Browser while holding down
the ‘Shift’ Key. For more details on adding destinations, see Introducing Dataflows article.

1.58.1 Flat File Destinations
Delimited File
Adding a delimited file destination object allows you to write to a delimited file. An example of what a delimited file
destination object looks like is shown below.

To configure the properties of a Delimited File Destination object after it was added to the dataflow, right-click on it
and select Properties from the context menu.
Fixed-Length File
Adding a fixed-length file destination object allows you to write to a fixed-length file. An example of what a fixedlength file destination object looks like is shown below.

To configure the properties of a Fixed-Length Destination object after it was added to the dataflow, right-click on it
and select Properties from the context menu.
Excel File
Adding an Excel file destination object allows you to write to an Excel file. An example of what an Excel file
destination object looks like is shown below.
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To configure the properties of an Excel Destination object after it was added to the dataflow, right-click on it and select
Properties from the context menu.

1.58.2 Tree File Destinations
XML File
Adding an XML file destination object allows you to write to an XML file. An example of what an XML file destination
object looks like is shown below.

To configure the properties of an XML Destination Object after it was added to the dataflow, right-click on it and select
Properties from the context menu. The following properties are available:
General Properties screen:
File Path – specifies the location of the destination XML file. Using UNC paths is recommended if running the
dataflow on a server.
Note: To open an existing destination file for editing in a new tab, click XXX icon next to the File Path input, and
select Edit File.
File Options:
Using the Encoding dropdown, select the appropriate encoding scheme for your destination file.
Check “Format XML Output” checkbox to have line breaks inserted into the destination XML file for improved
readability.
Schema Options:
Read From Schema File – specifies the location of the XSD file controlling the layout of the XML destination file.
Note: You can generate the schema based on the content of the destination XML file if the file already exists. The data
types will be assigned based on the destination file’s content. Note that the existing destination file will be overwritten
when the dataflow runs.
To generate the schema, click the icon next to the Schema File input, and select Generate.
To edit an existing schema, click the icon next to the Schema File input, and select Edit File. The schema will open
for editing in a new tab.
Using the Root Element dropdown, select the node that should be the root of your destination schema. Any nodes up
the tree will be excluded.
Note: To ensure that your dataflow is runnable on a remote server, please avoid using local paths for the destination.
Using UNC paths is recommended.

1.58.3 Database Destinations
Database Table
Adding a database table destination object allows you to write to a database table. An example of what a database
table destination object looks like is shown below.
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To configure the properties of a Database Table Destination object after it was added to the dataflow, right-click on it
and select Properties from the context menu. The following properties are available:
Destination Connection screen – allows you to enter the connection information for your destination, such as server
name, database and schema, as well as credentials for connecting to the selected destination.
Pick Table screen:
Database Transaction Management: Enable Transaction Management if you want to wrap your transfer inside a transaction. Depending on your database settings, this can give you performance improvements during the transfer. When
Transaction Management is enabled, you should choose between always committing transaction at the end of the
transfer, or only committing it if there were no errors. Any errors would result in the entire transaction being rolled
back.
Preserve System Generated Key Values From Source. This option is only available if you assigned at least one field
in your destination layout as System Generated field. If enabled, Centerprise will pass the incoming value from the
source to the system generated field. Otherwise, the incoming source value will be ignored, and the system will write
auto-increasing values to the destination System Generated field.
Database Load Options: specify the type of insert of your records into a destination database. The available types are
Single Record Insert, Bulk Insert with Batch Size, and Bulk Insert with All Records in One Batch.
These types allow you to customize your transfer to balance performance vs. logging needs. Bulk inserts typically
result in a better performance (faster transfer for a given number of records), but they also come with less logging, and
less ability to undo unwanted inserts should you need to.
Single Record Insert: Records are inserted into a destination table one-by-one. Performance is the slowest among the
three insert types. However, any errors or warnings during the transfer are displayed to you immediately as the transfer
progresses.
Bulk Insert with All Records in One Batch – typically a fast method of transferring large amounts of data. But keep in
mind that, should there be any database specific errors in your transfer, they won’t show until the end of the transfer
at which time the entire batch were to be written to the destination database. Note: Not all database providers support
this type of insert.
Bulk Insert with Batch Size – a good tradeoff between performance and logging needs. Records are inserted in batches
of the specified size. Typically, larger batch sizes result in better transfer speeds; however performance gains may be
less with relatively large batch sizes. Note: Not all database providers support this type of insert.
Note: Bulk insert may not be available if there are certain data types in a destination table. In this case the transfer
will proceed as “single insert”.
SQL Statement
SQL Statement Destination object offers extra flexibility over database destination objects in applying a custom INSERT or UPDATE SQL code that controls what will be written into the destination table. An example of what an SQL
Statement destination object looks like is shown below.
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To configure the properties of an SQL Statement Destination object after it was added to the dataflow, right-click on it
and select Properties from the context menu. The following properties are available:
Database Connection screen – allows you to enter the connection information for your SQL Statement, such as server
name, database and schema, as well as credentials for connecting to the selected database.
SQL Query screen:
In the SQL Query screen, you can enter an SQL expression controlling which fields and records should be written to
the destination. The SQL expression should follow standard SQL syntax conventions for the chosen database provider.
For example,
Insert into Orders values (@OrderId, “@OrderName”, “@CreatedDtTm”)
Notice the @ symbol in front of a field name. This makes the field appear in the field list inside the object box so that
the field can be mapped. The fields not showing @ symbol in front of them will not show in the list of fields, but they
can still receive values according to the logic of the SQL statement itself.
For example,
Insert into Orders (OrderId, OrderName, CreatedDtTm) values (@OrderId, “@OrderName”, “2010/01/01”)
Note: You can optionally use $ parameters inside your SQL expression.

1.59 Database Table Destination
The Databse Table Destination object in Astera Centerprise provides the functionality to write data to a database table.
This destination option provides a great deal of control over how data is written to a database table with its extended
data loading options.
Astera Centerprise supports a wide range of on-premise and cloud-based databases including SQL Server, Oracle,
DB2, Sybase, MySQL, Salesforce, Microsoft Dynamics CRM, and more. Centerprise delivers highly-optimized implementations for these database connectors including high-performance bulk insert, set-based updates and transaction
management. This, combined with Centerprise’s parallel-processing architecture, delivers industrial-strength performance and scalability.

1.59.1 Configuring the Database Table Destination Object
• To add a Database Table Destination object to your dataflow, go to Toolbox > Destinations > Database Table
Destination. If you’re unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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• Drag and drop the Database Table Destination object onto the designer.

If you look at it, the database destination object is empty right now, as in, it does not have any fields or mappings.
This is because the object has not been configured yet. There are two empty sub-nodes for Input and Output under the
DatabaseDest root node.
Connecting to the Database
1. To configure the properties of the Database Table Destination object, right-click on the header and select Properties
from the context menu.
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This will open a new window in Centerprise. The first screen is the Database Connection screen.
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• First, you need to select the relevant data provider from the Data Provider drop-down list.
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That is where you select the specific database provider you want to connect to. For instance, if you want to write
you data to a SQL database, select SQL Server from the list. The connection details will vary according to the data
provider selected.
• Test Connection to make sure that your database connection is successful and click Next.
2. Now, you need to provide details to configure connection with the destination database.
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• Enter your user ID and password. You can also use the Recently Used drop-down list to connect to a recentlyconnected database.
Picking Table
The next screen is the Pick Table screen. Here, you can choose from the following options:
• Pick Table: To append data into an existing table.
• Create/Replace: To write data to a new table or replace an existing table.
• Truncate Table: To overwrite data in an existing table.
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• Choose the option based on your requirement. In this case we will select the Create/Replace Table option and
create a new table in the database.
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Note: We will be creating a new table CustomerDetails.
Mapping
For a database destination object to work, data fields should be mapped to the object so that the mapped data can be
written to the destination.
• Configure the source object and place it onto the designer next to the Database Table Destination object.
Note: In this case a Customers sample data, coming in from an Excel Workbook Source, will be written to a Database
Table Destination.
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• Map the source object to the destination object. Data mapping from source to the destination can be done in the
following ways:
i. By dragging and dropping the parent node from the source object onto the destination object.

ii. By mapping the output port of the source object onto the input port of the destination object.

iii. By right-clicking on the parent node inside the source object and selecting Write to > Database Table Destination
from the context menu.

• The fields are now mapped.
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Configuration
1. The Pick Table screen has some other configuration options.
• Define Input Ports for Mapping
– Single Port: Works only for the records that have been updated and won’t treat records individually.
– Individual Ports for Actions: Works for all the records individually as per the selected action. The actions
that are provided are: Insert, Delete, Update and Upsert.
• Database Options
– Use constraint based write: When the layout has certain restrictions that you want to keep while writing.
– Preserve system generated key values: To generate unique values for the selected primary key in the
dataset. This option is only available if you assign at least one field in your destination layout as the
System Generated field.
– Use transaction
* Always commit transaction on completion: When you want the whole transaction to be processed
regardless of errors.
* Rollback if there are any errors: When you don’t want the dataset to process in case of errors and roll
back completely.
– Check field lengths for the incoming dataset with the lengths defined in the destination layout.
– Check for null values from the incoming dataset.
– Write null string as zero length strings where the string values are null, their length will be defined as
zero.
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– Write null numeric values as zeros for the numeric data types, the null values will be defined as zeros.
– Disable indexes during load for lengthy processing.
• Data Load Options
– Bulk insert with batch size when you want the whole dataset to be loaded in batches for the specified size.
Typically, larger batch sizes result in better transfer speeds; however performance gains may be less with
relatively large batch sizes.
– Bulk insert with all records in one batch when you want all the records to be loaded into a table in one
batch. In this case, any database specific error in your transfer won’t show until the end of the transfer.
– Use single record insert when you want records to be loaded individually. Records are inserted into a
destination table one-by-one. This loading option renders the slowest performance among the three insert
types. However, any errors or warnings during the transfer are displayed immediately as the transfer
progresses.
• Parallel Writing is used when you want to expedite the data loading process by increasing the number of writers
for that dataset.
2. Once you have specified your options on this screen, click Next.
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3. The next screen will show a Layout Builder. Here, the layout of the database destination file can be modified.

• To add a new field to the layout, go to the last row of the layout (Name column), which will be blank and
double-click on it, and a blinking text cursor will appear. Type in the name of the field to be added, and select
the properties for it. A new field will be added to the destination table’s layout.

Note: In this example, we will add a new field AccountType to the layout.
• To delete a field from the layout, click on the serial column of the row that is to be deleted. The selected row
will be highlighted in blue.
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Note: Here, we are deleting the Fax field from the layout.
• Right-click on the highlighted line, a context menu will appear which will have the option to Delete.
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Selecting Delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
• To change the position of any field and move it below or above another field in the layout, select the row and
use Move up/Move down buttons.
Note: Find the Move up/Move down icons on the top left of the builder.
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For example: To move the Country field right below the Region field, select the row and click the Move up
button in the toolbar at the top, to move the field up from 9th to 8th position.
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4. Once the object layout is configured, click Next. This will take you to the -Config Parameters screen where you
can further configure and define parameters for the database destination file.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change during the runtime.
Note: Parameters left blank will use their default values assigned on the properties page.
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5. Click Next. A General Options screen will appear. Here you have the following options:
• Comments can be added.
• General Options are given, which relate to the processing of records in the destination file.
– Clear Incoming Record Messages for any messages coming in from objects preceding the current object
to be cleared.
– Do Not Process Records With Errors will not let erroneous records to process further for the output.
– Do Not Overwrite Default Values with Nulls makes sure that values are not overwritten with null values in
the output.
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6. Click OK.
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The DatabaseDest object is now configured according to the settings made in the properties window.
Note: The changes that were made in this case are:
• Added a new field AccountType in the layout and mapped it’s value from the ***Constant Value Transformation***.
• Moved the Country field below the field Region field.

The Database Table Destination object is now successfully configured, and the destination file can now be created by
running the dataflow.
• The job can be traced through the Job Progress window once the job starts running.

This is how we use the Database Table Destination.

1.60 Delimited File Destination
Centerprise Delimited File Destination provides the functionality to write data to a delimited file. Delimited File
Destination gives you the ability to control the structure and content of file including numeric, date, and Boolean
formats, encodings, text qualifiers (quotes), and character sets. You can choose to create a new file or append data to
an existing file.
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1.60.1 Configuring Delimited File Destination Object
• To get a Delimited File Destination object from the Toolbox, go to Toolbox > Destinations > Delimited File
Destination. If you’re unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.

• Drag-and-drop the Delimited File Destination object onto the designer.

The dragged destination object is empty right now. This is because the object has not been configured yet.
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Mapping
For a delimited destination object to work, data fields should be mapped to the object so that the mapped data can be
written to the destination.
• Configure the source object and place it onto the designer next to the Delimited File Destination object.
Note: In this case a Customers sample table has been used from a Database Source to write to the Delimited
File Destination.

• Now map the source object to the destination object. The following ways can be used for mapping:
i. By dragging and dropping the parent nodes onto each other for automatic mapping.
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ii. By mapping the source parent node by dragging it to the destination parent node manually.

iii. By directly writing the source layout to a Delimited Destination through the source context menu of its parent
node.
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• The fields are now mapped.
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Configuration
1. To configure the Delimited File Destination object, right-click on the header, select Properties from the context
menu and a dialog box will open.

Select the Properties option from the context menu and a dialog box will open.
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2. Provide the File Path. This is where the delimited destination file will be saved.
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3. The dialog box has some other configuration options. Let’s go over these options:
• Options:
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– If the source File Contains Header, check the box to read headers from the source file.
– Field Delimiter box - Allows to select a delimiter from the drop-down list for the fields.
– Record Delimiter box - Allows to select the delimiter for the records in the fields. The choices available
are carriage-return and line-feed combination, carriage-return and line-feed. You can also type the record
delimiter of your choice instead of choosing the available options.
– Encoding box - Allows to choose the encoding scheme for the delimited file from a list of choices. The
default value is Unicode (UTF-8)
– A Text Qualifier is a symbol that identifies where text begins and ends. It is used specifically when
importing data.
– Apply Text Qualifier to all Fields will add the specified qualifier to all the fields that have been mapped
Say you need to import a text file that is comma delimited (commas separate the different fields that will
be placed in adjacent cells).
– Use Null Text to specify a certain value that you don’t want in your data and want it to be replaced by a
null value.
– Choose Append to File (If Exists) to append to an existing file or create a new file. Creating a new file
will overwrite any existing file data.
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– Check on Hierarchical Destination when the data in the source file needs to be sorted into hierarchies in
the destination file.
– Check on Write to Multiple Files for the data to be saved to multiple files instead of one single file. This
can be done within a single dataflow through the destination object and supporting transformations.
4. Once the data reading options have been specified on this screen, click Next.

The next screen will show a Layout Builder. On this screen, the layout of the delimited destination file can be modified.
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• To add a new field to the layout, go to the last row of the layout (Name column), which will be blank and
double-click on it, and a blinking text cursor will appear. Type in the name of the field to be added and select
the subsequent properties for it. A new field will be added to the source layout.
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Note: Adding a new field (Email) to the layout.
• To delete a field from the layout, click on the serial column of the row that is to be deleted. The selected row
will be highlighted in blue.
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Note: Deleting the Fax field from the layout.
• Right-click on the highlighted line, a context menu will appear in which will have the option to Delete.
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Selecting delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
• To change the position of any field and move it below or above another field in the layout, select the row and
use Move up/Move down keys.
Note: Find the Move up/Move down icons on the top left of the builder.
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For example: To move the Country field right below the Region field, select the row and use the Move up key
from the 9th row to the 8th row.
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5. Once the object layout is configured, click Next. A new screen will appear -Config Parameters, which allows to
further configure and define parameters for the delimited destination file.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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6. Next a General Options screen will appear. On this screen:
• Comments can be added.
• General Options are given, which relate to processing of records in the destination file.
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7. Click OK.
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The DelimitedDest object is now configured according to the changes that were made in the properties window.
Note: The changes that were made in this case are:
• Added a new field -Email in the layout.
• Moved the Country field below the field Region field.
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The Delimited File Destination object is successfully configured and the destination file can now be created by running
the dataflow.

1.61 Excel Workbook Destination
Excel Workbook Destination object in Centerprise provides the functionality to write data to Microsoft Excel workbooks. An important thing to note here is that, it is not necessary to have Microsoft Excel installed on the machine for
the excel destination object in Centerprise to work. The feature gives you the option to specify the worksheet and the
starting cell where the data write begins.

1.61.1 Configuring the Excel Workbook Destination Object
• To get the object from the Toolbox, go to Toolbox > Destinations > Excel Workbook Destination. If you’re
unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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• Drag-and-drop the Excel Workbook Destination object onto the designer.

The dragged destination object is empty right now. This is because the data fields are not mapped to it yet. In this
case, we’ll use a simple source to excel destination mapping scenario as an example.
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Mapping
• Configure the source object and place it onto the designer next to the Excel Workbook Destination object.
Note: We are using a sample table containing customers data from an SQL database.

• Now map the data fields from the source object to the destination object. Mapping can be done in the following
ways:
i. By dragging and dropping the parent node of the source object onto the parent node of the destination object
for auto-mapping the layout.
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ii. By creating a map from the source parent node to the destination parent node.

iii. By directly writing the fields in the source layout to an Excel Destination through the source context menu of its
parent node.

• The fields are now mapped.
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Configuration
1. To configure the Excel Workbook Destination object, right-click on the header, select Properties from the context
menu and a dialog box will open.
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2. Provide the File Path. This is where the excel destination file will be saved.
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3. The dialog box has some other configuration options. Let’s go over these options:
• Options:
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– If the First Row Contains Header, check the box to read headers from the source file.
– The Worksheet block can be used to specify the name of a worksheet for either overwriting the data in an
already existing worksheet or adding a new worksheet.
– Choose Append to File (If Exists) to append to an existing file or create a new file. Creating a new file
will overwrite any existing file.
– Check on Write to Multiple Files for the data to be saved to multiple files instead of one single file. This
can be done within a single dataflow through the destination object and supporting transformations.
4. Once the data reading options have been specified on this screen, click Next.
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The next screen will show a Layout Builder. On this screen, the layout of the excel destination file can be modified.
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• To add a new field to the layout, go to the last row of the layout (Name column), which will be blank and
double-click on it, and a blinking text cursor will appear. Type in the name of the field to be added and select
the subsequent properties for it. A new field will be added to the source layout.
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Note: Adding a new field (Email) to the layout.
• To delete a field from the layout, click on the serial column of the row that is to be deleted. The selected row
will be highlighted in blue.

1.61. Excel Workbook Destination

629

Centerprise, Release 8

Note: Deleting the Fax field from the layout.
• Right-click on the highlighted line, a context menu will appear which will have the option to Delete.
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Selecting delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
• To change the position of any field and move it below or above another field in the layout, select the row and
use Move up/Move down keys.
Note: Find the Move up/Move down icons on the top left of the builder.
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For example: To move the Country field right below the Region field, select the row and use the Move up key
to from the 9th row to the 8th row.
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The row is now moved from the 9th position to the 8th position.
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5. Once the object layout is configured, click Next. A new screen will appear -Config Parameters, which allows to
further configure and define parameters for the excel destinaion file.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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6. A General Options screen will appear. On this screen:
• Comments can be added.
• General Options are given, which relate to processing of records in the destination file.
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7. Click OK.
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The ExcelDest object is now configured according to the changes that were made in the properties window.
Note: The changes that were made in this case are:
• Added a new field - Email in the layout.
• Moved the Country field below the Region field.
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The Excel Workbook Destination object is successfully configured and the destination file can now be created by
running the dataflow.

1.62 Fixed Length File Destination
Centerprise Fixed Length File Destination provides the functionality to write data to a Fixed Length File.

1.62.1 Configuring the Fixed Length File Destination Object
• To get a Fixed Length File Destination object from the Toolbox, go to Toolbox > Destinations > Fixed Length
File Destination. If you’re unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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• Drag-and-drop the Fixed Length File Destination object onto the designer.

The dragged destination object is empty right now. This is because the object has not been configured yet.
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Mapping
For the Fixed Length File Destination object to work, it needs to be provided with a data source.
• Configure the source object and place it onto the designer next to the Fixed Length File Destination object.
Note: In this case we’ll be using a Customers sample table from the Database Source to write to the Fixed
Length File Destination.

• Now map the source object to the destination object. The following ways can be used for mapping:
i. By dragging and dropping the parent nodes onto each other for automatic mapping.
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ii. By mapping the source parent node by dragging it to the destination parent node manually.

iii. By directly writing the source layout to a Fixed Length File Destination through the source context menu of its
parent node.

• The fields are now mapped.
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Configuration
1. To configure the Fixed Length File Destination object, right-click on the header, select Properties from the context
menu.
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Select the Properties option from the context menu and a dialog box will open.
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2. Provide the File Path. This is where the fixed length destination file will be saved.
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3. The dialog box has some other configuration options. Let’s go over these options:
• Options:
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– If the First Row Contains Header, check the box to read headers from the source file.
– Record Delimiter box - Allows to select the delimiter for the records in the fields. The choices available
are carriage-return line-feed combination, carriage-return and line-feed. The record delimiter can also be
of choice, instead of choosing from the available options.
– In case the records don’t have a delimiter, the Record Length box is used to specify the character length
for a single record.
– Encoding box - Allows to choose the encoding scheme for the delimited file from a list of choices. The
default value is Unicode (UTF-8)
– Choose Append to File (If Exists) to append to an existing file or create a new file. Creating a new file
will overwrite any existing file.
– Check on Write to Multiple Files for the data to be saved to multiple files instead of one single file. This
can be done within a single dataflow through the destination object and supporting transformations.
– To define hierarchical file layout and process the data file as a hierarchical file check the This is a Hierarchical File box. Centerprise IDE provides extensive user interface capabilities for processing hierarchical
structures.
4. Once the data reading options have been specified on this screen, click Next.
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The next screen will show a Layout Builder. On this screen, the layout of the fixed length destination file can be
modified.
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• To add a new field to the layout, go to the last row of the layout (Name column), which will be blank and
double-click on it, and a blinking text cursor will appear. Type in the name of the field to be added and select
the subsequent properties for it. A new field will be added to the source layout.
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Note: Adding a new field (Email) to the layout.
• To delete a field from the layout, click on the serial column of the row that is to be deleted. The selected row
will be highlighted in blue.
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Note: Deleting the Fax field from the layout.
• Right-click on the highlighted line, a context menu will appear which will have the option to Delete.
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Selecting delete will delete the entire row.
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The field is now deleted from the layout and won’t appear in the output.
• To change the position of any field and move it below or above another field in the layout, select the row and
use Move up/Move down keys.
Note: Find the Move up/Move down icons on the top left of the builder.
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For example: To move the Country field right below the Region field, select the row and use the Move up key
to from the 9th row to the 8th row.
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The row is now moved from the 9th position to the 8th position.
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5. Once the object layout is configured, click Next. A new screen will appear -Config Parameters, which allows to
further configure and define parameters for the fixed length destination file.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way of
changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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6. A General Options screen will appear. On this screen:
• Comments can be added.
• General Options are given, which relate to processing of records in the destination file.
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7. Click OK.
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The FixedDest object is now configured according to the changes that were made in the properties window.
Note: The changes that were made in this case are:
• Added a new field -Email in the layout.
• Moved the Country field below the Region field.
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The Fixed Length File Destination object is successfully configured and the destination file can now be created by
running the dataflow.

1.63 SQL Statement Destination
The SQL Statement Destination in Astera Centerprise offers extra flexibility over other destination objects by providing
the option to apply a custom INSERT, UPDATE, or DELETE SQL statements to control what will be written to the
destination table. The object can also be used to call stored procedures. Moreover, you can parameterize your SQL
statement using the Parameterize Replacement functionality.
In this article, we’ll be looking at how you can configure and use the SQL Statement Destination object in Astera
Centerprise.

1.63.1 Configuring the SQL Statement Destination
1. Before moving on to the actual configuration, we’ll have to get an SQL Statement Destination object from the
Toolbox. To do so, go to Toolbox > Sources > SQL Statement Destination. In case you’re unable to view the toolbox,
go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag and drop the SQL Statement Destination object onto the designer.
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The destination object is currently empty because we are yet to map any data fields to it.
3. To configure the SQL Statement Destination object, right-click on its header and select Properties from the context
menu. Alternatively, you can double-click header of the destination object to go to its Properties.
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A new window will open when you click on Properties from the context menu.

Here, you need to configure the properties for the SQL Statement Destination object.
4. On the Database Connection screen, enter the details for the database you wish to connect to.
• Use the Data Provider drop-down list to specify which database provider you wish to connect to. The required
credentials will vary according to your chosen provider.
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• Provide the required credentials. Alternatively, use the Recently Used drop-down list to connect to a recently
connected database.
• Test Connection to ensure that you have successfully connected to the database. A separate window will appear,
showing whether your test is successful. Close it by clicking OK, and then click Next.
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5. The next screen will present a blank page for you to enter an appropriate SQL statement for the required outcome. This can consist of an INSERT, UPDATE, or DELETE statement that manipulates the data being written to the
database.
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The curly brackets on the right side of the screen indicate that the use of parameters is supported, which implies that
you can replace a regular value with a parameterized value that can be changed during runtime.

In this use-case, we will be inserting new records into an existing table, named TESTTABLE, that has three columns:
OrderID, CustomerID, and EmployeeID.
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Notice the @ symbol in front of a field name. This makes the field appear in the field list inside the object box so that
the field can be mapped. The fields that do not have a @ symbol in front of them will not show in the list of fields, but
they can still receive values according to the logic of the SQL statement itself. String fields need to be surrounded by
single quotes, whereas Integer fields do not. In this case, CustomerID is a String field, while OrderID and EmployeeID
are Integer fields.
The Database Options given at the bottom of the screen provide support for transaction management. Checking the
Use Transaction option will enable two other sub-options:
• Always commit transaction on completion: Ensures that the job is completed regardless of any erroneous records.
• Rollback if there are any errors: Aborts the job in case of one or more erroneous records.
Once you’ve entered an SQL statement and chosen your desired option, click Next.
6. On the new Config Parameters screen, you can define certain parameters for the SQL Statement Destination object.
These parameters facilitate an easier deployment of flows by excluding hardcoded values and providing a more convenient method of configuration. If left blank, they will assume the default values that were initially assigned to
them.
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7. At the end, a General Options screen will appear. Here, you are provided with:
• A text box to add Comments.
• A set of general options related to the processing of records.
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To conclude the configuration, click OK.
For a destination object to work, data fields must be mapped to it from a source. In this case, we will be using an SQL
Query Source object to get data from the Orders table in the Northwind database.
8. Configure the source object and place it next to the SQL Statement Destination object.
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9. Map the required data fields from the source object to the destination object. This can be done in the following
ways:
• By dragging and dropping the parent node of the source object onto that of the destination object.
• By individually dragging and dropping the required fields from the source object onto their respective nodes in
the destination object.

10. To preview the output, right-click on the destination object’s header and select Preview Output from the context
menu. In this case, you will see the following result:
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You can now write data to the destination table by running the dataflow.
This is how we use the SQL Statement Destination object in Astera Centerprise.
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1.64 XML File Destination
Centerprise XML/JSON File Destination object provides the functionality to write data to an XML or JSON file when
the data is in hierarchical format.

1.64.1 Use Case
In order to understand how to write to the XML/JSON File Destination object, we will take help of a use-case where
we will convert flat datasets to an hierarchical set, and then write the transformed data to an XML file.
Customers and Orders data from database tables will be used as the source objects. We will then join them using the
TreeJoin Transformation to create a hierarchical dataset.
Learn more about how the Treejoin Transformation works in Centerprise.
![](xml-file-destination.assets/Use Case.png)

1.64.2 Configuring the XML/JSON File Destination Object
• To get an XML/JSON File Destination object from the Toolbox, go to Toolbox > Destinations > XML/JSON
File Destination and drag-and-drop it onto the designer. If you’re unable to see the toolbox, go to View >
Toolbox or press Ctrl + Alt + X.
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The dragged destination object is empty right now. This is because the object has not been configured yet.
Note: In this case we’ll be using the use case discussed earlier, taking the Treejoin as the source for data to write to
the XML/JSON File Destination.

1.64. XML File Destination
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Creating a Schema File
A schema file is needed to write data to an XML/JSON destination. To create the schema file, right click on the source
object (Treejoin transformation in this case), a context-menu will appear, select the option Generate XML Schema for
layout.

• A new dialog box will open where you will be asked to save the XML schema file. Give the File Name and file
path for the schema file and click Save.
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• The schema file has been created on the location that was specified. To view the file, go to the file location and
open the file in Centerprise.
– The opened file would look like the one below:

1.64. XML File Destination
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File Path
• To configure the XML/JSON File Destination object, right-click on the header and select Properties from the
context-menu.
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• A dialog box will open - Destination XML File screen. Specify the file locations; File Path and Schema File for
the XmlJsonDest object.

1.64. XML File Destination
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• The destination file will now be saved to the file location provided. Click OK, to map the destination object to
the source object before further configuration.
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• The XmlJsonDest object will now have the layout of the source object (Treejoin Transformation in this case).

1.64. XML File Destination
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Mapping
• To map the source object to the destination object, the following ways can be used for mapping:
– By dragging and dropping the parent node of the source object (TreeJoin node in the TreeJoin table) onto
the child node of the destination object (TreeJoin node in the XmlJsonDest object) for automatic mapping.
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– By manually mapping the source parent node (TreeJoin in the TreeJoin table) by dragging it to the respective destination child node (TreeJoin in the XmlJsonDest object).

1.64. XML File Destination
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• The fields are now mapped.
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Properties
Once the file locations have been specified and the mappings have been done, further properties can be defined.
XML Layout
• The next screen after the Destination XML File Screen is the XML Layout screen.

1.64. XML File Destination
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• The screen shows the XML layout for the XmlJsonDest object. The collection nodes for the object can be seen
on this screen with their fields.
Config Parameters
• Click Next a new screen -Config Parameters will open, which allows to further configure and define parameters
for the XML/JSON Destination.
Parameters can provide easier deployment of flows by eliminating hardcoded values and provide an easier way
of changing multiple configurations with a simple value change.
Note: Parameters left blank will use their default values assigned on the properties page.
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General Options
• Click Next a new screen -General Options will open. On this screen:
– Comments can be added.
– General Options are given, which relate to processing of records in the destination file.

1.64. XML File Destination
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• Click OK.
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The XmlJsonDest object has been successfully configured and the destination file can now be created by running the
dataflow.

1.65 Creating Data Profile
The Data Profile feature provides a complete data field statistic – basic and detailed – containing information such
as the data type, minimum/maximum values, data count, error count etc. The statistics are collected for each of the
selected fields at the time the dataflow runs.
In this document, we will learn how to create Data Profile in Astera Centerprise.

1.65.1 Using Data Profile
In this case, we have Customers data coming in from a Database Table Source.

1.65. Creating Data Profile
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We want to collect statistics on these fields of data. For this purpose, we will use Data Profile feature of Centerprise.
1. To get a Data Profile object from the Toolbox, go to Toolbox > Data Profiling > Data Profile. If you’re unable to
see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag-and-drop the Data Profile object onto the dataflow designer.

1.65. Creating Data Profile
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You can see that the dragged Profile object is empty right now. This is because we haven’t mapped any fields on it yet.
3. Auto-map the fields from the source object onto the profile object.

Note: A Data Profile object is designed to capture statistics for an entire field layout. For this reason, it
should be linked to the main Output port of the object whose field statistics you wish to collect.
Configuring the Data Profile Object
1. To configure the Data Profile object, right-click on its header and select Properties from the context menu.
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A configuration window will open. First screen is Layout Builder screen. This is where we can create or delete fields,
change its name and data type.

1.65. Creating Data Profile
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2. Click Next. This is the Properties window.
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3. Provide the File Path where Centerprise will store the profile.

1.65. Creating Data Profile
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4. Specify the type of Field Statistics to be collected.
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Field Statistics dropdown allows you to select detail levels of statistic to collect. Select among the following detail
levels:
• Basic Statistics: This is the default mode. It captures the most common statistical measures for the field’s data
type.
• No Statistics: No statistics is captured by the Data Profile.
• Detailed Statistics – Case Sensitive Comparison: Additional statistical measures are captured by the Data
Profile, for example Mean, Mode, Median etc, using case-sensitive comparison for strings.
• Detailed Statistics – Case Insensitive Comparison: Additional statistics are captured by the Data Profile, using
case insensitive comparison for strings.
In this case, we are collecting a Detailed Statistics – Case Sensitive Comparison

1.65. Creating Data Profile
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Click OK.
Executing the Task
1. After configuring the settings for Data Profile object, click on Start Dataflow icon ![11_ icon](creating-dataprofiles.assets/11_ icon.PNG) from the toolbar at the top.
A Job Progress window will open at this instant and will show you the trace of the job.
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2. Click on the Profile link provided in the Job Progress window and the profile will open in Centerprise. Expand the
Profile node to see each field inside the object. Click on these fields to see the collected statistical values.

1.66 Creating Field Profile
The Field Profile feature captures statistics for selected fields from one or several objects. Field Profile is essentially a
transformation object as it provides Input and Output ports similar to other transformations. These output ports make
it possible to feed the statistics collected to another object on the dataflow.
In this document, we will learn how to create Field Profile in Astera Centerprise.

1.66. Creating Field Profile
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1.66.1 Using Field Profile
In this case, we have Invoice data extracted from a sample Database Table Source.

We want to collect detailed statistic on some of these fields of data and write it to a Delimited File Destination. For
this purpose, we will use Field Profile feature of Centerprise.
1. To get a Field Profile object from the Toolbox, go to Toolbox > Data Profiling > Field Profile. If you’re unable to
see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.
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2. Drag-and-drop the Field Profile object onto the dataflow designer.

1.66. Creating Field Profile
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You can see that the dragged Field Profile object contains an Input node and an Output node. Input node is empty
because we haven’t mapped any fields on it yet.
3. One-by-one map ShipName, CustomerID, Country, OrderDate, ProductName, UnitPrice, and Quantity and from
the source object onto the Field Profile object’s Input node.
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Note: Statistics will be collected only for the fields linked to the Input port of the Field Profile object.
This way, you can selectively collect statistics for a subset of fields from the selected field layout.
Configuring the Field Profile Object
1. To configure the Field Profile object, right-click on its header and select Properties from the context menu.

1.66. Creating Field Profile
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A configuration window will open. First screen is Layout Builder screen. This is where we can create or delete fields,
change its name and data type.
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2. Click Next. On this Properties window, specify the Statistics Type from the dropdown list.

1.66. Creating Field Profile
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Field Statistics dropdown allows you to select detail levels of statistic to collect. Select among the following detail
levels:
• Basic Statistics: This is the default mode. It captures the most common statistical measures for the field’s data
type.
• No Statistics: No statistics is captured by the Data Profile.
• Detailed Statistics – Case Sensitive Comparison: Additional statistical measures are captured by the Data
Profile, for example Mean, Mode, Median etc, using case-sensitive comparison for strings.
• Detailed Statistics – Case Insensitive Comparison: Additional statistics are captured by the Data Profile, using
case insensitive comparison for strings.
In this case, we are collecting a Detailed Statistics – Case Sensitive Comparison.

Click OK.
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3. Right-click on Field Profile object’s header and select Preview Output from the context menu.

A Data Preview window will open up showing you the statistics of each mapped field as a record.

Writing to a Destination
Observe that the Field Profile object contains an Output node. On expanding, you will see various statistical measures
as fields with output nodes.

1.66. Creating Field Profile
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We can write these statistical measures to a destination file.
1. Right-click on the Output node and go to Write to > Delimited File Destination.
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An Delimited File Destination object will be added to the dataflow designer with auto-mapped fields from the Output
node.

1.66. Creating Field Profile
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3. Configure settings for Delimited File Destination from here.
Executing the Task
1. After configuring the settings for Delimited File Destination object, click on Start Dataflow icon ![11_
icon](creating-field-profiles.assets/11_ icon.PNG)from the toolbar at the top.
A Job Progress window will open at this instant and will show you the trace of the job.

You can open the delimited file that contains field statistic from the link provided in Job Progress window.
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1.67 Data Quality Mode
In addition to the standard logging functionality, Centerprise provides a special Data Quality Mode, which is useful
for advanced profiling and debugging. When a dataflow is created/opened in data quality mode, most objects on the
dataflow show the Messages node with output ports.
In this document, we will learn how to use Data Quality Mode in Astera Centerprise.

1.67.1 Sample Use-Case
In this case, we have a simple dataflow designed to perform a data quality check. It contains customers data coming
in from an Excel Workbook Source. A Data Quality Rule object is added to validate data for null values and perform
warning checks.

If you preview the output for Customers data at this stage, you will see that some of the records have missing Region
and Fax values.

1.67. Data Quality Mode
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Data quality rules are set so that the records with empty Region field are marked as errors and the records with empty
Fax field are marked as warnings. A red exclamation sign in the data preview identifies the records that have failed to
match the rule and returned an error or a warning as a result.

Now for instance, we want to collect information regarding the number of errors/warnings in a single record, and the
error/warning messages attached to the records, and write this information to a destination. For this purpose, we will
use Data Quality Mode.
Note: The Record Level Log feature also collects and records this information but we can not further
process it in the dataflow.
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Activating Data Quality Mode

1. To activate the data quality mode, click the Data Quality Mode
designer.

icon placed at the top of the dataflow

Once Data Quality Mode is activated, a Messages node will be added to all the objects in the dataflow.

1.67. Data Quality Mode

713

Centerprise, Release 8

The Messages node captures following statistical information:
• TotalCount
• ErrorCount
• WarningCount
• InfoCount
• MessagesText
• DbAction
• Custom
In addition to that, FirstItem, LastItem, and Items sub-nodes provide a way to collect quality control data for each
of the records. The quality control data includes ElementName, MessageType, or Action etc. and can be written to a
destination object for record-keeping purposes.
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Writing to a Destination
Connecting the Messages node’s output ports to another object’s input ports on the dataflow makes it possible to get
both - summary statistics and record-level statistics for the dataset, which is useful for analysis and debugging. To do
that:
1. Right-click on the Messages node inside the NoNullValues_Rule object and go to Write to > Delimited File Destination.

A Delimited Destination object is added to the designer with mapped fields.

1.67. Data Quality Mode

715

Centerprise, Release 8

2. Configure settings for Delimited File Destination to save this data.
3. Right-click on the header of destination object and select Preview Output from the context menu.
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A Data Preview window will open, showing error and warning information.

1.67. Data Quality Mode
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1.68 Using Data Quality Rules in Astera Centerprise
Data Quality Rules found in the Data Profiling section of the toolbox is used to apply one or more conditions, called
data quality rules, against incoming records. Records that do not meet the data quality rule criteria will be assigned
the ‘Error’ status and may be optionally excluded from processing by the downstream objects.
Data Quality Rules is a record-level component which means that it does not require the entire dataset to flow through
it. In other words, you can map a single or a couple of fields to the Data Quality Rules component to set up quality
validation criteria and the transformed records can be mapped further in the dataflow.

1.68.1 Steps to Use the Data Quality Rules in a Dataflow
Let’s understand the application and usage of Data Quality Rules with this example.
Here we have sample data of employees of a fictitious organization which we have retrieved using an Excel file source.
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If we look at the preview of Employee_Report data, the values in the SalariedFlag column specify whether an employee
is salaried in terms of 0 and 1.
1 = the employee is salaried
0 = the employee is non-salaried and therefore is eligible for overtime.

1.68. Using Data Quality Rules in Astera Centerprise
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We can apply data quality rules to these values and identify which employees are not salaried and therefore, are eligible
for overtime. The Data Quality Rules object will process all records and those that doesn’t match the criteria will be
returned with an error. Which means that in this example, the Salaried employees with the salary flag ‘True’ will
return an error whereas the records of employees with salary flag ‘False’ will pass the data quality rule.
For this, drag the Data Quality Rules object from the Data Profiling section in the toolbox and drop it onto the dataflow
designer.

Now map the SalariedFlag field to the Data Quality Rules object.

Right-click on the Data Quality Rules object and select Properties from the context menu.
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This will open a new window. The first screen is the layout builder screen where you can see the ‘SalariedFlag’ field
we have mapped from our source.

1.68. Using Data Quality Rules in Astera Centerprise
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Click ‘Next’ to proceed to the Data Quality Rules screen.
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Here, we’ll set up the rules or data quality criteria. Click this

button to add a new rule.

Once a new rule is added, the options on this window will activate and the rule will be added to the grid.

1.68. Using Data Quality Rules in Astera Centerprise
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Let’s explore these options one by one:
Description: The description field contains the name or description of the rule. By default, the rules are termed as
Rule1, Rule2 and so on, depending on the number of rules you add. But you can also rename the rules for better
understanding and convenience.
As in this case, we want to set up data quality criteria to identify non-salaried employees, so we can rename the rule
as “NonSalariedEmployeesRule.”

724

Chapter 1. Other Versions

Centerprise, Release 8

Attach rule to the field: This is a drop-down list from which you can attach a rule to a particular field. You can see
that there’s a root node named ‘Data Quality Rules.’
Listed within the Data Quality node are the fields mapped to the Data Quality Rules object. Here we have only one
field mapped on which we want to apply this rule. In case you want to apply a rule to the whole dataset, you can
simply double-click on the Data Quality Rules root node and the rule will be applied to all fields mapped to the Data
Quality Rules object.
In this case, we’ll map the rule to the SalariedFlag field.

1.68. Using Data Quality Rules in Astera Centerprise
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Expression box: This is where you can type in the expression for your rule.
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Or you can click this
button to enter the expression builder where you can choose an expression from Centerprise’s library of built-in expressions or write one of your own.

1.68. Using Data Quality Rules in Astera Centerprise
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In this example, we want to validate records with the Salary Flag ‘False.’ So, we’ll write the expression:
SalariedFlag = 0 in the expression field.
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Observe that, simultaneously, Centerprise shows you a compile status of your expression below the expression box.
It says Successful so we can click OK. Alternatively, it will give you an error if the expression is incorrect and you’ll
have to correct the expression before clicking OK.
Show Message: We can also write a message to show up with the errors, which can also be written to the error log.
Let’s write a message:
Salaried employees are not eligible for overtime.
This message will help identify why a particular record was marked erroneous. And in case multiple rules are applied,
the message will point out which rule was not qualified by a particular record.

1.68. Using Data Quality Rules in Astera Centerprise
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Next, we have two checkboxes:
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• Active – to activate a rule.
• Is Error – when this is checked, all records that return an error will not be written to a target. Which means that
only the records that have passed the data quality rule will flow further in the dataflow pipeline.
However, if we uncheck this option, it will automatically check the ‘Warning’ checkbox. What it does is that the
records that do not pass the rule will return with a warning and will be written to a target even though they failed to
match the rule.

1.68. Using Data Quality Rules in Astera Centerprise
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In this case, let’s keep the errors as errors by checking the ‘Is Error’ box.
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So now we have set up a data quality rule.

You can add as many rules as you want by clicking this
button and similarly, you can also delete a rule by
pointing it in the grid and then right-click > Delete. In this example, we’ll work with a single rule which has been set,
so let’s go ahead and click OK.
Now let’s look at the preview. Right-click on the Data Quality Rules object and select Preview Output from the context
menu.

1.68. Using Data Quality Rules in Astera Centerprise

733

Centerprise, Release 8

You can see that the records that have matched the rule, that is the records with ‘False’ salary flag have been validated
and have matched the rule. On the other hand, the records that failed to match the rule, that is the records with the
True flag have returned an error, denoted by a red warning sign.
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If you move the cursor over this warning sign, it will show the error message in the tooltip. This is especially useful
in cases where you have applied more than one rule and you want to track which records have failed to match which
rule or when you want to store the erroneous records in an error log.

So now that we have validated the records against our data quality rule, we can map it to a target which is a delimited
file in this case. You can see that it’s named ‘Employees eligible for overtime,’ so the records of employees with the
‘False’ salaried flag will be passing through the Data Quality Rules and mapped to the destination file. Let’s do the
mapping.

1.68. Using Data Quality Rules in Astera Centerprise
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Now if we go to the properties of the destination file, you can see this option ‘Do Not Process Records With Errors’
on the last screen. It is checked by default in all target formats in Centerprise and what it does is that when we run
this dataflow, all records that have matched the data quality rule will be written on to the destination file, whereas the
records that failed to match the rule and returned an error will be omitted.
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The records that fail to match the data quality rule can be written and stored in a separate error log. Click here to learn
how you can store erroneous records using a Record Level Log.

1.69 Record Level Log
A Record Level Log captures the status (Success, Error, Warning, or Skip) for each of the records transferred and
includes snapshots of the source record and the destination record, as well as provides additional details, such as error
messages.
You can have any number of record level logs on the dataflow. Each record level log will collect the status of the
records in the object that it is connected to.
In this document, we will learn how to use Record Level Log object in Astera Centerprise.

1.69.1 Using record level log
In this case we have a simple dataflow performing a data quality check process. It contains Customers data coming in
from an Excel Workbook Source. Then a Data Quality Rule is applied to validate data for error and warning checks
and finally data is written to a Database Table Destination.

1.69. Record Level Log
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If you Preview Output for Customers data, you will see that some of the records for Region field and Fax field are
empty.

A Data Quality Rule is applied to identify null records in Region field as errors and empty records in Fax field as
warnings. Upon previewing its output you will see that the records that failed to match the rule have returned an error,
denoted by a red warning sign.
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If you hover on these warning signs, it will show you the error message.
Now, when we run this dataflow we want to know which records passed the validation check, which records failed the
validation check, which records had errors and which records ended in only warnings.
For this purpose, we will use Record Level Log.
Configuring a Record Level Log Object
1. To get a Record Level Log object from the Toolbox, go to Toolbox > Data Profiling > Record Level Log. If you’re
unable to see the toolbox, go to View > Toolbox or press Ctrl + Alt + X.

1.69. Record Level Log
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2. Drag-and-drop the Record Level Log object onto the dataflow designer.

Another way to get Record Level Log object is to right-click on the Output node inside Database Table Destination
and go to Write to > Record Level Log
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You can see that the dragged Log object is empty right now. This is because we haven’t mapped any fields on it yet.
3. Auto-map the fields from the source object onto the record log object.

4. To configure the Log object, right-click on its header and select Properties from the context menu.

1.69. Record Level Log
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A configuration window will open. First screen is Layout Builder screen. This is where we can create or delete fields,
change its name and data type.
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5. Click Next and you will be directed to a Properties window where you have to configure settings for creating the
log file.
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6. Specify the File Path where Centerprise will save this log file. Log files are saved with .prof extension.
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7. Specify the Log Level Type from the dropdown list.

1.69. Record Level Log
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All – all records (including Success records) are logged
Errors – only error records are logged
Warnings – only warning records are logged
Errors and Warnings – both error and warning records are logged
Off – no logging
In this case, we will select Errors and Warnings as our log type.

Stop Logging After . . . Records with Errors – allows you to limit excessive logging by setting a cap on the maximum
number of errors to be logged. The logging stops after the cap has been reached.
The default value is 1000 errors.
Click OK.
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Executing The Task

from the toolbar at the top. A Job
1. After configuring settings for Log object, click on Start Dataflow icon
Progress window will open at this instant and will show you the trace of the job.

2. Click on the log file link provided in the Job Progress window.

Record Level Log will open in Centerprise showing you the status of logged records.

1.69. Record Level Log
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Centerprise stores the error logs in XML format and if you expand each record, it will give you the Field Name to
which the error/warning message was attached, the Processing Step of data check that resulted in the errors, as well
as the error Message.
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If you click on View Record, Centerprise will show you the field values of the record failing the data quality rule.

1.69. Record Level Log
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1.70 Adding Workflow Tasks
There is a dedicated section of Workflow Tasks in the flow Toolbox to facilitate users in orchestrating a data process
in Centerprise.

This section expands into several task objects. You can use any number of task objects in your workflow, and these
tasks can be mapped in a sequence that controls the order in which the tasks are to be executed.
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In this document, we will learn about the various workflow tasks that can be used to orchestrate a data process.

1.70.1 Decision

A Decision task invokes one of the two paths in the workflow, depending on whether the logical expression inside the
Decision object returns a Yes (True) or a No (False) flag.
To use a decision task, drag and drop the Decision object onto the workflow designer. Configure the object by rightclicking on the object’s header and selecting Properties from the context menu.

This will open the Decision Properties window. This configuration screen provides the interface to create some
decision logic.

1.70. Adding Workflow Tasks
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In the Expression input box, enter an expression. This expression should return a Boolean result, such as True or False.
An example of this expression is shown below. The expression here is based on the presence of erroneous records in
a Run Datafllow task object.

Note: The right-hand pane displays the object tree (highlighted in yellow). You can double-click on an
object to add it to your expression.
Click Compile to check for any syntax errors in your expression. The status should read “Successful” for a successful
compilation.
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1.70.2 EDI Acknowledgement

An EDI Acknowledgement task issues an acknowledgement notification to the sender when an EDI message is received.
To use an EDI acknowledgement task, drag and drop the EDI Acknowledgement object onto the workflow designer.
Configure the object by right-clicking on the object’s header and selecting Properties from the context menu.

An EDI Acknowledgement Properties window opens as shown below. Here, we need to provide the following
information:

1.70. Adding Workflow Tasks
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• Partner Profile – is the path to the .tpp extension file that governs the EDI exchange with a specific customer or
vendor.
• Input File – is the path to the .edi extension file that contains EDI source file reader.
• Acknowledgement Settings-File Path – is the output file path.
• Transaction Set – is the acknowledgement that is being created, i.e. a 997 or a 999 etc.
• Pretty Print – adds a line break after each segment.
• Omit Byte Order Mark – leaves out the first two bytes for UTF indicating the actual encoding for the rest of the
file. (Note: Windows makes use of this, other systems might get confused by these two extra bytes.)
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1.70.3 File System

The File System Action task performs actions on a file or a folder, as it is configured. For example, this task can copy
a file, move a file to another folder, or delete all files in a folder.
To use a File System Action task, drag and drop the File System Action object onto the workflow designer. Configure
the object by right-clicking on the object’s header and selecting Properties from the context menu.

A File System Action Properties window opens as shown below. Here we configure the properties of the File System
Action task.
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Select an action from the Action dropdown list. The following options are available:

• File Copy – copies a file from a source folder into a destination folder
• File Move – moves a file from a source folder into a destination folder
• File Rename – renames a file
• File Delete – deletes a file
• Directory Move – moves all files in the folder into a new folder
• Directory Delete – deletes the folder along with any files or folders it contains
• Directory Content Delete – deletes all files from the folder, leaving the folder empty (the folder itself is not
deleted).
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Source File (Directory) Path – specifies the path to the source file or source directory
Destination Directory Path – specifies the path to the destination file or destination folder
Raise Error if no Source File Found – returns an error message if the source directory is empty
Overwrite Destination – overwrites data in the destination file or overwrites files in a destination folder
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1.70.4 File Transfer

The File Transfer task performs the specified actions on an FTP server. For example, the task can upload a file to an
FTP server, rename a file, or delete all files from a remote directory.
To use an FTP task, drag and drop the File Transfer task object onto the workflow designer. Configure the object by
right-clicking on the object’s header and selecting Properties from the context menu.

An File Transfer Action Properties window opens as shown below. Here, we configure the properties of the File
Transfer task.

758

Chapter 1. Other Versions

Centerprise, Release 8

FTP Connection – To configure connection with your FTP server, click on the ellipsis. A Web Connection window
opens up.
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Here, set up the FTP server connection by providing the URL, Login Name, Password. In case of using a proxy, fill in
the details under Proxy Info. For security protocols, provide details under FTPS Security Settings.

FTP Action – select an action from the FTP Action dropdown. The following options are available:
• Upload a File – uploads a file from a local folder into the remote directory
• Download a File – downloads a file from the remote directory into a local folder
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• Delete a File – deletes file from the remote directory
• Rename – renames a file in the remote directory
• Remove Directory – deletes the remote directory
• Upload a File with Unique Name– uploads a file from a local folder into the remote directory, renaming the file
if needed to ensure a unique file name in the remote directory.

• Remote Info-Path – specify the path of a file or folder on the FTP server.
• Local Info-Path– specify the local path on the server running the workflow.

1.70.5 OR
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The Or task works similar to the logic operator “OR”. It returns a true value if any one of its arguments is true,
otherwise it returns false.
To use an OR logic operator task, drag and drop the Or task object onto the workflow designer.

When linked with more than one decision task, the Or task triggers subsequent workflow tasks if any one of the
decision object returns a true value.

The Or task object does not have a dedicated configuration window. However, a General Options window opens if
you right-click on its header and select Properties from the context menu.
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This window appears as the last screen of the configuration window for all flow objects.
The Comments input allows you to enter comments associated with this object. These comments appear as you hover
on the object.
• Clear Incoming Record Messages – removes any message attached with a record, these could be an error or a
warning message.
• Do not Process Records with errors – filters out all the erroneous records from the incoming data set.
• Do not Overwrite Default Values with Nulls – prevents Centerprise from overwriting any previously assigned
default value with a null value.
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1.70.6 Run Dataflow

The Run Dataflow task is used to execute a dataflow as part of a workflow. Multiple Run Dataflow task objects can be
employed as part of a workflow, to orchestrating a data process.
To use a run dataflow task, drag and drop the Run Dataflow task object onto the workflow designer. Configure the
object by right-clicking on the object’s header and selecting Properties from the context menu.

A Start Dataflow Job Properties window opens as shown below.

764

Chapter 1. Other Versions

Centerprise, Release 8

Job Info-Path – specify the path to the dataflow that you want to run.
Note: To ensure that your workflow is runnable on a remote server, please avoid using local paths for the
dataflow. Using UNC paths is recommended.
Run in Pushdown mode – executes a dataflow on server without fetching data to Centerprise client.
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1.70.7 Run Program

The Run Program task is used to run an executable command, or batch file, as part of your workflow. Tasks, such as
a series of commands in other programming language (e.g. Python/R) in the form of .bat extension file, are executed
through Run Program task object.
To use a run program task, drag and drop the Run Program task object onto the workflow designer. Configure the
object by right-clicking on the object’s header and selecting Properties from the context menu.

A Run Program Properties window opens as shown below. This screen lets users define properties for an executable
batch file.
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Program Path – specify the file path to the executable batch file that you want to run as part of the workflow.
Run In – specify the default folder where Centerprise will run the batch file. (optional)
Arguments – specify any required or optional arguments for running the batch file, such as providing an external input
or indicating an input parameter change.
Run As – enter a user account (if different from the administrator) that should be used for running the batch file.
Password – enter the password specific to the user account entered in the Run As option.
Success Value – a value returned by the executable batch file upon its successful completion. The default value is 0.
The Run Program task will expect this value to signal successful completion of the task.
Timeout – define a time after which, if the program task fails to execute, Centerprise will terminate the process.
Fail Action if Unsuccessful – select this option to return an error when the executable batch file ends with an error in
the code.
Wait for Task to Complete – select this option to stop Centerprise from proceeding onto the next task in the workflow
until the batch file has finished running.
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1.70.8 Run SQL File

The Run SQL File task runs the SQL code inside a file of .sql extension as part of a workflow.
To use a run sql file task, drag and drop the Run SQL File task object onto the workflow designer. Configure the object
by right-clicking on the object’s header and selecting Properties from the context menu.

A Database Connection window opens as shown below. This is where we configure connection with the database.
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Centerprise offers native connectivity to a number of databases and applications. To connect to a database, click on
the drop-down menu next to the Data Provider option and select a data provider from the list.
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To establish a connection to a data provider, fill in the credentials such as User Id, Password, Server Name, Database
and Schema.
The next screen is Run Sql File Properties window.
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SQL File Path – specify the path to the SQL file that you want to execute through this task.
The next screen is the Config Parameters screen. This is where users can set up variable parameters to indicate a
run-time change for values in the list on the screen.
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1.70.9 Run SQL Script

The Run SQL Script task provides flexibility to write a sql code within Centerprise and deploy it as part of a workflow.
To use a Run SQL Script task, drag and drop the Run SQL Script task object onto the workflow designer. Configure
the object by right-clicking on the object’s header and selecting Properties from the context menu.

A Database Connection window opens as shown below. This is where we configure connection with the database.
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The connection to a data provider is established similar to how it is described for the Run SQL File task object.
The next is Run Sql Properties screen. In the SQL Statement box, enter the SQL code. This code will be executed
by the Run SQL Script task.
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1.70.10 Run Workflow

The Run Workflow task starts another workflow as part of a nested workflow. The object works similar to Run Dataflow
task.
To use a Run Workflow task, drag and drop the Run Workflow task object onto the workflow designer. Configure the
object by right-clicking on the object’s header and selecting Properties from the context menu.

A Start Workflow Job Properties window opens as shown below.
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Job Info-Path – specify the path to the workflow you want to run.
Note: To ensure that your workflow is runnable on a remote server, please avoid using local paths for the
workflow executed by this task. Using UNC paths is recommended.
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1.70.11 Send Mail

The Send Mail task sends emails to the administrator at appropriate junctions in a workflow.
To use a Send Mail task, drag and drop the Send Mail task object onto the workflow designer. Configure the object by
right-clicking on the object’s header and selecting Properties from the context menu.

A Send Mail Properties window opens up as shown below.
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Server – specify the server setting for an email platform by clicking on the ellipsis.
An Email Connection window opens up. This is where we specify the server connection details.
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Recent – select from the dropdown list of recent server configurations to automatically populate your connection info.
Options under Connection Info depends on the email provider the user wants to employ.
For more information on server settings for different email providers, click here.
Test your connection with the email provider by clicking on the Test Connection button.
A
Send Test Email window opens up that lets users send a test mail to the intended recipient.
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Once the connection with the email provider has been set up, go back to the Send Mail Properties window to fill in
the necessary details.
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From – enter the sender email account
To – enter the recipients of the email
Subject – enter the subject line for the email
CC – specify any CC recipients
BCC – specify any BCC recipients
Attachment – Provide any attachments that should be sent with the email
Message – Enter the body of the email that will be sent by this task
This concludes the description of the various workflow tasks in Astera Centerprise.

1.71 Using the Workflow Designer
A workflow enables automated and repeated execution of a sequence of tasks, such as running a program, sending
emails, uploading a file, running a transfer setting or batch, executing SQL scripts, and many others. To learn more
about Workflow Tasks, click here.
Let’s look at how we can use the features provided by the workflow designer.
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1.71.1 Creating a New Workflow
To create a new workflow, go to File > New > Workflow on the main menu. Alternatively, you can expand the Create
New Dataflow dropdown icon on the main toolbar and select Workflow, as shown below.

1.71.2 Managing the Workflow Layout
When the workflow designer opens up, you can see the workflow toolbar below the Workflow1 tab.

In the following sections, let’s discuss these features and their functions.
General Options
• Undo/Redo – The workflow designer supports unlimited undo and redo capability. You can quickly undo/redo
the last action done, or undo/redo several actions at once.
• Auto Layout Diagram – The Auto Layout feature allows you to arrange objects on the workflow improving its
visual representation.
• Zoom – The Zoom feature helps you adjust the display size of the workflow. Additionally, you can select a
custom zoom percentage by clicking on the Zoom % input box and typing in your desired value.
• Print – The Print feature allow you to print your created workflow.
• Expand All – The Expand All feature expands or enlarges the objects on the workflow improving the visual
representation.

1.71. Using the Workflow Designer

783

Centerprise, Release 8

• Collapse All – The Collapse All feature closes or collapses the objects on the workflow, improving the visual
representation and reducing clutter.
• Auto-Size All – The Auto-Size All feature resizes all the object in a manner where all fields of the expanded nodes
are visible and empty area inside the object is cropped out.
• Use Orthogonal Links – The Use Orthogonal Links feature draws the link between objects in an orthogonal
curve instead of a straight line.

Centerprise-Specific Options
• Replace Parameter Infos for All the Distinct Parameters – This feature displays all the distinct directories and
connections used in the objects available on the workflow designer.
To invoke this feature, click the Replace Parameter Infos for All the Distinct Parameters icon on the workflow toolbar.
Alternatively, you can open the workflow menu and select this feature.

A workflow can be ported to run in any number of target environments. Hence, you need to change the parameters
values depending on the current context in which the workflow runs. This feature can be used to change all the distinct
parameters without individually visiting the objects.
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• Replace Parameter Infos Individually – This feature displays all the parameters that have been assigned to each
object used in the workflow.
To invoke this feature, click the Replace Parameter Infos Individually icon on the workflow toolbar; you can open the
workflow menu and select this feature.

This feature displays the objects that have been used in the workflow in a categorical structure – View by Category –
and allows you to change the parameters by simply clicking and editing.

1.71.3 Linking Objects
Ports
Every object in the Workflow Tasks section of the toolbox has input and output ports when added to a workflow. These
ports make it possible to connect an object to another object via links, creating the required workflow path.
The input port on an object allows you to connect it to an upstream object on the workflow. Conversely, the output
port allows you to connect your object to a downstream object on the workflow. The downstream object represents a
task that will be processed after the upstream object it is connected to has finished running.
Note: There are some exceptions, such as the Run Program task, which may not require waiting for the program to
exit.
Here is a sample workflow that demonstrates the usage of input and output ports:
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Links
A link between two objects can be created by dragging the output port of the upstream object and dropping it on the
input port of the downstream object.
To remove a link between two objects, right-click on the link and select Delete from the context menu.
Note: It is also possible to connect multiple upstream objects to a single downstream object.
There are three types of links in a workflow.
1. Double Lined: Link from a Source object to a workflow task object. This line will only appear if you are using the
source as a loop.

786

Chapter 1. Other Versions

Centerprise, Release 8

Right-clicking on the Double Lined Link and selecting the Loop Options will show you the screen where you can
choose the ‘Degree of Parallelism’.

Degree of Parallelism indicates the number of concurrent supply of files. For example, if you set it to 2, two files we
go through the Run Dataflow Task simultaneously.
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2. Single Lined: Link from a workflow task object to any other object*.*
To change the link type, right click on the link and select Change Link Type.

• By default, a Normal link is created between an upstream and a downstream object. A Normal link means that
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the downstream object will be processed in the event of a successful completion of the upstream object to which
it is connected. Normal links are displayed in green.

• In contrast, an Error link means that the downstream object will be processed only in the event of a failed (error)
status of the upstream object to which it is connected. Error Links are displayed in orange.
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• In addition, an Always link means that the downstream object will be processed irrespective of the status of the
upstream object to which it is connected. Always Links are displayed in blue.
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3. Dotted Lined: Link from a Decision workflow task object to other objects.

This concludes our discussion on using the workflow designer in Astera Centerprise.
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1.72 Customizing Workflows with Parameters
The workflows you create with Centerprise can be ported to any number of target environments that may use different
connections to data providers, or other settings specific to the target environment. For example, you can create and
test your workflow in a staging environment, and then deploy it in your production environment. Prior to deploying
to your target environment, you may need to update the workflow’s data connections making them appropriate for the
target environment. The updating of data connections is made easy by using the Parameter Information Replacement
dialog.
To open the Parameter Information Replacement dialog, click theicon on the Workflow toolbar.
The left-hand pane of the Parameter Information Replacement dialog shows the parameter tree with all the objects
present in the workflow. Select an object in the tree, and update its connection in the right-hand pane’s input as
necessary.
Objects in the tree can be grouped by category, such as Source, Workflow Tasks etc, or left ungrouped. The grouping
is done by means of the two icons in the top left of the dialog.
Note: In the case of a scheduled workflow running on a server, a similar functionality is available in the Job Parameters
tab of the scheduled job interface in the Scheduler. For more information on Scheduler, see Scheduling Jobs.

1.72.1 Context Information
In addition to aligning your data connections with a target environment, you might also want to ensure that any context
information is suitable for the environment that your workflow will run in. For example, make sure that the server name
variable points to the correct server instead of being hard-coded. This can be achieved by using Context Information
parameters. Context Information parameters take their values dynamically at workflow run-time. These parameters
include ServerName, JobId, UserName, DroppedFilePath, among others.
To use context information parameters in your workflow, drag-and-drop the Context Information object from the
Resources group in the Flow toolbox on the workflow.
An example of what a Context Information object might look like is shown below.

The following parameters are available:
Name - name of the workflow, for example workflow1155.wf
JobId - ID of the job assigned by the server
ScheduledJobId - ID of the job associated with a schedule in case of scheduled running on a server
ServerName - name of the server running the workflow
UserName - user account that runs the workflow
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DroppedFilePath - path to the file being dropped, in case of a scheduled job of type ‘when file is dropped’
Note: You can also assign default values to parameters. These values will take effect when no other value is available.
To select a default value, open the properties of the Context Information object and enter the default value next to the
parameter.

1.72.2 Custom Parameters
You can also define any number of custom parameters. These custom parameters can be used throughout the workflow.
They can be initially assigned a default value, and then their value can change in the course of running your workflow.
Custom parameters can be configured in the Variables object. To add a Variables object in a workflow, drag it from the
Resources group in the Flow toolbox and drop it on the workflow.
An example of what a Variables object looks like is shown below.

To add a new parameter, open the Variables object properties and enter your new parameter in the grid. The parameter
should be assigned a data type, and it can be optionally assigned a default value.
You can also refer to most objects’ property values by using the $ (dollar-sign) notation, such as $object_name.field_name. This functionality is available in any area in the workflow that accepts $ parameters.
Examples of workflow areas that accept $ parameters are:
• Run SQL Script task
• Parameter Information Replacement dialog
• Send Mail task
Below is an example of using a $ parameter in a Run SQL Script object:
SELECT [dbo].[Customers].[CustomerID],
[dbo].[Customers].[CompanyName],
[dbo].[Customers].[ContactName],
[dbo].[Customers].[ContactTitle]
FROM [dbo].[Customers]
where CustomerId = ‘$(SQLQuerySource1.CustomerID)’

1.73 Workflows with a Dynamic Destination Path
Workflows are designed to orchestrate an automated and iterative execution of ordered tasks. When designing a
workflow to orchestrate a process, it requires a source object that can provide access to a directory containing bulk
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load of source files of the same layout and format. A workflow is designed such that each source file in that particular
directory goes through the same data processing.
This requires a source file to be replaced in the run-time until all the source files (of the same layout and format)
within a directory are processed and loaded to respective destination files. Now, this further involves the associated
destination files to be replaced in the run-time as well, hence making it essential to provide a dynamic destination
path. For example, a source directory containing 100 excel source files in this workflow will create 100 destination
files after going through the process.
In this document, we will learn to create workflows with a dynamic destination path that directs Centerprise to create
a unique destination file for each source file.
In Centerprise 8, dynamic destination path is achieved in two steps:
1. Parameterizing the dataflow through Variables object.
2. Providing a run-time destination path through Expression Transformation object in the workflow.

1.73.1 Parameterizing the Dataflow
In this case, we are orchestrating a simple dataflow that contains customer account details coming in through an Excel
Workbook Source. The source data is passed through an Aggregate Transformation and loaded to an Excel Workbook
Destination.

Now, there are 100 Excel source files in a directory containing customer account details of 100 customers. Each of
these customer account files must go through the same aggregate transformation and loaded to a distinctive Excel
destination file.
For this purpose, we will add a Variables object and parameterize the source file path and destination file path in the
dataflow.
1. Go to Toolbox > Resources > Variables, and drag and drop the Variables object onto the dataflow designer.

The Variables object is currently empty and needs to be configured.
2. Right-click on the object’s header and select Properties from the context menu. A properties window will open.
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3. On the Variable Properties window, create two new fields:
• Excel_Source
• Excel_Destination
Set both fields as Input. For their Default Value, paste the path for customer account file source and customer account
file destination in each field, respectively.
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Click OK.
4. Double-click on the header of Customer_Account source. An Excel Source Properties window will open. Click
Next and you will arrive at the Layout Builder screen. Click Next again and Config Parameters screen will open.

5. On the Config Parameters window, under the Value column for File Path, provide the name of the field enclosed
in {. . . .} that points to the source file path in the Variables object in step 3.
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6. Repeat step 4 and step 5 now for ExcelDestination object.
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Out dataflow has been parameterized. The next step is to create a workflow with a dynamic destination path.

1.73.2 Creating a Workflow
1. Open a new workflow by going to File > New > Workflow.
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2. To provide access to the local source directory containing 100 customer account files, go to Toolbox > Sources >
File System Item Source and drag and drop the File System Item Source object onto the workflow designer.

3. Right-click on the object’s header and select Properties from the context menu. A configuration window will open
up for the FileSystem object.
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4. Provide the local directory path in File Location. Apply a filter ***.xls ** and click OK.
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5. Right-click on the FileSystem source object’s header and select Loop from the context menu. This will direct
Centerprise to run the task in a loop, replacing the source file paths in real-time, ultil all the source files have been
processed through it.

6. Go to Toolbox > Workflow Tasks > Run Dataflow and drag and drop the Run Dataflow object onto the workflow
designer. Map the header output port of FileSystem source object onto the header input port of Run Dataflow object.

7. Right-click on the Run Dataflow object’s header and select Properties from the context menu. Here, provide the
Job Info path for the dataflow that is being orchestrated and click OK.
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8. Go to Toolbox > Transformation > Constant Value, drag and drop the Constant Value transformation object onto
the workflow designer. Double-click on its header, a Constant Value Map Properties window will open.

9. Paste the path of the folder where Centerprise will load the destination files, in the Constant Value box as shown
below. Click OK.
![7 (workflows-with-dynamic-destination-path.assets/7 (2).png)](D:/Typora Articles/CP_8/Workflows with dynamic
destination path/7 (2).png)
10. Go to Toolbox > Transformation > Expression, drag and drop the Expression transformation object onto the
workflow designer. Double-click on its header, a Layout Builder screen will open.

11. On this Layout Builder screen, create four new fields and set the data type accordingly.
• FullPath
• DestinationDirectory
• FileName
• DestinationFilePath
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Click OK.
12. Define field mappings as follows:
• FullPath field under FileSystem source object onto the FullPath field under Expression transformation object.
• FullPath field under FileSystem source object onto the Excel_Source field under RunDataflow task object.
• Value field under Constant Value transformation object onto the DestinationDirectory field under Expression
transformation object.
• DestinationFilePath field under Expression transformation object onto the Excel_Destination field under RunDataflow task object.
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13. Double-click on the header of Expression transformation object, its Layout Builder screen will open. Write the
following expressions for these fields:
• FileName : LSplit(RSplit(FullPath,2,”\”,0),2,”.”,0)
• DestinationFilePath : DestinationDirectory+FileName+”.xls”
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Click OK. A dynamic destination file path has been created.
14. Click on Start Workflow icon placed in the toolbar at the top to execute this workflow.

This will create a uqniue destination file for each source file.

1.74 Using the Data Source Browser in Astera Centerprise
Astera Centerprise allows users to integrate multiple databases in a single instance. It has a built-in Data Source
Browser that not only helps connect to various databases, but also allows users to navigate between the different
tables, source data, and run transfers and queries.
In this article, we will cover:
• An overview of the Data Source Browser
• Connecting to a single database using the Data Source Browser
• Connecting to multiple databases using the Data Source Browser

1.74.1 Using the Data Source Browser
The Data Source Browser enables you to connect to and query data from a database server. Astera Centerprise allows
you to connect to multiple database servers at the same time.
Steps to open the Data Source Browser
1. Click View>Data Source Browser.
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Or press Ctrl+Alt+D.
The Data Source Browser will open on Centerprise client.
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• You can click the Add Database Server button inside the Data Source Browser to connect to a database server.
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• The connected database servers are displayed inside the Data Source Browser.
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• The connected database server is displayed as a tree in the Data Source Browser. You can click the Disconnect
Select Database Server button to disconnect from the selected database server.
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Using Data Source Browser with Queries
The Data Source Browser can also be used to start a query. The connected database servers are displayed in the
database browser window. Right-click on a database server to view the available options.
Steps:
1. Right-click on the connected database server. The context menu is displayed.
2. Click New Query. A new query starts with a database connection already established.
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Using Data Source Browser for Transfers
The Data Source Browser can be used to export data to a Microsoft Excel Worksheet or a delimited file from the
connected database server in the form of a table. You can right-click on the connected database server to view the
available options.
1. Right-click on the connected database server. The context menu is displayed.
2. Click Export all Tables to Excel files or Export all Tables to Delimited files.
3. Provide the destination path where you want to save the exported files.
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Exploring the Database Connection Window
The Database Connection window is where you can establish connection to a database server, while working with
with transfers, batches and queries.
The following table describes the options available in the Database Connection window.
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Connecting to a Single Database
To learn more about connecting to a single Database Table Source in Astera Centerprise, click here.
Connecting to Multiple Databases
Astera Centerprise provides you the option to work with more than one database at a time. The steps for connecting to
multiple databases are the same as those for Connecting to a Single Database. While connecting to multiple databases,
you can connect to an existing data provider or establish a new connection with a different data provider.
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The Data Source Browser displays all the active database connections. You can switch between these databases by
clicking on the Server name in the Data Source Browser. The active database appears highlighted in the Data Source
Browser.
This concludes using the Data Source Browser in Astera Centerprise.

1.75 Using The Workflow Designer
A workflow enables automated and repeated execution of a sequence of tasks, such as running a program, sending
emails, uploading a file, running a transfer setting or batch, executing SQL scripts, and many others. To learn more
about Workflow Tasks, click here.
Let’s look at how we can use the features provided by the workflow designer to make the implementation and visualization of the job effortless.

1.75.1 Creating a New Workflow
To create a new workflow, go to File > New > Workflow on the main menu. Alternatively, you can expand the Create
New Dataflow dropdown icon on the main toolbar and select Workflow, as shown below.

1.75.2 Managing the Workflow Layout
When the workflow designer opens up, you can see the workflow toolbar below the Workflow1 tab.

In the following sections, let’s discuss these features and their functions.
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General Options
• Undo/Redo – The workflow designer supports unlimited undo and redo capability. You can quickly undo/redo
the last action done, or undo/redo several actions at once.
• Auto Layout Diagram – The Auto Layout feature allows you to arrange objects on the workflow improving its
visual representation.
• Zoom – The Zoom feature helps you adjust the display size of the workflow. Additionally, you can select a
custom zoom percentage by clicking on the Zoom % input box and typing in your desired value.
• Print – The Print feature allow you to print your created workflow.
• Expand All – The Expand All feature expands or enlarges the objects on the workflow improving the visual
representation.
• Collapse All – The Collapse All feature closes or collapses the objects on the workflow, improving the visual
representation and reducing clutter.
• Auto-Size All – The Auto-Size All feature resizes all the object in a manner where all fields of the expanded nodes
are visible and empty area inside the object is cropped out.
• Use Orthogonal Links – The Use Orthogonal Links feature draws the link between objects in an orthogonal
curve instead of a straight line.

Centerprise-Specific Options
• Replace Parameter Infos for All the Distinct Parameters – This feature displays all the distinct directories and
connections used in the objects available on the workflow designer.
To invoke this feature, click the Replace Parameter Infos for All the Distinct Parameters icon on the workflow toolbar.
Alternatively, you can open the workflow menu and select this feature.

A workflow can be ported to run in any number of target environments. Hence, you need to change the parameters
values depending on the current context in which the workflow runs. This feature can be used to change all the distinct
parameters without individually visiting the objects.

1.75. Using The Workflow Designer
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• Replace Parameter Infos Individually – This feature displays all the parameters that have been assigned to each
object used in the workflow.
To invoke this feature, click the Replace Parameter Infos Individually icon on the workflow toolbar; you can open the
workflow menu and select this feature.
![06-IndParam ](using-workflow-designer.assets/06-IndParam .png)
This feature displays the objects that have been used in the workflow in a categorical structure – View by Category –
and allows you to change the parameters by simply clicking and editing.
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1.75.3 Linking Objects
Ports
Every object in the Workflow Tasks section of the toolbox has input and output ports when added to a workflow. These
ports make it possible to connect an object to another object via links, creating the required workflow path.
The input port on an object allows you to connect it to an upstream object on the workflow. Conversely, the output
port allows you to connect your object to a downstream object on the workflow. The downstream object represents a
task that will be processed after the upstream object it is connected to has finished running.
Note: There are some exceptions, such as the Run Program task, which may not require waiting for the program to
exit.
Here is a sample workflow that demonstrates the usage of input and output ports:
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Links
A link between two objects can be created by dragging the output port of the upstream object and dropping it on the
input port of the downstream object.
To remove a link between two objects, right-click on the link and select Delete from the context menu.
Note: It is also possible to connect multiple upstream objects to a single downstream object.
There are three types of links in a workflow.
1. Double Lined: Link from a Source object to a workflow task object. This line will only appear if you are using the
source as a loop.
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Right-clicking on the Double Lined Link and selecting the Loop Options will show you the screen where you can
choose the ‘Degree of Parallelism’.

Degree of Parallelism indicates the number of concurrent supply of files. For example, if you set it to 2, two files we
go through the Run Dataflow Task simultaneously.

1.75. Using The Workflow Designer

819

Centerprise, Release 8

2. Single Lined: Link from a workflow task object to any other object*.*
To change the link type, right click on the link and select Change Link Type.

• By default, a Normal link is created between an upstream and a downstream object. Normal link means that the
downstream object will be processed in the event of a successful completion of the upstream object to which it
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is connected. Normal links are displayed in green.

• In contrast, an Error link means that the downstream object will be processed only in the event of a failed (error)
status of the upstream object to which it is connected. Error Links are displayed in orange.
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• In addition, an Always link means that the downstream object will be processed irrespective of the status of the
upstream object to which it is connected. Always Links are displayed in blue.
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3. Dotted Lined: Link from a Decision workflow task object to other objects.

This is how various features of the workflow toolbar can be utilized to abridge the time and effort needed for the

1.75. Using The Workflow Designer

823

Centerprise, Release 8

creation of complex tasks in a workflow in Astera Centerprise.

1.76 GPG-Integrated File Decryption in Astera Centerprise
Encrypted files can easily be decrypted manually using an OpenPGP tool such as GPG or PGP. However, if you receive
decrypted files in bulk regularly, and want to automate the whole process of decrypting those files, you can do that by
creating a workflow in Astera Centerprise.

1.76.1 GPG4Win Integration in Centerprise
GPG4Win is one of the many tools commonly used to decrypt encrypted files. Generally, it is run using Window’s
Command Prompt. To integrate it with Centerprise, you can create a batch file and run it using the RunExe Task in a
workflow. The batch file contains commands that are to be executed on GPG4Win to decrypt files.

1.76.2 Creating a Batch File
A batch file is a simple text file that contains commands that are to be executed on GPG4Win to decrypt files. A batch
file can be created by opening a new file in Notepad and saving it with ‘.bat’ extension.
Variables Required for Decryption
• *PriKey* – Location where the Private Key resides
• *Passphrase* – Passphrase required to access the Private Key
• *Output* – Destination path of decrypted files (with new filename)
• *Input* – Location path to the encrypted files
Batch File Explanation
Here we have created a batch file in Notepad. It contains the following commands to be run in the GnuPG environment.

• echo off – echo prints the command being executed on the command prompt. Turning it off prevents it.
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• gpg – GNU Privacy Guard; it indicates that the following command is for GNUPG.
• –import %prikey% - This imports the Private Key required for decryption. This is an essential step and the
proper way to import the PriKey.
• –no/yes – Permission to overwrite if a file with the same name already exists. If set to no, and a file with the
same name already exists, it will not perform any action, and the job will be counted as ‘unsuccessful.’ You can
utilize the ‘Fail Action if Unsuccessful’ option (in the RunExe workflow task) to terminate the flow or ignore it
as required.
• –pinentry-mode=loopback – GnuPG requires you to enter passphrase for which it gives a pop-up at runtime.
Since this passphrase needs to be entered manually in the pop-up, it may hinder automated jobs. The ‘loopback’
pinentry-mode forces it to suppress the pop-up and utilize the passphrase in the batch file itself.
• –passphrase %passphrase% – Since the private key is stored somewhere on the computer, it should be secured
to prevent unauthorized access. The passphrase is a secret phrase (just like a password) needed to utilize the
private key, without which the key will not work.
• -o %output% – Destination of decrypted files (including new filename)
• -d %input% – Path to the files to be decrypted

1.76.3 Automating the Process in Astera Centerprise
Here, we’ve already designed a workflow using a File System Items Source task, an Expression task, and a RunExe
task. We’ve also used a Variable object to pass the PriKey location path and the Passphrase to access the PriKey.

The FileSystemItemsSource utilizes ‘.gpg’ filter to filter out encrypted files and runs in a loop to execute the corresponding RunExe task for all of them one by one.
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The Expression task uses the information from Variables and FileSystemItemsSource to generate a parameter string.
The parameter string contains all 4 parameters (variables required for decryption), separated by a single space and
enclosed within quotes. As in, Variables.key + “ “” + Variables.passphrase + “” “” + output + “” “” + InPath
+”””
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The Variable object feeds the path to the Private Key and Passphrase into the parameter string in the Expression task,
during runtime.
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Next, we have used a RunExe task to run the batch file in GnuPG environment. The Program Path is the path to the
batch file, whereas the ‘Run in’ is the location of the GnuPG environment where the commands will be run.
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The batch file does not have the four parameters (arguments), and we have fed these parameters to it using the parameter string from the Expression object.
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Our workflow is ready. You can now schedule it on Astera Integration Server to be executed automatically at your
specified time and frequency.
Before you run the workflow, make sure you’re logged on to Astera Integration Server with an account that has access
to the Private Key. To do that, go to Services > Astera Integration Server 8 > Properties > Log On.
Let’s run this workflow. You can observe the progress in the job trace.

Now, if you look at the location we specified for the output, you can see that all source files have been successfully
decrypted and stored in a new folder named ‘Output.’
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This concludes integrating GPG commands and orchestrating the file decryption process in Astera Centerprise.

1.77 Using Subflow in Astera Centerprise
The subflow feature can be seen as a ‘black box’ inside a dataflow. It simplifies and streamlines the dataflow design,
increases reusability, and achieves an easier-to-understand view of the dataflow. Unlike dataflows, a subflow cannot
run on its own. You must call a subflow in a dataflow for it to be executed.
A subflow can be nested, meaning that you can call a Subflow transformation object in another subflow.
Over time, if the logic inside your subflow changes, you can modify the subflow, and use it in the same dataflow as
before. This saves the user from making repeated changes in the dataflow when the subflow is being called multiple
times. This will be clearer when we study the example use-case given below.

1.77.1 Use-Case
In this example, we have datasets of Student Allowance for three different classes: Primary, Secondary, and High
School Students, stored in three separate Excel files. For each student in a particular class, we have four allowance
categories: Lunch, Books, Uniform and Stationery.
Here is a preview of the data for Primary School Students:
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First, we want to clean the data by removing duplicate records. Next, we want to find the total amount a student gets
(sum of all 4 categories) and find the following statistics for each class and save it in separate Excel destinations:
• Average total allowance
• Minimum total allowance
• Maximum total allowance
Here is the desired sample output summary for Primary School Students:

The logic implemented in the dataflow to get the output shown above is as follows:

Observe that performing the same process three times for each class of students would be repetitive. Therefore, we
will use the Subflow object to create the repeating logic.
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1.77.2 Creating a Subflow
1. Open a new subflow.
a. To open a new subflow, go to File > New > Subflow or press the shortcut keys Ctrl+Shift+S.

b. Alternatively, you can also expand the dropdown button in the main toolbar and select Subflow as shown below.
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Subflow Input and Output
The Subflow Input object makes it possible to feed data into the subflow from an upstream object on the dataflow that
calls the subflow. The Subflow Output object is used to send data to the downstream dataflow object connected to the
subflow.
You can find the Subflow Input and Subflow Output objects in the Subflow section in the Toolbox.
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Note: The Subflow section will only appear in the Toolbox if a Subflow file is open.
Drag and drop these items onto the subflow designer to use them.
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Subflow Input
The Subflow Input object is a connector controlling the input layout of your subflow. Any data that is fed into the
subflow will pass through the Subflow Input when the subflow is called by a dataflow or another subflow.
In our example, we need our subflow to take the student allowance details as the input using the Subflow Input object.
We can also use any other source object, such as Excel Workbook Source.
1. Right-click on the Subflow Input object and go to Properties.

2. Add appropriate data fields, along with their data types, in the Layout Builder, and click OK.
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3. Your Subflow Input object is now configured and ready for use.
Subflow Output
The Subflow Output object is a connector controlling the output layout of your subflow. Any data that leaves the
subflow will pass through the Subflow Output when the subflow is called by a dataflow or another subflow.
1. Like the previous step, right-click on the Subflow Output object and select Properties.
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2. Add appropriate data fields, along with their data types, and click OK.
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3. Your Subflow Input and Subflow Output objects are now configured.
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Designing a Subflow
Add required objects between your Subflow Input and Subflow Output objects and map the respective data fields.
In this case, we have added the following transformations:
• Distinct: To remove all duplicate records and keep only records with distinct ID.
• Expression: To find the Total for each student by summing the amount in all four columns (Col1 + Col2 + Col3
+ Col4).
• Aggregate: To find the Average, Min and Max total allowance of a student.

Once done, save your subflow in the relevant directory with an appropriate name. Here, we are naming it as SampleSubflow.Sf.

1.77.3 Using the Subflow Transformation Object in a Dataflow
1. Make a new dataflow, import data from the respective Excel Workbook Source, and create data fields in the respective
Excel Workbook Destination. Your designer would look like this:

2. Then, drag-and-drop the Subflow object from the Transformation section of the Toolbox onto the designer.
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3. Right-click on the Subflow object and go to Properties.

4. a. Copy and paste the path of the directory where the SampleSubflow.Sf is saved.
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b. Alternatively, you can click on the folder icon on the right of the textbox to locate the file, SampleSubflow.Sf, in
your local directory. Click Open.
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Click OK in the Properties window.
5. Your Subflow transformation object is now configured and ready for use. You can now map appropriate data fields
from and to the Excel Source and Excel Destination respectively.

6. Right-click on the ExcelDest object and select Preview Output. It should display the Average, Maximum and
Minimum total allowance for Primary School Students.

844

Chapter 1. Other Versions

Centerprise, Release 8

7. Repeat the same steps given above for the other two datasets containing information of student allowance for
Secondary School Students and High School Students.
This concludes our discussion on the functionality of the Subflow Input, Subflow Output and Subflow transformation
objects in Astera Centerprise.

1.78 Database Write Strategies
The Database Write Strategies available in Astera Centerprise provide a convenient way for you to make updates and
insertions in a database table. They can be used to implement advanced logic for handling data updates, thus promoting
seamless data integration and warehousing.
In this article, we will be discussing the Database Write Strategies available in Astera Centerprise. Let’s take a look at
a sample use case.

Here, we are writing data from a source table in one database to a destination table in another database. The source
data consists of customer information from a fictitious organization, and the organization would like to have control
over which records are written to the destination table.
Centerprise supports the following database write strategies:
• Data Driven
• Database Diff Processor
• Slowly Changing Dimensions
• Source Diff Processor

1.78. Database Write Strategies
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1.78.1 Data Driven
The Data Driven write strategy processes records based on some predefined criteria expressed in the form of rules.
For example, insert records where LTV > 80, or delete records where CreatedDtTm < UpdatedDtTm.
Each rule has a database action associated with it, such as Insert, Update, Delete or Error. If a record does not pass a
rule, the record will be tried against the next rule on the list, until all rules have been exhausted.
To add a Data Driven write strategy, open the flow Toolbox, expand the Database Write Strategy group, and drag and
drop the Data Driven object onto the dataflow designer.
An example of what a Data Driven object looks like is shown below.

The following properties are available to help you configure the logic of your database update:
The Layout Builder screen allows you to add or remove fields in the field layout, as well as select their data type.
Note: To quickly add fields to the layout, drag and drop the node Output port of the object whose layout you wish to
replicate into the node Input port of the Data Driven object. The fields added this way will show in the list of fields
inside the node and as well as in the Layout Builder.
Data Driven Write Strategy Conditions screen allows you to manage rules and associate them with database actions.
To add a new rule, follow these steps:
1. Click the Add Condition icon to create a new rule.
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2. Type a descriptive name for the rule in the Description field.
3. Activate the rule by checking the Active checkbox.
4. Select a database action, such as Insert, Update, Delete or Error, from the Perform Database Action dropdown
list. This action will be applied when the rule holds.
5. In the When the Following Condition Holds input, write an expression for the rule. For example, LoanAmount
< 320000. Or click . . . to open the Expression Builder where you can visually build your rule using Record tree
and IntelliSense.
6. Click Compile to check for any syntax errors in your rule. The status should read “Successful” for a successful
compilation. Close the Expression Builder.
7. The new rule has been successfully configured.
8. You can add multiple rules if necessary. To delete an existing rule, select it and click the Remove Condition
icon.

1.78. Database Write Strategies
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General Options screen
The Comments input allows you to enter comments associated with this object.

1.78.2 Database Diff Processor
The Diff Processor database write strategy synchronizes records between two tables. The destination table is compared
against a diff table, and any differences between the two tables are reconciled in the destination table.
To apply Diff Processor write strategy, open the Flow toolbox, expand the Database Write Strategy group, and drag
and drop the Diff Processor object onto the dataflow designer.
An example of what a Diff Processor object may look like is shown below.
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The following properties are available to help you configure the logic of your database update:
Database Connection screen – allows you to enter the connection information for the diff table, such as server name,
database and schema, as well as credentials for connecting to the selected diff table.
Pick Table screen:
Using the Pick Table screen, select the diff table for this database write strategy.
Select Field for Matching Database Record – specifies a field (or a combination of fields) which will be used to match
records from the diff table with records that exist in the destination table.
Output Options:
• Single Output: This is the default selection when using a database write strategy. Single Output means that the
database action, such as Insert, Update, Skip or Error will be chosen by the database write strategy’s logic rather
than specified by the user. Using a single output is recommended when a database write strategy is applied.
• One Port for Each Action – This adds extra flexibility in letting you specify maps for each of the database
write actions, such as Insert, Update, Skip or Error. Each set of maps is completely independent of another, and
will be applied according to logic of the database write strategy.

1.78.3 Slowly Changing Dimensions
The Slowly Changing Dimensions (SCD) database write strategy addresses scenarios where a field’s value for a record
varies over time. Centerprise supports industry-standard Type 1 and Type 2 SCD methods to handle slowly changing
values in the selected fields of a dimension table.
The Type 1 method is used when no historical data is required on how values changed in the SCD field over time.
Type 1 method simply updates a record in the dimension table, overwriting an old SCD value with a new value.
The Type 2 method makes it possible to track historical data by creating multiple records in the dimension table. The
records are identified by using an extra surrogate key in addition to any other keys already present in the table. With
Type 2, you have unlimited history as a new record is inserted each time a change to the SCD value is made. Additional
fields, such as EffectiveDate, ExpirationDate, or Version may be used to track the timeline of SCD value updates, as
well as identify the current SCD value.
To add the Slowly Changing Dimensions write strategy, open the Flow toolbox, expand the Database Write Strategy
group, and drag and drop Slowly Changing Dimensions object on the dataflow.
1.78. Database Write Strategies
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An example of what an SCD object might look like is shown below.

The following properties are available to help you configure the logic of your database update:
Database Connection screen – Here you need to enter the connection information for the SCD table, such as server
name, database and schema, as well as credentials for connecting to the selected SCD table.
Pick Table screen – Using Pick Table screen, select the SCD table that will be updated by this database write strategy.
Output Options:
• Single Output: This is the default selection when using a database write strategy. Single Output means that the
database action, such as Insert, Update, Skip or Error will be chosen by the database write strategy’s logic rather
than specified by the user. Using a single output is recommended when a database write strategy is applied.
• One Port for Each Action: Adds extra flexibility in letting you specify maps for each of the database write
actions, such as Insert, Update, Skip or Error. Each set of maps is completely independent of another, and will
be applied according to logic of the database write strategy.
Layout Fields screen:
Using the SCD Field Type dropdown, select among the following designations for each field in the layout:
For SCD Type 1 updates:
• Business Key - designates the field holding the key that is normally used to identify records in the table
• Not Used - designates a field that is not used by the SCD update logic. However, this field may still be updated
if it is mapped.
• Update Not Allowed - designates a field that is not used by the SCD update logic. This field may not be updated
even if it is mapped. An attempt to update the field will result in an error status for the entire record.
• SCD1 - Update - designates a field that stores an SCD value. This is the value that slowly changes over time.
• Audit - Last Changed - stores the date and time when the record with the SCD value was last updated.
• Audit - SCD1 Change - stores the date and time when the record with the SCD Type 1 value was last updated.
For SCD Type 2 Updates:
• Business Key - designates the field holding the key that is normally used to identify records in the table.
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• Surrogate Key - designates the field holding an extra key that identifies versions of the SCD value with the
same business key.
• Not Used - designates a field that is not used by the SCD update logic. However, this field may still be updated
if it is mapped.
• Update Not Allowed - designates a field that is not used by the SCD update logic. This field may not be updated
even if it is mapped. An attempt to update the field will result in an error status for the entire record.
• SCD2 - Update and Insert - this field stores an SCD value changing over time. A new record will be added each
time the SCD value changes. The existing record may be updated with the new ExpirationDate.
• Current Record Designator - stores the Active Value if the record has the current version of the SCD value.
Otherwise it stores the Inactive Value. Active Value and Inactive Value should be entered in the appropriate cells
in the grid next to the Current Record Designator.
• SCD2 Effective Date - stores the effective date of the SCD value in the record.
• SCD2 Expiration Date - stores the expiration date of the SCD value in the record. Expiration Date is Null in
the record storing the current SCD value.
• Audit - Created - stores the date and time when a new record with a new SCD value was created.
• Audit - Last Changed - stores the date and time when the record with an SCD value was last updated.
• Audit - SCD2 Change - stores the date and time when the record with an SCD Type 2 value was last updated.
• Version - stores the version number of the SCD value.

1.79 Data Driven
Data Driven Write Strategy is a set level functionality, which means that the entire incoming dataset must flow through
it. It allows a user to stamp a database directive on the record so that when it reaches its destination, it will be loaded
according to that directive to perform the specified write action. You can specify multiple rules within the properties
of a Data Driven write strategy object. These rules are tried against each record from top to bottom. If a record passes
the first rule, it will not be tried against the next rule(s).

1.79.1 Use-Case
Assume a scenario in which Orders data from a Database Table source is written to a Database Table destination. We
want to DELETE those records where Ship Date is before the year 2000 and declare those records where freight is
less than 10 as ERROR. We will use theData Driven Write Strategy to achieve this task.

1.79.2 How to Work with Data Driven Write Strategy
1. Drag and drop the Data Driven object from Toolbox > Database Write Strategy > Data Driven on to the dataflow
designer and map the source data to Data Driven object.

2. Right-click on the header of Data Driven object and select Properties.

1.79. Data Driven
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3. A Layout Builder screen will open where you can modify your layout. Click Next.
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4. The next screen is the Data Driven Write Strategy Conditions screen where you can specify rules to route your data.
Click on fx option to enable the Expression Builder.

1.79. Data Driven
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Once you select this option, the Expression Builder will be enabled.
5. Now, specify the following rules in the expression builder and select Database Action as ERROR in freight rule and
DELETE in date rule.
• Year(ShippedDate) < 2000
• Freight < 10
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There are five Database actions: Insert, Update, Delete, Skip and Error. From these, you can select the action you
want to be taken for a certain rule.
6. Once you’re done specifying the rule(s), click OK.
You can now write your data to a Database Table destination.
It is important to note here that while working with Database Write Strategies, Single Port is selected. Once you check
the Single Port option in the Database Table Destination object, a box will appear in which you will have to specify a
field for matching database record. In our case, we will select OrderID.

1.79. Data Driven
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7. We have successfully configured the settings and built the layout.

856

Chapter 1. Other Versions

Centerprise, Release 8

8. Let’s preview the output.
Data Driven output:

You can see that Centerprise has appended an error message with the records where freight is less than 10. You can
create an error log of these records or load them into a database if you want.
Note: Since, freight rule is our second rule, only those records which have failed against the first rule would be declared
as an error. Which is why the error message only appears with records where both ship date is greater than 2000 and
freight is less than 10.
Now, whenever you’ll access the same database table, you will see that the records where ship date is before the year
2000 would be deleted.

That concludes using the Data Driven Write Strategy in Astera Centerprise.

1.80 Source Diff Processor
Source Diff Processor is one of the Database Write Strategies offered in Centerprise. It works like Database Diff
processor, however, unlike the Database Diff processor, it is used to perform write actions (such as Insert, Update and
Delete) on file destinations. It stores a snapshot of your data processed in the first run in a CDC file. So, the next time
you run it, it will only import the new records.

1.80.1 Use Case
We have a sample employees data coming in from an Excel source. Initially, we had records of 10 employees but
later on, 2 more were added in the source dataset. We wish to apply a database write strategy that can read the data
incrementally from file sources. To achieve that, we will use the Source Diff Processor in Astera Centerprise.

1.80.2 How to Work with Source Diff Processor
1. Drag and drop the Source Diff Processor object from Toolbox > Database Write Strategy > Source Diff Processor
on to the dataflow designer and map the source data to it.

2. Right click on the Source Diff Processor’s header and select Properties.
1.80. Source Diff Processor
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3. A Layout Builder screen will open where you can modify your layout. Click Next.

858

Chapter 1. Other Versions

Centerprise, Release 8

4. The next screen is be the Incremental Write Options screen.

1.80. Source Diff Processor
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Here, you have to specify the Record Matching Field. The Record Matching Field is used to match and compare the
incoming and existing records. We will select EmployeeID as the Record Matching field.
Case Sensitive – check this option if you want to compare records on a case sensitive basis.
Sort Input – check this option if you want to sort the incoming data.
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• Now, if the incoming dataset has a new record with a new EmployeeID i.e. the ID is not present in the existing
file which is being compared against the incoming file, Centerprise will perform the INSERT action.
• If the EmployeeID is already present in the existing file, Centerprise will compare the records against that ID
and will perform UPDATE action in the fields where the information has updated.
• If the EmployeeID is there in the existing file, but not present in the incoming file, it means that the particular
record has been deleted. In this case, Centerprise will perform the DELETE action.
In the Output Options section, you can either select the Single Output option or One Port for Each Action.

1.80. Source Diff Processor

861

Centerprise, Release 8

Single Output:
Single Output option is selected if you wish to load your data into the destination without modifying it further on the
basis of individual write actions. If you select Single Output, the database action such as INSERT, UPDATE, SKIP or
ERROR will be chosen by the database write strategy’s logic rather than specified by the user. Using a single output
is recommended when a database write strategy is applied.
One Port for Each Action:
One Port for Each Action is used when you want to further transform or log your data. If you select One Port for Each
Action, you will get separate nodes for each Diff action in the Source Diff Processor’s object.
In this example, we will select Single Output.
The third section on the Incremental Write Options screen is the Incremental Transfer Information File Path option.
Here, you specify the file path where you want to store information related to the last run.
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Now if you have worked with Excel and Database table sources in Centerprise, you would have noticed that the
Database table source object gives you the option to read incremental changes. However, no such option is available
in Excel or other file source objects. This option here in Source Diff Processor enables you to read incrementally from
different file formats such as Excel, delimited, and fixed length.
Click OK.
5. Now, right-click on the Source Diff Processor’s header and select Preview Output.

1.80. Source Diff Processor
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Output preview for Single Output:

Output preview if One Port for Each Action is selected:
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You can now write your data to any destination or perform any transformation on the dataset.

This concludes using the Source Diff Processor write strategy in Astera Centerprise.

1.81 Database Diff Processor
Database Diff Processor is one of the four Database Write Strategies offered in Astera Centerprise. Its purpose is to
synchronize the data present in two separate datasets. The object compares the two datasets and performs write actions
(insert and update) on the destination table so that both tables contain the same information.

1.81. Database Diff Processor
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1.81.1 Use Case
In this use case, we have a sample dataset of customers that is stored in a database table. Initially, this dataset contains
10 records, but two more customer records are to be added later on. Furthermore, updated phone numbers are to be
added for two other customers.
We want to write the initial dataset to another database table and ensure that whenever the aforementioned changes
are made, they are applied to both of the tables. To achieve this, we will be using the Database Diff Processor object
in Astera Centerprise.

1.81.2 How to use the Database Diff Processor
1. Drag and drop the Database Table Source object from Toolbox > Sources > Database Table Source onto the
dataflow designer. Configure this object so that it reads data from the source table.

To learn how you can configure a Database Table Source object, click here.
2. Drag and drop the Database Diff Processor object from Toolbox > Database Write Strategies > Database Diff
Processor onto the dataflow designer. Auto-map all of the elements from the source object to the Database Diff
Processor object.

3. Right-click on the header of the Database Diff Processor object and select Properties.
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4. This will open the Database Connection screen. Here, you will have to enter the credentials for the database you
want to connect to. Alternatively, you can connect to a recently used database by selecting it from the Recently Used
dropdown list.

1.81. Database Diff Processor
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In this case, we will connect to a test database that contains an empty Customers table.
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Once you’ve entered the required credentials, click Next.
5. On the next screen, you will have to pick a destination table on which the write actions (Insert and Update) will be
performed.

1.81. Database Diff Processor
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In this case, we will pick the empty Customers table that has already been created in this database.
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There are a couple of options related to Record Matching at the bottom of the screen:
• Select a field to be used for matching records between the source table and the destination table. In this case,
we will select CustomerID because it cannot change for each customer.
• Check the Case Sensitive option if you want the comparison to be case sensitive. In this case, we will leave this
option unchecked.

1.81. Database Diff Processor
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Now that the required table and Record Matching options have been selected, click OK to close the configuration
window.
6. Run the dataflow to write your source data to the destination table. To preview the source data, right-click on the
Database Table Source object and select Preview Output.
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This is what the source data looks like:

To check whether this data has been written to the destination table, right-click on the Database Diff Processor object
1.81. Database Diff Processor
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and go to Database Table > View Table Data.

The destination table will open in a separate tab within Centerprise.

The data present in the destination table is the same as that in the source table, showing that we have successfully
written the data by running the dataflow.
7. The source dataset has been updated to include two more customer records. Moreover, two other customers have
updated their phone numbers. This is what the source data looks like after the changes have been implemented:
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Run the dataflow again to apply these changes to the destination table. This is what the destination table should look
like when you open it in Centerprise after running the dataflow again:

1.81. Database Diff Processor
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The changes that were made to the source table have automatically been applied to the destination table as well,
showing that the Database Diff Processor object has achieved its task.
This concludes using the Database Diff Processor write strategy in Astera Centerprise.

1.82 Delimited Parser
The Delimited Parser in Astera Centerprise reads and processes a single stream of text in delimited format as input and
returns its elements as parsed output. It enables users to transform an otherwise semi-structured data into a structured
format.
In this document, we will learn to use the Delimited Parser to parse an incoming text stream in Astera Centerprise.
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1.82.1 Use Case
In this case, we are using the Delimited File Source to extract our source data. You can download this sample data
from here.

The source file contains customers’ contact information including their name, address, postal code, phone number,
etc.

Upon previewing the data, you can see that it is difficult to decipher fields and elements since the data is in a single
text stream with fields and records separated by delimiters. To make sense of this data, each records needs to be parsed
into its elements in respective fields.
To do that, we will use the Delimited Parser object.
Using Delimited Parser
1. To get the Delimited Parser object, go to Toolbox > Text Processors > Delimited Parser and drag and drop the
object onto the designer.

You can see that the dragged object contains a single Text field.
2. Map the Customer_Info field inside the source object onto the Text field inside DelimitedParser object.

1.82. Delimited Parser
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3. Right-click on the object’s header and go to Properties.
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A configuration window will open as shown below.

1.82. Delimited Parser
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Let’s look at the properties on this window.
• Parse Data Pattern – contains three patterns in which the dataset can be parsed:

– Single Record – data is parsed into a single record with multiple fields. Users need to provide a field
delimiter, and a text qualifier, if necessary.
– Multiple Records – data is parsed into multiple records with a single or multiple fields. Users need to
provide a field delimiter as well as a record delimiter.
– Field Arrays – data is parsed into an array of records and fields. Users need to provide a field value
delimiter and an array separator.
The source data in this case contains multiple records with many different fields. Therefore, we will set the Parse Data
Pattern option to Multiple Records.
4. Provide a Field Delimiter and a Record Delimiter. The source file also contains a Text Qualifier.
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Click Next. This is the Layout Builder screen.

1.82. Delimited Parser
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5. Here, write the names of the fields that you want to create.

Click OK. The Delimited Parser object now has new fields in the Output node.
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To preview data, right-click on the object’s header and select Preview Output from the context menu.

1.82. Delimited Parser
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A Data Preview window will open. Upon expanding the records, you can view the parsed output.

To store this parsed output, you can write it to a destination file or use it for some transformation further in the dataflow.
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This concludes using the Delimited Parser in Astera Centerprise.

1.83 Delimited Serializer
The Delimited Serializer converts a structured data set into a single text stream with fields and records separated by
delimiters or identified by text qualifiers. A serialized data with delimiters allows sharing or storage of the data in a
form that allows recovery of its original structure.
In this document, we will learn how to use a Delimited Serializer to serialize a structured data in Astera Centerprise.

1.83.1 Use Case
In this case, we are using the Customers table from the Northwind database. You can download this sample data from
here.

The source file contains customer’s contact information including their contact name, address, postal code, phone
number, etc., in a structured format.

1.83. Delimited Serializer
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We want to convert the information contained in multiple fields into a single text stream separated by a delimiter.
To perform this task, we will use the Delimited Serializer object in Astera Centerprise.
Using Delimited Serializer
1. To get the Delimited Serializer object, go to Toolbox > Text Processors > Delimited Serializer and drag and drop
the object onto the designer.

You can see that the dragged object contains a Text field with an output port and an Input sub-node which is currently
empty.
2. Auto-map source fields by dragging and dropping the top node of the source object, that is Customers, onto the
input node of transformation object – Delimited Serializer.
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3. Right-click on the object’s header and go to Properties.

1.83. Delimited Serializer
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A configuration window will open as shown below.
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Let’s look at the properties on this window.
• Field Delimiter – allows users to specify a delimiter for the source fields from the dropdown list.
• Text Qualifier – allows users to specify qualifiers at the start and end of a text stream. In most cases, text qualifier
encloses an entire record.
• Build Operation Type – contains two options in which a dataset can be serialized:

– One Record Per Input – creates a single text record separated by delimiters for the entire data set
– One Record Per Transaction – creates as many text records as the source file separated by only field
delimiter.
Let’s leave the properties as default and click OK. The data has been serialized.
4. To preview the data, right-click on Delimited Serializer object and select Preview Output from the context menu.

1.83. Delimited Serializer

889

Centerprise, Release 8

A Data Preview window will open showing the serialized data with field delimiters
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To store this serialized output, write it to a destination file or you can use this data further in the dataflow.
This concludes using the Delimited Serializer in Astera Centerprise.

1.84 Language Parser
In v8.2 of Astera Centerprise, we have added language parser functionality to the Expression Builder to enable advanced expressions such as interpolated string and verbatim. This will enable users to compile different values from
incoming datasets into an expression and present it as an interpolated string in the output.
In this article, we will look at a use case and understand how the language parser works in Astera Centerprise.

1.84.1 Use Case
We have some employee data from a fictitious organization stored in an Excel spreadsheet. We will work with that
data to create:
• An interpolated string
• A verbatim string
We will be using the fields in the Employee data Excel sheet and interpolate the data into an EmployeeInfo string.
After string interpolation, we will create a new field to apply escape characters inside an expression transformation
object through a verbatim string.
Astera Centerprise also provides an extensive and detailed support for error information that may occur while data
parsing and string interpolation. We will use some examples to see how error information works in Astera Centerprise.

1.84. Language Parser
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Follow through the steps below to see how it works:
1. Retrieve the source data.
Note: In this case, the source data of Employees is stored in an Excel file. We will extract it using the Excel File
Source object in a dataflow.

2. Next, get the Expression Transformation object to create string expressions. Map fields from the Excel source
object ( EmployeeData).
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3. Right-click on the Expression transformation object and go to Properties. A Layout Builder will open from where
you can go to the Expression Editor and define the expression for each field.

1.84.2 Interpolated String
Let’s discuss how to create an interpolated string in an Expression transformation object.
1. Create a new field in the Layout Builder. Since this field will only return an output, we will check the Output box
and set the data type as ‘String.’ In this case, we have named the new field as EmployeeInfo.

1.84. Language Parser
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2. In the Expression Editor, we will define the Interpolated String Expression for the new field. You can either write
the expression in the given field or click on the ellipses in the left corner of the field to go to the Expression Editor.
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3. The interpolated string expression will be built in the Expression box.

1.84. Language Parser
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• It is important to note that an interpolated string expression starts with a dollar ($) sign. The $ notation denotes
the parameters or the variables in the string which will be parsed dynamically during the preview and runtime
for each record in the source file.
Here, we will create an interpolated string using the EmployeeID, LastName, FirstName, Title, TitleOfCourtesy,
HireDate and City fields from our source data.
The interpolated string expression in this case will be written as:
$”{TitleOfCourtesy} {FirstName} {LastName} from {City} was hired on {HireDate} and works as {Title}”
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During both the preview and the runtime, the variables or the parameters enclosed in {} will take input from the source
data and return the output for each record in new field ‘EmployeeInfo.’ Here’s an example of the parameter and the
source value for the first record:
Hence, the output of the interpolated string for the first record will return as: “Ms. Nancy Davolio from Seattle was
hired on 01/04/06 and works as Sales Representative.”
4. Now if we look at the preview, you can see that a new field ‘EmployeeInfo’ has been created and the interpolated
string output for each record has been returned in that field.

1.84.3 Verbatim String
Let’s go over how to use a Verbatim String with a line break in an Expression transformation object.
1. Create a new field in the Layout Builder for the verbatim string. Since this field will only give an output, we will
check the Output box and set the data type as ‘String’. In this case, we will name the new field as office.

1.84. Language Parser

897

Centerprise, Release 8

2. In the Expression field of the Layout Editor, we will define the verbatim string expression for that field. You can
either write the expression in the corresponding expression field or click on the ellipses in the left corner of the field
to enter the Expression Editor.
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3. The verbatim string expression will be built in the Expression box on the Expression Builder screen.

1.84. Language Parser
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4. It is important to note that verbatim string only works with an at the rate (@) sign before the expression and returns
the value as it is, throughout the output field.
In this example, we want the following output to be returned in the Office field that we created:
Output:
Office
North Street, 301, San Francisco
The verbatim string expression to achieve this output will be written as:
@”Office
North Street, 301, San Francisco”
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5. The output preview will show the verbatim string upon hovering over values in the verbatim field or you can also
export it to any destination to view the data.

1.84.4 Error Info
The error information feature in Centerprise has now been improved to provide more comprehensive information
about errors to the users in real time. The information that it now provides is more precise and specific which helps in
debugging errors as you build expression logics.
Let’s work on a few examples to explore how the error information functionality has been improved and how it can
help in resolving errors and successfully compiling expressions in the Expression Builder.
Note: Three of the common error messages are being discussed below, there can be other error messages as well.

1.84. Language Parser
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1. Unexpected Token:

For an incomplete expression, it will instantly notify that the expression status is Not Compiled and further gives a
message explaining that there is an unexpected token which expects an expression further to compile the expression
successfully.
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2. Unterminated String Literal:

Unterminated String Literal means that a string variable is not closed properly, either because of an un-escaped character in it, or a line break. Hence, it won’t compile till the expression is closed.
Successful Compilation of the Error:

1.84. Language Parser
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The string has now been closed and the Compile Status has been updated to Successful.
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3. Invalid Identifier

The Invalid Identifier message appears when a field name is not valid. If you look at the given object, there is no field
by the name “TitleCourtesy”; hence the invalid identifier error. The available field is TitleOfCourtesy.
This concludes using the Language Parser functionality in Astera Centerprise.

1.85 Fixed Length Parser
Fixed Length Parser processes a stream of fixed length data as an input and give elements as parsed output. This is
useful when the source data is in text format (information is contained in a single field) and it needs to be put into
multiple fields for further integration.
In this document, we will learn how you can use Fixed Length Parser in Astera Centerprise.

1.85.1 Sample Use-Case
The sample data that we are using is a fixed length text file containing customers’ information.

1.85. Fixed Length Parser
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Observe that all the information such as name, street number, street type, city, state and zip code are concatenated
in a single field. Now we want to parse the Contact_Details field into Name, Street Number, Street Type and other
respective fields.
To parse the data into separate fields, we will use Fixed Length Parser object in Centerprise.
Extracting Data
To parse the data, we first have to extract it. Since the data is stored in a continuous stream, can not extract it directly
using a Fixed Length File Source object. Therefore, we will use a combination of transformations to get the desired
outcome. The diagram below explains the process that we’ll be following, right from extraction to to parsing the data.
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Let’s begin with extracting the data.
1. Go to Toolbox > Transformations > Constant Value and drag-and-drop the Constant Value object onto the designer.

2. Right-click on the object’s header and select Properties from the context-menu.

1.85. Fixed Length Parser
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3. In the Constant Value section, provide the file path of the source file (file containing customers data in a stream).
Click OK.
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4. Next, go to Toolbox > Function Transformations > Files > ReadFileText(String filePath) - String and drag-anddrop the object onto the designer.

You an see that the dragged transformation object has two sub-nodes - Input and Output.
5. Expand the Input node and map the Value field from the Constant Value Transformation object to the filePath
field inside the Read File Text object.

This will redirect Centerprise to read the data from the given file path. Now we can use the Fixed Length Parser object
to parse the text data into separate fields.
Using Fixed Length Parser
1. To get the Fixed Length Parser object, go to Toolbox > Text Processors > Fixed Length Parser and drag-and-drop
the object onto the designer. Map the Value field, under the Read File Text object, onto the Text field inside the Fixed
Length Parser object.

1.85. Fixed Length Parser
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You can see that the dragged-object also contains an Output sub-node which is currently empty.
2. Configure the Fixed Length Parser object by right-clicking on its header and going to Properties.

3. A properties window will open. Here you will see three options, make sure to check the first two options.
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4. Click Next and you will be directed to a Source Fields window.

1.85. Fixed Length Parser
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Here, you have to provide the name of each field that you want to parse the source date into, as shown below.
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5. Click OK. Now expand the Output node inside Fixed Length Parser object, you will see all the fields that you
have created in the previous step.

6. Right-click on the object’s header and select Preview Output from the context menu.

1.85. Fixed Length Parser
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A Data Preview window opens up. Expand the node and you will see a parsed output of each record.
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To store this parsed output, write it to a destination file.
Writing to a Destination
1. Right-click on the Output sub-node inside the Fixed Length Parser object, go to Write to > Excel Workbook
Destination. An Excel Workbook Destination object is added to the dataflow designer with auto-mapped fields.

2. Configure settings for Excel Workbook Destination object.
Learn how to configure settings for Excel Workbook Destination from here.
3. Click on the Start Dataflow button placed in the toolbar at the top to create this destination file.

1.85. Fixed Length Parser
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1.86 Fixed Length Serializer
Fixed Length Serializer is useful when source data is stored in multiple fields and is to be converted to text format
(store entire data in a single field). This is helpful is scenarios where you have to:
• Store large datasets, so you compress the information in a single field
• Transport volumes of data over a network
In this document, we will learn how to use Fixed Length Serializer in Astera Centerprise.

1.86.1 Sample Use-Case
In this case, we are using an Excel Workbook Source.
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The source file contains customers’ contact details.
To preview data, right-click on the header of source object and select Preview Output from the context menu.

A Data Preview window will open, displaying the source data.

1.86. Fixed Length Serializer
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Now, we want to convert the information contained in multiple fields into a single field in text format.
To perform this task, we will use Fixed Length Serializer object in Astera Centerprise.
Using Fixed Length Serializer
1. To get the Fixed Length Serializer object, go to Toolbox > Text Processors > Fixed Length Serializer and dragand-drop the object onto the designer.

You can see that the dragged-object contains a Text field and an Input sub-node which is currently empty.
2. Auto-map source fields by dragging-and-dropping top node of the source object, ContactDetails onto the Input
node of transformation object – Fixed Length Serializer.

3. Right-click on the object’s header and go to Properties.
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A configuration window will open as shown below.

1.86. Fixed Length Serializer
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4. Check the options according to the contents and format of your source file.
In this example, both options have been checked as the first row in the source file contains header and the data also
contains multiple records.
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5. Specify the Record Delimiter of the source data. In this case, it is <CR><LF>.
You can specify any delimiter based on the format of your source file.

1.86. Fixed Length Serializer
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6. Under the Builder Options, select the relevant type from the drop-down list. For this dataset, we will use One
Record Per Input.
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7. Click Next. This will bring you to the Destination Fields screen where you can see all the incoming fields from the
source object.

1.86. Fixed Length Serializer
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Here you can delete fields, change their Header or Data Type, modify Start Position of the string, define field Length
and customize the fields according to your requirements.
Click OK.
8. Right-click on the Fixed Length Serializer object and select Preview Output.
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A Data Preview window will open, displaying the serialized data.

1.86. Fixed Length Serializer
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To store this serialized output, write it to a destination file.
9. Right-click on FixedLengthSerializer node, go to Write to > Fixed Length File Destination. A Fixed Length
File Destination object is added to the dataflow designer with Text field auto-mapped to it.

10. Configure settings for Fixed Length File Destination object.
Learn to configure settings for Fixed Length File Destination from here.
11. Click on the Start Dataflow button placed in the toolbar at the top to create the destination file.
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A fixed length file destination file will successfully be created. You can find its link in the Job progress window.

1.87 XML/JSON Parser
XML/JSON parser reads and processes a single text stream of hierarchical data and give elements as parsed output in
XML/JSON format.

1.87.1 Sample Use-Case
In this case, we are using an Excel Workbook Source.

The source file contains details of customers’ orders.
To preview data, right-click on header of the source object and select Preview Output from the context menu.

1.87. XML/JSON Parser
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A Data Preview window will open, displaying the source data.

Observe that it is difficult to decipher fields and elements when the data is in a text stream. To make sense of this data,
it needs to be structured in a proper format, with fields and collection regions clearly identified.
To parse this source data, we will use XML/JSON Parser in Astera Centerprise.
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Using XML/JSON Parser
1. To get the XMl/JSON Parser object, go to Toolbox > Text Processors > Parser and drag-and-drop the object onto
the designer.

You can see that the dragged object contains a Text field.
2. Map the Text field in Customer_Orders object to the Text field in XMLJSONParser object.

3. Right-click on the object’s header and go to Properties.

1.87. XML/JSON Parser
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A configuration window will open as shown below.
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4. Provide the XML schema path. Centerprise will parse the text file based on the structure defined in the schema file.

1.87. XML/JSON Parser
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Click Next. This is the Layout Builder screen where the final layout of the incoming fields and the collection regions
can be seen.
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Click OK. The data stream is parsed into regions and fields which can be seen on the XMLJSON Parser object.

1.87. XML/JSON Parser
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5. Right-click on the object’s header and select Preview Output from the context menu.
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A Data Preview window opens up. Expand the node and you will see parsed output for each record.

To store this parsed output, write it to a destination file.

1.87. XML/JSON Parser
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6. Right-click on Customer_Orders node under XMLJSON Parser object, go to Write to > Database Table Destination. A Database Table Destination object is added to the dataflow designer with all fields auto-mapped to it.

7. Configure settings for Database Table Destination object.
Learn to configure settings for Database Table Destination from here.
8. Click on the Start Dataflow button placed in the toolbar at the top to create the destination file.

A database table will be created successfully with parsed output in XML format.

1.88 XML/JSON Serializer
XML/JSON Serializer reads hierarchical data and converts it into a text stream. It is basically the conversion of data in
structured format to a single stream in a text-like format.

1.88.1 Sample Use-Case
In this case, we are using an XML/JSON File Source.
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The XML/JSON File Source contains the hierarchical data of customers, their orders, and the order details.
Right-click on the header of the XML/JSON File Source object and select the Preview Output option to visualize the
hierarchical data.

1.88. XML/JSON Serializer
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View the source data from the Data Preview window.

Now, to convert this hierarchical data into a single text stream, we will use the XML/JSON Serializer object.
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1.88.2 Steps to Use the XML/JSON Serializer Object
1. Select the XML/JSON Serializer object from the toolbox window and drag-and-drop it onto the dataflow designer.

2. Right-click on the header of the XML/JSON Serializer and select the Properties option from the context menu.

A configuration window will open, as shown below.

1.88. XML/JSON Serializer
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3. Provide the file path for the XML Schema i.e., the structure or layout of the XML File.
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• Check the JSON Format option if your file is a JSON.

1.88. XML/JSON Serializer
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Click on Next. This is the Config Parameters window, which allows us to configure and define certain parameter for
the XML Serializer Source file.
Use of Parameters eliminates the process of inserting hardcoded values and provides simplification in the deployment
of flows. If the parameters are left empty, the default values defined at the Properties window are assigned for use.
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Now, click on OK to proceed further.
4. Map the fields of the XML/JSON File Source object onto the XML/JSON Serializer object’s fields.

5. Right-click on object’s header and select Preview Output.

1.88. XML/JSON Serializer
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You can view the data through Data Preview window.

Hover over the Text field and you will see the Serialized output i.e., stream of text for each hierarchical record of the
XML/JSON file.
To store the Serialized Output, we must write it to a destination file.
6. Right-click on the XmlJsonSerializer, click on Write To and select your desired destination object. A destination
object is created on the dataflow designer with the Text field auto-mapped.
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Here, we have used an Excel Workbook Destination object.
7. Right-click on the destination object’s header and provide the file path for the destination file. Select the relevant
options and click OK.

By running this dataflow, you can now create an Excel file containing the serialized XML output.

This is how an XML Serializer Object can be used in Astera Centerprise to format hierarchical data into a single stream
of text.

1.88. XML/JSON Serializer
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1.89 Setting Up IBM DB2/iSeries Connectivity in Centerprise
DB2 is a relational database management system that works with database servers developed by IBM. They are designed to deliver high data performance and availability. Its operational database is supported across Linux, Unix,
Windows, and iSeries (AS/400). Astera Centerprise provides native connectivity to DB2 or iSeries database using
database objects such as Database Table Source, Database Table Destination, Database Connection, and Database
Lookup.
To connect to DB2 iSeries databases using IBM DB2, you need to have the appropriate driver installed on the host
where Centerprise client and/or server runs.
Let’s look at the steps involved in connecting to IBM DB2 servers on different operating systems. .

1.89.1 IBM DB2 for Linux, Unix, and Windows
To connect to the IBM DB2 database in Astera Centerprise, no additional installations or licenses are required. You can
connect to it using any database object in Astera Centerprise by selecting the DB2 Data Provider from the drop-down
list on the object’s connection screen. And provide credentials for your DB2 account.
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To learn more, follow the steps under the heading Connecting to DB2 Database in Astera Centerprise.

1.89.2 IBM DB2 for iSeries (AS/400)
To connect to IBM DB2 server on iSeries (AS/400), you need to set up the license certificate.
If the DB2Connect driver is not already installed, instal it on your machine and follow the steps below to set up the
license certificate.
Note: DB2Connect driver should be of version 11.5 and onwards.

1.89. Setting Up IBM DB2/iSeries Connectivity in Centerprise
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• Visit the IBM website at ibm.com and navigate to the IBM support page. And log in to your IBM account.
• Open the link given below.
https://www.ibm.com/docs/en/db2/11.5?topic=configuring-db2-licenses
Note: This link is provided for your convenience. It is working as of the time of writing this article. However, please
note that IBM may change this link in the future.
• Scroll down to Table 1.
db2consv_is.lic.

DB2 License Certificate Files and select the license certificate file named

• Once you have the file downloaded, place the file in the license folder of Astera Centerprise Integration Server.
To do that go to Program Files > Astera Software > Astera Integration Server 8 > clidriver > License and
place the file here.
Or you may follow the path below:
C:\Program Files\Astera Software\Astera Integration Server 8\clidriver\License
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• To use the license file, you need to get it activated through IBM. Refer to the link below.
https://www.ibm.com/docs/en/db2/11.1?topic=li-activating-license-certificate-file-db2-connect-unlimitededition
• Once the license is registered, you can connect to iSeries in Astera Centerprise.

1.89.3 Connecting to DB2 Database in Astera Centerprise
Follow the steps below to learn how to connect to a DB2 database in Astera Centerprise.
1. In a new dataflow, go to Toolbox > Source > Database Table Source and drag and drop it on the designer.
2. To configure the connection, right-click on its header and select Properties from the context menu.

1.89. Setting Up IBM DB2/iSeries Connectivity in Centerprise
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This will open a new window where you can configure the connection with the DB2 database.
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3. From the Data Provider drop-down list, select DB2 as your data provider.

1.89. Setting Up IBM DB2/iSeries Connectivity in Centerprise
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4. Put in the required credentials for your DB2 database account.
• User ID
• Password
• Server Name
• Database
• Schema
• Port
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5. Test Connection to make sure that your database connection has been established and click OK.

We’ve have learned about setting up DB2 license for iSeries and connecting to DB2 Database in Astera Centerprise.
To learn more on how to use the Database Table Source object in Astera Centerprise, click here.

1.90 Connecting to SAP HANA Database
SAP HANA is an in-memory, relational database management system used for storing and retrieving data as requested
by applications. Astera Centerprise allows you to connect to SAP HANA databases to read data from or to write
data to its tables through various database objects. The SAP HANA database can be natively connected to through a
database source or a database destination object in Centerprise. We can also use other objects such as lookups, SQL
script task in a workflow, database write strategies and in any other object where connecting to a database is supported
in Centerprise.
To learn more about SAP HANA and its installation, click here.
In this article, we will explore:
1. A use case where a SAP HANA Database is being used in Astera Centerprise
2. Connecting to a SAP HANA database in Centerprise.

1.90.1 Use Case
Let’s use the SAP HANA Database in an ETL process and see how it can integrate data in a dataflow.
We have Orders data in a Database Table Source. We need to get a list of all the orders to be shipped to Brazil.
To learn more about how a Database Table Source works in Astera Centerprise, click here.

1.90. Connecting to SAP HANA Database

953

Centerprise, Release 8

We will use the Filter transformation to filter out records for orders to be shipped to Brazil.
To know more about how a Filter Transformation works in Astera Centerprise, click here.
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If we preview the output, we can see all orders that are to be shipped to Brazil.
![img](connecting-to-sap-hana-database.assets/03-SAPHANA Output.png)
Now, we can write this data to a database using the Database Table Destination in Astera Centerprise. Let’s drag and
drop the Database Table Destination object onto the dataflow designer.

Let’s connect to the SAP HANA Database using the Database Table Destination object.
1. To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

1.90. Connecting to SAP HANA Database
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As soon as you’ve selected the Properties option from the context menu, a new window will open.
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This is where you can configure conenction with the database.
2. The first step is to select the Data Provider from the list. We’ll select SAP HANA as our data provider in this case.

1.90. Connecting to SAP HANA Database
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• Put in the required credentials for your SAP HANA data provider account.
•

1. User ID
2. Password
3. Server Name
4. Database
5. Schema
6. Port
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• Test Connection to make sure that your database connection is successful and click Next.

1.90. Connecting to SAP HANA Database

959

Centerprise, Release 8

Once the connection is established, you can Pick Table or Create Table and modify Writing Options for SAP HANA
Database on the Properties screen.
The Database Table Destination object has some specific data writing options for SAP HANA. On the Pick Table
screen, there is an added option for Table Type.
The SAP HANA databases support two types of tables for Column and Row based storage, where the data can be
stored either in a column table or a row table.
To learn more about Column and Row based data storage, click here.
In the Table Type drop-down, you have two options:
1. Column Stored Table
2. Row Stored Table
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For this use case, we will Create a new table and set the Table Type as Column Stored Table.
To read more on other different data writing options in a Database Table Destination, click here.

1.90. Connecting to SAP HANA Database
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You have successfully configured SAP HANA as your database provider for your Database Table Destination object.
The data will now be written to the SAP HANA Database once we run the dataflow.

This concludes connecting to the SAP HANA Database in Astera Centerprise.
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1.91 Connecting to MariaDB Database
MariaDB is a database management system used for storing data in a structured format and making it accessible for
use through different tools and applications. Astera Centerprise offers native connectivity for MariaDB databases at
both source and destination points. The connectivity also extends to other objects such as Database Lookup, SQL
Query Lookup, SQL script task in a workflow, and Database Write Strategies.
To learn more about MariaDB and its installation, click here.
In this article, we will cover:
1. Connecting to MariaDB in Astera Centerprise
2. Data reading options available for MariaDB database
3. A use case to see how you can work with MariaDB databases in Centerprise

1.91.1 Use Case
To configure connection with MariaDB databases, we’ll be using the Database Table Source object.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

As soon as you’ve selected the Properties option from the context menu, a new window will open.

1.91. Connecting to MariaDB Database
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This is where you configure the connection with the database.
2. The first step is to specify the Data Provider for the source object.
Select MariaDB as your data provider from the list.
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• Put in the required credentials for your MariaDB data provider account.
•

1. User ID
2. Password
3. Server Name
4. Database
5. Schema

1.91. Connecting to MariaDB Database
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6. Port

• Test Connection to check that your database connection is successful and click Next.
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Once the connection is established, you can Pick Source Table and modify Reading Options for MariaDB Database
on the Properties window.
To read more on different data reading options in a Database Table Source, click here.
You have now successfully configured MariaDB as the database provider for your Database Table Source object. The
fields from the source object can now be mapped to other objects in a dataflow.

1.91. Connecting to MariaDB Database
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Let’s use the data from the selected table from the MariaDB Database table in a dataflow.
In this example, we have sourced Customers data from the database. We need to filter out data of customers with the
contact title ‘Sales Representative.’
We will use the Filter transformation to filter out records of customers who are Sales Representatives.
To know more about how a Filter Transformation works in Astera Centerprise, click here.
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If we preview the output, we have filtered records for customers with the contact title as Sales Representatives.

Now, we can write this data to a destination in Astera Centerprise.

1.91. Connecting to MariaDB Database
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In this case, we’ve written the data to an Excel Workbook Destination.

We have successfully connected to MariaDB Database and completed our use case in Astera Centerprise.
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1.92 Connecting to Salesforce Database
Salesforce is one of the most commonly used Customer Relationship Management (CRM) solutions. It allows businesses to use cloud technology to better connect with partners and potential customers. Astera Centerprise offers
Salesforce database connectivity at both source and destination points. The connectivity also extends to other objects
such as Database Lookup, SQL Statement Lookup in Transformations and SQL Script Task in a workflow.
To learn more about Salesforce and its products, click here.
In this article, we will cover:
1. Connecting to Salesforce in Astera Centerprise
2. Data reading options for Salesforce databases
3. A use case to see how Salesforce can be configured for use in Astera Centerprise

1.92.1 Use Case
To connect to a Salesforce database, we’ll be using the Database Table Source object.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

As soon as you’ve selected the Properties option from the context menu, a new window will open.

1.92. Connecting to Salesforce Database
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This is where you can configure connection with the Salesforce database.
2. The first step is to select the Data Provider. Select Salesforce as your data provider from the drop-down list.
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• Put in the required credentials for your Salesforce account.
•

1. User
2. Password
3. Security Token

1.92. Connecting to Salesforce Database
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The following options are available:
o Retrieve deleted items - to include items that were previously deleted.
o Connect to sandbox - to create a new connection to Sandbox completely isolated from your actual Salesforce
account.
• Test Connection to make sure that your database connection is successful and click Next.
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Once the connection is established, you can Pick Source Table and modify Reading Options for your Salesforce
database on the Properties screen.
To read more on different data reading options in a Database Table Source, click here.
You have successfully configured Salesforce as your database provider for your Database Table Source object. The
fields from the source object can now be mapped to other objects in a dataflow.

1.92. Connecting to Salesforce Database
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Let’s use the data from the configured Salesforce table in a dataflow.
We have Employee Contact Details data in the table. We need a list of all employees in the Finance department so that
they can be listed for an audit.
We will use the Filter transformation to filter out records of Finance Employees.
To know more about how a Filter Transformation works in Astera Centerprise, click here.
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If we preview the output, we can see records of all the Employees working in the Finance Department.

Now, we can write this data to a desired destination in Astera Centerprise.

1.92. Connecting to Salesforce Database
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In this case, we’ve written this data to an Excel Workbook Destination.

We have successfully connected to Salesforce Database table and completed our use case in Astera Centerprise.
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1.93 Connecting to Salesforce – Legacy Database
Salesforce - Legacy is an acclaimed customer relationship management (CRM) platform used by enterprises across the
globe. Astera Centerprise offers in-built connectivity to Salesforce - Legacy databases at both source and destination
points. The connectivity also extends to other objects such as Database Lookup, SQL Statement Lookup in Transformations, SQL Script Task in a Workflow, Database Diff Processor and Slowly Changing Dimensions in Database
Write Strategies.
In this article, we will learn to configure Salesforce - Legacy as a data provider in Astera Centerprise. We will be using
the Database Table Source object to establish the connection with the Salesforce - Legacy database.
1. To configure the properties of a Database source, right-click on the header and select Properties.

1.93. Connecting to Salesforce – Legacy Database
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2. This will open a new Database Connection window where you need to provide details to configure connection with
the database.
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3. On the Database connection window, select Salesforce - Legacy from the from the Data Providers drop-down list.

1.93. Connecting to Salesforce – Legacy Database
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4. Provide the credentials to your Salesforce - Legacy account.
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There are following options available for Salesforce - Legacy settings:
Retrieve deleted items - includes items that were previously deleted.
Connect to sandbox - creates a new connection to Sandbox completely isolated from your actual Salesforce - Legacy
account.
5. Test Connection to make sure that your connection has been established with Salesforce - Legacy database. When
the connection is established, click Next.

1.93. Connecting to Salesforce – Legacy Database
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The connection to Salesforce - Legacy database has been established successfully. You can now pick a table from
Salesforce - Legacy database and use the data in your dataflow. To learn more about how to pick a table from a
database source and specify other reading options, click here.
This concludes connecting to Salesforce - Legacy database in Astera Centerprise.

1.94 Connecting to Vertica Database
Vertica is one of the fastest and scalable advanced analytics platforms, trusted by data-driven enterprise across the
globe. It is a column-oriented relational database, which means that the data is stored in columns instead of rows. This
reduces the memory consumption and disk I/O. Vertica databases are designed to manage large and growing volumes
of data and provide fast query performance when used for data warehouses and other query-intensive applications.
Astera Centerprise offers native connectivity to Vertica databases at both source and destination points. The connectivity also extends to other objects such as Database Lookup, SQL Statement Lookup in transformations, SQL Script
Task in a workflow, Database Diff Processor and Slowly Changing Dimensions in Database Write Strategies.

To learn more about Vertica and its installation, click [here](https://www.vertica.com/docs/9.2.x/HTML/Content/Authoring/InstallationG
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Vertica|Installing Manually|_____1)
In this article, we will cover:
1. A use case where Vertica Database is being used in Astera Centerprise
2. Connecting to a Vertica database in Centerprise
3. Different data writing options for a database destination in Centerprise

1.94.1 Use Case
In this use case, we’ll be connecting to a Vertica Database and integrate data from it in a dataflow.
We have Sales by Category data for a month, in a Database Table Source and we want to calculate the total amount
of sales closed for each category.
To learn more about how a Database Table Source works in Astera Centerprise, click here.

We will use the Aggregate transformation and apply Sum function to the ProductSales field while grouping the dataset
by CategoryID.
To know more about how the Aggregate Transformation works in Astera Centerprise, click here.

1.94. Connecting to Vertica Database
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If we preview the output, we can see the total product sales for each category.

Next, we can write this data to a database table using the Database Table Destination in Astera Centerprise.

986

Chapter 1. Other Versions

Centerprise, Release 8

We’ll be using the Database Table Destination object.
1. To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

As soon as you’ve selected the Properties option from the context menu, a new window will open.

1.94. Connecting to Vertica Database
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This is where you can configure the properties for the Database Table Destination object.
2. The first step is to specify the Database Connection for the source object.
Select Vertica as your data provider from the drop-down list.
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• Put in the required credentials for your Vertica data provider account.
•

1. User ID
2. Password
3. Server Name
4. Database
5. Port

1.94. Connecting to Vertica Database
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• Test Connection to make sure that your database connection is successful and click Next.
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Once the connection is established, next you can Pick Table or Create Table and modify Writing Options for Vertica
Database on the Properties screen.
To read more on the different data writing options available for a database table, click here.

1.94. Connecting to Vertica Database
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You have successfully configured Vertica as your database provider for the Database Table Destination object. The
data will now be written to the Vertica Database once the dataflow is run.

We have successfully connected to Vertica Database and completed our use case in Astera Centerprise.

1.95 Connecting to Snowflake Database
Snowflake is an enterprise-ready data warehouse designed for the cloud. It uses a central data repository that makes
data management easier, secure, and more accessible. Astera Centerprise provides native connectivity to Snowflake
databases through its database objects. The connectivity can also be established through the Database Table Source,
Database Table Destination, SQL Query Source, Database Lookup, SQL Query Lookup, and Database Write Strategies in Astera Centerprise.
In this article, we will cover:
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1. A use case where Snowflake is being used as a database in Astera Centerprise
2. Connecting to Snowflake databases in Centerprise
3. Different data loading and reading options for Snowflake databases in Centerprise

1.95.1 Use Case
We have some sample Orders and Customer data stored in a Snowflake database. The data contains multiple fields
containing orders and customer information. We want to join both the tables to have a consolidated view of this
information.
We’ll be using the Database Table Source object to source data from the Snowflake database.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

This will open a new window where you can configure connection with the Snowflake database.

1.95. Connecting to Snowflake Database
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2. The first step is to select the Data Provider. Select Snowflake as your data provider from the drop-down list.
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• Put in the required credentials for your Snowflake account.
1. User ID
2. Password
3. Server Name
4. Account
5. Database

1.95. Connecting to Snowflake Database
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6. Warehouse
7. Schema
8. Role

• Test Connection to make sure that your database connection has been established and click Next to proceed to
the next screen.
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3. Here, you can Pick Source Table and modify Reading Options for your Snowflake database.

1.95. Connecting to Snowflake Database
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Note: In this case, we will select the Orders table.
To learn more about data reading options in a database table source, click here.
Since we want to join two tables, we’ll get the Customers table on the dataflow using the same steps.
• You can use the Recently Used option on the connection screen to connect to the Snowflake database using the
previously used credentials.
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On the Pick Table screen, we will pick the Customers table from the database.

1.95. Connecting to Snowflake Database
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4. Now, we will use the Join transformation and provide the key fields for both the tables in the dataflow.
To know more about how the Join Transformation works in Astera Centerprise, click here.
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5. Next, we will write this data to our Snowflake database using the Database Table Destination in Astera Centerprise.
To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

1.95. Connecting to Snowflake Database
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This will open a new window on your screen.
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Here you can configure the properties for the Database Table Destination object.
Since we have previously used Snowflake database to extract our source data, we can use the Recently Used credentials
to connect to it again.

1.95. Connecting to Snowflake Database

1003

Centerprise, Release 8

All the credentials have been filled in automatically.
• Test Connection to make sure that your database connection is successful.
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There is an option on the database connection screen for Snowflake where you can select the Staging Area.
A staging area is a cloud storage location outside the Snowflake environment that allows greater flexibility in loading
data to Snowflake. A stage specifies an area where temporary batches of data files are stored (i.e. “staged”) so that
these files can be loaded into tables.
Astera Centerprise provides connectivity to both staging areas for bulk insertion:
• Amazon S3 storage
• Microsoft Azure storage

1.95. Connecting to Snowflake Database
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Select the Staging Area from the drop-down list.
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Note: In this case we will use the Amazon S3 Bucket for staging.

1.95. Connecting to Snowflake Database
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Once the staging area is selected, you will be required to enter the following credentials:
1. S3 Key
2. S3 Secret
3. S3 Bucket
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1.95. Connecting to Snowflake Database
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Now, Test S3 Connection to see if the Amazon S3 Bucket has been connected.

6. Once the connection is successful, click OK. Now click Next to move to the next screen.
You can Pick Table or Create Table and modify Writing Options for Snowflake Database on the Properties screen.
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Note: In this case, we will create a new table and name it as PUBLIC.ConsolidatedData, where Public is the schema
for the database.
Since we selected the staging area, we will set the Data Load Options as Bulk Insert.

1.95. Connecting to Snowflake Database
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To read more on the different data writing options available for a database table, click here.
Once you’ve set the data reading options, click OK.
We have successfully configured Snowflake as our database provider for the Database Table Destination object. The
data will now be written to the Snowflake database once the dataflow is run.
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If we now preview the data in the database table, we can see that the details for all the orders placed by customers have
been written into the destination table.

1.95. Connecting to Snowflake Database
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We have successfully connected to Snowflake Database and completed our use case in Astera Centerprise.

1.96 Connecting to Amazon Redshift Database
Amazon Redshift is one of the most popular, fully managed cloud data warehouse services. It allows users to work
with large scale data workloads for analytics which can further help in compiling reports for various business functions.
It is popular for data storage due to its scalability, speed, and efficient compression features which process bulk loads
of data.
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Astera Centerprise offers code-free connectivity to Amazon Redshift databases at both source and destination points.
These databases can also be connected for use in other functionalities such as Database Lookup, SQL Query Lookup,
and Database Write Strategies depending on the type of business decisions to be performed.
To learn more about Amazon Redshift Databases, click here.
In this article, we will cover:
1. A use case where Amazon Redshift Database is being used in Astera Centerprise
2. Connecting to an Amazon Redshift database in Centerprise
3. Different data loading and reading options for Amazon Redshift database objects in Centerprise

1.96.1 Use Case
We have some sample Invoice data stored in an Amazon Redshift database table. The data contains information about
the orders placed by customers. We want to aggregate records of customer orders to find the sum of the price and the
quantities ordered by each customer. We will then create a new table in the Amazon Redshift database and write this
data to it.
We’ll be using the Database Table Source object to source data from the Amazon Redshift database.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

This will open a new window where you can configure connection with the Amazon Redshift database.

1.96. Connecting to Amazon Redshift Database
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2. The first step is to select the Data Provider. Select Amazon Redshift as your data provider from the drop-down list.
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• Put in the required credentials for your Amazon Redshift account.
1. User ID
2. Password
3. Server Name
4. Database
5. Port

1.96. Connecting to Amazon Redshift Database
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• Test Connection to make sure that your database connection is successful and click Next to proceed to the next
screen.

1018

Chapter 1. Other Versions

Centerprise, Release 8

1.96. Connecting to Amazon Redshift Database
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3. Here, you can Pick Source Table and modify Reading Options for your Amazon Redshift database.
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Note: In this case, we will select the Invoices table.
To learn more about data reading options in a database table source, click here.
4. Now, we will use the Aggregate transformation to group customer records and find the sum of unit price and
quantities for each.
To know more about how the Aggregate Transformation works in Astera Centerprise, click here.

1.96. Connecting to Amazon Redshift Database
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5. Next, we will create a new table in the Amazon Redshift database and write the transformed data to that table using
the Database Table Destination in Astera Centerprise.
To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

This will open a new window on your screen.
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Here you can configure the properties for the Database Table Destination object.
The first step is to specify the Database Connection for the destination object. Select Amazon Redshift as your data
provider from the drop-down list.
Alternatively, you can use the Recently Used drop-down and select Amazon Redshift connection from the list, since
you have connected to it previously while configuring the source object.

1.96. Connecting to Amazon Redshift Database
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• Put in the required credentials for your Amazon Redshift data provider account.
1. User ID
2. Password
3. Server Name
4. Database
5. Port
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• Test Connection to make sure that your database connection is successful.

1.96. Connecting to Amazon Redshift Database
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If you’re using the Bulk Insert option for loading the data into the Amazon Redshift database, there is an option to
provide S3 Bucket Credentials for Amazon Redshift.
The S3 Credentials require:
1. S3 Key
2. S3 Secret
3. S3 Bucket
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In this case, we will provide the credentials to the S3 Bucket since we’ll be loading the data through bulk insert with
batch size.
• Test S3 Connection to check if the bucket has been connected successfully. Click OK and then Next to proceed
1.96. Connecting to Amazon Redshift Database
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to the next screen.

On the next screen, you can Pick Table or Create Table and modify Writing Options for Amazon Redshift Database
on the Properties screen.
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Note: In this case, we will create a new table and name it as PurchaseHistory.
To read more on the different data writing options available for a database table, click here.
There are different Data Load Options for Amazon Redshift data provider, we will select Bulk Insert with Batch Size
since we’ve connected to the Amazon S3 Bucket and adjust the batch size to 1000.

1.96. Connecting to Amazon Redshift Database
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Once you’ve set the data reading options, click OK.
We have successfully configured Amazon Redshift as your database provider for the Database Table Destination
object. The data will now be written to the Amazon Redshift Database once the dataflow is run.

1030

Chapter 1. Other Versions

Centerprise, Release 8

If we preview the output for the destination object, we can see that the summed up unit price and quantities for each
customer record have been written into the destination table.

1.96. Connecting to Amazon Redshift Database
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We have successfully connected to Amazon Redshift Database and completed our use case in Astera Centerprise.

1.97 Connecting to Amazon Aurora Database
Amazon Aurora is a fully managed relational database engine that is compatible with MySQL and PostgreSQL. It is a
part of Amazon’s Relational Database Service (Amazon RDS) - a managed database web service that makes it easier
to set up, operate, and scale a relational database on the cloud.
To learn more about Amazon Aurora, click here.
In Astera Centerprise, users can connect with Aurora MySQL and Aurora PostgreSQL as a database source or destination, with DB lookup, SQL Statement Lookup, and Database Write Strategies and also with Run SQL Script task in
a workflow.
In this article, we will cover:
1. A use case where Amazon Aurora PostgreSQL is being used as a database in Astera Centerprise
2. Connecting to Amazon Aurora PostgreSQL databases in Centerprise
3. Different data loading and reading options for Amazon Aurora databases in Centerprise
Note: You can connect to both Amazon Aurora PostgreSQL and Amazon Aurora MySQL by following the same steps
as discussed in the use case below.

1.97.1 Use Case
We have some sample Orders data stored in an Amazon Aurora database. The data contains multiple fields containing
information related to orders placed by customers. To make the shipment process more relevant, it is required to use
specific codes for the Country field. We will use a List Lookup transformation and create a new table in the database.
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We’ll be using the Database Table Source object to source data from the Amazon Aurora database.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

This will open a new window where you can configure connection with the Amazon Aurora database.

1.97. Connecting to Amazon Aurora Database
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2. The first step is to select the Data Provider. Select Amazon Aurora PostgreSQL as your data provider from the
drop-down list.
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• Put in the required credentials for your Amazon Aurora PostgreSQL account.
1. User ID
2. Password
3. Server Name
4. Database
5. Schema
6. Port

1.97. Connecting to Amazon Aurora Database
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• Test Connection to make sure that your database connection has been established. Once it’s successful, click
Ok and then Next to proceed to the next screen.
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3. Here, you can Pick Source Table and specify different Reading Options for your Amazon Aurora database.

1.97. Connecting to Amazon Aurora Database
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Note: In this case, we will select the Orders table.
To learn more about data reading options in a database table source, click here.
4. Now, we will use the List Lookup and provide the country codes for the fields.
To know more about how the List Lookup Transformation works in Astera Centerprise, click here.
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5. Next, we will write this data to our Amazon Aurora database using the Database Table Destination in Astera
Centerprise.
To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

1.97. Connecting to Amazon Aurora Database
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This will open a new window on your screen.
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Here you can configure the properties for the Database Table Destination object.
Since we have previously used Amazon Aurora database to extract our source data, we can use the Recently Used
credentials to connect to it again.

1.97. Connecting to Amazon Aurora Database
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All the credentials have been filled in automatically.
• Test Connection to make sure that your database connection has been established.
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Next, you can Pick Table or Create Table and specify different Writing Options for Amazon Aurora Database on the
Properties screen.

1.97. Connecting to Amazon Aurora Database
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Note: In this case, we will create a new table and name it as ShipmentList.
To read more on the different data writing options available for a database table, click here.
Once you have set the data reading options, click OK.
We have successfully configured Amazon Aurora as our database provider for the Database Table Destination object.
The data will now be written to the Amazon Aurora database once the dataflow is run.
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If we now preview the data in the database table, we can see that the Country names have been replaced by their
specific codes and written into the destination table.

We have successfully connected to Amazon Aurora Database and completed our use case in Astera Centerprise.

1.97. Connecting to Amazon Aurora Database
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1.98 Connecting to Google Cloud SQL in Astera Centerprise
Google Cloud SQL is a fully managed database service that makes it easy to set-up, maintain, and manage MySQL
and PostgreSQL relational databases in the cloud.
There are three types of databases supported in Google Cloud.
1. MySQL
2. PostgreSQL
3. SQL Server
All of them can be connected to by following the same steps in Astera Centerprise:

1.98.1 Steps to Connect to Google Cloud SQL via Astera Centerprise
Follow the steps below to connect to Google Cloud SQL via Centerprise:
1. Create an instance in the GCP Console. Once that is done, the following screen will appear.
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2. Go to the CONNECTIONS tab and click on Add network. You will have to enter the public IP of your system from
where you want to access databases. This will enable you to access the databases hosted on GCP.

3. In the USERS tab, create a user account if you don’t have one already.

1.98. Connecting to Google Cloud SQL in Astera Centerprise
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4. Now, in Centerprise:
• Select the relevant database provider (MySQL or PostgreSQL).
• Provide the Username and Password that you created in the step 3.
• Provide the Public IP address in the Server Name as shown in the screenshot below:
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Now, click on Test Connection to see if your connection has been established with the database. When the connection
is established click Next. You can now pick a table from your database and use it in your dataflow.
To learn more about how to pick a table from a database source and specify other reading options, click here.
This concludes connecting to Google Cloud SQL via Astera Centerprise.

1.99 Connecting to MySQL Database
MySQL is a fully managed database service that allows users to meet databases challenges and deploy cloud-native
applications using an open source database. Astera Centerprise offers native connectivity for MySQL databases at
both source and destination points. The connectivity also extends to other objects such as Database Lookup, SQL
Query Lookup, SQL script task in a workflow, and database write strategies.
1.99. Connecting to MySQL Database
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In this article, we will see how we can connect to MySQL as a database source in Centerprise. To establish the
connection, we’ll be using the Database Table Source object.
1. Drag and drop the Database Table Source object from the toolbox onto the dataflow designer. Right-click on its
header and select Properties from the context menu.
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A Database Connection window will open.

1.99. Connecting to MySQL Database
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This is where you configure the properties to establish the connection with the database.
2. On the Database Connection screen, you will find a drop-down list next to the Data Provider option.
Select MySQL as your data provider from this list.

1052

Chapter 1. Other Versions

Centerprise, Release 8

• Put in the required credentials for your MySQL account.

1.99. Connecting to MySQL Database
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• Test Connection to make sure that the database connection is successful and click OK.

1054

Chapter 1. Other Versions

Centerprise, Release 8

The connection to MySQL as your database provider has been successfully established. You can now pick a source
table from MySQL database and use that data in your dataflow.
To learn more about how to pick a table from a database source and specify other reading options, click here.
This concludes connecting to MySQL databases in Astera Centerprise.

1.100 Connecting to PostgreSQL in Astera Centerprise
PostgreSQL is an open source relational database management system that stores data workloads. It helps in managing
all kinds of datasets with its extensive range of features. Astera Centerprise provides connectivity to PostgreSQL
databases through its database objects. You can connect to PostgreSQL databases in Astera Centerprise using the
Database Table Source, Database Table Destination, Database Lookup, SQL Query Lookup, SQL script task in a
workflow, and database write strategies.
In this article we will cover:
1. A use case where PostgreSQL is being used as a database in Astera Centerprise.

1.100. Connecting to PostgreSQL in Astera Centerprise
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2. How to connect to PostgreSQL database in Centerprise.
3. Different data loading and reading options for PostgreSQL databases in Centerprise.

1.100.1 Use Case
We have some sample Customer data stored in a PostgreSQL database. The data contains multiple fields containing
customer information. One of these fields is for Countries that the customers reside in. We want to replace these
country names with the respective country code. We can then use these codes further to obtain additional insights
from this data.
We’ll be using the Database Table Source object to source data from the PostgreSQL database.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

This will open a new window where you can configure connection with the PostgreSQL database.
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2. The first step is to select the Data Provider. Select PostgreSQL as your data provider from the drop-down list.

1.100. Connecting to PostgreSQL in Astera Centerprise
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• Put in the required credentials for your PostgreSQL account.
1. User ID
2. Password
3. Server Name
4. Database
5. Port
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6. Schema

• Test Connection to make sure that your database connection is successful and click Next to proceed to the next
screen.

1.100. Connecting to PostgreSQL in Astera Centerprise
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3. Here, you can Pick Source Table and modify Reading Options for your PostgreSQL database.
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In this case, we will select the Customers table.
To learn more about data reading options in a database table source, click here.
4. Now, we will use the List Lookup transformation and provide coded values for all the country records in the data.
To know more about how the List Lookup Transformation works in Astera Centerprise, click here.

1.100. Connecting to PostgreSQL in Astera Centerprise
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5. Next, we will pick a table in the PostgreSQL database and write this data to it using the Database Table Destination
in Astera Centerprise.
To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

This will open a new window on your screen.
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Here you can configure the properties for the Database Table Destination object.
The first step is to specify the Database Connection for the destination object.
Select PostgreSQL as your data provider from the drop-down list.

1.100. Connecting to PostgreSQL in Astera Centerprise
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• Put in the required credentials for your PostgreSQL data provider account.
1. User ID
2. Password
3. Server Name
4. Database
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5. Port
6. Schema

• Test Connection to make sure that your database connection is successful and click Next.

1.100. Connecting to PostgreSQL in Astera Centerprise
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You can Pick Table or Create Table and modify Writing Options for PostgreSQL Database on the Properties screen.
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Note: In this case, we will pick the Customers table which is the same as the source table.
To read more on the different data writing options available for a database table, click here.
Once you’ve set the data reading options, click OK.
We have successfully configured PostgreSQL as our database provider for the Database Table Destination object. The
data will now be written to the PostgreSQL Database once the dataflow is run.

1.100. Connecting to PostgreSQL in Astera Centerprise
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If we now preview the data in the database table, we can see that the country names have been replaced with country
codes and the data has been written into the destination table.

We have successfully connected to PostgreSQL Database and completed our use case in Astera Centerprise.
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1.101 Connecting to Netezza Database
Netezza is a data warehouse and analytics platform that caters to a wide variety of data-related business needs. It offers
meaningful and sophisticated insights on large data volumes that are crucial to enterprises of all kinds.
Astera Centerprise offers in-built connectivity to Netezza databases using a range of objects available in the toolbox.
The connection can be established primarily via the Database Table Source and Destination objects. Moreover, the
Netezza database can also be accessed through and used in Database Lookup and SQL Statement Lookup in Transformations, SQL Script Task in a workflow, and Database Diff Processor and Slowly Changing Dimensions in Database
Write Strategies.
In this article, we will be looking at how Netezza can be configured as a database in Astera Centerprise. However,
before doing so, we will need to install the ODBC driver for Netezza.

1.101.1 Installing the ODBC Driver for Netezza

1. The Netezza ODBC driver is available on IBM’s website and can be downloaded from
[here](https://www.ibm.com/support/fixcentral/swg/selectFixes?parent=PureData
System
for
Analytics&product=ibm/Information+Management/Netezza+NPS+Software+and+Clients&release=NPS_7.2.1&platform=All&function
To access the installation package, you will require a valid IBM login ID.
2. Once you’ve acquired the installer zip file, run the nzodbcsetup.exe setup. The installer window will appear.
Select a language and click OK.

1.101. Connecting to Netezza Database
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1. The next screen will provide some guidelines on the installation process. Click Next.
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1. On the next screen, choose an appropriate bit size for the driver according to your target OS. Click Next.

1.101. Connecting to Netezza Database
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1. The Optimize for ASCII character set option can be selected on the Character Translation screen if you wish
to convert and optimize your character data. Do not select the option if your data contains special characters.
Click Next.
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1. The next screen will provide the option to install C++ libraries. Select Install and click Next.

1.101. Connecting to Netezza Database
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1. The Pre-Installation Summary screen gives a brief overview of the product being installed. Click Install.
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1. Wait for the installation process to successfully complete. On the final screen, click Done.

1.101. Connecting to Netezza Database
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1.101.2 Using Netezza in Database Table Source in Astera Centerprise
1. We will be using a Database Table Source object to establish a connection with Netezza database. To configure
the properties of the object, right-click on its header and select Properties.

1.101. Connecting to Netezza Database
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1. A Database Connection window will appear as soon as you click Properties.

1. On the Database Connection window, select Netezza in the drop-down list of data providers.

1.101. Connecting to Netezza Database
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1. Provide the credentials to your Netezza user account.
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1. Test Connection to ensure that your connection is successful. When the connection is established, click Next.

1.101. Connecting to Netezza Database
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The connection to Netezza database has been successfully established. You can now pick a table from Netezza database
and use the data in your dataflow.
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To learn more about how to pick a table from a database source and specify other reading options, click here.
This concludes connecting to Netezza database in Astera Centerprise.

1.102 Connecting to Oracle Database
Oracle database is the world’s leading converged, relational database management system produced and managed
by Oracle Corporation. It enables customers to simplify relational database environments and run OLTP and data
warehouse management workloads by allowing to safely store and retrieve data from it. You can connect to Oracle
databases in Astera Centerprise at both source and destination points. The connectivity also extends to other objects
such as Database Lookup, SQL Statement Lookup in transformations, SQL Script Task in a workflow, Database Diff
Processor and Slowly Changing Dimensions in Database Write Strategies. To learn more about Oracle Databases,
click here.
In this article, we will cover:
1. A use case where Oracle Database is being used in Astera Centerprise
2. Connecting to an Oracle database in Centerprise
3. Different data loading and reading options for Oracle database objects in Centerprise

1.102.1 Use Case
We have some sample employee data stored in an Oracle database. We want to filter out records of employees that fall
under the higher income bracket and send those records to a separate table in the database.
We’ll be using the Database Table Source object to source data from the Oracle database.
1. To configure the Database Table Source object, right-click on its header and select Properties from the context
menu.

This will open a new window where you can configure connection with the Oracle database.

1.102. Connecting to Oracle Database
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2. The first step is to select the Data Provider. Select Oracle ODP .Net as your data provider from the drop-down list.
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• Put in the required credentials for your Oracle account.
1. User ID
2. Password
3. Server Name
4. Database
5. Port
6. Schema

1.102. Connecting to Oracle Database
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If you want to use a TNS Name file, there is an option to provide the file path and the Net Service Name for the file
below the database credentials.

• Test Connection to make sure that your database connection is successful and click Next to proceed to the next
screen.
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3. Here, you can Pick Source Table and modify Reading Options for your Oracle database on the Properties screen.

1.102. Connecting to Oracle Database
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Note: In this case, we will select the HR Employees table.
To learn more about data reading options in a database table source, click here.
4. Now, we will use the Filter transformation and group the data for all the employee records with salary higher than
$10,000.
To know more about how the Filter Transformation works in Astera Centerprise, click here.
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5. Next, we will create a new table in the Oracle database and write this data to it using the Database Table Destination
in Astera Centerprise.
To configure the Database Table Destination object, right-click on its header and select Properties from the context
menu.

This will open a new window on your screen.

1.102. Connecting to Oracle Database
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Here you can configure the properties for the Database Table Destination object.
The first step is to specify the Database Connection for the destination object. Select Oracle ODP .Net as your data
provider from the drop-down list.
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• Put in the required credentials for your Oracle data provider account.
1. User ID
2. Password
3. Server Name

1.102. Connecting to Oracle Database
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4. Database
5. Port
6. Schema
If you’re using a TNS file, you will get an option to provide the file path and the Net Service Name for that, once you’ve
filled in the credentials.
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• Test Connection to make sure that your database connection is successful and click Next.

You can Pick Table or Create Table and modify Writing Options for Oracle Database on the Properties screen.

1.102. Connecting to Oracle Database
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Note: In this case, we will create a new table and name it as HighIncomeEmployees.
To read more on the different data writing options available for a database table, click here.
In the Data Load Options for Oracle data provider, there is an option to load data using the Oracle SQL Loader with
an adjustable Batch Size.
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Once you’ve set the data reading options, click OK.
You have successfully configured Oracle as your database provider for the Database Table Destination object. The
data will now be written to the Oracle Database once the dataflow is run.

1.102. Connecting to Oracle Database
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If we preview the output for the destination object, we can see employee records with salaries higher than 10,000 that
have been written into the destination table.

We have successfully connected to Oracle Database and completed our use case in Astera Centerprise.
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1.103 Connecting to Microsoft Azure Databases
Microsoft Azure is a cloud computing service that manages applications and services through Microsoft data centers.
It provides a wide range of services that include data computing, analysis, storage, and networking.
Microsoft Azure is mostly used for hosting relational databases in the cloud. Astera Centerprise provides native
connectivity to these databases. Data can be retrieved from and written to Azure databases through various database
objects in Centerprise such as Database Table Source, Database Table Destination, Database Lookup, SQL Query
Lookup, SQL script task in a workflow, and Database Write Strategies.
Astera Centerprise provides connectivity to the following Microsoft Azure databases:
• MySQL
• PostgreSQL
• SQL Server
• MariaDB
All of them can be connected to by following the same steps in Astera Centerprise:
Note: To configure a Microsoft Azure database, you need to provide the IP Address of the system you’re connecting
from on your Microsoft Azure Portal.
Link to the portal: portal.azure.com
Steps: Azure Portal > Main Menu > SQL Server > Select Registered Server > Security > Firewalls and Virtual
Networks > Allow Access > Provide IP Address

1.103. Connecting to Microsoft Azure Databases
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1.103.1 Steps to Connect to Microsoft Azure Databases in Astera Centerprise
In this example, we will establish connection with an SQL Server database in Microsoft Azure through the Database
Table Source object in Astera Centerprise.
To learn more about a Database Table Source object, click here.
1. Go to the Properties of Database Table Source object by right-clicking on the object header and selecting Properties
in the context menu. This will open the Database Connection window on your screen.
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2. Here, you will find a drop-down list next to the Data Provider option.
Select SQL Server as your data provider from the list.

1.103. Connecting to Microsoft Azure Databases
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3. Now, put in the credentials for your SQL Server database account in Microsoft Azure.
The credentials require:
• User ID
• Password
• Server Name
• Database
• Schema
• Port
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4. Test Connection to make sure that the database connection is successful and click OK.

1.103. Connecting to Microsoft Azure Databases
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The connection to SQL Server database in Microsoft Azure has been successfully established. You can now pick a
source table on the next screen from Microsoft Azure database and use that data in your dataflow in Astera Centerprise.
To learn more about how to pick a table from a database source and specify other data reading options, click here.
You can also connect to MySQL, PostgreSQL and MariaDB databases in Microsoft Azure by following the same steps
as for any database object in Astera Centerprise.
This concludes connecting to Microsoft Azure databases in Astera Centerprise.
Additional Reading Links:
Connecting to MySQL Database in Astera Centerprise
Connecting to PostgreSQL Databases in Astera Centerprise
Connecting to MariaDB Databases in Astera Centerprise

1.103. Connecting to Microsoft Azure Databases
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1.104 Connecting to Amazon RDS Databases
Amazon RDS is a web service that manages secure relational databases in the cloud. It is easier to set up, operate,
and scale a relational database in the cloud through Amazon Web Services data centers. It provides a cost-effective,
resizable capacity for an industry-standard relational database for administering tasks that include computing, analysis,
storage, and data networking.
Amazon RDS takes over many of the tedious and challenging management tasks of a relational database and makes
it easy to administer, scalable, durable, fast, and secure. Astera Centerprise provides native connectivity to Amazon
RDS databases. Data can be retrieved from and written to Amazon RDS databases through various database objects in
Centerprise such as Database Table Source, Database Table Destination, Database Lookup, SQL Query Lookup, SQL
script task in a workflow, and Database Write Strategies.
Amazon RDS is available on several database instance types and provides you with six familiar database engines to
choose from. Astera Centerprise provides connectivity to the following Amazon RDS databases:
1. Amazon Aurora
2. PostgreSQL
3. MySQL
4. MariaDB
5. Oracle Database
6. MySQL
All of them can be connected to by following the same steps in Astera Centerprise:

1.104.1 Steps to Connect to Amazon RDS Databases in Astera Centerprise
In this example, we will establish connection with a MySQL database in Amazon RDS through the Database Table
Source object in Astera Centerprise.
To learn more about using a Database Table Source object, click here.
1. Go to the Properties of a Database Table Source object by right-clicking on the object header and selecting
Properties in the context menu. This will open the Database Connection window on your screen.
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2. Here, you will find a drop-down list next to the Data Provider option.
Select MySQL as your data provider from the list.

1.104. Connecting to Amazon RDS Databases
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3. Now, put in the following required credentials for your MySQL database account in Amazon RDS.
• User ID
• Password
• Server Name
• Database
• Port
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4. Test Connection to make sure that the database connection is successful and click OK.

1.104. Connecting to Amazon RDS Databases
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The connection to MySQL database in Amazon RDS has been successfully established. You can now pick a source
table on the next screen from Amazon RDS database and use that data in your dataflow in Astera Centerprise.
To learn more about how to pick a table from a database source and specify other data reading options, click here.
You can connect to Amazon Aurora, PostgreSQL, MariaDB, Oracle Database, and SQL Server databases in Amazon
RDS by following the same steps as for any database object in Astera Centerprise.
This concludes connecting to Amazon RDS databases in Astera Centerprise.
Additional Reading Links:
Connecting to MySQL Database in Astera Centerprise
Connecting to PostgreSQL Databases in Astera Centerprise
Connecting to MariaDB Databases in Astera Centerprise
Connecting to Amazon Aurora Databases in Astera Centerprise
Connecting to Oracle Database in Astera Centerprise

1.104. Connecting to Amazon RDS Databases
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1.105 Deployment
Deployment is a way for setting up Centerprise projects to run on the Scheduler.
When you are deploying a project, you can also specify parameters by creating a config file for project archive (.car)
files to run project flows independent of any local parameters.
In this document, we will learn how to deploy projects on Astera Centerprise.

1.105.1 How to deploy a project on Astera Centerprise Server
1. Go to Server > Server Explorer. This will open a Server Explorer panel.

2. On the Server Explorer panel, right click on the DEFAULT server node and go to Cluster Settings.
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This will direct you to the general settings tab.

3. On the general settings tab, specify the Deployment Directory path. The Deployment Directory is the location where
the deployment files will be stored for the server to access when a deployment schedule is run.

1.105. Deployment
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4. Now open the project that you want to deploy on Astera Centerprise Server by going to Project > Open and direct
it to the .cprj file. This will open the selected project in the Project Explorer panel.
Note: .cprj file refers to a Centerprise project file.

5. In the Project Explorer panel, right-click on the project node and select Build Archive (.Car) for the Project option
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from the context menu.

6. Save this archive file on your system.
7. Now, open the deployment window. Go to Server > Deployment.

This will direct you to the main screen of Deployment.
8. Click on Add Deployment icon to add a new deployment.

1.105. Deployment

1113

Centerprise, Release 8

9. Configure deployment settings by providing following details:
• Name
• Archive File Path (*.car)
• Config File Path (an optional file to specify project parameters)
• Comment (optional)

10. Save this deployment by clicking on Save Deployment icon
projects.

1114

and it will be added to the list of deployed

Chapter 1. Other Versions

Centerprise, Release 8

Multiple deployments can be configured on the cluster from the deployment window. The top part of the deployment
screen shows the configured deployment files.

1.106 Server Monitoring and Job Management
Advanced server monitoring and job management features have made troubleshooting server related errors and managing jobs easier for administrators. Proactively monitoring server health, preventing server downtimes, and identifying
the causes of server failure is also made possible with the improved server monitoring and logging capabilities.
Moreover, a diagnostic file can be generated in case of server failure that contains information such as server status,
server health, active connections, installed drivers etc. Administrators can use this information to troubleshoot and fix
the problems.
The server monitoring features that we will discuss in this article are:
• Using Job Monitor to monitor jobs scheduled on the server
• Viewing Server Properties
• Creating Diagnostics File to troubleshoot server related issues

1.106. Server Monitoring and Job Management

1115

Centerprise, Release 8

• Viewing Server Information
• Managing cluster databases through Cluster Monitor and Settings
Let’s go over each of them one by one.

1.106.1 Job Monitor
The Job Monitor will show you information regarding all the jobs (running, scheduled, or executed) on Centerprise
server.
The Job Monitor gives following details:
1. Job ID
2. Parent
3. Priority
4. Job Type
5. Server
6. Job File
7. Job Name
8. Queued
9. Started
10. Duration
11. Status
12. Scheduled Job
13. Email Status
14. Records Read
15. Error Records
16. Warning Records
17. User
To open the Job Monitor, go to Server Explorer > Right Click on Default > Job Monitor.
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1.106.2 Server Properties
The server connection properties window gives information about the cluster database and options for the diagnostics
file. It can also be used to change the cluster database connection at any instance.
To open the Server properties, go to Server Explorer > Right click on the connected Server node > Server Properties.
A server connection properties screen will open.

1.106. Server Monitoring and Job Management
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1.106.3 Generating a Diagnostics File
A diagnostics file is generated in case of server failure or downtime. The diagnostics file is used to troubleshoot the
causes for failure or downtime. It works as a performance and health monitor for Centerprise server.
Information included in the diagnostics file is as follows:
• Operating System
• Machine Information
• Error Information
• Server Information
To generate a diagnostics file, go to Server Explorer > Right Click on the connected server node > Generate Diagnostics File. It will ask you for a file path where you want to save the file.
Once the file is saved, you can open the file from the given file path, and an XML file will open.

1.106. Server Monitoring and Job Management
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1.106.4 Server Information
To view details related to the server, Centerprise provides information regarding the connected server and machine
through this option for easier management.
Server Information screen will show the following specifics:
1. Server Information
2. Licensing Information
3. System Information
4. Server Snapshot
To access Server Information, go to Server Explorer > Right Click on the connected server node > Show Server
Information.
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1.106.5 Cluster Monitor and Settings
The cluster monitor and settings help in managing the cluster database that you’ve made for Centerprise.
To open the Cluster Monitor, go to the Server Explorer > Right Click on Default > Cluster Monitor.

In the Cluster Settings, you can:
• General: Give staging and deployment directory paths.
• Mail Setup: Provide with credentials to support mailing for job automation.
• Path Mapping: Provides alternate paths for directory.
To open the Cluster Settings, go to the Server Explorer > Right Click on Default > Cluster Settings.
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1.107 Connecting to Source Control
Centerprise features integration with Team Foundation Server and VSTS to manage version control over your projects.
To connect to a Source Control server, navigate to
Project > Source Control > Connect to Source Control Server
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1.107.1
1.107.2 Connecting to TFS
Windows Authentication can be used to connect to a Team Foundation Server. This uses the current user which is
logged on to Windows and uses the windows credentials to authenticate the user.

1.107. Connecting to Source Control
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1.107.3 Connecting to VSTS
Various authentication methods can be used to connect to Visual Studio Team Services (Visual Studio Online). When
using these authentication methods, the Path can be set as empty with Port set to 0.
Alternate Authentication can be enabled inside the Security settings for your Visual Studio account. This enables
the account to have a manageable separate username and password.

Personal Access Tokens can also be enabled and uses a generated token to authenticate the account.

Rest Authentication provides a built in prompt to login using your Microsoft account.

1.107.4 Auto Connect
By default, Centerprise will try to auto-connect to source control once the client starts. This can be changed by
Navigating to
Tools > Options > Source Control Tab
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1.108 REST API Browser
1.108.1 What is an API?
API (Application Programming Interface) is defined as an interface or medium through which one software communicates with another. In other words, it is a set of contracts that allows different software systems to share information
with each other. The greatest advantage of an API is that different programs and devices can communicate with each
other in a secure manner without knowing or interfering with the insides of the other.
APIs are messengers that conform with the technical contract between two parties. They are language and platform
independent which means C# can talk to Java and Unix can communicate with Mac without any difficulty. An API is
not same as a remote server. In fact, it is a part of a remote server that receives requests and sends responses. More
precisely, an API is a structured request and response.

1.108.2 REST API Browser in Astera Centerprise
The REST API Browser in Astera Centerprise has narrowed down the steps to make HTTP calls to just one step
authentication. Once you have imported an API in Centerprise, all the call methods in that particular API are populated
at once. API definition describes what requests are available and what the responses will look like. So, once you load
an API definition all the supported methods are populated in the REST API Browser. Unlike Legacy where all the
supported methods have to be configured separately in each object.
There are two methods for configuring APIs in Astera Centerprise. For open APIs, you only need to provide the API
Import Source and File path or Base URL to configure the connection with a specific API. Once all of this standardized
information is provided, any API that you have imported will populate in Centerprise’s REST API Browser along
with their methods, for example, GET, PUT, POST, PATCH and DELETE and they will remain accessible until their
authentication period expires. From the REST API Browser in Astera Centerprise, you can simply drag and drop those
operations and use them in your dataflow or workflow.

1.108. REST API Browser
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It is important to note that a REST Client Project must be created before importing APIs to work with the REST API
Browser in Astera Centerprise. However, you can access the API without a project too. For that you would need a
REST Connection object in your dataflow or workflow.
The REST API Browser in Astera Centerprise, along with all of its features and functionalities, works only within the
scope of an integration project. Else it will give you the following error:

When a user imports an API, a shared connection file is created within the project automatically. The shared action
file contains the Base URL of the imported API.

HTTP Request Methods
Astera Centerprise supports the following HTTP request methods:
1. PUT: To send data or parameters to a specified resource to be processed on an API.
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2. GET: To retrieve data from a specified resource on an API.
3. POST: To create or update an existing record on an API.
4. DELETE: To delete a specified resource on an API.
5. PATCH: To apply partial modifications to an existing resource.

1.108.3 Creating a REST Client Project for REST API Browser
To work with REST API Browser in Astera Centerprise, you must first create a REST Client Project.
Follow the steps below to create a REST Client Project in Astera Centerprise:
1. Go to Menu Bar > Project > New > REST Client Project.

Provide a name to the REST Client Project and point the path to the location and directory where you want to save it.
Best Practice: Always create a new project in a new folder to avoid any errors.
2. Now open the REST API Browser panel on your Centerprise client from Menu Bar > View > REST API Browser.

1.108. REST API Browser
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3. As you click on it, a REST API Browser panel will open on the left side of your Centerprise client window.
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Here, you can see three icons in the toolbar of REST API Browser:
• Import API – by clicking this option, you can import different APIs
• Remove API from Browser – this option removes the selected API from REST API Browser
• Edit Properties - this option allows you to change the name of the REST API Browser panel that appears on the
top and bottom of the panel
• Open REST API Connection - this option allows you to directly open .sact file for the API you have in the REST
API Browser panel at that time
• Refresh API Tree - this option allows you to redraw the browser tree after you have deleted some operations or
you have expanded the tree and now you want to collapse it

1.108.4 How to Import APIs in Centerprise
To import an API in Astera Centerprise, click on the Import API icon. An Import API screen will open.
Here, first you need to select the API Import Source type from the drop-down menu. Astera Centerprise offers three
ways to import APIs.
Type 1 – JSON/YML File
1. JSON/YML File – for this type of API source you only need to provide the Open API Specification file path in JSON
or YML file formats.

1.108. REST API Browser
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2. Specify the file path and click OK.

This API will be populated in the REST API Browser panel from where you can simply expand the nodes and drag
and drop the methods on to your designer window.
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Type 2 – JSON/YML URL
1. JSON/YML URL – for this type of API source, you need to provide the URL in JSON or YML format
1.108. REST API Browser
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2. Specify the URL and click on OK.

This API will be populated in the REST API Browser panel.
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This concludes the basic concepts of working with the REST API Browser in Astera Centerprise. To learn more on
how to make HTTP requests through REST API Browser, click here.

1.108. REST API Browser
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1.109 Making HTTP Requests Through REST API Browser
In this document, we will see how we can make HTTP requests through REST API Browser in Astera Centerprise.

1.109.1 Making a GET Request
To make a GET request, drag and drop the relevant GET request object from the REST API Browser onto the designer
window and pass your required PetId into it.
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In this scenario, we want to get the info for pet with the PetId ‘3’. For this, we will select the GET request ‘Find pet
by ID’ and pass the relevant PetId using a ConstantValue object.

1.109. Making HTTP Requests Through REST API Browser

1139

Centerprise, Release 8

To explore the REST Client object for this method, right-click on its header and select Properties.
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This will open the REST Client screen where the connection info of your API is defined.

Shared Connection – shows the name of your REST Connection. You can select any shared REST API Connection
you want to use from the drop-down list. The connections for all the APIs that have been imported in the project will
be shown here.

1.109. Making HTTP Requests Through REST API Browser
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REST Request
HTTP Method – shows the HTTP method of your request
Resource – shows what information you want to get from a specific API. It is a part of the UrI of request sent.
Content Type – shows the type of your content
All the above information is configured according to the request method that you have selected.
Click Next to proceed to the Parameters screen.

1142

Chapter 1. Other Versions

Centerprise, Release 8

Here, you will see the following options:
Name - it contains the name of the parameter
Parameter Location - it tells which parameter is being used to make the call. The following three parameters are
supported by Centerprise:
1. URL: This is a required parameter.
2. Query: This parameter may or may not be optional and can work as a filter while processing records.
3. Header: This parameter is generally used for authentication purpose.
Click Next to proceed to the Output Layout screen where you can build the Response Layout of your API. There are
two ways in which you can generate the output layout:
1. The first one is by providing sample text by clicking on ‘Generate Layout by providing Sample Text’ option.
2. The other way to do that is by running a request by clicking the ‘Generate Layout by running Request’ option.

1.109. Making HTTP Requests Through REST API Browser
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Click Next to proceed to the Pagination Options screen.
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Pagination
Pagination refers to managing the traffic of records coming from a source. It divides the records into discrete number
of pages so that they are comprehensible for a user. Pagination is not supportedby all APIs. For those that do, Astera
Centerprise offers four types of pagination.
Offset:
It requires two parameters: a limit and an offset value to be specified by the user. A limit specifies the number of
records that you want to specify in one page and an offset simply tells the number of records to be skipped before
selecting records.
- Initial Offset – the record from which you want to start your pagination
- Number of Pages – the number of pages which you want to be processed
- Limit - number of records on one page
- Offset Parameter - here, you specify the offset parameter of the API that you are working with as specified on the
Parameters screen
- Limit Parameter - here, you specify the limit parameter of the API that you are working with as specified on the
Parameters screen

1.109. Making HTTP Requests Through REST API Browser
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Cursor:
This type of pagination generates a token for the next page of records. You can set a limit to the number of pages you
want to process.
- Cursor Field – here, the field you want to attach your cursor with is specified.
- Number of Pages – here, the number of pages you want to see in your output are specified or you can simply check
the option of ‘Read Till End’ if you want to process all the records without any limit.
- Cursor Parameter - here, you specify the cursor parameter of the API that you are working with as specified on the
Parameters screen.
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Next URL:
It is the same as Cursor pagination, except that it generates a URL for every next page instead of a token.
- Next URL Field - here, the field you want to attach your URL with is specified.
- Number of Pages - here, the number of pages you want to see in your output are specified or you can simply check
the option of ‘Read Till End’ if you want to process all the records without any limit.
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Page Number
In this type of pagination, you can specify the number of pages you would like to fetch in one go. It requires two
parameters:
- Start Page Number - the page number from where you want to start fetching your output or the lower limit
- End Page Number - the page number where you want to end
- Page Number Parameter - here, you specify the page number parameter of the API that you are working with as
specified on the Parameters screen
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Click Next to proceed to the the Service Options screen.
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Here you can see the following service options:
Request Delay – the time (in milliseconds) to be delayed before sending a request
Retry Count – the number of retries to be made in case of a failed request
Retry Delay – the time (in milliseconds) to be delayed before making a request again
Ignore HTTP Status Codes checkbox is used to skip the error response for unsuccessful requests
Continue on Retry Failure - this option is used to retry building the connection if it fails
Use Parallelism - this option specifies if you want multiple requests to be run in parallel and the number of those
requests can be specified in Degree of Parallelism option
Include Content as String - you can check this option if you want to include your content in the output preview
Include Response Headers - you can check this option if you want to include the response headers in you data preview
Include Raw Bytes - you can check this option if you want to include the raw data bytes in your data preview
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Once you have specified these options, click OK.

1.109.2 Making a POST Request
Now, let’s try posting a pet to Petstore. Drag the ‘Add a new pet to the store’ request from the REST API Browser
panel and drop it on to the dataflow designer.

1.109. Making HTTP Requests Through REST API Browser
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We will pass the required parameters to the POST request object using a Variables object.
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Now, right-click on the REST API Client (addPet) object and select Preview Output.

You can see that the ‘HTTPStatusCode’ is 200 which means that the REST API has successfully carried out the action
requested by client. Let’s verify it by making a GET request for the same PetId which we had posted earlier.

1.109. Making HTTP Requests Through REST API Browser
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You can see that a GET request for PetId 1 has returned us the same information which we had posted.
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1.109.3 Making a DELETE Request
Now, let’s try making a DELETE request. For that, we will first make a GET request to see if that pet exists on the
petstore or not and try to delete that. We will pass PetId 5 using a ConstantValue object.

Right-click on the REST Client (getPetById) object and select Preview Output.

1.109. Making HTTP Requests Through REST API Browser
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It has fetched the details of the pet with PetId 5, and the status shows that the pet is available on Petstore.
To delete this pet record, we will drag and drop the ‘Deletes a pet’ request from the REST API Browser panel on to
dataflow designer.
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Pass PetId 5 to the DELETE request object using a ConstantValue object.

Right-click on the REST Client object and select Preview Output. You can see that it has returned ‘HTTPStatusCode’
200 which indicates a successful execution.

Let’s verify it by making a GET request again and check if pet with PetId 5 has been deleted.

1.109. Making HTTP Requests Through REST API Browser
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Right-click on the REST API Client (getPetById) object and select Preview Output.

You can see that Centerprise has returned error 404 which means that there is no pet found with PetId 5 and the pet
record has been successfully deleted from petstore API.

1.109.4 Making a PATCH Request
Let’s make a GET request to see what information is there in the user ID where we want to update something.
To make a GET request, drag and drop the ‘GetUser’ method from the REST API Browser onto the designer window.
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Pass userID ‘89’ to the userId under the Parameters node in the ‘GetUser’ object using ConstantValue transformation.

Right-click on the header of REST Client (GetUser) object and select Preview Output.
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Here is what the output looks like:

Now, drag and drop the ‘PatchUser’ method from the REST API Browser and drop it on to the designer window.
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Pass userId ‘89’ and email ‘updatedemail@astera.com’ using a Variables resource object.

Right click on the ‘PatchUser’ and select Preview Output.
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You can see that the ‘HTTPStatusCode’ is 200 which means that the REST API has successfully carried out the
PATCH request. Let’s verify it by making a GET request for the same userId in which we made the changes.

Right-click on the header of the ‘GetUser’ object and select Preview Output.
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As you can see, the request has been successfully carried out and the email address has been updated to updatedemail@astera.com.

1.109.5 Working with APIs That Require Authentication
Let’s try making an API request that needs authentication. We’ll be making a GET request object using an Adafruit
API.
1. First, import the API by using the relevant import source. In this case, we will import using the JSON/YML URL
import source.

You will see that all the APIs present on Adafruit’s URL have been populated in the REST API Browser.

1.109. Making HTTP Requests Through REST API Browser
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2. Now, you need to authenticate Adafruit’s APIs to use them in your dataflow. Without authentication, you will get
an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under the Shared
Connection node. In this case, we will double-click on Adafruit’s .sact file.
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3. Adafruit’s .sact file will open on the designer. Now, right click on shared action file’s header and select Properties.
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This will open the REST Connection window where you can configure the settings to authenticate Adafruit’s API.
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Authentication
Following authentication types are supported in Astera Centerprise:
1. No Authentication
2. OAuth 2
3. API Key
4. Basic Authentication
5. Bearer Token
No Authentication
With this security type, the user can send requests and receive responses without any kind of authentication from APIs.
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O Auth 2
In the OAuth 2 authentication, you can select any of the four grant types:
1. Implicit
2. Authorization Code
3. Password
4. Client Credentials
Implicit
In this grant type, you only need to provide Authentication URL and Client ID to request token and authorize.
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Authorization Code
In this grant type, you need to provide Authentication URL, Access Token URL, Client ID, and Client Secret to authorize.
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Password
In this grant type, you need Access Token URL, Username, Password, Client ID and Client Secret in order to authorize.
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Client Credentials
In this grant type, you need Access Token URL, Client ID, and Client Secret to authorize.
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API Key
An API Key is a token that a client provides when it makes an API request. An API key is a secret that only the client
and server know. They can be sent in the Query string or as a request Header.
It requires two parameters for authentication:
1. Key
2. Value
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Basic Authentication
Basic Authentication is structured according to the HTTP protocol to provide a username and password when making
a REST request. In basic HTTP authentication, a request contains a header field in the form of Authentication: Basic
, where credentials are the Base64 encoding of ID and password joined by a single colon “:”.
It requires the following information:
1. Username
2. Password
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Bearer Token
Bearer token or token authentication is an HTTP-based authentication. The token is a text string included in the request
header. It is generated by the server in response to a login request.
To authorize Bearer token, you need:
1. User Name
2. Password
3. Token URL
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4. Select the Security Type and specify the relevant details.
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You can see that the Security Type has been specified as API Key which means that the Adafruit’s API uses ‘API Key’
as its authentication method.
5. Click OK. Now that the API has been authenticated, we can work with the API and make HTTP requests.
To make a GET request, drag and drop the ‘Get feed by feed key’ object from the REST API Browser on to the
dataflow designer.
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It requires two parameters: username and feed_key. We will pass the values to these parameters either by using a
source object via mapping it or by specifying the parameter value in the default value column in the properties of
‘getFeed’ object.
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In this case, we have provided the username through a ConstantValue object. Now let’s specify the feed_key in the
Default Value column in the properties of the getFeed object.
Right click on the REST Client object (getFeed) and select Properties. Go to the Parameters screen and specify the
feed_key value in the Default Value column.
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Click Next to proceed to the Output Layout screen. Here, you can see the Response Layout of your selected method.
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Click Next to proceed to the the Service Options screen.
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Now, right click on the REST Client (getFeed) object and select Preview Output.

You can see that Centerprise has returned the feed information by providing the required parameters.
This concludes making HTTP requests through REST API Browser in Astera Centerprise.

1.110 Open APIs – Configuration Details
Note: Client Secret, Access Token and API Key are to be generated by the user and will be unique for
every application. The values written below are just for example.

1.110. Open APIs – Configuration Details
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1.110.1 Adafruit IO
Authentication Type: API Key
• Import API: https://raw.githubusercontent.com/adafruit/io-api/gh-pages/v2.json
• Authentication: API-KEY
• Key: X-AIO-Key
• Value: aio_UTqF73klycqdLWpbp0wLl7RHKV25
• UserName: [Enter you user name]
• FeedKey: [Enter your feed key]
• Adafruit Login Page: https://accounts.adafruit.com/users/sign_in
• Email: [Enter your login email]
• Password: [Enter your password]

1.110.2 Avaza API
Authentication Type: OAuth 2, Authorization Code
• Import API: https://api.avaza.com/swagger/docs/v1
• Authentication: oauth2 (Access token will be valid for 1 day)
• Token URL: https://any.avaza.com/oauth2/token
• Auth URL: https://any.avaza.com/oauth2/authorize
• ClientId: [Enter client ID]
• Client Secret: c1d4b723790f0e24d0b2df68ebde613e9533
• Avaza Login Page: https://any.avaza.com/account/login
• Email: [Enter your email]
• Password: [Enter your password]

1.110.3 BOX API
Authentication Type: Bearer Token
• Base URL: https://api.box.com/2.0
• Authentication: Bearer Token (Access token will be valid for 1 hr)
• Token: 1IVYyDgfDPyWpoXe9c4RMOt7tmtiB75q
• Steps to generate access token:
• Page: https://app.box.com/developers/console/app/984015/configuration
• Email: [Enter your login email]
• Password: [Enter password]
• Click on Generate Developer Token to generate access token
• API Reference: https://developer.box.com/en/reference
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1.110.4 Facebook API
Authentication Type: OAuth 2, Authorization Code
• Base URL: https://graph.facebook.com/
• Auth URL: https://www.facebook.com/dialog/oauth
• Access Token URL: https://graph.facebook.com/oauth/access_token
• Client ID: 217423066002
• Client Secret: d7d8969c6ea31bf117f04768b63bb
• Credentials to use when using ‘Request Token’
• Email address: [Enter your email]
• Password: [Enter your password]

1.110.5 Google Drive
Authentication Type: Bearer Token
• Base URL: https://www.googleapis.com/drive/v3
• Authentication: Bearer Token (Token will be valid for an hour)
• Token:
ya29.Il_AB6CICAcAQD6lKoQCW3K2DO_enBd3be5G2Vvd0hZ3Q8US4eHLPEOS1qRD7zzSEN3t_qb_eNqWzZS3zsXP_FcAHA9TSoy-tDpsWv0RnWRledPhZqRt79f9X
• API Reference: https://developers.google.com/drive/api/v3/reference
Steps to generate access token:
1. Go to https://developers.google.com/oauthplayground/
2. Select the APIs you want to authorize and click ‘Authorize APIs.’
3. On the next screen, provide your credentials.
4. Email: [Enter your login email]
5. Password: [Enter your password]
6. Now click on ‘Exchange authorization code for tokens’ to generate access token.

1.110.6 netAuth API
Authentication Type: API Key
• Import API: https://api.doc.nextauth.com/api/swagger.json
• Authentication: API-KEY
• KEY: [Enter API Key]
• VALUE: J5znqilK_qUt65iQyy9W2Q
• Help link: https://api.doc.nextauth.com/

1.110. Open APIs – Configuration Details
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1.110.7 OMDb API
Authentication Type: API Key
• API key to be passed as a query parameter
• JSON File: http://www.omdbapi.com/swagger.json
Steps to generate API Key:

1. Open http://www.omdbapi.com/apikey.aspx?__EVENTTARGET=freeAcct&__EVENTARGUMENT=&__LASTFOCUS=&__V
2. Select Account Type ‘FREE.’
3. Enter your email address.
4. Enter your first name and last name.
5. Describe in a few words your purpose of using this service.
6. Click on ‘Submit.’
7. You will get the API Key in your email with a link to activate it, click on that link and the key will be activated.

1.110.8 Square Connect API
Authentication Type: Bearer Token
• Import API: https://raw.githubusercontent.com/square/connect-api-specification/master/api.json
• Authentication: Bearer Token
• Token: EAAAEPXVtza2Utrx-GJ90Az4sCQ_NLbLYOKANVFmJiPGJ1Z6B-eJgZ-2V1
• Use this API to import: https://raw.githubusercontent.com/
Note: This looks like an issue with Square Connect’s documentation because the ‘Import API’ option
does not work.

1.110.9 Zendesk API
Authentication Type: Basic Authentication
• Username: [Enter username or login email]
• Password: [Enter password]

1.111 Authorizing Facebook APIs in Astera Centerprise
Facebook uses HTTP-based APIs that can be utilized to extract or load data, to and from Facebook. You can configure
Facebook APIs for use in Astera Centerprise using the ‘Custom API’ source in the REST API Browser (Beta).
To authorize a Facebook API in Astera Centerprise, follow the steps below.
1. Go to this Url: https://developers.facebook.com/ and log in.
Note: If you have not created an account yet, you need to create one first after signing in.
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2. Enter the email address of your Facebook account to log in.

3. Go to My Apps > Create App to create an application.

1.111. Authorizing Facebook APIs in Astera Centerprise
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4. Provide the Display Name for your application and click on Create App ID.

Once your application is created, it will show up under the My Apps tab.
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5. Click on Centerprise to open the dashboard.
Reference Url: https://developers.facebook.com/apps/217423066002800/dashboard/

6. Click on Settings > Basic to get the relevant credentials.
Reference Url: https://developers.facebook.com/apps/217423066002800/settings/basic/

1.111. Authorizing Facebook APIs in Astera Centerprise
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7. Here you can see the App ID and App Secret. Save them to use them later for authentication.

8. To use Bearer Token authentication, go to Tools > Graph API Explorer.
Reference Url: https://developers.facebook.com/tools/explorer/
9. Click on Generate Access Token and copy the token.
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10. To access and try out different APIs, go to Tools > Graph API Explorer.
Reference Url: https://developers.facebook.com/tools/explorer/

11. Select anything from the drop-down list.

1.111. Authorizing Facebook APIs in Astera Centerprise
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12. Click on Submit, to see the results.

13. Import the API in Centerprise using the Import API option in the REST API Browser (Beta). Select API Import
Source as ‘Custom API’ by providing Name and Base Url. To learn more about how to work with custom APIs in
Centerprise click here.
Base Url: https://graph.facebook.com/
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14. Now, you need to authenticate the Facebook APIs to use them in your dataflow. Without authentication, you will
get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under the
Shared Connection node.

Facebook’s .sact file will open on the designer. Now, right-click on the shared action file’s header and select Properties.
This will open the REST API Connection window, where you can configure the settings to authenticate Facebook’s
API.

1.111. Authorizing Facebook APIs in Astera Centerprise
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Facebook uses ‘OAuth 2’ authentication with Grant Type ‘Authorization Code’.
Auth Url: https://www.facebook.com/dialog/oauth
Access Token Url: https://graph.facebook.com/oauth/access_token
Provide ClientID and secret that you had saved earlier, then click on Request token to generate the access token for
Facebook.
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Note: As you click on Request Token, Facebook’s login window will open where you will have to provide
your credentials to generate the access token to access Facebook API.

1.111. Authorizing Facebook APIs in Astera Centerprise
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15. Save the shared action file after authentication and you are ready to use Facebook APIs in Centerprise. For more
information on how to use a Custom API in Centerprise, click here.
This concludes authenticating the Facebook APIs in Astera Centerprise.

1.112 Centerprise’s Server API
Follow the steps below to learn how to authenticate Centerprise’s Server APIs.
1.
Right-click on the server name in Server Explorer > Server Connections > DEFAULT >
HTTPS://(ServerName):9260.
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2. A wizard will appear with the Centerprise Server API Path. Click on the copy icon at the bottom-left of the wizard
to copy it.

A message will appear to confirm that the text has been copied successfully. Click OK.

3. Click on the Import API option in the REST API Browser and paste the Centerprise Server API path in the URL
box. Then click OK.
Note: Check the “Ignore certificate errors over HTTP/SSL” option to avoid any certification barriers.

4. A wizard will appear notifying you about the shared action file created. Click Yes to set it up.
You can also click on the .sact file in Project Explorer to configure the authentication settings.
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The REST API Browser will be populated with the Centerprise’s Server APIs, which you can use in your dataflow.

1.112. Centerprise’s Server API

1197

Centerprise, Release 8

5. Right-click on the Centerprise_Server object and select Properties.
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This will open the REST Connection screen. Select the Security Type as ‘Bearer Token’ as Centerprise Server APIs
use Bearer Token authentication.

1.112. Centerprise’s Server API
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Provide the User Name, Password, and Token URL for Bearer Token. Then click on Request Token to generate a token
and click OK. Press Ctrl+S to save changes in the shared action file.
Note: You will have to regenerate the token if the validity period has expired.
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6. Now drag and drop the /api/ServerInfo from the REST API Browser to make a GET request.

1.112. Centerprise’s Server API
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7. Right-click on the object’s header and select Preview Output.
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This is how your output would look like:

1.112. Centerprise’s Server API
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This concludes working with Centerprise’s Server API in Astera Centerprise.

1.113 Authorizing Avaza APIs in Astera Centerprise
The Avaza API follows REST protocol with ‘OAuth2’ authentication. It allows you to access contacts, projects, tasks,
invoices and taxes. In Astera Centerprise, you can configure an Avaza API through a swagger definition using the
Import API option in REST API Browser.
Let’s go over how we can authenticate an Avaza API in Astera Centerprise.
1. Create an integration project by going to Project > New > Integration Project.
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2. To import Avaza API in your Centerprise client, click on the following icon.

3. An Import API window will open where you need to select your relevant import source. In this case, we will import
using the Json/Yml Url source.
Base URL: https://api.avaza.com/swagger/docs/v1

1.113. Authorizing Avaza APIs in Astera Centerprise
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You will see that all the APIs present on Avaza’s URL have been populated in the REST API Browser (Beta).
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4. Now, you need to authenticate the Avaza APIs to be able to use them in your dataflow. Without authentication, you
will get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under the
Shared Connection node.

1.113. Authorizing Avaza APIs in Astera Centerprise
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The Avaza .sact file will open on the designer. Now, right click on shared action file’s header and select Properties.

5. This will open the REST API Connection window where you can configure settings to authenticate Avaza API.
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Avaza uses ‘OAuth 2’ authentication. In the ‘OAuth 2’ Security Type, select one from the following Grant Type
options:
1. Authorization Code
2. Implicit
In this case, we will be using the ‘Authorization Code’.
Note: Login to your Avaza account and go to Settings > Developer Apps > Add OAuth App to generate
the ClientID and Client Secret.
Auth Url: https://any.avaza.com/oauth2/authorize
Access Token Url: https://any.avaza.com/oauth2/token

1.113. Authorizing Avaza APIs in Astera Centerprise
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6. Now click on Request token to generate access token and refresh token for Avaza.
Note: As you click on Request Token, Avaza’s authorization app will open where you will be required to
provide your credentials to be able to generate access token and refresh token to access Avaza.
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7. Save the shared action file after authentication and you are ready to use Avaza APIs in Centerprise.
This concludes authenticating the Avaza APIs in Astera Centerprise.

1.114 Authorizing Sqaure API in Astera Centerprise
Square API is an HTTP-based API that follows REST standards. It allows you to manage the resources of your Square
account by making requests to URLs representing those resources. You can configure Square API for use in Astera
Centerprise by providing its swagger definition using the Import API option in the REST API Browser.
1. After you have created the application in Square, go to Manage Properties.

2. Now go to OAuth properties in Production tab. Here, you have to provide the ‘Redirect URL’ for the authorization
callback.
Note: Save Applicant ID and secret to use it later for Centerprise authentication.
Reference Link: https://developer.squareup.com/docs/oauth-api/overview

1.114. Authorizing Sqaure API in Astera Centerprise
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3. Now create an integration project in Centerprise by following the instructions provided in this article. Also, import
the following swagger definition in REST API Browser:
Base Url: https://raw.githubusercontent.com/square/connect-api-specification/master/api.json

4. Go to the properties of Square’s shared action file (.sact) to authenticate it in Centerprise. Click here to learn more
on how to work with APIs that require authentication.
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You can authorize Square API by using Security Type ‘OAuth 2’ or ‘Bearer Token’. In this example, we’ll be authorizing using ‘OAuth 2’.
5. Set its Security Type as ‘OAuth 2’ and Grant Type as ‘Authentication Code’. Provide the application ID and secret
that you had saved in step 2.
Click on Request Token to get the access token to Square API.
Auth Url: https://connect//squareup.com/oauth2/authorize
Access Token Url: https://connect.squareup.com/oauth2/token

Additional Info: You can modify your authorization by mentioning names of only those permissions that you want to
access from your Square account in Centerprise. In case you want to access all of them, leave the settings at default.

1.114. Authorizing Sqaure API in Astera Centerprise
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6. Once you get the access token, save the Shared Action file and you are ready to use Square API in Centerprise.
This concludes authenticating the Square API in Astera Centerprise.

1.115 Authorizing ActiveCampaign API in Astera Centerprise
The ActiveCampaign API is structured around REST, HTTP, and JSON. You can make requests by using URL endpoints particular to a specific resource. The resources in ActiveCampaign are represented in JSON following a conventional schema. In Astera Centerprise, you can configure an ActiveCampaign API using the Import API option present
in the REST API Browser.
ActiveCampaign doesn’t provide an Open API definition so we will add a request manually by using a Custom API in
Centerprise.
To authorize an ActiveCampaign API in Centerprise, follow these steps:
1. Create an integration project in Centerprise by following the instructions provided in this article.
2. Create a custom API and provide Base Url. To learn more on how to work with Custom APIs in Centerprise, click
here.
Reference link for Base Url: https://developers.activecampaign.com/reference#url
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3. Now, you need to authenticate the ActiveCampaign APIs to use them in your dataflow. Without authentication, you
will get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under the
Shared Connection node.

The ActiveCampaign .sact file will open on the designer. Now, right click on shared action file’s header and select
Properties.

1.115. Authorizing ActiveCampaign API in Astera Centerprise
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4. ActiveCampaign uses an ‘API Key’ as Security Type. Specify your Key and Value.
Key: API-Token
Value: {Token}
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5. Click OK and save the shared action file (.sact).
6. Add methods in REST API Browser panel which you want to use in Centerprise by adding requests and you are
ready to use the ActiveCampaign API in Centerprise. You can learn more about it in this document.
This concludes authorizing the ActiveCampaign API in Astera Centerprise.

1.116 Authorizing QuickBooks’ API in Astera Centerprise
The QuickBooks API is a RESTful API that allows you to read or write data to and from QuickBooks. It uses ‘OAuth
2’ authentication type. You can configure a QuickBooks API in Astera Centerprise by using the Import API option
present in the REST API Browser.
QuickBooks doesn’t provide Open API definition, so we will add the request manually by using a Custom API in
Astera Centerprise.
We only need to follow steps from Development > Create and Configure an App from the following link:
Authentication steps: https://developer.intuit.com/app/developer/qbo/docs/build-your-first-app
Where the Redirect Url used in step 7 on the above link for Centerprise would be:
Redirect Url for Centerprise Server: http://{Server_Name}:8050/)
Note: Save ClientID and secret to use it afterwards in Centerprise authentication

1.116. Authorizing QuickBooks’ API in Astera Centerprise
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1.116.1 Follow these steps to authorize QuickBooks’ API in Astera Centerprise:
1. Create an integration project in Centerprise by following the instructions provided in this article.
2. Create a Custom API and provide a Name and Base Url.
Base Url (Sandbox): https://sandbox-quickbooks.api.intuit.com
Base Url (Production): URL:https://quickbooks.api.intuit.com

3. Now, you need to authenticate QuickBooks APIs to be able to use them in your dataflow. Without authentication,
you will get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under
the Shared Connection node.

The QuickBooks .sact file will open on the designer. Now, right click on the Shared Action file’s header and select
Properties.
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4. QuickBooks uses ‘OAuth 2’ Security Type with Grant Type ‘Authentication Code’.
Auth Url: https://appcenter.intuit.com/connect/oauth2
Token Url: https://oauth.platform.intuit.com/oauth2/v1/tokens/bearer
ClientID: {ClientID}
Client Secret: {Client_Secret}
Scope: {Scope}
State: {State}

1.116. Authorizing QuickBooks’ API in Astera Centerprise
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Additional Info - You can modify the authorization by mentioning names of only those permissions that you want to
access from QuickBooks in Centerprise.
Note: While working with QuickBooks APIs, it is necessary to specify ‘Scope’ and ‘State’ to generate
the access token.

5. Click OK and save the Shared Action file (.sact).
6. Add methods in the REST API Browser which you want to access in Centerprise by adding requests and you are
ready to use QuickBooks APIs in Centerprise.
Reference Link: https://developer.intuit.com/app/developer/qbo/docs/api/accounting/most-commonly-used/account
This concludes authorizing a QuickBooks API in Astera Centerprise.
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1.117 Using REST Client Outside the Scope of the Project
The REST Client object in Astera Centerprise can be used outside the scope of a project, such as in a dataflow. The
REST API Browser is dependent upon the project, which is why when using REST Client outside the project’s scope,
we have to make each request manually.
To use the REST Client object in a dataflow, follow the steps below:

1.117. Using REST Client Outside the Scope of the Project
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2. Right-click on the header of RESTConnection object and select Properties.
The REST Connection window will open where you can specify the Base URL of the API using which you can establish
your REST Client’s connection. Specify the Security Type, if your API requires authentication, otherwise click OK.
In this scenario, we are using Petstore’s open API definition. So, we do not need any authentication.

3. Right-click on the header of the REST Client object and select Properties. The REST API Client screen will open
where you will have to specify the following:
Shared Connection – the shared action using which you want to establish your REST Client’s connection
REST Request:
HTTP Method – the HTTP request which you want to make
Resource – the resource of the API which you want to make a GET request from
Content Type – JSON, by default. If there comes a type which is not supported, a popup notification will appear to
prompt the the content type is not supported. Click ok, then the new content type starts appearing in the properties
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4. Click Next. A Parameters screen will appear where you will have to specify the following:
Name – the name of your parameter
Parameter Location – the parameter type such as Query, URI, and Header. In this example, we are using a Query
parameter.
Data Type – specify the data type of your parameter
Default Value - the parameter’s value for which you want to make a GET request. In this case, it is “available.”

1224

Chapter 1. Other Versions

Centerprise, Release 8

5. Click Next. A REST Client Output Layout screen will open where we will Select Generate the Layout by Running
Request to build the response layout. Then click Ok.
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6. Now right-click on the header of the REST Client object and select Preview Output.
Your request has successfully been executed as you can see that ‘HTTPStatusCode’ is 200 which means that the REST
Client has successfully carried out GET request for the “available” status.
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This concludes working with REST Client object outside the scope of the project in Astera Centerprise.

1.117. Using REST Client Outside the Scope of the Project
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1.118 Using Dynamic Layout/Template Mapping in Astera Centerprise
The Dynamic Layout/Template Mapping feature in Astera Centerprise enables users to create a template dataflow
that can be used to process multiple files and generate copies of the same dataflow, without having to change the
mapping links individually for each source dataset. Upon execution, Centerprise will replace the values dynamically
and generate a new dataflow automatically for all source files.

1.118.1 Benefits of Template Mapping
• Running your routine processes does not require you to design and map your ETL flows every time.
• ETL pipelines can be run without any dependence on the development environment.
• Template mapping also facilitates scheduling repetitive, routine jobs for automation.
• Using runtime parameters, you can customize your templates to suit your changing requirements.
• Template mapping makes it all the more convenient for non-technical users to customize and deploy these
templates in different business scenarios.
In this document, we will learn how to use the Dynamic Layouts/Template Mapping functionality in Astera Centerprise.
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1.118.2 Use Case: Auto-Generating Dataflows through Template Guide Maps
Dataflow templates are reusable flows that can be customized using runtime parameters and generate copies of the
same flow for multiple source files upon execution.
Let’s understand it with an example.
Here we have around 15 tables in a database and we need to process the data in each of these tables through a
dataflow. Following a traditional ETL mapping approach, we would need to design 40 different dataflows and run
them separately. Although the records and the layout are different in each table, the data in each table is processed
through a similar process that involves the following steps:
1. Extracted using the Database Table Source object in Astera Centerprise
2. Written into a .csv file using the Delimited File Destination object
Mapping the same flow to different source tables and destinations paths manually can be time-consuming, inefficient,
and prone to human errors. However, by designing and creating a dataflow template, you can map the task to the
template which will generate a copy of the same dataflow for each table, with unique source and destination paths.
Let’s see how it works in Astera Centerprise.
Creating a Template Dataflow in Astera Centerprise
To create a template dataflow, drag and drop the relevant source object from the sources section in the toolbox. The
Dynamic Layout option for template mapping is supported in the Database Table Source, Excel File Source, and
Delimited File Source in Astera Centerprise. In this example, our source data is stored in a database table, so we’ll use
a Database Table Source object to retrieve our data.
Drag and drop it from the Sources section in the toolbox onto the dataflow designer.

Now, right-click on the Database Source object and go to Properties.

1.118. Using Dynamic Layout/Template Mapping in Astera Centerprise
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This will open a new window where you need to provide details to configure connection with the database.
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Once the connection is established, click ‘Next’ to proceed to the next screen.
Here, you need to pick a table from the database. In this case, We’ll select the ‘Customers’ table from the list.
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Leave the other options as default and scroll down to the Dynamic Layout section on the same screen.
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Check the ‘Dynamic Layout’ option. This will enable the other two options in this section.
• Delete Fields in Subsequent Objects: When this option is checked, it will remove all elements already present
in the subsequent objects.
• Add Fields in Subsequent Objects: When this option is checked, it will populate the fields from the source table
in the subsequent objects.
Both of these options are checked by default and enabled when you check the ‘Dynamic Layout’ option.

1.118. Using Dynamic Layout/Template Mapping in Astera Centerprise
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Once done, click OK to exit the Properties screen.
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Now if you look at the Database Table Source object, you can see this small icon or flag DYN over the header. This
denotes that the source object has been set to work with dynamic layouts.
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Now drag and drop a Variable object from the Resources section in the Toolbox and drop it onto the designer.

Using this Variable object, we will define input parameters for the Source table. Right-click on the Variable object and
go to Properties.
1236

Chapter 1. Other Versions

Centerprise, Release 8

This will open a new window where we will specify the input parameters or variables for Source table.

• Name: TBLName
This is the name of the input variable and will be hardcoded in the config parameters of the Database Table
Source object.
• Data Type: String
• Variable Type: Input
• Default Value: Employees
The Default Value can be the name of any table in your source database which you want to process on the
template dataflow. Here, we have provided the Default Value as ‘Employees’ since we want to process the
Employees table through the template dataflow we’re designing.
Once you have specified the parameter details, click OK.
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Now go to the Database Table Source object and enter its Properties. Go to the Config Parameters screen.
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Here, you need to provide details of the parameters you’ve specified in the Variable object.
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Click on the Value field for TableInfo.Name and write {Variables.TBLName}. Once done, click OK.
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Now, as per our use case, we want to write the source data to a delimited file destination. For this, let’s drag the
Delimited File Destination object from the Destinations section in the Toolbox onto the designer.
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Now map fields from Database Table Source object to Delimited File Destination object.

Right-click on the Delimited File Destination object and go to Properties.
This will open a new window where you need to point the path to the location where you want to save your output file.
Provide a name and location and click ’Save.’

1242

Chapter 1. Other Versions

Centerprise, Release 8

Since we will be using this dataflow template for multiple tables in our database, the destination file path should be
dynamic so that it could generate a new output file with a unique name for each table it processes. To do that, go to
Config Parameters screen in the Delimited File Destination object.
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Here, you need to provide parameters that will generate a new output file every time a table is processed through the
dataflow. Let’s write the following value for Destination File:
\arrakis\share\Fiza Baig\TemplateMap_Output{Variables.TBLName}.csv
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Once done, click Ok to close the Properties window.
Now right-click on any mapping link connecting a field from source to destination and select Template Map Properties
from the list.

1.118. Using Dynamic Layout/Template Mapping in Astera Centerprise

1245

Centerprise, Release 8

This will open a new window where you need to specify the template map type.

Click on the Template Map Type drop-down list. You can see two options:
• Guide Map: This mapping link serves as a pointer between two objects in a dataflow and determines how the
data flows between them. The Guide Map works independent of the different fields in a source object. As in, it
merely defines the path of the data from source to destination and has nothing to do with whichever field it is
mapped to.
• Conditional Map: Conditional Map specifies a set of conditions for a particular field in Source and Destination
file layouts.
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Let’s select Guide Map as our Template Map Type and click OK.

You can now see Guide Map written over the mapping link.

1.118. Using Dynamic Layout/Template Mapping in Astera Centerprise

1247

Centerprise, Release 8

Our template dataflow is ready. Now let’s run the dataflow. You can observe the progress in the Job Progress window.

If you look at the job trace, you can see that Centerprise has generated a new dataflow (DynLayoutProcessed.df ) based
on our template dataflow. The output file too, which is a CSV file in this case, has been generated at the specified
location. You can find clickable links to the new dataflow as well as output file in the job trace.

Note: To be able to access and open the new dataflow in Centerprise, you need to be logged on to Astera Integration
Server. For this, go to Services > Astera Integration Server 8 > right-click > Properties > Log on.
Let’s open this new dataflow in Centerprise by clicking on the link in the job trace.
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You can see that this new dataflow that has been generated automatically is the exact copy of the template dataflow we
created in the previous steps.

Based on the Default Value ‘Employees’ in the variable object, the Database Table Source object has automatically
picked the table from the database, replacing the Customers table in the template dataflow, and has populated the fields
from the Employees table in the Source as well as Destination objects.
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Click on the output file link in the job trace to open the CSV file in Centerprise.

You can see that records from Employees table have been written into the output file.

Automating Template Maps for the Entire Database
Our source database contains multiple tables and we want to run all of them through the same process we defined
in our template dataflow. We can orchestrate this entire process for automation using the workflow and scheduler
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component in Astera Centerprise.
Let’s see how it’s done.
Open a new workflow by going to File menu > New > Workflow.

This will open a new workflow window in Astera Centerprise.
Drag and drop the ADO.Net Metadata Collection object from the Sources section in the Toolbox and drop it onto the
designer. The ADO.Net Metadata Collection object provides metadata to the database we want to read the data from.
However, if you are working with file sources such as Excel or Delimited, you can use the File System Items Source
to provide metadata for your source files.
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Right-click on the ADO.Net Metadata Collection object and go to Properties.
This will open a new window where you need to provide details to establish connection with the database. Once the
connection is established, click Next.
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Here, you need to select the ADO Collection from the list. Click on the drop-down and select ‘Tables’ from the list.
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This will provide us metadata about the tables in the database. Now click OK to exit the window.
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Right-click on the ADO.Net Metadata object again and set it to run on loop. This is because we have multiple tables
in our database, and we want to process them all through the dataflow.
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Now, drag a Run Dataflow task object from the Workflow Tasks section of the toolbox and drop it onto the designer.
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Map the Ado.Net object from the header node to the RunDataflow task.

Now right-click on the RunDataflow task header and go to Properties.
This will open a new window where you need to provide the path to the template dataflow. Click Ok.
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Now expand the Input node inside the RunDataflow task object and map ‘TABLE_NAME’ field from ADO.NET object
to the ‘TBLName’ field in the RunDataflow task object.
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Our workflow is now ready for run. Save it to your desired location and click the Run button in the main toolbar.

This will start the job. You can see the progress in the Job Trace window.
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You can see that all the tables in the database have been processed sequentially through the template dataflow and a
new dataflow has been generated automatically for each table. You can open these dataflows as well as output files by
clicking on the links in the job trace.

The output files too have been generated at the specified location.
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As mentioned earlier, you need to be logged on to Astera Integration Server to be able to access and open the autogenerated dataflows in Astera Centerprise.
The workflow can now be deployed on Centerprise’s built-in Scheduler to be executed automatically, at a time and
frequency of your choice.
This concludes using the Dynamic Layout/Template Mapping Feature in Astera Centerprise. Please note that this is a
beta version of the feature. The functionality is still in testing phase and could change as we get user feedback on this
feature. Should you have any suggestions or feedback, or come across a bug, please report to our Support site or email
at support@astera.com.

1.119 Synonym Dictionary File
A synonym dictionary file enables users to handle challenges that arise because of inconsistencies in the headers in a
data set. You can create a Synonym Dictionary file in a project to store the values for alternate headers in the source
data. Centerprise will check for variants and match these variations at run-time to extract the incoming data. You
can also use Synonym Dictionary file to facilitate automapping between objects on the flow diagram that use alternate
names in field layouts.

1.119.1 Adding a Synonym Dictionary File to a Project
1. In the project explorer window, right-click on the object in the project tree where you want to add a synonym
dictionary file and select Add New Item > Synonym Dictionary File.
2. Provide the name of the file and click Add and a new text file with a .Syn extension will be added to the project.

1.119. Synonym Dictionary File

1261

Centerprise, Release 8

1262

Chapter 1. Other Versions

Centerprise, Release 8

3. Synonym Dictionary File is a text-based file and you can specify alternate header values in a pipe-separated format.
Example
Imagine that you collect shipping data from various customer organizations. Each of your customer organizations
sends in the data but Organization A refers to shipping number as ShippingID, Organization B refers to it as Shipment_ID, and Organization C refers to the same data field as Shipment Number. Now you want to continuously
process the incoming files through a single dataflow.
You can add a synonym dictionary file to your project and specify the alternate header values used by your customers
for shipping number. Centerprise will match for the values provided in the dictionary and read the data from the
incoming source files containing the header variations. In the screenshot below, we have created a synonym file for
the example illustrated above.
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4. Save your synonym dictionary (.Syn) file and you can easily use the file for multiple dataflows within a project that
use SmartMatch layout feature.
In the following section of the article, we will cover how you can enable the smart match reading option for file
sources. When SmartMatch option is enabled, Centerprise will look for alternate header values defined in the synonym
dictionary file and read the data from incoming file sources accordingly.

1.119.2 How to Use SmartMatch Option for File Sources
1. Drag-and-drop the file source object from the Toolbox onto the designer. If the Toolbox is hidden, press Ctrl +
Alt +X.
2. Right click and select Properties from the context menu to go the properties of the file source.
3. In the properties window, under the Advanced File Options, select the option that says Use SmartMatch with
Synonym Dictionary.

Centerprise will now look for the alternate header options in the synonym dictionary file in the project and read the
values for the header names that are different between the source layout in the dataflow and the incoming source file.
Note: The SmartMatch feature to read alternate header values from a synonym dictionary file is available only for file
sources (Fixed length, Delimited, and Excel Workbook sources).
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1.120 SmartMatch Feature
SmartMatch feature in Astera Centerprise adds to the reusability of the file source objects used in the flow documents
(dataflows, workflows, and subflows). When the SmartMatch option is enabled, Centerprise checks for the specified
alternate header values in a synonym dictionary file that is a part of the project.

1.120.1 How SmartMatch Option Works
Astera Centerprise looks for the alternate header values using a step-by-step approach. First, it looks for exact header
match in the incoming source file and the object layout specified in the dataflow. Second, it checks for alternate headers
in the field layout (as opposed to alternate headers in the synonym file).

1.120.2 Synonym Exact Match
If for any specific field, it is unable to find the exact header match, it then looks for the specified alternate header values
in the synonym dictionary file.
Note: The Use SmartMatch with Synonym Dictionary option should be enabled for file sources for Centerprise to look
for alternate header values in a synonym dictionary.
In a synonym dictionary file, it will look for exact variants first. For example, if the synonym file has an entry
ShippingID=Shipping Number, Centerprise will read the data from the fields marked ShippingID and Shipping Number
in the same way.

1.120.3 Synonym Token Match
You can also create tokens in a synonym dictionary file.
For example, if you define that ID = Number|Num|number|#
Centerprise will store the values defined as a token and use it to read the data wherever an exact header match is not
found. Tokens are useful to handle layout differences in multiple header fields at once.
For instance, for the token created for ID, shown above, Centerprise will handle unmapped data fields as shown in the
table below:

1.120.4 Compact String Match
If there are still unmapped fields, Centerprise will remove whitespaces and punctuation characters and attempt to
match source and target.

1.120. SmartMatch Feature
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1.121 Scheduling Jobs on the Server
Astera Centerprise comes with a built-in scheduler that allows you to run your jobs automatically as per the defined
settings. There are various options to set the the frequency of a schedule such as Run Once, Hourly, Daily, Weekly,
Monthly, and When file is Dropped. Once you create a job schedule, it will run according to the defined frequency and
command.
Scheduled jobs run silently on the server in the background. A new tab in the Job Progress window will be added for
each scheduled job that has started running. Results of the scheduled jobs are stored in the Job Log in the same way
as for the regular jobs.
Optionally, you can set an email notification to signal the start and/or the completion of a scheduled job. An additional
email can notify the selected recipient for any errors that occurred during the job.

1.121.1 Opening the Job Scheduler
To open the Job Scheduler, go to the main menu bar > Server > Job Schedules.
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The Scheduler will open in a new tab.
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Another way of opening the Job Scheduler is through the Server Explorer.
Go to Server Explorer > Toolbar and you will find an icon for Job Schedules.
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Or, you can also right-click on the Default Server node and find Job Schedules in the context menu.

1.121.2 Adding Schedule Tasks
1. To add tasks in the Scheduler, go to the Icon Bar in the Scheduler and click on the first icon that says Add Scheduler
Task.
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Once you click on the icon to add a task, the Deployed Jobs tab is going to get active.
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2. Provide a name to your job in the Name bar.
In this case let’s name this job as “Sample Job”
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3. Next, you need to select the Schedule Type for the schedule.
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There are two Schedule Types:
• File: This option is selected when you want to create the schedule for a dataflow, dubflow or workflow.
• Deployment: This option is selected when you have to deploy a project.
In this case, we’ll select the File type for scheduling the task.
4. In this File Location, provide the Full Path to the file that you want to schedule.
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There are some other options as well for Server, Dataflow and Job which you can select according to your requirements.
5. Once the file path has been provided, you can set the Frequency of the schedule.
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There are different Frequency options to set your schedule.
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Let’s discuss these one by one:
• Once

– Run on: This is to set the date for the one time run.
– Start at: This is to set the time for the one time run.
• Hourly
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– Scope: You can select No restriction on hours or specify the hourly window in the Run only between
hours option.
– Frequency Details: You can specify the minutes in the hour by selecting the Once every hour option or
select Multiple times every hour and specify the minutes interval.
• Daily

– Start at: You can set the exact time you want the schedule to run.
– Perform this task: You can select whether you want this task to be performed everyday of the week by
selecting Every Day, or select Weekdays so that the task does not run on weekends, or you may give the
number of days that you want the task to run on by selecting the last option.
– Start Date: You can set the exact date on which you want the schedule to run.
• Weekly
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– Start at: You can specify the exact time when you want the schedule to start each day.
– Select days of the week when the task is run: You can check the specific days of the week on which you
want the schedule to run.
• Monthly

– Start at: You can specify the exact time when you want the schedule to start each month.
– Day: You can specify the date of the month that you want the task to run. Or you can select from the
generic options for one specific day of the week such as First, Second, Third, Fourth, and Last.
• When File is Dropped
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– Dropped File Info: You can provide the directory path that the scheduler needs to watch for file drop to
start the job.
– File Filter: You can filter out specific file formats to be picked from the specified directory.
• Continuous

– Scope: You can select No restriction on hours if there is no specific time frame to run the job or specify
an hourly window in the Run only between hours option.
– Continuous Settings: You can select options for Rerun, Erroneous Records and Job Termination to run
the job continuously.
In this case we will set the Frequency of schedule to be run Monthly on every last Friday of a quarter at 5 pm.
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1.121.3 Other Scheduling Options
There are some other scheduling options in the scheduler which you can set while scheduling a job.
Job Parameters
In this tab, you can specify parameters for the objects used inside the dataflow or workflow that you have scheduled.
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Notification Email
Using Notification Email tab, you can select Enable Notification option to configure emails notifications for a scheduled job.
• Notify only on abnormal termination: Select when you want the email only to be sent for a failed job.
• Send Notification Email: Select when your notification email should be sent When the job ends, When the job
starts or Both.
• Notification Email Content: Depending on the level of information you need in the notification email, you can
select from two modes: Summary and Detailed.
• Email Addresses: You can provide a single or multiple email addresses in the dialog box.
In this case, we will Enable Notification for a Summary, When the job ends and we will add two email addresses.
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Job Run Options
You can specify run options such as Pushdown Hints if you want to run the schedule in pushdown mode. You can
also enable Optimization for dataflows.

6. Our schedule task has now been configured. The next step is to save the schedule for it to run on the server. To do
that, click on the Save Selected Task icon in the icon bar.
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7. You can now see your saved schedule task in the Job Schedules.
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You have successfully scheduled a job in Astera Centerprise.

1.122 Role-Based Access Control in Astera Centerprise
In many business scenarios, Centerprise client is used by multiple users within an organization, each with a different
skill set and job role. Addressing the need for security and access control in such cases, we have implemented a robust
role-based security control mechanism in Centerprise 8 that enables administrators to define user roles and assign all
the resources they need.

1.122.1 Default User Roles and Assigned Resources
Astera Centerprise 8 is shipped with three standard roles, each with a pre-defined level of access to resources. These
roles are Root (Super User), Developer, and Operator. Each role has access to a set of URLs (REST APIs) and UI
Commands relevant to the type and nature of their job. The URLs allow accessing the feature/functionality via a REST
API call. Whereas the UI commands allow users to see the enabled features and functionalities on the client UI
The permissions and access can be modified for each role by a Super User with admin privileges. Moreover, new
roles can be created with custom permission sets. A new role can be quickly created by copying the permissions of an
existing role, which greatly simplifies a custom security setup.
Here are the three default role types described in detail.
Root (Super User or Admin)
The Super User has complete access to all types of resources available via REST API URLs and the client user interface
(also known as UI commands). The Super User also has the administrative authority to create, edit, and modify other
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roles as well as grant, revoke or customize access to available resources. You can assign Super User (Root) access to
more than one user in Centerprise.
Developer
This role has access to all the APIs and commands required for designing ETL and ELT flows, workflows, report
mining, query writing and editing, XML editor, mapping editor, data validation and profiling, as well as deployment.
This is to allow users with developer access to design, modify, schedule dataflows, workflows and deploy projects on
the server. Moreover, they can modify other scheduled jobs on the server, but do not have the permission to delete
them. Some of the resources assigned to the Developer role by default are listed below:
REST API URLs
• Jobs
• Schedules
• Cluster
• Events
• Deployments
• Preview
• Event
• Functions
• Partial access to DB and ServerInfo APIs
You can access Centerprise’s REST API documentation on the following link:
Centerprise API Documentation
Commands
Design Tools
• *Dataflow* – commands to execute dataflows, create new dataflows and subflows
• *Workflow* – workflow UI commands such as Execute, Stop, Pause, etc.
• *QueryEditor* – query editor commands for foreign/primary key drop, key script create, key script drop, create
new query, open query, connect or change connection, increase/decrease indent, execute, etc.
• *XMLEditor* – XML editor commands to format, create new XML/XSD file, new text file, load, clear, and
generate schemas
Monitoring UI
• *Trace* – job trace commands to show error info, export trace, find error, error navigation, show SQL statement,
etc.
• *Output Control* – clear output command
• *ServerMonitor* – commands for Server Monitor features
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• Server Log – commands for server activity and jobs run
• *JobStatus* – workflow job monitor command
Mapping Commands
• *dbConnectionMapsCommands* – database connection maps commands such as add, remove, edit, etc.
• *ServerPathMapping* – add, delete, save, export, import server path mapping
• *MapProperties* – commands for different mapping types and properties (one-to-one, one-to-many, many-toone)
• *MapEditor* – mapping commands
Scheduler
• *ScheduleFile* – schedule new file command
• *Scheduler* – commands to add, run, remove, save, refresh, import, or export a scheduled task
• *SchedulerLog* – Scheduler log refresh and delete all commands
Operator
The Operator role has been designed for a user responsible for deploying, scheduling, and monitoring jobs to run on
the target server. An Operator, by default, is assigned the least level of access presets compared to other role types.
They have permission to access commands and REST APIs required to view and export job trace, refresh job lists,
manage and track runtime instances of jobs, and execute jobs scheduled on the server.
The Operator role, by default, has access to the following resources:
REST API URLs
• Schedules
• Events
• Deployments
• Partial access to Account, Jobs, Cluster, and Server APIs
UI Commands
• Output Control
• Deployment
• Scheduler
• Partial access to File, Window, QueryEditor, Trace, Server, Server Monitor, and QueryPreview
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1.122.2 Accessing Resources Assigned to a Role
A user with ROOT access has the ability to add, edit or restrict access to resources for any role. To access resources
assigned to a role, right-click on any Role in the Role Management window and select ‘Edit Role Resources’ from the
context menu. You can open the Role Management window by going to Server Explorer > right-click DEFAULT >
Role List.
Here, we’re accessing resources assigned to the DEVELOPER role.

This will open a new window where you can edit and modify resource access for the selected role.

1.122. Role-Based Access Control in Astera Centerprise
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There are two panels on this screen.
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The left panel contains two main nodes:
• Url:// - allows accessing the feature/functionality via a REST API call. For instance, ServerInfo can be accessed
via the following REST API call:
HTTPS://$servername:9260/api/adm/ServerInfo
• Cmd:// - enables users to see the enabled features and functionalities on the client UI
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If we expand these nodes, you can see that the panel contains all the resources available in Centerprise.
You will see that the resources listed in this panel appear in three different colors. The color scheme is to distinguish
between what resources have been enabled, disabled, or partially enabled for a role.
• Red: Denotes that the resource has been restricted for the role.
• Green: Denotes that the resource has been enabled for the role.
• Black: Denotes that the resource has been partially enabled, with limited access to some features.
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The right panel lists all the resources assigned to a role.
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To disable access to a resource, right-click on that resource in the Role Resources panel and click Disallow.
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This will disable the selected resource for the user role. Or you can click on the Edit link next to a resource and
uncheck the Allowed option, to disable access to a resource.
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You can also permit or remove access to resources using these buttons.
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1.122.3 URL and CMD Resources Available in Centerprise
REST API URLs
You can access Centerprise’s REST API documentation on the following link:
https://localhost:9260/swagger/index.html
CMD
• *File* – File menu commands, such as Print, Save, SaveAs, SaveAll, Close, FileExit, etc.
• *Edit* – Edit menu commands, such as Cut, Copy, Undo, Find, etc.
1.122. Role-Based Access Control in Astera Centerprise
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• *Window* – designer windows, tabs, dockable panels
• *Context* – context info commands such as copy path, open folder, etc.
• *View* – View menu commands
• *Tools* – Tools menu commands
• *Browser* – Browser commands (Home, Next, Previous, Refresh, Stop)
• *CloudPath* - CloudFilePathCommandConnect
• *ODBC UI* – ODBC UI commands base and connection string commands
• ODBCCommands – ODBC drivers and connection string commands
• *dbConnectionMapsCommands* – database connection maps commands such as add, remove, edit, etc.
• *ServerPathMapping* – add, delete, save, export, import server path mapping
• *Project* – project-related commands
• *QueryEditor* – query editor commands
• *DataModel* – data model commands
• *EDI* – new custom repository, new partner profile
• *Formats* – format maintenance command
• *Development* – development commands to write built-in function, localization, reset package and language
picker flag, load and save new colors, generate XML for URI-securable and command-securable resources
• *General Editor* – general command toggle binary mode
• *XmlEditor* – XML editor commands
• *Wizard* – run transfer wizard commands
• *Workflow* – workflow UI commands such as Execute, Stop, Pause, etc.
• *Session* – add a new session, execute session command
• *Dataflow* – dataflow commands
• *Packages* – SFToCRMPackageCommand
• *Resource list command* – show details, refresh resource list
• *ListEditor* – add, remove, save list editor commands
• *Trace* – job trace commands
• *JobStatus* – workflow job monitor command
• *Server* – commands to deploy, schedule, run and remove jobs on server
• *ServerMonitor* – commands for Server Monitor features
• *Views* – toolbar button edit filter
• *Output Control* – clear output command
• *Flow* – flow UI commands
• *Data Mart Tree* – remove, add, rename data mart tree commands
• *DataModelBrowser* – commands for Data Model Browser features
• *EntityList* – base, select all, deselect all entity list controls
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• *Data Model Mapping* – data model mapping commands
• *Data Model Sync* – commands for data model sync maps
• *DbBrowser2* – commands for Data Model Browser features
• *Lineage* – commands for data lineage and impact
• *LoadSettings* – new load settings command
• *ScheduleFile* – schedule new file command
• *SharedAction* – create a new shared action command
• *OLAPViewer* – edit, refresh, preview, print, show, stacked, chart totals commands for OLAP viewer
• *ReportMining* – UI commands for report mining features and functionalities
• *TextReportPattern* – alpha, digit, alpha digit, whitespace, non-blank text report commands
• *ConditionRules* – add or remove condition rules
• *Build Layout* – build output layout command
• *WizardControlCommand* – next page, previous page, go to page commands
• Export – commands to write transfer to Excel
• *QueryBuilder* – features, and options in query builder (show filter, sort order, where clause, add and remove
a filter, add sort, refresh data model)
• *PickTable* – add tables, stop add, select and deselect all
• *CDC Table* – create all, script all CDC table
• *TableSelection* – table selection commands to show views, select and deselect all
• *List View* – base, add, edit, and delete command for list view
• *AsteraDataGridView* – copy all, delete, find, export to Excel
• *AsteraUltraGridView* – delete, find, ExportToExcel
• *Diagram* – flow diagram commands for auto-layout, collapse, expand all, and various types of zooms
• *Preview* – data preview commands
• *NodeMetaTree* – add segment, element or composite element reference, move up and down, add EDI group,
delete meta
• *TransactionMapCommands* – add or delete transaction maps
• *EDIPartnerCommands* – commands to generate test data file
• *EDIMaintenanceCommands* – save, delete, verify an item
• *EDIValidationRuleCommands* – move EDI validation rules up and down
• *EDIValidationCommands* – commands to add, edit, delete EDI validation
• *LayoutGrid* – copy value to all fields
• *MapProperties* – commands for different mapping types and properties (one-to-one, one-to-many, many-toone)
• *MapEditor* – mapping commands
• *Object Node* – expand or collapse objects on designer
• *Layout Tree* – commands to sort the layout in the alphabetical or original order

1.122. Role-Based Access Control in Astera Centerprise

1297

Centerprise, Release 8

• *Profile* – data profiling commands
• *QueryPreview* – commands to show, copy, and refresh queries
• *SortOrder* – add or remove the sort order
• *Filter* – filter commands for the query builder
• *Sequences* – commands to add, save, remove or modify sequences
• *ValidationRules* – data quality commands
• *Verification* – commands to verify flows before execution
• *Deployment* – commands to import, export, add, save, or remove deployments
• *PathInfoReplacementCommands* – path info parameter commands for base, ApplyToAll, Discard, SwitchModeToGrouped, and SwitchModeToListView
• *Scheduler* – commands to add, run, remove, save, refresh, import, or export a scheduled task
• *SchedulerLog* – Scheduler log refresh and delete all commands
This concludes a round-up of role-based access control in Astera Centerprise. Click here to read more on how to create
a new role and assign resources in Astera Centerprise.
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1.123 Astera Centerprise – What’s New in Version 7 and Version 8
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1.123.1 Astera Centerprise 7 - New Features
ELT (Pushdown) Optimization introduced
The support for ELT mode (stands for extract, load, transform), also known as ‘pushdown’ has been enabled in
Centerprise 7. This mode allows certain flows to run directly on the database server, reducing or even eliminating the
need for data to travel to and from Centerprise server. This brings in some tremendous performance gains for certain
scenarios. In addition, the new Pushdown Verification feature allows the user to quickly check if the flow is eligible
for pushdown.
Layout Expressions
Many objects on the flow allow expressions to be defined in field layout. This saves the need to have a separate
Expression transformation object on the diagram, simplifying flow design.
‘Continuous’ schedule; option to name schedules
A new ‘Continuous’ option of schedule has been added to ‘Schedule Type’ options. This schedule type allows the user
to create schedules that run in a continuous loop and specify custom delay settings. Moreover, you now optionally
name the schedules you create in Centerprise 7.
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Updated SOAP and REST Connectors; REST connectivity through built-in REST client
SOAP destination and SOAP lookups have been deprecated. Their functionality is offered by the single SOAP transformation object, which improves ease-of-use. REST connectivity is achieved thanks to the built-in REST client
object.
New Project Deployment Model with Config Parameters
Centerprise 7 introduces a new way the flows can be deployed to the target environment, which streamlines the management of environment-specific database connections, network paths and flow variables. A project can be packaged
into a single deployment file (aka CAR file), and the deployment file can have several config files with environment
specific settings, making it possible to reuse the same deployment file and customize it for each target environment.
Database Writer Optimizations
Database write speeds are faster now for most database providers. The speed gain is especially noticeable for larger
data sets using bulk or array insert. This performance improvement applies to several key database providers, including
MSSQL, DB2, Oracle, Salesforce, MySQL, and Postgres.
Database writer framework has been redesigned to use temp tables with indexes on key columns, as well as temp files
where applicable, which reduces network and database overhead, and increases bulk write speed.
New implementation of bulk UPSERT (Update followed by Insert) has been enabled for most database providers. This
brings a significant speed advantage over previous versions, which processed data loads on a per record basis. Array
Insert is faster than previous versions and it also optimizes memory use for typical batch sizes
New Transformations Features
A new *Transform Layout* interface has been added, which greatly simplifies the design and management of collections in complex object trees. This new feature is invoked via a command on the context menu for EDI Parser and
EDI Builder objects, as well as the PassThru transformation. Using this new feature, the user can select a node and
transform it to modify the structure of the object tree without the need to update the underlying schema.
New Database Features
*Identity Columns* and *Sequence Objects* are supported in more database providers now. Centerprise 7 introduces support of identity columns in Oracle destinations (this requires Oracle 12c or later) as well as adds more robust
handling of sequence objects in the database providers that support it, including Oracle, DB2 and PostgreSQL. The
handling of binary data in DB2 and Oracle has been improved. PostgreSQL destination has a new mode for bulk
loading data from a temp file directly into the Postgres server. This increases write speeds for certain configurations.
New EDI Features
• Improved X12, HL7 and Edifact support
• EDI repositories for X12, HL7 and Edifact are no longer bundled with the client/server installer. They can be
installed as needed by selecting the required dialect in the special Addon installer.
• EDI transaction configuration has been simplified. In 7.4, EDI versions and transaction sets can be selected
directly in the EDI object on the diagram, rather than via the Trade Partner Profile dialog.
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New RM Features
*Improved portability of Report Models across different locales*. Report Models can now be re-used in different
locales without worrying about date/currency/number format compatibility in the target locale. The user can specify
that the report model keeps the settings of the locale in which the model was created. These settings will apply
regardless of the target environment/locale where the report model is used. Conversely, the report model can be set to
adapt to the target locale so that the locale-specific settings are processed according to the target environment.
Other New Features
• *Importing Schedules and Deployments* – schedules and deployments can now be exported into a file,
and then imported into a target repository. This simplifies repository migration tasks as it saves the need to
backup/restore Centerprise repository.
• *FileSystem* object has a new property to return an extra record for each folder
• *EmailSource* object supports POP3 protocol now, in addition to IMAP. Email logging has been improved.
• *Write To* command on the context menu lets you add a destination object of your choice and map it in one
step.
Switch Transformation
Switch transformation has been added to Centerprise’s library of built-in transformations. It matches source data for
the criteria specified by the user, and wherever the criteria is met, it replaces the information in the particular field with
the desired output (also specified in the layout). This gives users more control over their data and helps them manage
it in a better way.
Reconcile Transformation
Reconcile transformation in Astera Centerprise enables the user to identify and reconcile new, updated, or deleted
information entries within the existing data source. It can be applied in a wide variety of business scenarios that require
a user to identify changes in multiple data records and capture them efficiently to drive critical business decisions.
Merge Transformation
Merges data from disparate sources for a consolidated and unified view. Merge transformation in Centerprise is designed to merge data fragments from disparate sources, based on some predefined logic, and present it in a consolidated
form to draw actionable insights.
Data Cleanse transformation
A new transformation Data Cleanse Transformation has replaced the ApplyToAll transformation in Centerprise 7. It
enables users to cleanse and prepare raw data for further usage. You can perform all sorts of data cleansing tasks such
as removing whitespaces, unnecessary letters and digits, or any other specified characters. You can even perform a
find-and-replace action on your data set or change strings to lower/uppercase as needed.
Flows that use ApplyToAll transformation, created on earlier versions of Centerprise will continue to work as is, and
do not need any modifications after the upgrade.
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SmartMatch Functionality
It is common to run into cases where you are dealing with alternate headers. For instance, a Product ID field can
be defined in multiple ways in the incoming data sets. It can be called ProductID, Productid, Prod_ID or any other
variation of it.
You can now create a Synonym Dictionary File in a project to store these alternate header values and Astera Centerprise
will match these variations at run-time to map the incoming data. You can also do synonym-based mapping of the
fields that have different names in the two objects by defining them in the dictionary and then using the Shift key while
adding the maps.
Built-in Job Optimizer
Centerprise 7 introduces Job Optimizer that is designed to optimize and modify the flow at run-time. The Job Optimizer
helps improve dataflow performance, reduce running times and optimize CPU, RAM, disk and network utilization.
For example, it can remove unnecessary sort operations from the dataflow when the data has previously been sorted,
which can dramatically improve flow running time. Conversely, Job Optimizer can add ORDER BY clause on database
sources where needed so that the sorting takes place in the database as opposed to on the ETL server.
In addition, it also provides suggestions in the job trace to help the user further optimize the flow. An example below
shows how Job Optimizer presents optimization improvements and suggestions in the job trace.
Auto-Determine Field Names
This new feature automatically detects the header name for each column of the data region from the source file loaded
into a report model. To work with it, select the desired field, right-click on it and Auto Determine Field Names.

1.123.2 Centerprise 7 - Improvements
Improved parallel-processing engine that takes full advantage of multicore and multiprocessor hardware
Improved parallel-processing engine that takes full advantage of multicore and multiprocessor hardware. Cluster
failover is now more robust compared to version 6. Overall better scalability to efficiently accommodate massive data
volumes. Better handling of database connections and file streams. Better memory management when loading large
data volumes during preview. Memory leaks have been fixed.
Function objects support outbound maps for input parameters
Function objects support outbound maps for input parameters, making it easier to connect them to other objects on
the flow diagram. Functions also support optional parameters starting with version 7.1. Certain function objects also
support collections.
Workflow designer allows the user to run a single task on the diagram
Workflow designer allows the user to run a single task on the diagram, skip certain tasks, run the flow up to the selected
task, and start the flow from the chosen task.
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Enabled SCD support for versioning, ‘Insert Only’ and ‘Previous Surrogate Key fields
SCD (Slowly Changing Dimensions) and Diff Processor components have been completely redesigned to address
some functionality shortcomings from prior versions. SCD supports versioning, ‘Insert Only’ and ‘Previous Surrogate
Key’ fields now. The new default mode for SCD is ‘No Output’, which means it is not showing outbound maps. This
makes SCD and Diff Processor act more like database destination objects, which improves performance at run-time,
and simplifies dataflow development.
Updated REST and SOAP connectors
Updated SOAP and REST connectors. SOAP destination and SOAP lookups have been deprecated. Their functionality
is offered by the single SOAP transformation object, which improves ease-of-use. REST connectivity is achieved
thanks to the built-in REST client object.
Improved processing of large XML files
Better handling of large XML files, both during preview and at run-time. This results in less chance of an out-ofmemory situation when processing large files with limited RAM.
Import of COBOL copybooks
Report models can now extract data in a much more meaningful way from COBOL copybooks using the new visual
hierarchical model building and modification capability. In addition, there is now a command in the report tree to
import a copybook, which automatically creates data regions for each of the copybook objects and builds report model
fields based on the copybook fields. Then users can rearrange the data regions in a way that forms a proper hierarchical
model.
Improved handling of nested expressions
Ability to better handle nested expressions, which results in faster initialization and running times when using large
expressions with lots of nested levels.
Client Performance Optimization
• Object trees refresh faster on the flow diagram
• Scrolling of objects with complex trees is faster
• Project load and refresh times are significantly faster for larger projects. In addition, lineage building can be
temporarily disabled in Project Explorer, which helps optimize project tree response times
Server Stability and Performance Optimizations
• Flow termination logic has been improved. Flows terminate faster now, and the Server is generally more stable after terminating flows, even ones that involve termination of child processes and/or database transaction
rollback
• Server framework has been updated to reduce the possibility for resource leaks, deadlocks and orphan connections, which further improves server stability
• Job Monitoring UI is much faster now
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Improved Server Resiliency
We have greatly improved the server resiliency in Centerprise 7. This will ensure trouble-free server operations, better
and quick recovery in the case of a database outage event, and overall improvement in the performance.
The server will no longer go in a permanent state of error in case of a database outage event and will automatically
recover as soon as the connection is restored. Server connection will be automatically established when the connection
to the repository database is available and no manual restarts will be required. Activity and error tracking are greatly
improved in v7. The server writes database connection issues in the Windows event log and includes a link to the error
file for easier troubleshooting.
Workflow performance and reliability
We have made some key improvements to the Astera server code to enhance the reliability and performance of workflows. Additional safeguards have been added to the workflow logic to make sure that workflows never get stuck
in Running state even in the case of transient communication errors between the cluster servers and the repository
database. Workflow completion times have also improved significantly as a result of these changes.
Improvement in Resume and Terminate functionalities in workflows
In the case of nested workflows and processes, if a child process (dataflow or workflow) returns an error and is not
executed completely, the parent flow will automatically get terminated. Similarly, if a child flow is resumed then the
parent flow will also be resumed automatically. Moreover, you now have the option to either resume your selected
workflow from where it was terminated or rerun the entire flow from the beginning.
New features in the Scheduler
A new option is added to the Scheduler which lets you skip a new instance of a job if the previous instance is still
queued or running. This prevents multiple instances of the same job from queuing in the case of a busy server.
Continuous schedule code has been revised with the goal of improving the reliability and performance of Continuous
schedules, especially when running a busy server with multiple schedule types present. A minimum delay of 5 seconds
is now required between continuous schedule runs. This is done to make sure the continuous schedule doesn’t get in
the way of other schedules competing for the server resources.
Improvements to the Monitoring window
In Centerprise 7, we have significantly improved the UI response times when displaying and navigating long traces.
This in turns help optimize the flow performance of the flows generating large trace output due to reduced database
contention when reading and writing to the trace tables. In addition, the Monitoring window has a new Refresh button
on the monitoring toolbar, which shows a snapshot of the current job status when the trace is paused.
New server configuration keys to improve flow performance when sorting large datasets
Centerprise 7 has a new Sort algorithm that is designed to optimize RAM and CPU use when performing sort operations on large datasets. This new model can bring about significant performance gains in certain scenarios. In addition,
the server administrator is able to further optimize sort performance by modifying the additional configuration keys for
Sort in ServerAdminConfig.xml file. Changing these settings can improve the performance of sorting operations by
allowing the server to allocate more RAM if needed. Changing these values is recommended only if adequate RAM
is available to the server during flow run-time.
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1.123.3 Centerprise 8 - New Features
REST Server Architecture and Lean Client
Featuring an innovative implementation of the client-server architecture, Astera Centerprise 8 uses a REST-enabled
server and lightweight, lean client application. The major part of processing and querying is handled by the server
component, which communicates with the client using HTTPS commands. Therefore, database drivers are installed
only on the Centerprise server. This enables you to scale horizontally and add multiple clients to an existing cluster of
servers without the need to replicate driver installation on every machine.
With this functionality, we aim to minimize the logistical and maintenance challenges involved in installing Astera
Centerprise, creating a more scalable architecture and simplifying software deployment.
New and Improved UI Design
We’ve updated the look and feel of the product with new icons, modern design, and eye-catching colors. The dragand-drop development environment has been revamped into an improved and more responsive UI to deliver a more
user-friendly experience. In addition to the enhanced visual appeal, this new UI is designed to simplify navigation and
enable easier implementation of integration tasks.
Role-Based Security
The new Centerprise 8.0 includes authorization and authentication features to secure any action performed by authenticated users against the run-time and design-time components of the solution. The security is built around three key
areas:
• *User authentication* via bearer-token authentication
• *Secure domain communication* between the client and server over TCP/IP and HTTP protocols
• ***Role-based access control ***via an intuitive user management and access control dashboard
These enhancements will help administrators prevent unauthorized access to data management workflows and ensure
access policies for both internal and remote users.
SmartMatch Functionality
We have introduced the SmartMatch functionality in Centerprise 8 to simplify complex mapping jobs in ETL flows. It
uses a Synonym Dictionary File created by the user to resolve mapping issues that arise due to naming inconsistencies
in the incoming source data. The Synonym Dictionary file is a simple txt file in which users can specify variations
of the header name in a pipe delimited format and Astera integration server will automatically read and match field
names at run-time based on the predefined information in the dictionary.
Job Optimizer
The Job Optimizer enables users to optimize ETL performance and minimize job execution time. It issues recommendations to optimize integration flows, at runtime in job trace. These recommendations can be removing repetitive sort
operations on presorted data, apply an ORDER BY clause on database sources to run sort operations in the database,
or any other suggestion to optimize your flow. As a result, it helps bring a significant increase in performance by
efficiently managing the RAM, CPU, network and disk utilization while executing jobs.
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Astera Web Service APIs
We have published an extensive library of Astera REST web service APIs. Now, you can perform a wide range of
data integration functions by using APIs to directly communicate with the Centerprise server and get the required data.
Here are the resources that are available for the users in the first round of the beta release:
• Account APIs: Resources related to account login and user authentication.
• Server APIs: Resources related to job monitoring, schedules, and server information.
REST API Browser (Beta)
Astera Centerprise 8 features an intuitive REST API Browser that enables connectivity to popular business applications
via single-step authentication to make HTTP calls. It decouples data from the point of origin to make it consumable,
independent from the source system.
To use an API, the user needs to perform a one-time set up for the API connection in the Import API screen. Then, the
REST API Browser populates all the HTTP requests (GET, PUT, POST, DELETE, PATCH) present in that specific
API. Users can access and integrate these calls in their dataflows simply by dragging-and-dropping the object from the
Browser.
Language Parser
We have added the language parser functionality to the Expression Builder to enable advanced expressions such as
interpolated string and verbatim. This will enable users to compile different values from incoming datasets into an
expression and present it as an interpolated string in the output.
Support for New Data Providers
Delivering on the popular demands from our customers, we have pushed the envelope to offer native connectivity to
several new databases, data warehouses, and enterprise applications.
• SAP HANA
• MariaDB
• Vertica
• Salesforce
• Salesforce SOAP (Legacy)
• Amazon Aurora (MySQL)
• Amazon Aurora (PostgreSQL)
• Amazon Redshift
• Snowflake
• Microsoft Access
RM Upgrade
Astera ReportMiner upgrade is shipped with a complete UI overhaul and a number of bug fixes and improvements to
the existing features. The UI has been redesigned to present a fresh, new look while also simplifying navigation and
improving user experience. Here’s a summary of the improvements in Astera ReportMiner upgrade:
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•
UI Improvements
New Options for Raw Data Cleansing
Auto-Determine Field Names
Compared to previous versions, we have now introduced dedicated properties panel for Report Options, and Region,
Pattern and Field Properties in ReportMiner. Each of these panels has a dedicated toolbar with relevant shortcut icons,
making it convenient for users to specify and configure properties of the various components of a Report Model such
as data regions and fields, from within a single panel. The main toolbar too now features shortcuts to facilitate users
in creating report models.
•
We have added a couple of new options to the ‘Remove’ options used for cleansing and scrubbing the extracted data
in ReportMiner. In addition to removing extra spaces inside the text, text qualifiers (surrounding quotes), and leading
and trailing spaces, you can now remove all white spaces and punctuations from within the extracted data by simply
checking the ‘All White Spaces’ and ‘Punctuations’ options under the ‘Remove’ section in the Field Properties panel.
•
While creating extraction templates for reports, you can now automatically determine field names using the ‘Auto
Determine Field Name’ option. Once you’ve specified a data region, add data fields, right-click on a data field and
select ‘Auto Determine Field Name’ from the context menu. This will automatically identify and update field names
as they appear in a report.

1.123.4 Centerprise 8 - Improvements
Monitoring UI Improvements
Centerprise 8.0 includes advanced server monitoring and job management features to enable administrators to proactively manage job monitoring, prevent downtimes, and identify the causes of server failure. Moreover, in case of server
failure or outage, users can generate a diagnostic file to get details about the state of the server and the machine where
it’s deployed.
This diagnostic file contains information such as server status, server health, active connections, process memory size,
thread count, installed drivers, etc. which you can use for troubleshooting and improvements. Furthermore, you can
track, monitor and manage the jobs scheduled, running or executed on the server in the Job Monitor window.
Server and Repository Improvements
Job concurrency has been optimized. The server now counts only active running jobs (whether it’s a parent or child
flow) against the maximum limit for concurrent jobs and will not include the idle parent jobs of those running jobs.
For instance, if a parent workflow (A) constitutes another workflow (B) which calls a dataflow (C), the job run for
dataflow (C) will be counted as a single job and could be run concurrently with other jobs (scheduled or running) on
the server at that time. This improvement, however, is not enabled by default and will only be available for certain
licenses.
Purge function for repository has been improved. Users can now set a frequency (in terms of days) to purge the
repository of old and outdated records. You can also define a time window (in hours) for when you want to purge
the repository as well as purge timeout settings, and purge chunk sizes, to help optimize purging performance in busy
environments.
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Workflow Performance Optimization
Another significant highlight of Centerprise 8.0 is the improvement in Astera server code to optimize the performance,
reliability, and scalability of workflows. The workflow execution logic has been optimized to eliminate any chance of
a workflow hanging amidst session in any state (queued, running, or terminating), even if there are transient communication errors between the main server or cluster servers and the repository.
Parametrization
The parametrization functionality in Centerprise 8.0 has been improved to support expression compilation in variables.
The syntax has been changed from ‘$ ()’ notation to ‘{}’. However, this update won’t affect the parameters incorporated in existing flows. The current flows will continue to run seamlessly as before, without having to manually update
the syntax. And once you save any flow that was using previous notation ‘$ ()’ in version 8, it will automatically get
converted to ‘{}’.
Improvements in List Lookup and DB Lookup transformations
New options added to the layout builder screen of List lookup and DB lookup transformations. Now you can keep the
source value for the values that do not match the replacing criteria in a list or a database table.
Path Mappings tab added
A new tab for specifying client and server path mappings has been added on the Cluster Settings This is particularly
useful when the client and server reside on different networks or network file systems and their paths have to be
mapped to correctly transfer files at run-time.
Option added to repair file paths
For better project management, we have added a new option to repair the file paths for files in any particular folder.
This option is useful if you are working in a case-sensitive environment.
Shortcut for replacing parameters information for consolidated parameters added
Now you can replace the common parameter information for all objects in a flow with this command right from the
dataflow screen.
Pushdown mode is expanded and improved
More transformations and expressions are now supported in the Pushdown mode. We have also improved the explanations for the verification errors for easier troubleshooting.
Salesforce UPSERT is fully supported
Salesforce UPSERT is now fully supported. UPSERT uses an external ID field in the Salesforce table to match
incoming data with existing records.
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Keyboard shortcuts added and displayed
Keyboard shortcuts are enabled for various task windows. You can view the shortcut keys next to their respective
commands.
Performance improvements when mapping complex trees
Runtime performance of the dataflows containing complex tree structures is improved.
SCD Type 3 and Type 6 Supported
SCD type 3 and type 6 are now supported.
REST call retries
For the REST calls running in timeout error, Centerprise will automatically make up to three retry attempts to process
the call.
Extended Support for PostgreSQL Repository
We have enabled support for PostgreSQL for creating cluster databases and server repository in Astera Centerprise
8.2. You can now use a PostgreSQL database to store and manage the record of the server’s activity, including job
logs, job queues, and schedules.

1.123.5 Important Considerations and Known Issues
Digest Authentication
Digest Authentication is not supported in Centerprise 8.
VC++Prerequisite for Centerprise 8
VC++ is a prerequisite for Centerprise 8.3. Before migrating or updating to v8.3, users will need to install VC++
redistributable package on their machine. The bitness (32-bit or 64-bit) of Centerprise and VC++ redistributable package should be same. Minimum required version is Microsoft Visual C++ 2015-2019, v14.26. VC++ redistributable
package can be downloaded from the following link:
Download VC++

1.123.6 Miscellaneous Updates and Important Considerations.
Read more on the other updates and important considerations related to Centerprise 8 on the link below:
Centerprise 8 – Important Considerations
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1.123.7 Upgrading from Centerprise 6 to v7
Astera Centerprise 7 is shipped with new features and functionalities that require an update to the Cluster Database
used by the integration server. Click on the link below to find information on how to upgrade the Cluster Database for
use with Centerprise 7, while migrating from Centerprise 6.
Upgrading from Centerprise 6 to Centerprise 7

1.124 Updating Your License in Astera Centerprise
The license key provided to you for Centerprise 8 contains information regarding the number of clients that can connect
to a single server and the features available to the connected clients. In case you wish to change this information, or if
your current license has expired, you can request Astera for an update. Once your license has been updated by Astera,
you can update it on your Centerprise client.
In this article, we will be covering the steps to successfully update your Centerprise 8 license.
1. First, you will have to access the License Management window, which can be done in three ways:
• Go to Tools > Manage License.

• Go to Server > Manage > Manage License.
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• Click the “Manage the Server’s license” icon in the Server Explorer.
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2. Once you’ve opened the License Management window, click Update License.
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3. On the next screen, click Update.
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4. Centerprise will proceed to updating your license and notify you with a small popup window once it is up to date.
Click OK.
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5. Another popup window will notify you that the server license has been changed and the client needs to shut down
in order to implement the changes. Click OK.
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The Centerprise client will now shut down. Once you start it again, the changes associated with the new license will
have been put into effect.
This concludes updating your license in Astera Centerprise.

1.125 Deploying Astera Centerprise on Microsoft Azure Cloud
Microsoft Azure is an on-premise, hybrid, and future-ready cloud solution. The azure cloud platform has cloud
services designed to build, run, and manage applications across multiple clouds. It provides scalable and highperformance cloud computing experience with virtual machines and SQL databases for testing and deployments.
You can now deploy and configure Astera Centerprise on Microsoft Azure Cloud either through the Azure Marketplace
or using virtual machines on Azure Cloud.
In this article, we will cover:
• Deploying Astera Centerprise using Azure Marketplace on Azure Cloud
• Deploying Astera Centerprise manually on Azure Cloud
To continue, please login to the Microsoft Azure portal here.
1.125. Deploying Astera Centerprise on Microsoft Azure Cloud
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1.125.1 Deploying Astera Centerprise Using Azure Marketplace
Follow the steps below to deploy Astera Centerprise using Azure Marketplace once you login to your Azure portal.
1. Find Marketplace on your portal either through the Portal Menu or by searching for it on the search bar.

2. On the Marketplace search bar, search for Astera Centerprise. You will get the link to Astera Centerprise Virtual
Machine.
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3. If you open Astera Centerprise on the marketplace, it will give you options to either create your own virtual machine
or start with a pre-set configuration. You can choose from the options as required.
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It comes with an overview, plan and pricing, usage information, support, and reviews for more information.
Note: If you deploy it through the marketplace, you have to skip the image selection option in Basics settings and the
SQL Server Settings because the credentials have already been configured. The credentials are as follows: MS SQL
Database Username: Trial MS SQL Database Password: Trial1234567

1.125.2 Deploying Astera Centerprise Manually
Follow the steps below to deploy Astera Centerprise manually using virtual machines on the Azure portal once you
login.
1. Find Virtual Machines on your portal either through the Portal Menu or by searching for it on the search bar.
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2. Once Virtual Machines open, go to Create and select Virtual Machine.
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3. You are now redirected to a setting and configurations page for the virtual machine that you want to create. The
following steps are involved in the configuration:
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Basics

• Subscription: Pay-as-you-go
• Resource Group: You can either create a new resource group or select one from your already existing resource
groups.
• Virtual Machine Name: Name your virtual machine.
• Region: Select your region
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• Availability options: Keep default.
• Image: Select ‘See All Images’, it would redirect you to the Azure Marketplace. Here, search for SQL Server
Microsoft Corporation. Note: You can select any image officially sourced by Microsoft that is MSSQL 2005 or
later on Windows server 2012 R2 or later.

• Sizes: You can refer to the system requirements document to select the size, click here.
• Username: Set a username to access the virtual machine.
• Password: Set a password to go with the username.
• Inbound Port Rule: Keep default.
• Licensing: Keep default.
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Disks

Keep all settings under the Disks heading set to default.
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Networking

Here, everything will stay by default. You will only have to a create a Public IP, select create new to do that. A side
pane will open where you can create your public IP address. Name your IP address and leave its other settings on
default.
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Management

Leave everything set to default in the Management setting.
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Advanced

Let everything be by default in the Advanced setting.
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SQL Server Settings

All settings in this section should be set as default.
• You can optimize Storage Configurations as per your requirements.
• If you have the SQL Server License, you can provide that by selecting Yes.
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Tags

You can create tags here if you require or skip this section.
Review + Create

If your settings pass the validation checks, it will bring you to the review and create window. Select Create to create
your virtual machine.
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4. You can now connect to the created virtual machine by using the Public IP we created in the Networking section on
your remote desktop.
5. Once connected to the virtual machine, you can now install Astera Centerprise on it.
• To download the trial of Astera Centerprise, click here.
• To learn more about the installation of Astera Centerprise, click here.
Note: Once you’ve created the virtual machine, you can connect to the SQL database through the Administrator
Account credentials that you provided earlier in the Basics section while configuring the virtual machine.
This concludes deploying Astera Centerprise on Microsoft Azure cloud.

1.126 Server Command Line Utility
Command Line Utility gives users the ability to submit, terminate, and monitor jobs from the command line. The
executable file, Centerprisecl.exe, and the assembly file, Astera.Core.dll, are essential to utilize the Command Line
Utility. All other assemblies found in the server’s bin directory (read program files) are irrelevant. This means that
centerprisecl.exe is a lightweight program that can be anywhere .NET is installed.

1.126.1 Syntax
The syntax of the command is:
centerprisecl [-H <ServerUri>] [-R <filePath> [[-A] [-V <check|trace>] [-U <interval>]]] | [-S <JobId>] | [-T <JobId>]
| [-I <JobId>]

1.126.2 Arguments
1.126.3 Sample Use-Case
In this article, we will demonstrate how you can submit a dataflow to run on the server that is listening on a specific
port. We will also dynamically change the file path found inside the action objects i.e., our source object and destination object, at runtime. In this example, we will use an Excel Workbook Source object and a Delimited Destination
object.
Finally, we will monitor our job using the verbosity argument with trace option while adding update interval every 3
seconds.
In the following section, let’s see how you can achieve this.
Essential Steps
Parameterization
Parameterization allows the source and destination files to be replaced at runtime. This is an essential step.
1. Parameterize the file path of the action objects used in the dataflow.
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We have used a Variables object in our dataflow to parameterize the file path of the source and destination objects.
The source_file variable will receive the source file path, while the dest_file field will receive the destination file path.
Now, go to the Config Parameters window of both the action objects and provide the relevant variable as Value to the
FilePath (source object) and DestinationFile (destination object) parameters.

1.126. Server Command Line Utility
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Now, let’s go over how to use the Command Line Interface.
Command Line Interface
1. Navigate to the folder location of the Astera Integration Server and copy the path. Go to the command line interface,
run as administrator, and change the directory to the folder location of Astera Integration Server.
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2. Write the command to run the dataflow.

On the Command Line Interface, you can see that the login was successful and the job was executed. You can also
verify this through Centerprise client application by going to Server > Job Monitor.

1.126. Server Command Line Utility
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The job has successfully been executed.
Command Components
Server Uri
Specifying the server and the port it should listen to requires the use of the -H argument.
https://serverUri:port

The format is:

• serverUri is the name or the IP address of the server. For example, we have used our machine name, ASTLAP035.
• port is the communication endpoint. You have to specify the port number. For example, we have used the port
number 9260. If no port number is assigned, 9260 is used by default.
Login
You have to provide your login credentials to access the Astera Integration Server. The format is: username::password
Running a Job
Running a job requires use of the -R argument. When this is done, the path of the file is read, parsed, and the contents
are sent to the server. Keep in mind that the server may be on a separate machine and file paths need to be accessible
from that server.
If the -A argument is used, only the ID of the job that was created is returned and displayed on screen. If the -A
is not used, centerprisecl will not return until the job has finished. If the check verbosity flag is used, a status will
be displayed periodically, along with a timestamp. This timestamp is the time of the status request. If the “trace”
verbosity argument is used, centerprisecl will periodically poll the server and get the latest trace information.
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Monitoring a Job
Monitoring a job is usually done when the -A argument is used to submit it. For example, you can submit a job, get
the job ID back, and later use the -I or -S flags to check on it.
General Flow Parameters
Centerprisecl can change any parameter available in a flow using the -P argument.
The -P argument can take multiple parameter value pairs separated by a semicolon.
The format is: objectName.parameter1=value1;objectName.parameter2=value2
• objectName is the name of the object you wish to modify. For example, in the dataflow shown above, there is a
Variables object named Variables. Thus, objectName would be “Variables”.
• parameter is the field that is defined inside the object. For example, in the dataflow shown above, the Variables
object has two fields, source_file and dest_file. Thus, the parameter can be either “source_file” or “dest_file”.
• value is the entry for the parameter.
This concludes our discussion on the use of Server Command Line Utility in Astera Centerprise.

1.127 Using Astera Centerprise to Create and Orchestrate an ETL
Process for Partner Onboarding
The secret to enterprise success lies in the expansion of business networks in a way that maximizes operational efficiently. These networks include suppliers, resellers, vendors, and countless other business partners that provide an
open door to vast markets that are inaccessible through in-house logistics alone. However, to secure these advantages,
the external data coming in from these partners should be integrated through an efficient, reliable, and scalable process.
With Astera Centerprise, you can achieve exactly that.
In this article, we will be looking at a detailed use case that showcases the effectiveness of Astera Centerprise in
Partner Onboarding.

1.127.1 Use Case
Wheel Dealers, an online automotive marketplace, will be the subject of our discussion. The WD portal provides customers with a comprehensive list of available cars from multiple different dealerships, with added options to compare
features, prices, and other services. The company currently serves over 1 million customers and acquires data from
over 200 different dealerships across New England and the Mid-Atlantic, with tentative plans to add a thousand new
vendors from the Midwest and Northeast.
At the moment, Wheel Dealers runs a manual ETL process that requires ample time and resources. And with major
expansion plans in the pipeline, this approach will not suffice in the near future. Using Astera Centerprise, we will
be designing an automated data integration solution that extracts data from disparate sources with minimal manual
intervention, thus providing Wheel Dealers with a seamless Partner Onboarding experience.
This implementation of an ETL process will employ the use of numerous items/features available in Centerprise, such
as the following:
• Dataflow
– Excel Workbook Source
– Variables

1.127. Using Astera Centerprise to Create and Orchestrate an ETL Process for Partner Onboarding
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– Data Cleanse Transformation
– Data Quality Rules
– Database Table Destination
– Record Level Log
• Workflows
– File Transfer Action
– List FTP Directory Contents
– Expression
– Run Workflow
– Context Information
– Run Dataflow
• Job Scheduler
A Dataflow will be used to create the ETL process, whereas two Workflows and the Job Scheduler will be used to
orchestrate it.
Let’s take a detailed look at the methodologies being used.

1.127.2 Creating a Project
All of the items being used will be consolidated in one Project. To open a new Integration Project in Centerprise, go
to Project > New > Integration Project.

You can add new items to the Project by right-clicking on the Project tab and selecting Add New Items.
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1.127.3 Creating the ETL Process
As mentioned earlier, we will be creating this ETL Process in one Dataflow[AK1] . The Centerprise toolbox is packed
with various source, destination, and transformation objects that can serve numerous different purposes. For Wheel
Dealers, we want to design a system that captures data, presents it in a refined manner[AK2] , and uploads it to the
dealer database.
Capturing Data
For this demonstration, we will be using an Excel Workbook Source object to capture the partner data. We are assuming
that all of the incoming data is in an Excel format. However, any other source object could have been used depending
on the nature of the incoming files.
1. While the actual source files will be coming in from an FTP server, we will configure the source object through a
template file. This will populate the object with all of the required fields.
1.127. Using Astera Centerprise to Create and Orchestrate an ETL Process for Partner Onboarding
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2. To ensure that the source object picks up the files that are received from the FTP server, we will define a different
file path at runtime by using the Config Parameters screen in the configuration window.
• First, create a file path variable by using the Variables object from the toolbox.
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• Enter this variable as a parameterized value in the FilePath section of the Config Parameters screen.
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For more information on how you can configure an Excel Workbook Source object, click here.
Cleansing Data
To refine and cleanse Wheel Dealers’ data, we will be using two separate transformations.
1. Sort Transformation will be used to sort the data in an ascending order.
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A simple sort will make your data easier to query and analyze, which will consequently reduce burden on the integration server.
For more information on how you can configure and use the Sort Transformation object, click here.
2. Data Cleanse Transformation will be used to further refine the data by removing unwanted characters and spaces.
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The data received by Wheel Dealers is usually well-formatted. Therefore, we will only be using this transformation to
remove leading and trailing whitespaces.
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For more information on how you can use the Data Cleanse Transformation object, click here.
Resolving Errors & Uploading to Database
Wheel Dealers needs a method to fix the errors present in the partner data and integration flows. For this purpose, we
will be using the Data Quality Rules and Record Level Log objects. Moreover, the final data will be uploaded to the
dealer database by using a Database Table Destination object.
1. Data Quality Rules can be used to define some conditions, known as data quality rules, for incoming records. The
records that do not meet these conditions are flagged as errors or warnings.
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In this case, we will be applying two data quality rules.
• Rule 1: The mileage of a used car cannot be null.
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• Rule 2: The transmission cannot be null.
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For more information on how to use the Data Quality Rules object, click here.
2. Next, we will use a Database Table Destination object to access the dealer database and upload the dataset to it.
For information on how to configure and use a Database Table Destination object, click here.
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Notice that some of the element names in the Data Quality Rules object are inconsistent with those in the database.
With an ample amount of partner data coming in from disparate sources, discrepancies are bound to happen. Despite
these discrepancies, Centerprise has still managed to match some of the elements with their counterparts due to naming
similarities, for example, ID and Dealer_ID. However, there are still a few elements that have not been matched
with any others, such as MethodOfPayment, SP, DateOfOrder, and DateOfDelivery. For these, we will be using the
Synonym Dictionary.
• Add a Synonym Dictionary file to the Project and create alternatives for element names, as needed.
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• Press Shift and map the parent node of the Data Quality Rules object to that of the Database Destination object.
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For more information on the Synonym Dictionary feature, click here.
3. Finally, a Record Level Log will be used to flag the errors that do not meet the data quality rules that were defined
earlier.

Once you preview the output, you can see that the relevant erroneous records have been indicated.

WD’s business analysts can investigate this further and follow up with the concerned dealership.
For more information on how you can use the Record Level Log object, click here.
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Final Dataflow
The ETL process has now been created. This is what the final Dataflow should look like:

1.127.4 Orchestrating the Process for Automation
The orchestration of this ETL process requires two main Workflows, an inner Workflow, and the Job Scheduler. Wheel
Dealers wants to implement self-operating and self-regulating processes wherever possible, so the purpose here is to
automate the entire system. Workflows will be used to coordinate how the integration flows are executed; Workflow
1 will collect newly uploaded documents from Wheel Dealers’ FTP server and download them to their local network,
whereas Workflow 2 will dynamically pick up the input files and feed them to the Dataflow we have designed. The
Job Scheduler will be used to schedule Workflow runs.

Workflow 1
Workflow 1 will consist of a main Workflow and another Inner Workflow. The former’s job will be to fetch new files
from the FTP server, whereas the latter will download this new data to the local directory while deleting older files to
ensure that only fresh partner files are downloaded during each run.
Inner Workflow
1. First, we will create a file path variable using the Variables object in the toolbox. This will specify the path of the
files coming in from the FTP server.
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2. The File Transfer object in the Workflow Tasks section of the toolbox will be used to download and delete the files.
Two objects, one for each purpose, will be added to the Workflow designer.
• File Transfer Task 1: Downloading files.
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• File Transfer Task 2: Deleting files.
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• Connect the File Transfer objects to run sequentially, meaning that the older files will be deleted once the new
files have been downloaded.
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• Map the file path variable onto the RemotePath input element of both File Transfer objects. As a result, this is
what the final Inner Workflow should look like:

1358

Chapter 1. Other Versions

Centerprise, Release 8

Main Workflow
1. First, we will use the List FTP Directory Contents object, present in the sources section of the toolbox, to extract
data from the FTP server. The object will be used to specify the FTP connection and the remote path where our
required files are present.
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Notice the S on the top-left of the object header. This denotes Singleton, which means that the object will only work
in a single instance and will thus only retrieve one file from the FTP server. However, our purpose is to retrieve all of
the new files present. For this to happen, right-click on the object header and select Loop from the context menu.
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A Loop icon will now appear on the top-left of the object header.
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2. The Expression object will be used to concatenate the file names coming in from the FTP Server with the path of
the directory, thus creating a complete path for each file after every loop.
• First, map the FileName element from the List FTP Directory Contents object to the FileName element in the
Expression object.
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• A new element by the name of FilePath will be created in the Expression object. Using the Expression Builder
in the Layout Builder screen, concatenate the directory path with the file name. This will dynamically update
the file path as new files are fetched from the FTP server.
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3. The next step is to load the fetched files into the Inner Workflow so that they may be downloaded or deleted. For
this, we will be using the Run Workflow object from the Workflow Tasks section of the toolbox.
• Configure the Run Workflow object by providing the file path for the Inner Workflow.
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• The FP element in the Run Workflow object denotes the file path variable that we had defined in the Inner
Workflow. Map the FilePath element from the Expression object onto FP in the Run Workflow object.

In the Inner Workflow, this variable has been mapped onto two File Transfer objects. As a result, their respective
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actions will take place on the files that are being fetched from the FTP server in a loop.
This is what the final Main Workflow should look like:

Workflow 2
Workflow 2 will feed the downloaded partner files to the integration flow that we had designed earlier for cleansing,
validating, and consolidating data.
1. The Context Information object in the Resources section of the toolbox will be used to dynamically provide our
Dataflow with the dropped file path i.e. the complete path of files that are downloaded from the FTP server and
dropped into a particular folder.

This object, paired with the Job Scheduler, will automate the process of running this Workflow whenever a new partner
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file is downloaded.
2. The Run Dataflow object in the Workflow Tasks section of the toolbox will be used to run our Dataflow whenever a
new partner file is downloaded.
• Configure the Run Dataflow object by providing the file path to our Dataflow.
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• The FilePath input element in the Run Dataflow object denotes the file path variable that we had defined in the
Dataflow. Map the DroppedFilePath parameter from the Context Information object onto FilePath in the Run
Dataflow object. As a result, this is what Workflow 2 should look like:

The FilePath variable has been used to dynamically provide the source object in our Dataflow with a file path. Consequently, whenever a new file is downloaded from the FTP server, a new file path will be fed to the source object
through this mapping.
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Job Scheduler
As mentioned earlier, Wheel Dealers wants to automate its data integration process wherever possible. The Job
Scheduler in Astera Centerprise can be used to schedule any job to run at specific intervals or whenever a file is
dropped into a folder, without any manual intervention. In this case, we will be making two schedules – one for each
Workflow.
For a detailed guideline on how to open and use the Job Scheduler, click here.
Scheduling Workflow 1
For Workflow 1, we will assume that partner files are coming in on a biweekly basis, specifically on Mondays and
Wednesdays. Thus, Workflow 1 will be scheduled to run every week on Mondays and Wednesdays.

Scheduling Workflow 2
The files being fetched from the FTP server are added to a specific folder. Therefore, we will schedule Workflow 2 to
run whenever a new file is dropped into that folder.
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Everything is now in place, and Wheel Dealers can rely on this automated ETL Process to handle their Partner Onboarding needs. With Astera Centerprise, most of the tasks associated with Partner Onboarding can be automated,
significantly cutting down on the time and resources required.
This concludes creating and orchestrating an ETL process for Partner Onboarding in Astera Centerprise.

1.128 Context Information
The Context Information object in Astera Centerprise provides a set of context information parameters that take their
values at runtime of a dataflow or workflow. These parameters include several details related to the job taking place
and the server on which it is being run, such as ServerName, JobId, UserName, and DroppedFilePath, among others.

1.128.1 Use Case
In this use case, we will automate the process of writing a fictitious organization’s customer data, which is currently
available in an Excel format, to a database table. The source data is stored in multiple Excel files, and each of these files
will be dropped into a particular folder. Our goal is to design a process where customer data is extracted from every
file that is dropped into the folder and this data is then written to a destination table without any manual intervention.
For this, we will be using the DroppedFilePath parameter in the Context Information object in conjunction with the
‘When File is Dropped’ option in the Centerprise Job Scheduler.

1.128.2 Using the Context Information Object in Astera Centerprise
We’ve already designed a dataflow to create the process of writing data to a destination table, and we’ll orchestrate
this process for automation in a workflow.
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In the dataflow, we’ve used an Excel Workbook Source object to extract data from the source files and a Database
Table Destination object to write this data to a database table. A Variables object has been used to create a variable
that will provide source file paths to the Excel Workbook Source object.
On the properties screen of the Variables object, you’ll see that we’ve created an input variable by the name of FilePath.

1.128. Context Information
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We’ve used this variable as an input parameter for the FilePath section in the Config Parameters screen of the Excel
Workbook Source object.
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We’ve incorporated this dataflow into our workflow by using the Run Dataflow object. You’ll notice that the FilePath
variable is visible in the object layout.

1.128. Context Information
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Go to the Resources section in the toolbox and drag and drop the Context Information object onto the workflow
designer.

In the object layout, you can see all of the context information parameters that are available. If you wish to see their
data types, right-click on the object header and select Properties from the context menu.
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Name: Name of the workflow, for example Workflow1.wf
JobId: ID of the job assigned by the server
ScheduledJobId: ID of the job associated with a schedule in case of scheduled running on a server
ServerName: Name of the server running the workflow
UserName: User account that runs the workflow
DroppedFilePath: Path to the file being dropped, in case of a scheduled job of type ‘When File is Dropped’
As mentioned earlier, all of these parameters take their values at run-time.
In this case, we require the DroppedFilePath parameter’s value to be fed to the source object in our dataflow. Map this
parameter from the Context Information object to the FilePath variable that’s visible under the input node of the Run
Dataflow object.

1.128. Context Information
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Now, all that’s left is to schedule this job to run whenever a source file is dropped into a specified folder. For this,
we’ve selected the ‘When File is Dropped’ option under the Frequency section of the Job Scheduler.

Moreover, we’ve specified a directory where the files will be dropped.
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Once we’ve created this schedule, every delimited file dropped into this folder will automatically be written to the
destination table. Here is a look at the destination table after we’ve added one source file to the folder.

This concludes using the Context Information object in Astera Centerprise.
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